
"



QGIS User Guide
Release 2.14

QGIS Project

08 August 2017





Contents

1 Introduzione 1

2 Convenzioni 3
2.1 Convenzioni per l’interfaccia grafica . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
2.2 Convenzioni per il Testo o la Tastiera . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
2.3 Istruzioni specifiche per un sistema operativo . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

3 Premessa 5

4 Caratteristiche 7
4.1 Visualizzazione dati . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
4.2 Esplorare dati e comporre mappe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
4.3 Creazione, modifica, gestione ed esportazione dati . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.4 Analizza i dati . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.5 Pubblicazione di mappe su internet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.6 Estendi le funzionalità di QGIS attraverso i plugin . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.7 Console python . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
4.8 Problemi noti . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

5 Novità in QGIS 2.14 11

6 Come Iniziare 13
6.1 Installazione . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
6.2 Launching QGIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
6.3 Sample Session: Load raster and vector layers . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
6.4 Progetti . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
6.5 Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

7 QGIS GUI 19
7.1 Barra dei Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
7.2 Panels and Toolbars . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
7.3 Mappa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
7.4 Barra di Stato . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

8 Strumenti generali 35
8.1 Scorciatoie da tastiera . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
8.2 Guide contestuali . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
8.3 Visualizzazione . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
8.4 Color Selector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
8.5 Blending Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
8.6 Zooming and Panning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
8.7 Misurazioni . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
8.8 Selezionare e deselezionare elementi . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

i



8.9 Data defined override setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
8.10 Informazione elementi . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
8.11 Note testuali . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
8.12 Segnalibri geospaziali . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
8.13 Progetti nidificati . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
8.14 Decorazioni . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
8.15 Authentication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
8.16 Save layer into file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
8.17 Use of variables for dynamic content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

9 QGIS Configuration 53
9.1 Proprietà progetto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
9.2 Opzioni dell’interfaccia grafica (GUI) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
9.3 Personalizzazione . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

10 Lavorare con le proiezioni 67
10.1 Panoramica sul supporto alle proiezioni . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
10.2 Specifiche globali delle proiezioni . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
10.3 Definire la riproiezione al volo (OTF) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
10.4 Sistemi di riferimento personalizzati . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
10.5 Trasformazioni datum predefinite . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

11 QGIS Browser 73
11.1 QGIS Browser widget . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
11.2 QGIS Browser as a standalone application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

12 Lavorare con i vettori 77
12.1 Formati supportati . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
12.2 The Symbol Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
12.3 Proprietà dei vettori . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
12.4 Expressions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141
12.5 Lavorare col la tabella degli attributi . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
12.6 Modifica . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
12.7 Layer virtuali . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

13 Lavorare con i dati raster 177
13.1 Lavorare con i dati raster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
13.2 Proprietà raster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
13.3 Analisi raster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187

14 Lavorare con i dati OGC 191
14.1 QGIS as OGC Data Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
14.2 QGIS as OGC Data Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200

15 Lavorare con i dati GPS 213
15.1 Plugin GPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
15.2 Tracciamento live GPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217

16 Authentication System 223
16.1 Authentication System Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 223
16.2 User Authentication Workflows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230
16.3 Security Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241

17 Integrazione con GRASS GIS 245
17.1 Demo dataset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
17.2 Caricare layer raster e vettoriali GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
17.3 Importing data into a GRASS LOCATION via drag and drop . . . . . . . . . . . . . . . . . . . 245
17.4 Managing GRASS data in QGIS browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
17.5 GRASS Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
17.6 Avviare il plugin GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246

ii



17.7 Opening GRASS mapset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
17.8 LOCATION e MAPSET in GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
17.9 Importare dati nelle LOCATION GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
17.10 Il modello dati vettoriale di GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249
17.11 Creare un nuovo layer vettoriale GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
17.12 Digitalizzare e modificare layer vettoriali GRASS . . . . . . . . . . . . . . . . . . . . . . . . . 250
17.13 Lo strumento Regione di GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252
17.14 The GRASS Toolbox . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

18 ambiente Processing di QGIS 261
18.1 Introduzione . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261
18.2 Strumenti . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261
18.3 Modellatore grafico . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
18.4 L’interfaccia per i processi in serie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
18.5 Usare gli algoritmi di Processing dalla console dei comandi . . . . . . . . . . . . . . . . . . . . 283
18.6 Il gestore della cronologia di Processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
18.7 Writing new Processing algorithms as python scripts . . . . . . . . . . . . . . . . . . . . . . . . 290
18.8 Handing data produced by the algorithm . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291
18.9 Comunicare con l’utente . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
18.10 Documenting your scripts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
18.11 Example scripts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
18.12 Best practices for writing script algorithms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293
18.13 Pre- and post-execution script hooks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293
18.14 Configurazione di applicazioni esterne . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293
18.15 La riga di comando . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 300

19 Print Composer 303
19.1 Overview of the Print Composer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303
19.2 Composer Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311
19.3 Creating an Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 339

20 Plugin di QGIS 345
20.1 QGIS Plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 345
20.2 Using QGIS Core Plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 350
20.3 Plugin Cattura coordinate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351
20.4 Plugin DB Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351
20.5 Plugin Convertitore DXF2Shape . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352
20.6 Plugin eVis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354
20.7 Plugin fTools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 364
20.8 Plugin GDALTools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 367
20.9 Geometry Checker Plugin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 370
20.10 Geometry Snapper Plugin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 373
20.11 Plugin Georeferenziatore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 373
20.12 Plugin Mappa di concentrazione . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 377
20.13 Plugin Interpolazione . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381
20.14 Client Catalogo MetaSearch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 382
20.15 Plugin Offline Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 386
20.16 Oracle Spatial GeoRaster Plugin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 387
20.17 Plugin Analisi geomorfologica . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 390
20.18 Plugin grafo strade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 391
20.19 Plugin Spatial Query . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
20.20 Validatore topologico . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 393
20.21 Plugin Statistica zonale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 395

21 Aiuto e supporto 397
21.1 Le Mailing list . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397
21.2 IRC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 398
21.3 BugTracker . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399
21.4 Blog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399

iii



21.5 Plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399
21.6 Wiki . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399

22 Appendice 401
22.1 GNU General Public License . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401
22.2 GNU General Public License . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 404

23 Letteratura e riferimenti web 411

Indice 413

iv



CHAPTER 1

Introduzione

This document is the original user guide of the described software QGIS. The software and hardware described
in this document are in most cases registered trademarks and are therefore subject to legal requirements. QGIS is
subject to the GNU General Public License. Find more information on the QGIS homepage, http://www.qgis.org.

I dettagli, i dati, i risultati ecc. presenti in questo documento sono stati scritti e verificati al meglio delle conoscenze
e della responsabilità degli autori e degli editori. Ciononostante, possono essere presenti errori nei contenuti.

Pertanto, nessun dato è soggetto ad alcun obbligo o garanzia. Gli autori, i redattori e gli editori non si assumono
alcun obbligo o responsabilità per malfunzionamenti e possibili conseguenze. Tutti gli utenti sono pertanto invitati
a segnalare eventuali errori.

This document has been typeset with reStructuredText. It is available as reST source code via github and online
as HTML and PDF via http://www.qgis.org/en/docs/. Translated versions of this document can be downloaded in
several formats via the documentation area of the QGIS project as well. For more information about contributing
to this document and about translating it, please visit http://qgis.org/en/site/getinvolved/index.html.

Collegamenti presenti in questo documento

Questo documento contiene collegamenti interni ed esterni. Cliccando su un collegamento interno puoi spostarti
all’interno del manuale, mentre cliccando su un collegamento esterno si aprirà un indirizzo internet. in formato
PDF i collegamenti interni ed esterni sono mostrati in colore blu e sono gestiti dal browser del sistema operativo.
In formato HTML, il browser gestisce e mostra entrambi allo stesso modo.

Autori e redattori delle guide per l’utente, l’installazione e la programmazione:

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Andy Schmid Hien Tran-Quang

Copyright (c) 2004 - 2014 QGIS Development Team

Internet: http://www.qgis.org

Licenza di questo documento

È garantito il permesso di copiare, distribuire e/o modificare questo documento in base ai termini della GNU
Free Documentation License, Versione 1.3 o ogni versione successiva pubblicata dalla Free Software Foundation;
senza alcuna sezione non modificabile, senza testo di copertina e retro-copertina. Una copia della licenza è inclusa
nell’appendice
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2 Chapter 1. Introduzione



CHAPTER 2

Convenzioni

Questa sezione descrive le convenzioni e gli stili che verranno usati in questo manuale.

2.1 Convenzioni per l’interfaccia grafica

Le convenzioni stilistiche per l’interfaccia grafica hanno lo scopo di imitarne l’effettivo aspetto. In generale,
lo stile presentato nel manuale fa riferimento a ciò che compare nell’interfaccia grafica e non ai messaggi che
compaiono se il cursore del mouse si ferma sopra un pulsante.

• Opzioni di menu: Layer → Aggiungi raster oppure Impostazioni → Barre degli strumenti → Digitaliz-
zazione

• Tool: Add a Raster Layer

• Pulsante: [Salva come predefinito]

• Titolo finestra di dialogo: Proprieta layer

• Scheda (tab): Generale

• Casella di controllo: Visualizzatore

• Radio Button: Postgis SRID EPSG ID

• Select a number:

• Select a string:

• Browse for a file:

• Select a color:

• Cursore:

• Input Text:

L’ombreggiatura caratterizza un componente dell’interfaccia grafica che è cliccabile.

2.2 Convenzioni per il Testo o la Tastiera

This manual also includes styles related to text, keyboard commands and coding to indicate different entities, such
as classes or methods. These styles do not correspond to the actual appearance of any text or coding within QGIS.

• Collegamenti web: http://qgis.org

• Combinazioni di tasti: Ctrl+B significa premere il tasto B mentre si tiene premuto il tasto Ctrl.

3

http://qgis.org


QGIS User Guide, Release 2.14

• Nome di un file: lakes.shp

• Nome di una classe: NewLayer

• Metodo: classFactory

• Server: myhost.de

• Inserimento di testo nel terminale: qgis --help

I frammenti di codice sono identificati con un carattere a spaziatura fissa:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Istruzioni specifiche per un sistema operativo

GUI sequences and small amounts of text may be formatted inline: Click File QGIS → Quit to close
QGIS. This indicates that on Linux, Unix and Windows platforms, you should click the File menu first, then Quit,
while on Macintosh OS X platforms, you should click the QGIS menu first, then Quit.

I testi di grandi dimensioni possono venire formattati come elenco:

• fai questo

• fai quello

• fai qualcos’altro

o come paragrafi:

Fai questo e questo e questo. Quindi fai questo e questo, e questo.

Fai quello. Poi fai quello e quello, e quello.

Le schermate riportate nella guida sono state create su diversi sistemi operativi, indicati da apposite icone alla fine
della didascalia.
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CHAPTER 3

Premessa

Benvenuti nel meraviglioso mondo dei Sistemi Informativi Geografici (GIS)!

QGIS is an Open Source Geographic Information System. The project was born in May of 2002 and was estab-
lished as a project on SourceForge in June of the same year. We’ve worked hard to make GIS software (which
is traditionally expensive proprietary software) a viable prospect for anyone with basic access to a personal com-
puter. QGIS currently runs on most Unix platforms, Windows, and OS X. QGIS is developed using the Qt toolkit
(https://www.qt.io) and C++. This means that QGIS feels snappy and has a pleasing, easy-to-use graphical user
interface (GUI).

QGIS punta a essere un GIS facilmente utilizzabile da chiunque, fornendo tutte le funzioni e caratteristiche prin-
cipali. L’obiettivo iniziale del progetto era quello di fornire un visualizzatore di dati GIS. Evolvendosi, QGIS
supporta ora moltissimi formati raster e vettoriali, supporto che si amplia con l’uso dei plugin esterni.

QGIS è rilasciato sotto la GNU General Public License (GPL). Sviluppare QGIS con questa licenza significa che
puoi ispezionare e modificare il codice sorgente e garantisce che tu, nostro utente, avrai sempre accesso a un
programma GIS libero che potrai liberamente modificare. Insieme alla copia di QGIS dovresti aver ricevuto anche
una copia completa del testo della licenza che puoi trovare anche nell’Appendice di questo manuale GNU General
Public License.

Suggerimento: Documentazione aggiornata
Puoi sempre trovare la versione più recente di questo documento sul sito di QGIS all’indirizzo
http://www.qgis.org/en/docs/.
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CHAPTER 4

Caratteristiche

QGIS offre molte delle più comuni funzionalità GIS grazie alle sue caratteristiche di base e ai plugin. Di seguito
viene elencato un piccolo riassunto delle sei categorie principali e dei plugin, seguito da una panoramica della
console python integrata.

4.1 Visualizzazione dati

Puoi visualizzare e sovrapporre vettori e raster di diversi formati e con diverse proiezioni, senza che sia necessaria
alcuna conversione di formato. I formati supportati includono:

• Tabelle e viste spaziali PostGIS, SpatiaLite e MS SQL Spatial, Oracle Spatial e vettori supportati dalla
libreria OGR come ESRI shapefile, MapInfo, SDTS, GML e molti molti altri, vedi la sezione Lavorare con
i vettori.

• Raster e immagini supportati dalla libreria GDAL (Geospatial Data Abstraction Library), come GeoTIFF,
ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG e molti altri ancora, vedi la sezione Lavorare con i dati
raster.

• Raster e vettori GRASS dai relativi database (location/mapset), vedi la sezione Integrazione con GRASS
GIS.

• Dati spaziali accessibili da Web Services OGC, come (WMS, WMTS, WCS, WFS, WFS-T, ...), vedi sezione
Lavorare con i dati OGC.

4.2 Esplorare dati e comporre mappe

Puoi creare delle mappe ed esplorare i dati spaziali con un’interfaccia grafica molto facile da usare. L’interfaccia
grafica ti mette a disposizione molti strumenti, fra cui:

• QGIS Browser

• Riproiezione al volo

• DB Manager

• Compositore di stampe

• Pannello vista generale

• Segnalibri spaziali

• Note testuali

• Funzioni di identificazione/selezione

• Modifica/visualizzazione/ricerca degli attributi

• Etichettatura con dati definiti dall’utente

7



QGIS User Guide, Release 2.14

• Simbologia definita dall’utente per vettori e raster

• Creazione atlante

• Freccia nord, barra di scale ed etichetta copyright per le mappe

• Supporto per il salvataggio e il ripristino di progetti

4.3 Creazione, modifica, gestione ed esportazione dati

Puoi creare, modificare, gestire ed esportare i vettori e i raster in molti formati. Ecco un elenco di alcune caratter-
istiche principali di QGIS:

• Strumenti per la digitalizzazione per i formati OGR e per i vettori GRASS

• Possibilità di creare e modificare shapefile e vettori GRASS

• Plugin georeferenziatore per geocodificare le immagini

• Strumenti GPS per importare ed esportare formati GPX, convertire altri formati GPS in GPX o scari-
carli/caricarli direttamente su di una unità GPS (nella versione Linux, usb: è stata aggiunta alla lista degli
strumenti GPS)

• Supporto per la visualizzazione e la modifica di dati OpenStreetMap

• Creazione tabelle di database spaziali da shapefile con il plugin DB Manager

• Gestione delle tabelle di database spaziali migliorata

• Strumenti per gestire le tabelle degli attributi di un vettore

• Salvataggio di schermate come immagini georiferite

• DXF-Export tool with enhanced capabilities to export styles and plugins to perform CAD-like functions

4.4 Analizza i dati

Puoi effettuare analisi spaziali su database spaziali e altri formati supportati da OGR. Attualmente QGIS offre
strumenti di analisi vettoriale, geoprocessing, geometria e gestione database. Puoi anche utilizzare gli strumenti
integrati di GRASS, ovvero avrai completo accesso agli oltre 400 moduli di GRASS (vedi sezione Integrazione con
GRASS GIS). Puoi anche utilizzare il plugin Processing che permette di effettuare potentissime analisi geospaziali
grazie agli algoritmi provenienti da altri programmi come GDAL, SAGA, GRASS, fTools e molti altri ancora
(vedi sezione Introduzione).

4.5 Pubblicazione di mappe su internet

QGIS può essere utilizzato come client WMS, WMTS, WMS-C e WFS-T e come server WMS, WFS o WCS (vedi
sezione Lavorare con i dati OGC). Inoltre puoi esportare e pubblicare i tuoi dati in internet usando un webserver
con installato UMN MapServer o GeoServer.

4.6 Estendi le funzionalità di QGIS attraverso i plugin

Puoi adattare QGIS ai tuoi scopi grazie all’architettura estensibile dei plugin. QGIS fornisce librerie che possono
essere usate per la creazione di plugin. Ma puoi anche creare le tue nuove applicazioni con C++ o python!
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4.6.1 Plugin nativi

I plugin nativi includono:

1. Cattura coordinate (cattura le coordinate, tramite il mouse, nei diversi Sistemi di Riferimento)

2. DB Manager (scambia, modifica e visualizza layer e tabelle da/su database; esegue interrogazioni in SQL)

3. Convertitore Dxf2Shp (converte file DXF in shapefile)

4. eVIS (visualizza eventi)

5. fTools (analisi e gestione di vettori)

6. Strumenti GDAL (Strumenti GDAL integrati in QGIS)

7. Georeferenziatore raster (aggiunge ai raster informazioni sulla proiezione utilizzando GDAL)

8. Strumenti GPS (carica e importa dati GPS)

9. GRASS (integrazione con GRASS)

10. Mappe di concentrazione (Genera delle mappe di concentrazione raster partendo da dati puntuali)

11. Plugin interpolazione (interpolazione basata sui vertici in un vettore)

12. Client Catalogo MetaSearch

13. Offline Editing (consente le modifiche offline e la sincronizzazione con un database)

14. Oracle Spatial Georaster

15. Processing (SEXTANTE nelle versioni precedenti)

16. Plugin per l’analisi geomorfologica (analisi del terreno basata su raster)

17. Grafo strade (analisi del percorso più breve)

18. Plugin Interrogazione spaziale

19. Validatore topologico (trova errori topologici in un vettore)

20. Plugin statistiche zonali (calcola il conteggio, la somma, la media di un raster per ogni poligono di un
vettore)

4.6.2 Plugin esterni in python

QGIS offre un crescente numero di plugin python esterni creati dalla comunità. Questi plugin sono presenti
all’interno del repository ufficiale dei plugin e possono essere facilmente installati usando l’installatore dei plugin
python (vedi sezione La finestra di dialogo Plugins).

4.7 Console python

Se usi script, puoi sfruttare la console python integrata, accessibile dal menu Plugin → Console Python. La
console si apre come una finestra di dialogo non modale. Per interagire con l’ambiente di QGIS esiste la variabile
qgis.utils.iface che è un’istanza di QgsInterface. Questa interfaccia ti permette di accedere alla
mappa, ai menu, alle barre degli strumenti e ad altre applicazioni di QGIS. Puoi creare uno script, trascinarlo
all’interno della finestra di QGIS ed esso sarà eseguito automaticamente.

Per maggiori informazioni su come utilizzare la console Python e programmare plugin per QGIS, fai riferimento
a PyQGIS-Developer-Cookbook.

4.7. Console python 9
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4.8 Problemi noti

4.8.1 Limitazione numero di file aperti

Se stai aprendo un grande progetto di QGIS e sei sicuro che tutti i layer sono validi, ma qualche layer viene
segnalato come corrotto, probabilmente ti stai scontrando con questo problema. Linux (e probabilmente anche
altri sistemi operativi) hanno un limite di file aperti per ogni processo. I limiti delle risorse e per ogni processo
vengono automaticamente ereditati. Il comando ulimit, preinstallato nella console dei comandi, cambia i limiti
solo per il processo attuale; il nuovo limite viene ereditato da ogni altro processo.

Puoi vedere tutti gli ulimit attuali digitando

user@host:~$ ulimit -aS

Poi vedere l’attuale numero permesso di file aperti per ogni processo con questo comando da console

user@host:~$ ulimit -Sn

Per cambiare i limiti di una sessione esistente, potresti usare qualcosa del genere

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

Risolverlo per sempre

Sulla maggior parte dei sistemi Linux, i limiti alle risorse sono impostati al momento del login tramite
il modulo pam_limits in funzione delle impostazioni contenute in /etc/security/limits.conf o
/etc/security/limits.d/*.conf. Dovresti modificare questi file sei hai i permessi di amministratore
(anche tramite sudo), ma dovrai effettuare di nuovo il login prima che i cambiamento siano effettivi.

Maggiori informazioni:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en
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CHAPTER 5

Novità in QGIS 2.14

Questa versione contiene nuove funzionalità ed amplia l’interfaccia di programmazione delle precedenti versioni.
Consigliamo quindi di usare questa versione al posto di quelle precedenti.

In questa versione sono stati corretti centinaia di bug e sono state aggiunte molte nuove funzionalità rispetto a
QGIS 2.8 che saranno descritti in questo manuale. L’elenco dei cambiamenti è disponibile all’indirizzo:

• http://qgis.org/en/site/forusers/visualchangelog210/index.html

• http://qgis.org/en/site/forusers/visualchangelog212/index.html

• http://qgis.org/en/site/forusers/visualchangelog214/index.html
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CHAPTER 6

Come Iniziare

This chapter gives a quick overview of installing QGIS, some sample data from the QGIS web page, and running
a first and simple session visualizing raster and vector layers.

6.1 Installazione

Installation of QGIS is very simple. Standard installer packages are available for MS Windows and Mac OS X. For
many flavors of GNU/Linux, binary packages (rpm and deb) or software repositories are provided to add to your in-
stallation manager. Get the latest information on binary packages at the QGIS website at http://download.qgis.org.

6.1.1 Installazione da codice sorgente

If you need to build QGIS from source, please refer to the installation instructions. They are dis-
tributed with the QGIS source code in a file called INSTALL. You can also find them online at
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Installazione su supporti esterni

QGIS allows you to define a --configpath option that overrides the default path for user configuration (e.g.,
~/.qgis2 under Linux) and forces QSettings to use this directory, too. This allows you to, for instance, carry a
QGIS installation on a flash drive together with all plugins and settings. See section Menu Sistema for additional
information.

6.1.3 Dati campione

The user guide contains examples based on the QGIS sample dataset.

The Windows installer has an option to download the QGIS sample dataset. If checked, the data will be down-
loaded to your My Documents folder and placed in a folder called GIS Database. You may use Windows
Explorer to move this folder to any convenient location. If you did not select the checkbox to install the sample
dataset during the initial QGIS installation, you may do one of the following:

• usare dati GIS che hai già;

• Download sample data from http://qgis.org/downloads/data/qgis_sample_data.zip

• Uninstall QGIS and reinstall with the data download option checked (only recommended if the above solu-
tions are unsuccessful)

For GNU/Linux and Mac OS X, there are not yet dataset installation packages available as rpm,
deb or dmg. To use the sample dataset, download the file qgis_sample_data as a ZIP archive from
http://qgis.org/downloads/data/ and unzip the archive on your system.
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The Alaska dataset includes all GIS data that are used for examples and screenshots in the user guide; it also
includes a small GRASS database. The projection for the QGIS sample dataset is Alaska Albers Equal Area with
units feet. The EPSG code is 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

If you intend to use QGIS as a graphical front end for GRASS, you can find a selection of sample locations (e.g.,
Spearfish or South Dakota) at the official GRASS GIS website, http://grass.osgeo.org/download/sample-data/.

6.2 Launching QGIS

6.2.1 Starting and Stopping QGIS

Starting QGIS is done as you usually do for any other application on your platform. It means that you can launch
QGIS by:

• typing qgis at a command prompt, assuming that QGIS is added to your PATH or you’re in its installation
folder

• using the Applications menu if using a precompiled binary, the Start menu or the Dock

• double clicking the icon in your Applications folder or desktop shortcut

• double clicking an existing QGIS project (.qgs) file. Note that this will also open the project

To stop QGIS, click:

• the menu option Project → Exit QGIS or use the shortcut Ctrl+Q

• QGIS → Quit QGIS, or use the shortcut Cmd+Q

• or use the red cross at the right top corner of the main interface of the application.

6.2.2 Opzioni linea di comando

In previous section you learned how to start QGIS. You will see that QGIS also provides further command line
options.

QGIS supports a number of options when started from the command line. To get a list of the options, enter qgis
--help on the command line. The usage statement for QGIS is:

14 Chapter 6. Come Iniziare

http://grass.osgeo.org/download/sample-data/


QGIS User Guide, Release 2.14

qgis --help
QGIS - 2.6.0-Brighton ’Brighton’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noversioncheck] don’t check for new version of QGIS at startup
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--authdbdirectory path] use the given directory for authentication database
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--dxf-export filename.dxf] emit dxf output of loaded datasets to given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-preset visiblity-preset] layer visibility preset to use for dxf output
[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Suggerimento: Esempio di utilizzo delle opzioni da riga di comando
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on
startup using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

Opzioni linea di comando --snapshot

L’opzione consente di catturare una schermata in formato PNG della mappa. Utile quando hai molti progetti e
vuoi generare schermate dai propri dati.

Il file PNG generato ha una risoluzione di 800x600 pixels. Puoi adattare la risoluzione grazie agli argomenti
“–width” e “–height” da riga di comando. Puoi anche aggiungere il nome del file dopo l’argomento “–snapshot”.

Opzioni linea di comando --lang

Based on your locale, QGIS selects the correct localization. If you would like to change your language, you can
specify a language code. For example, qgis --lang it starts QGIS in Italian localization.

Opzioni linea di comando --project

Starting QGIS with an existing project file is also possible. Just add the command line option --project
followed by your project name and QGIS will open with all layers in the given file loaded.

Opzioni linea di comando --extent
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Per avviare QGIS con un specifica estensione devi aggiungere i confini della bounding box in questo ordine e
separati da una virgola:

--extent xmin,ymin,xmax,ymax

Opzioni linea di comando --nologo

This command line argument hides the splash screen when you start QGIS.

command line option --noversioncheck

Don’t check for new version of QGIS at startup.

Opzioni linea di comando --noplugins

Se all’avvio di QGIS si verificano problemi con i plugin puoi evitare di caricarli con questa opzione. I plugin
rimarranno comunque disponibili nel Gestore plugin. Opzioni linea di comando --customizationfile

Usando questa opzione puoi specificare un file di personalizzazione dell’interfaccia grafica che verrà caricato
all’avvio.

Opzioni linea di comando --nocustomization

Usando questa opzione le personalizzazioni dell’interfaccia non verranno applicate all’avvio.

Opzioni linea di comando --optionspath

You can have multiple configurations and decide which one to use when starting QGIS with this option.
See Opzioni dell’interfaccia grafica (GUI) to confirm where the operating system saves the settings files.
Presently, there is no way to specify a file to write settings to; therefore, you can create a copy of the orig-
inal settings file and rename it. The option specifies path to directory with settings. For example, to use
/path/to/config/QGIS/QGIS2.ini settings file, use option:

--optionspath /path/to/config/

Opzioni linea di comando --configpath

This option is similar to the one above, but furthermore overrides the default path for user configuration
(~/.qgis2) and forces QSettings to use this directory, too. This allows users to, for instance, carry a QGIS
installation on a flash drive together with all plugins and settings.

Command line option --authdbdirectory

Again, this option is similar to the one above but define the path to the directory where the authentication database
will be stored.

Opzioni linea di comando --code

This option can be used to run a given python file directly after QGIS has started.

Per esempio, se hai un file python load_alaska.py con il seguente contenuto:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Assuming you are in the directory where the file load_alaska.py is located, you can start QGIS, load the
raster file landcover.img and give the layer the name ‘Alaska’ using the following command: qgis --code
load_alaska.py

Command line options --dxf-*
These options can be used to export QGIS project into a DXF file. Several options are available:

• –dxf-export: the DXF filename into which to export the layers;

• –dxf-extent: the extent of the final DXF file;

• –dxf-symbology-mode: several values can be used here: none (no symbology), symbollayer (Symbol layer
symbology), feature (feature symbology);
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• –dxf-scale-deno: the scale denominator of the symbology;

• –dxf-encoding: the file encoding;

• –dxf-preset: choose a visibility preset. These presets are defined in the layer tree, see Layers Panel.

6.3 Sample Session: Load raster and vector layers

Now that you have QGIS installed and a sample dataset available, we would like to demonstrate a short and simple
QGIS sample session. We will visualize a raster and a vector layer. We will use:

• the landcover raster layer i.e., qgis_sample_data/raster/landcover.img

• and the lakes vector layer i.e., qgis_sample_data/gml/lakes.gml.

1. Start QGIS as seen in Starting and Stopping QGIS

2. Click on the Add Raster Layer icon.

3. Trova la cartella qgis_sample_data/raster/, seleziona il file ERDAS IMG landcover.img e
clicca [Apri].

4. If the file is not listed, check if the Files of type combo box at the bottom of the dialog is set on the
right type, in this case Erdas Imagine Images (*.img *.IMG).

5. Now click on the Add Vector Layer icon.

6. File should be selected as Source Type in the new Add vector layer dialog. Now click [Browse] to select
the vector layer.

7. Browse to the folder qgis_sample_data/gml/, select Geography Markup Language [GML]
[OGR] (*.gml *.GML) from the Filter combo box, then select the GML file lakes.gml and
click [Open]. In the Add vector layer dialog, click [OK]. The Coordinate Reference System Selector dialog
opens with NAD27 / Alaska Alberts selected, click [OK].

8. Zoom in a bit to your favourite area with some lakes.

9. Fai doppio click sul vettore lakes nella legenda per aprire la finestra di dialogo Proprietà.

10. Clicca sulla scheda Stile e seleziona blu come colore di riempimento.

11. Click on the Labels tab and select Show labels for this layer in the drop-down menu to enable labeling.
Then from the Label with list, choose the NAMES field as the field containing labels.

12. To improve readability of labels, you can add a white buffer around them by clicking Buffer in the list on

the left, checking Draw text buffer and choosing 3 as buffer size.

13. Clicca [Applica], controlla se il risultato è buono e infine clicca [OK].

You can see how easy it is to visualize raster and vector layers in QGIS. Let’s move on to the sections that follow
to learn more about the available functionality, features and settings, and how to use them.

6.4 Progetti

The state of your QGIS session is considered a project. QGIS works on one project at a time. Settings are
considered as being either per-project or as a default for new projects (see section Opzioni dell’interfaccia grafica

(GUI)). QGIS can save the state of your workspace into a project file using the menu options Project → Save

or Project → Save As.... If the loaded project file on disk was meanwhile changed, by default, QGIS will ask

you if you want to overwrite the changes into the project file. This behavior is set by checking Prompt to save
project and data source changes when required under Settings → Options → General menu .
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Load saved projects into a QGIS session using Project → Open..., Project → New from template or Project
→ Open Recent →.

At startup, a list of screenshot with the name and path of each of the most recent projects (up to ten) is shown
instead of a white and empty map canvas. This is a handy and quicker way to remember what a project was about
and double-click a row opens the selected project. If you’re willing to create a new project, just add new layers
and the list disappears.

If you wish to clear your session and start fresh, choose Project → New. Either of these menu options will
prompt you to save the existing project if changes have been made since it was opened or last saved.

Le informazioni salvate nel file di progetto includono:

• Layer aggiunti

• Which layers can be queried

• Layer properties, including symbolization and styles

• Proiezione usata per la mappa

• Ultima estensione della mappa

• Print Composers

• Print Composer elements with settings

• Print Composer atlas settings

• Digitizing settings

• Table Relations

• Project Macros

• Project default styles

• Plugins settings

• QGIS Server settings from the OWS settings tab in the Project properties

• Queries stored in the DB Manager

The project file is saved in XML format, so it is possible to edit the file outside QGIS if you know what you are
doing. The file format has been updated several times compared with earlier QGIS versions. Project files from
older QGIS versions may not work properly any more. To be made aware of this, in the General tab under Settings

→ Options you should tick Warn when opening a project file saved with an older version of QGIS.

Whenever you save a project in QGIS a backup of the project file is made with the extension .qgs~.

6.5 Output

There are several ways to generate output from your QGIS session. We have discussed one already in section
Progetti, saving as a project file. Here is a sampling of other ways to produce output files:

• Menu option Project → Save as Image... opens a file dialog where you select the name, path and type
of image (PNG, JPG and many other formats). A world file with extension PNGW or JPGW saved in the
same folder georeferences the image.

• Menu option Project → DXF Export... opens a dialog where you can define the ‘Symbology mode’, the
‘Symbology scale’ and vector layers you want to export to DXF. Through the ‘Symbology mode’ symbols
from the original QGIS Symbology can be exported with high fidelity.

• Menu option Project → New Print Composer... opens a dialog where you can layout and print the
current map canvas (see section Print Composer).
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CHAPTER 7

QGIS GUI

When QGIS starts, you are presented with the GUI as shown in the figure (the numbers 1 through 5 in yellow
circles are discussed below).

Figure 7.1: QGIS GUI with Alaska sample data

Nota: L’aspetto delle finestre (barra del titolo, ecc.) potrà apparire diverso a seconda del sistema operativo e
dell’ambiente desktop.

The QGIS GUI is divided into five areas:

1. Barra dei Menu

2. Toolbars

3. Panels

4. Mappa

5. Barra di Stato

These five components of the QGIS interface are described in more detail in the following sections. Two more
sections present keyboard shortcuts and context help.
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7.1 Barra dei Menu

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the associated icons as they appear on
the toolbar, and keyboard shortcuts. The shortcuts presented in this section are the defaults; however, keyboard
shortcuts can also be configured manually using the Configure shortcuts dialog, opened from Settings → Configure
Shortcuts....

Anche se la maggior parte dei menu ha uno strumento corrispondente (e viceversa), i menu non sono organizzati
come le barre degli strumenti. Gli strumenti contenuti in queste ultime infatti sono identificate con una casella di
controllo nel menu corrispondente. Alcuni strumenti sono visibili solamente se il plugin corrispondente è attivo.
Per maggiori informazioni sugli strumenti e sulle barre degli strumenti, vedi la sezione Toolbars.

Nota: QGIS is a cross-platform application meaning that though it provides you with the same tools, they may be
placed in different menus according to the operating system specification. The lists below show the most common
location and precise when there is a variation.

7.1.1 Progetto

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

New Ctrl+N vedi Progetti Progetto

Open Ctrl+O vedi Progetti Progetto
Nuovo da modello → vedi Progetti
Open Recent → vedi Progetti

Save Ctrl+S vedi Progetti Progetto

Save As... Ctrl+Shift+S vedi Progetti Progetto

Save as Image... vedi Output
DXF Export... vedi Output

Project Properties... Ctrl+Shift+P vedi Progetti

New Print Composer Ctrl+P vedi Print Composer Progetto

Composer manager... vedi Print Composer Progetto
Stampe → vedi Print Composer

Exit QGIS Ctrl+Q

Under Mac OSX, the Exit QGIS command corresponds to QGIS → Quit QGIS (Cmd+Q).
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7.1.2 Modifica

Voce di Menu Scorciatoia Riferimento Barra degli
Strumenti

Undo Ctrl+Z vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Redo Ctrl+Shift+Zvedi Digitalizzazione avanzata Digitalizzazione
avanzata

Cut Features Ctrl+X vedi Modifica di un layer esistente Digitalizzazione

Copy Features Ctrl+C vedi Modifica di un layer esistente Digitalizzazione

Paste Features Ctrl+V vedi Modifica di un layer esistente Digitalizzazione
Incolla elementi come → vedi Lavorare col la tabella degli

attributi

Add Feature Ctrl+. vedi Modifica di un layer esistente Digitalizzazione

Move Feature(s) vedi Modifica di un layer esistente Digitalizzazione

Delete Selected vedi Modifica di un layer esistente Digitalizzazione

Rotate Feature(s) vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Simplify Feature vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Add Ring vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Add Part vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Fill Ring vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Delete Ring vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Delete Part vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Reshape Features vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Offset Curve vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Split Features vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Split Parts vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Merge Selected Features vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Merge Attr. of Selected
Features

vedi Digitalizzazione avanzata Digitalizzazione
avanzata

Node Tool vedi Modifica di un layer esistente Digitalizzazione

Rotate Point Symbols vedi Digitalizzazione avanzata Digitalizzazione
avanzata
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After activating Toggle editing mode for a layer, you will enable the Add Feature icon in the Edit menu
depending on the layer type (point, line or polygon).

7.1.3 Modifica (extra)

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Add Feature vedi Modifica di un layer esistente Digitalizzazione

Add Feature vedi Modifica di un layer esistente Digitalizzazione

Add Feature vedi Modifica di un layer esistente Digitalizzazione

7.1.4 Mappa

Voce di Menu Scorciatoia Riferimento Barra degli
Strumenti

Pan Map see Zooming and Panning Navigazione mappa

Pan Map to Selection Navigazione mappa

Zoom In Ctrl++ see Zooming and Panning Navigazione mappa

Zoom Out Ctrl+- see Zooming and Panning Navigazione mappa
Seleziona → vedi Selezionare e deselezionare

elementi
Attributi

Identify Features Ctrl+Shift+I see Informazione elementi Attributi
Misura → vedi Misurazioni Attributi

Statistical Summary see Statistical Summary Panel Attributi

Zoom Full Ctrl+Shift+F Navigazione mappa

Zoom To Layer Navigazione mappa

Zoom To Selection Ctrl+J Navigazione mappa

Zoom Last Navigazione mappa

Zoom Next Navigazione mappa

Zoom To Native
Resolution

Navigazione mappa

Proprietà → vedi Decorazioni
Modalità anteprima →

Map Tips see Menu Visualizza Attributi

New Bookmark... Ctrl+B vedi Segnalibri geospaziali Attributi

Show Bookmarks Ctrl+Shift+B vedi Segnalibri geospaziali Attributi

Refresh F5 Navigazione mappa
Pannelli → vedi Panels and Toolbars
Barre degli strumenti → vedi Panels and Toolbars
Toggle Full Screen Mode F11

Under Linux KDE, Panels →, Toolbars → and Toggle Full Screen Mode are rather placed in Settings menu.

Preview mode → is not available under Mac OS X.
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7.1.5 Layer

Voce di Menu Scorciatoia Riferimento Barra degli
Strumenti

Crea Layer → vedi Creating new Vector layers Gestione layer
Aggiungi Layer → see Formati supportati Gestione layer
Embed Layers and Groups... vedi Progetti nidificati
Add from Layer Definition
File...

Copy style see Save and Share Layer
Properties

Paste style see Save and Share Layer
Properties

Open Attribute Table vedi Lavorare col la tabella degli
attributi

Attributi

Toggle Editing vedi Modifica di un layer esistente Digitalizzazione

Save Layer Edits vedi Modifica di un layer esistente Digitalizzazione

Current Edits → vedi Modifica di un layer esistente Digitalizzazione
Save As... see Save layer into file
Save As Layer Definition File...

Remove Layer/Group Ctrl+D

Duplicate Layers (s)
Definisci Scala di Visibilità dei
Layer
Set CRS of Layer(s) Ctrl+Shift+C
Set project CRS from Layer
Properties... see Proprietà dei vettori
Filter... see Costruttore di interrogazioni

Labeling see Menu Etichette

Add to Overview Ctrl+Shift+O Gestione layer

Add All To Overview

Remove All From
Overview

Show All Layers Ctrl+Shift+U Gestione layer

Hide All Layers Ctrl+Shift+H Gestione layer

Show selected Layers

Hide selected Layers
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7.1.6 Impostazioni

Voce di Menu Scorcia-
toia

Riferimento Barra degli
Strumenti

Custom
CRS...

vedi Sistemi di riferimento personalizzati

Gestore di stili vedi The Style Manager
Configure

shortcuts...

Customization...
vedi Personalizzazione

Options... vedi Opzioni dell’interfaccia grafica (GUI)
Snapping
Options...

see Settare la tolleranza dello snapping e il raggio di
ricerca degli elementi

Under Linux KDE, you’ll find more tools in Settings menu such as Project Properties, Panels →, Toolbars →
and Toggle Full Screen Mode.

7.1.7 Plugins

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Manage and Install Plugins... vedi La finestra di dialogo Plugins
Python Console Ctrl+Alt+P

When starting QGIS for the first time not all core plugins are loaded.

7.1.8 Vector

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Open Street Map → vedi Caricare vettori OpenStreetMap

Strumenti di analisi → vedi Plugin fTools

Strumenti di ricerca → vedi Plugin fTools

Strumenti di Geoprocessing → vedi Plugin fTools
Strumenti di Geometria → vedi Plugin fTools

Strumenti di Gestione Dati → vedi Plugin fTools

When starting QGIS for the first time not all core plugins are loaded.

7.1.9 Raster

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Raster calculator... see Raster Calculator
Align Raster... see Raster Alignment

When starting QGIS for the first time not all core plugins are loaded.

7.1.10 Database

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Database → see Plugin DB Manager Database

When starting QGIS for the first time not all core plugins are loaded.
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7.1.11 Web

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Metasearch see Client Catalogo MetaSearch Web

When starting QGIS for the first time not all core plugins are loaded.

7.1.12 Processing

Voce di Menu Scorciatoia Riferimento Barra degli
Strumenti

Toolbox vedi Strumenti

Graphical
Modeler...

vedi Modellatore grafico

History and
log...

vedi Il gestore della cronologia di
Processing

Options... vedi Configurazione dell’ambiente di
elaborazione

Results viewer... vedi Configurazione di applicazioni esterne

Commander Ctrl+Alt+M vedi La riga di comando

When starting QGIS for the first time not all core plugins are loaded.

7.1.13 Guida

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Help Contents F1 Guida

What’s This? Shift+F1 Guida
API Documentation
Report an Issue
Need commercial support?

QGIS Home Page Ctrl+H

Check QGIS Version

About

QGIS Sponsors

7.1.14 QGIS

This menu is only available under Mac OS X and contains some OS related commands.

Voce di Menu Scorciatoia Riferimento
Preferences
About QGIS
Hide QGIS
Show All
Hide Others
Quit QGIS Cmd+Q

Preferences and About QGIS are the same commands as Settings → Options and Help → About. Quit QGIS
corresponds to Project → Exit QGIS under the other platforms.
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7.2 Panels and Toolbars

From the View menu (Settings under KDE), you can switch on and off QGIS widgets (Panels →) or toolbars
(Toolbars →). You can (de)activate any of them by right-clicking the menu bar or a toolbar and choose the item
you want. Each panel or toolbar can be moved and placed wherever you feel comfortable with in QGIS interface.
The list can also be extended with the activation of Core or external plugins.

7.2.1 Toolbars

Le barre degli strumenti forniscono accesso alla maggior parte delle funzioni presenti nei menu, oltre a funzioni
aggiuntive volte ad interagire con la mappa. Ogni oggetto della barra degli strumenti ha un aiuto a comparsa
(pop-up). Lasciando il cursore del mouse sopra l’icona, verrà visualizzata una breve descrizione della funzione di
quello strumento.

Every toolbar can be moved around according to your needs. Additionally, they can be switched off using the
right mouse button context menu, or by holding the mouse over the toolbars.

Figure 7.2: The Toolbars menu

Suggerimento: Ripristinare le barre degli strumenti
If you have accidentally hidden a toolbar, you can get it back by choosing menu option View → Toolbars → (or
Settings → Toolbars → under Linux KDE). If for some reason a toolbar (or any other widget) totally disappears
from the interface, you’ll find tips to get it back at restoring initial GUI.

7.2.2 Panels

QGIS provides by default many panels to work with.
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Figure 7.3: The Panels menu

Some of these panels are described below while others may be found in different parts of the document, namely:

• the Browser Panel

• the Advanced Digitizing Panel

• the Spatial Bookmarks Panel

• the GPS Information Panel

• the Tile Scale Panel

• the Identify Panel

• the User Input Panel

Layers Panel

The layers panel lists all the layers in the project. The checkbox in each legend entry can be used to show or hide
the layer. The toolbar in the layers panel allows you to:

• Add new group

• Manage Visibility: control visibility of layers and preset layers combination

• Filter Legend by Map Content: only the layers that are set visible and whose features intersect the current map
canvas have their style rendered in the layers panel. Otherwise, a generic NULL symbol is applied to the
layer. Based on the layer symbology, this is a convenient way to identify which kind of features from which
layers cover your area of interest.

• Filter Legend by Expression: helps you apply an expression to remove from the selected layer tree styles that
have no feature satisfying the condition. This can be used for example to highlight features that are within
a given area/feature of another layer. From the drop-down list, you can edit and clear the expression set.
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• Expand All or Collapse All layers and groups in the layers panel.

• and Remove Layer/Group currently selected.

The button allows you to add Presets views in the legend. Presets are a way to save and easily restore a
combination of layers with their current style. To add a preset view, just set visible the layers you want, with their
desired symbology, and click on button. Choose Add Preset... from the drop-down menu and give a name to
the preset. The added preset is listed at the bottom of the drop-down menu and is recalled by clicking on it.

The Replace Preset → option helps you overwrite a preset content with the current map view while the Remove
Current Preset button deletes the active preset.

Tutte le viste predefinite aggiunte sono presenti anche nel compositore di stampe in modo di permetterti di creare
stampe impostate sulle suddette viste (vedi: ref: composer_main_properties).

Nota: Tools to manage the layers panel are also available to layout the map and legend items of the print composer

Puoi selezionare un layer e trascinarlo in modo da modificarne la visibilità (Z-ordering). Z-ordering significa che
i layer in cima alla legenda coprono nella mappa quelli sottostanti.

Nota: This behavior can be overridden by the Layer Order panel.

Layers in the legend window can be organized into groups. There are two ways to do this:

1. Press the icon to add a new group. Type in a name for the group and press Enter. Now click on an
existing layer and drag it onto the group.

2. Seleziona alcuni layer, clicca con il tasto destro e scegli Gruppo selezionato. I layer selezionati saranno
automaticamente spostati nel nuovo gruppo.

Per rimuovere un layer da un gruppo puoi selezionare e trascinare il layer al di fuori dello stesso o in alternativa
puoi cliccare con il tasto destro del mouse sul layer e selezionare Muovi fuori dal gruppo –>. I gruppi possono
essere nidificati all’interno di altri gruppi.

Puoi usare la casella di controllo di un gruppo per mostrare/nascondere tutti i layer del gruppo con un singolo
click.

The content of the right mouse button context menu depends on whether the selected legend item is a raster or

a vector layer. For GRASS vector layers, Toggle editing is not available. See section Digitalizzare e modificare
layer vettoriali GRASS for information on editing GRASS vector layers.

Below are listed available options in context menu depending on the selected item.
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Option Vector Layer Raster Layer Group

Zoom to Layer/Group

Show in Overview

Zoom to Native Resolution (100%)

Stretch Using Current Extent

Remove

Duplicate

Imposta la scala di visibilità del layer

Set Layer/Group CRS

Imposta SR progetto dal layer

Stili →
Copy Style

Paste Style

Open Attribute Table

Toggle Editing

Current Edits → (in Edit mode)

Save As...

Save As Layer Definition File...

Filtro

Show Feature Count

Proprietà

:menuselection:‘ Muovi al livello più alto‘

Rinomina →
Gruppo selezionato

Proprietà

Set Group WMS Data

Mutually Exclusive Group

Add Group

Enabling the Mutually Exclusive Group option you can make a group have only one layer visible at the same
time. Whenever a layer within the group is set visible the others will be toggled not visible.

Puoi selezionare più di un layer o di un gruppo allo stesso tempo tenendo premuto il tasto Ctrl e cliccando il
tasto sinistro del mouse sui vari layer. Potrai cosi spostare contemporaneamente tutti i layer selezionati in un
nuovo gruppo.

You may also delete more than one layer or group at once by selecting several items with the Ctrl key and
pressing Ctrl+D afterwards. This way, all selected layers or groups will be removed from the layers list.

Editing vector layer style

From the Layers panel, you have shortcuts to easily and quickly edit the layer rendering. Right-click on a vector
layer and select Styles –> in the list in order to:

• see the currently applied styles to the layer. In case you defined many styles for the layer, you can switch
from one to another and have your layer rendering automatically updated in the map canvas.

• copy the current style, and when applicable, paste a copied style from another layer
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• rename the current style, add a new one (which is actually a copy of the current one) or delete the current
style (when multiple styles available).

Nota: The previous options are also available for raster layer.

Whether the features in the vector layer have all the same unique symbol or they are classified (in that case, the
layer is displayed in a tree structure with each class as sub-item), the following options are available at layer level
or class level:

• a Edit Symbol... button to open the The symbol Selector dialog and update any property (symbol, size,
color...) of the layer or feature symbol. Double-clicking on a feature does also open the Symbol Selector
dialog.

• a Color Selector widget with a Color Wheel from which you can click a color and have it automatically
update the symbol fill color. For convenience, Recent colors are available at the bottom of the color wheel.

• a Show All Items and Hide All Items to toggle on or off the visibility of all the classes of features.
This avoids (un)checking items one by one.

Suggerimento: Quickly share a layer style
From the context menu, copy the style of a layer and paste it to a group or a selection of layers: the style is applied
to all the layers that are of the same type (vector vs raster) as the original layer and, in case of vector, have the
same geometry type (point, line or polygon).

Lavorare con la legenda indipendentemente dall’ordine dei layer

There is a panel that allows you to define an independent drawing order for the layers panel. You can activate it in
the menu Settings → Panels → Layer Order Panel. This feature allows you to, for instance, order your layers in

order of importance, but still display them in the correct order (see figure_layer_order). Checking the Control
rendering order box underneath the list of layers will cause a revert to default behavior.

Figure 7.4: Define a legend independent layer order
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Statistical Summary Panel

This panel can show some statistics on a specific vector layers. The panel allows users to choose:

• the vector layer;

• the column or the expression;

• filter statistics to selected features;

• refresh the informations;

• the statistics information to display with the bottom right button;

QGIS Overview Panel

In QGIS, you can use an overview panel that provides a full extent view of layers added to it. Within the view is
a rectangle showing the current map extent. This allows you to quickly determine which area of the map you are
currently viewing. Note that labels are not rendered to the map overview even if the layers in the map overview
have been set up for labelling. If you click and drag the red rectangle in the overview that shows your current
extent, the main map view will update accordingly.

Log Messages Panel

When loading or processing some operations, you can track and follow messages that appear in different tabs

using the Log Messages Panel. It can be activated using the most right icon in the bottom status bar.

Undo/Redo Panel

For each layer being edited, this panel shows the list of actions done, allowing to quickly undo a set of actions by
simply selecting the action listed above.

7.3 Mappa

Also called Map canvas, this is the “business end” of QGIS — maps are displayed in this area. The map displayed
in this window will depend on the vector and raster layers you have chosen to load (see sections that follow for
more information on how to load layers). The map view can be panned, shifting the focus of the map display
to another region, and it can be zoomed in and out. Various other operations can be performed on the map as
described in the label_toolbars description above. The map view and the legend are tightly bound to each other —
the maps in view reflect changes you make in the legend area.

Suggerimento: ZOOM IN E ZOOM OUT CON LA ROTELLA DEL MOUSE
Per le operazioni di zoom puoi anche utilizzare la rotella del mouse. Posizionando il puntatore del mouse nell’area
di visualizzazione delle mappe aumenterai lo zoom girando la rotella verso lo schermo, lo ridurrai girandola nel
verso contrario. La posizione del puntatore costituisce il centro per l’ingrandimento. Puoi regolare il comporta-
mento della funzione di zoom con la rotella del mouse nella scheda Strumenti mappa del menu Impostazioni →
Opzioni .

Suggerimento: MUOVERE LA MAPPA CON I TASTI FRECCIA E LA BARRA SPAZIATRICE
Puoi spostare la mappa anche con le frecce della tastiera. Posiziona il mouse sulla mappa e clicca la freccia destra
per spostarti verso est, la freccia sinistra per spostarti verso ovest, la freccia in su per spostarti verso nord e la
freccia in giù per spostarti verso sud. Puoi anche spostare la mappa con la barra spaziatrice oppure premendo la
rotellina del mouse: nel primo caso tieni premuta la barra spaziatrice e muovi il mouse, mentre nel secondo caso
tieni premuto il tasto della rotellina mentre muovi il mouse.
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7.4 Barra di Stato

The status bar provides you with general information about the map view, and actions processed or available and
offers you tools to manage the map view.

On the left side of the status bar, you can get a summary of actions you’ve done (such as selecting features in
a layer, removing layer) or a long description of the tool you are hovering over (not available for all tools). On
startup, the bar status also informs you about availability of new or upgradeable plugins (if checked in Plugin
Manager settings).

In case of lengthy operations, such as gathering of statistics in raster layers or rendering several layers in map
view, a progress bar is displayed in the status bar to show the current progress of the action.

The Coordinate option shows the current position of the mouse, following it while moving across the map
view. You can set the unit (and precision) to use in the project properties, General tab. Click on the small button

at the left of the textbox to toggle between the Coordinate option and the Extents option that displays in map
units, the coordinates of the current lower leftmost and upper rightmost points of the map view, as you pan and
zoom in and out.

Next to the coordinate display you will find the Scale display. It shows the scale of the map view. If you zoom in
or out, QGIS shows you the current scale. There is a scale selector, which allows you to choose among predefined
and custom scales to assign to the map view.

Alla destra della scala è possibile definire la rotazione in gradi (in senso orario) della mappa.

On the right side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being
rendered to the map view (see section Visualizzazione).

To the right of the render functions, you find the Current CRS: icon with the EPSG code of the current project
CRS. Clicking on this lets you Enable ‘on the fly’ CRS transformation properties for the current project and apply
another CRS to the map view.

Finally, the Messages button opens the Log Messages Panel which informs you on underlying process (QGIS
startup, plugins loading, processing tools...)

Suggerimento: Calcolare la scala corretta della mappa
When you start QGIS, the default CRS is WGS 84 (epsg 4326) and units are degrees. This means that QGIS
will interpret any coordinate in your layer as specified in degrees. To get correct scale values, you can either
manually change this setting, e.g. to meters, in the General tab under Project → Project Properties, or you can

use the Current CRS: icon seen above. In the latter case, the units are set to what the project projection specifies
(e.g., +units=us-ft).

Note that CRS choice on startup can be set in Settings → Options → CRS.
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CHAPTER 8

Strumenti generali

8.1 Scorciatoie da tastiera

QGIS provides default keyboard shortcuts for many features. You can find them in section Barra dei Menu. Ad-
ditionally, the menu option Settings → Configure Shortcuts... allows you to change the default keyboard shortcuts
and add new keyboard shortcuts to QGIS features.

Figure 8.1: Define shortcut options

Configuration is very simple. Just select a feature from the list and click on :

• [Change] and press the new combination you want to assign as new shortcut

• [Set none] to clear any assigned shortcut

• or [Set default] to backup the shortcut to its original and default value.

Once you have finished your configuration, you can save it as an XML file and load it to another QGIS installation.

8.2 Guide contestuali

Se vuoi ottenere maggiori informazioni su una funzionalità specifica puoi usare il pulsante [Aiuto] disponibile in
molte finestre di dialogo. Nota che nel caso di plugin di terze parti la guida contestuale potrebbe rimandare ad una
pagina web dedicata.
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8.3 Visualizzazione

By default, QGIS renders all visible layers whenever the map canvas is refreshed. The events that trigger a refresh
of the map canvas include:

• Aggiungi un layer

• Sposti, ingrandisci o riduci la mappa

• Resizing the QGIS window

• Cambi la visibilità di uno o più layer

QGIS allows you to control the rendering process in a number of ways.

8.3.1 Visualizzazione in funzione della scala

La visualizzazione in funzione della scala permette di specificare la scala minima e massima alla quale il vettore
verrà visualizzato. Per impostare questa funzionalità, apri la finestra Proprietà facendo doppio click sul vettore.

Nella scheda Generale, clicca sulla casella di controllo Visualizzazione dipendente dalla scala: potrai cosi
inserire i valori minimi e massimi di visualizzazione della scala.

You can determine the scale values by first zooming to the level you want to use and noting the scale value in the
QGIS status bar.

8.3.2 Controllare la visualizzazione della mappa

Map rendering can be controlled in various ways, as described below.

Sospensione della visualizzazione

To suspend rendering, click the Render checkbox in the lower right corner of the status bar. When the
Render checkbox is not checked, QGIS does not redraw the canvas in response to any of the events described in
section Visualizzazione. Examples of when you might want to suspend rendering include:

• Aggiunta di molti layer con simbologia predefinita prima della visualizzazione

• Aggiunta di uno o più layer di grosse dimensioni e impostazione di una scala prima della visualizzazione

• Aggiunta di uno o più layer di grossa dimensione e zoom ad un’area specifica prima della visualizzazione

• Combinazioni delle precedenti

Se la casella di controllo Aggiorna è spuntata, la visualizzazione e l’aggiornamento della mappa saranno
immediati.

Controllare la visibilità dei layer quando sono caricati

Puoi scegliere l’opzione di caricare i nuovi layer senza che questi vengano immediatamente visualizzati sulla
mappa. Ciò significa che quando aggiungerai un layer al progetto, la casella di controllo per la visibilità nella
legenda risulterà disabilitata. Per impostare questa opzione, apri il menu Impostazioni → Opzioni → e clicca sulla

scheda Visualizzazione. Deseleziona la casella di controllo Per impostazione predefinita i nuovi layer aggiunti
alla mappa vengono visualizzati subito. Ogni layer aggiunto alla mappa risulterà essere quindi spento (invisibile).
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Fermare la visualizzazione

Per fermare la visualizzazione della mappa primi il tasto ESC. In questo modo l‘aggiornamento della mappa verrà
bloccato e la mappa rimarrà parzialmente disegnata. Dopo aver premuto il tasto ESC potrebbe passare un po‘ di
tempo finché l‘interruzione della visualizzazione della mappa sia effettiva.

Nota: Attualmente non si può interrompere la visualizzazione in corso: questa opzione è stata disabilitata nella
porta Qt4 a causa di diversi problemi dell’interfaccia utente (UI).

Modificare la qualità della visualizzazione

QGIS has an option to influence the rendering quality of the map. Choose menu option Settings → Options, click

on the Rendering tab and select or deselect Make lines appear less jagged at the expense of some drawing
performance.

Velocizzare la visualizzazione

There are some settings that allow you to improve rendering speed. Open the QGIS options dialog using Settings
→ Options, go to the Rendering tab and select or deselect the following checkboxes:

• Usa il caching del disegno quando possibile per velocizzare la visualizzazione

• Render layers in parallel using many CPU cores and then set the Max cores to use.

• The map renders in the background onto a separate image and each Map Update interval, the content
from this (off-screen) image will be taken to update the visible screen representation. However, if rendering
finishes faster than this duration, it will be shown instantaneously.

• With Enable Feature simplification by default for newly added layers, you simplify features’ geometry
(less nodes) and as a result, they quickly display. Be aware that you can also face rendering inconsistencies.

8.4 Color Selector

The select color dialog will appear whenever you push the icon to choose a color. The
features of this dialog depends on the state of the Use native color chooser dialogs parameter checkbox in Settings
→ Options → General menu. When checked, the color dialog used is the one of the OS being used. Otherwise,
QGIS custom color chooser is used.

This dialog has four different tabs which allow you to select colors by color ramp, color wheel, color swatches

or color picker (not available under ).

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. There is also an opacity slider to set transparency level. On the lower
left part of the dialog you can see a comparison between the current and the new color you are presently selecting
and on the lower right part you have the option to add the color you just tweaked into a color slot button.

Suggerimento: Dynamically change the color with the live-updating option
Check the Use live-updating color chooser dialogs option in the General Settings to have the color applied to your
items as you change color parameters in the QGIS custom color chooser dialog.

With color ramp or with color wheel, you can browse to all possible color combinations. There are other

possibilities though. By using color swatches you can choose from a preselected list. This selected list is populated
with one of three methods:

8.4. Color Selector 37



QGIS User Guide, Release 2.14

Figure 8.2: Color selector ramp tab

• Recent colors,

• Standard colors, a user-defined list of colors set under Settings → Options → Colors menu

• or Project colors, a user-defined list of colors set under Project → Project Properties → Default Styles.

Figure 8.3: Color selector switcher tab

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by OSX.

Suggerimento: quick color picker + copy/paste colors
You can quickly choose from Recent colors, from Standard colors or simply copy or paste a color by clicking the

drop-down arrow that follows the color box.
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Figure 8.4: Quick color selector menu

8.5 Blending Modes

QGIS offers different options for special rendering effects with these tools that you may previously only know
from graphics programs. Blending modes can be applied on layers, on features but also on print composer items:

• Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with the
pixel beneath it. The colors aren’t mixed.

• Lighten: This selects the maximum of each component from the foreground and background pixels. Be
aware that the results tend to be jagged and harsh.

• Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This mode
is most useful for mixing the texture of one item with another item (e.g., you can use a hillshade to texture
another layer).

• Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works best
if the top pixels aren’t too bright; otherwise the effect is too extreme.

• Addition: This blend mode simply adds pixel values of one item with the other. In case of values above
one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

• Darken: This creates a resultant pixel that retains the smallest components of the foreground and back-
ground pixels. Like lighten, the results tend to be jagged and harsh.

• Multiply: Here, the numbers for each pixel of the top item are multiplied with the corresponding pixels for
the bottom item. The results are darker pictures.

• Burn: Darker colors in the top item cause the underlying items to darken. Burn can be used to tweak and
colorise underlying layers.

• Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light parts
become lighter and dark parts become darker.

• Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge. This
is supposed to emulate shining a soft light onto an image.

• Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a very
intense light onto an image.

• Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to always get
a positive value. Blending with black produces no change, as the difference with all colors is zero.

• Subtract: This blend mode simply subtracts pixel values of one item from the other. In case of negative
values, black is displayed.
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8.6 Zooming and Panning

QGIS provides tools to zoom and pan to your area of interest.

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys.

8.6.1 Zooming and panning with the mouse wheel

You can press the mouse wheel to pan inside of the main window, and you can roll the mouse wheel to zoom
in and out on the map. For zooming, place the mouse cursor inside the map area and roll it forward (away from
you) to zoom in and backwards (towards you) to zoom out. The mouse cursor position will be the center of the
zoomed area of interest. You can customize the behavior of the mouse wheel zoom using the Map tools tab under
the Settings → Options menu.

8.6.2 Panning with the arrow keys

Panning the map is possible with the arrow keys. Place the mouse cursor inside the map area, and click on the
right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow key to pan
south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out.

8.7 Misurazioni

QGIS provides four means of measuring geometries:

• the interactive measurement tools ,

• measuring in the Field Calculator,

• derived measures in the Informazione elementi tool,

• and a vector analysis tool: Vector → Geometry Tools → Export/Add Geometry Columns

Measuring works within projected coordinate systems (e.g., UTM) and unprojected data. The first three measuring
tools behave equally to global project settings:

If “on the fly” CRS transformation is enabled, the default measurement metric is - different from most other GIS -
ellipsoidal, using the ellipsoid defined in File → Project properties → General. This is true both when geographic
and projected coordinate systems are defined for the project. If you want to calculate the projected / planimetric
area or distance using cartesian maths, the measurement ellipsoid has to be set to “None / Planimetric” (File →
Project properties → CRS). However, with a geographic (= unprojected) CRS defined for the data and project, area
and distance measurement will be ellipsoidal. If “on the fly” CRS transformation is disabled, the measurement
metric is planimetric when the project coordinate system is projected and ellipsoidal when the project coordinate
system is unprojected / geographic.

However, neither the identify tool nor the field calculator will transform your data to the project CRS before
measuring. If you want to achieve this, you have to use the vector analysis tool: Vector → Geometry Tools →
Export/Add Geometry Columns. Here, measurement is by default planimetric except if you choose the ellipsoidal
measure.
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8.7.1 Measure length, areas and angles interactive

All measuring modules use the snapping settings from the digitizing module. This is useful, if you want to measure
along lines or areas in vector layers.

To select a measuring tool, click on and select the tool you want to use.

By default, Measure Line: QGIS measures real distances between given points according to a defined ellipsoid.
You can define a rubberband color and your preferred measurement units (meters or feet) and angle units (degrees,
radians and gon) in the menu option Settings → Options → Map Tools. The tool then allows you to click points
on the map. Each segment length, as well as the total, shows up in the measure window. To stop measuring,
click your right mouse button. Note that you can interactively change the measurement units in the measurement
dialog. It overrides the Preferred measurement units in the options. There is an info section in the dialog that
shows which CRS settings are being used during measurement calculations.

Figure 8.5: Measure Distance

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. In
addition, the measuring tool will snap to the currently selected layer, provided that layer has its snapping tolerance
set (see section Settare la tolleranza dello snapping e il raggio di ricerca degli elementi). So, if you want to
measure exactly along a line feature, or around a polygon feature, first set its snapping tolerance, then select the
layer. Now, when using the measuring tools, each mouse click (within the tolerance setting) will snap to that layer.

Figure 8.6: Measure Area

Measure Angle: You can also measure angles. The cursor becomes cross-shaped. Click to draw the first segment
of the angle you wish to measure, then move the cursor to draw the desired angle. The measure is displayed in a
pop-up dialog.

8.8 Selezionare e deselezionare elementi

The QGIS toolbar provides several tools to select features in the map canvas. To select one or several features,

just click on and select your tool:

• Select Features by area or single click to select feature(s) either by simple click or by rectangle
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Figure 8.7: Measure Angle

• Select Features by Polygon

• Select Features by Freehand

• Select Features by Radius

To deselect all selected features, click on Deselect Features from All Layers.

Select features using an expression allows user to select features using expression dialog. See Expressions chapter for
some example.

Users can save selected features into a New Memory Vector Layer or a New Vector Layer using Edit → Copy
Features and Edit → Paste Features as in the wanted format.

8.9 Data defined override setup

Beside many options in the vector layer properties dialog or settings in the print composer, you can find a
Data defined override icon. Thanks to expressions based on layer attributes or item settings, prebuild or custom functions
and variables, this tool allows you to set dynamic value for the concerned parameter. When enabled, the value
returned by this widget is applied to the parameter regardless its normal value (checkbox, textbox, slider...).

Clicking the Data defined override icon shows:

• a Description ... that indicates if it is enabled, which input expected, valid input type and the current
definition,

• an entry to list the Field type available,

• an entry to list the Variable available,

• Edit ... button to create or edit the expression to use,

• Paste and Copy buttons,

• Clear button to remove the setup.

Suggerimento: When the data-defined override option is setup correctly the icon is yellow or ; if it is
broken, the icon is red or .

Parameters that can be used with data-defined tools are:

• Style and symbols parameters

• Labels parameters

• Composer parameters
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8.10 Informazione elementi

The Identify tool allows you to interact with the map canvas and get information on features in a pop-up window.

To identify features, use View → Identify features or press Ctrl + Shift + I, or click the Identify features

icon on the Attributes toolbar.

QGIS offers two ways to identify features with the Identify features tool:

• left click will identify features according to the mode set in the Identify results panel

• right click will fetch all the snapped features from all the visible layers. This will open a context menu,
allowing the user to choose more precisely the features to identify.

If you click on feature(s), the Identify results dialog will list information about the clicked feature(s). The default
view is a tree view where the first item is the name of the layer and its children are its identified feature(s). Each
feature is described by the name of a field along with its value. This field is the one set in Properties → Display.
Then follows all the other information about the feature.

Puoi personalizzare questa finestra in modo da visualizzare determinati campi, ma in modo predefinito vengono
mostrati tre tipi di informazione:

• Actions: Actions can be added to the identify feature windows. The action is run by clicking on the action
label. By default, only one action is added, namely view feature form for editing. You can define
more actions in the layer’s properties dialog.

• Derived: This information is calculated or derived from other information. This includes the feature id,
its length or perimeter and area in map units depending on its geometry, the count of spatial parts and the
number of the clicked part in case of multi-geometry, the count of vertices in the feature and the number of
the closest one to the point clicked. It also reports the X and Y (and Z/M if available) coordinate values of
both clicked point and feature closest vertex.

• Data attributes: This is the list of attribute fields and values for the feature that has been clicked.

Figure 8.8: Identify features dialog

At the top of the window, you have seven icons:

• Expand tree

• Collapse tree

• Default behavior to define whether next identified features information should be collapsed or expanded

• View the feature form

• Clear Results
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• Copy selected feature to clipboard

• Print selected HTML response

At the bottom of the window, you have the Mode and View comboboxes. With the Mode combobox you can define
from which layers features should be identified:

• ‘Current layer’ : only features from the selected layer are identified. The layer may not be visible in the
canvas.

• ‘Top down, stop at first’: for only features from the upper visible layer.

• ‘Top down’: for all features from the visible layers. The results are shown in the panel.

• and ‘Layer selection’: opens a context menu where the user selects the layer to identify features from.
Operates like a right-click. Only the chosen features will be shown in the result panel.

The View can be set as ‘Tree’, ‘Table’ or ‘Graph’. ‘Table’ and ‘Graph’ views can only be set for raster layers.

The identify tool allows you to auto open a form. If checked, each time a single feature is identified QGIS will
open a form showing its attributes. This is a handy way to quickly edit a feature’s attributes.

Puoi trovare altre opzioni nel menu contestuale dell’elemento identificato. Per esempio, dal menu contestuale
puoi:

• Visualizzare modulo geometria

• Zoomare alla geometria

• Copiare elementi: copiare tutti gli elementi e gli attributi della geometria

• Toggle feature selection: Adds identified feature to selection

• Copiare un valore di un attributo: copiare solo il valore dell’attributo identificato

• Copy feature attributes: Copy the attributes of the feature

• Cancellare risultati: verranno cancellati i risultati nella finestra

• Cancellare evidenziati: verranno cancellate le geometrie evidenziate sulla mappa

• Evidenziare tutto

• Evidenziare vettore

• Attivare un vettore: scegliere un vettore che deve essere attivato

• Proprietà del vettore: aprire la finestra delle proprietà del vettore

• Espandi tutto

• Racchiudi tutto

8.11 Note testuali

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Se fai doppio click sull’elemento aggiunto alla mappa si aprirà una finestra di dialogo con diverse opzioni. Avrai
accesso a un editor per aggiungere il testo della nota. Inoltre hai anche la possibilità di scegliere se la nota dovrà
essere posizionata su un punto preciso della mappa (visualizzata come indicatore) oppure se la posizione della
nota dovrà essere relativa a una posizione dello schermo (quindi indipendente dalla mappa). Puoi muovere sia
tutta la nota (trascinando l’indicatore) sia solamente il testo (trascinando il riquadro del testo).

The Move Annotation tool allows you to move the annotation on the map canvas.
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Figure 8.9: Annotation text dialog

8.11.1 Note Html

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.

8.11.2 Note SVG

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.

8.11.3 Modulo annotazioni

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://youtu.be/0pDBuSbQ02o?t=2m25s from Tim Sutton for more information.

Nota: Nota: Premendo Ctrl+T con uno strumento nota attivo (Nota testuale, Nota con modulo, Muovi nota) lo
stato di visualizzazione delle note si inverte: se sono visibili diventano invisibili e viceversa.

8.12 Segnalibri geospaziali

Spatial Bookmarks allow you to “bookmark” a geographic location and return to it later. Bookmarks are saved on
the computer, meaning that they are available from any project in the same computer.

8.12.1 Creazione di un segnalibro

Per creare un segnalibro:
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Figure 8.10: Customized qt designer annotation form

1. Usa lo zoom o muovi la mappa all’estensione d’interesse.

2. Select the menu option View → New Bookmark or press Ctrl-B. The Spatial Bookmark panel opens with
the newly created bookmark.

3. Inserisci un nome descrittivo per il segnalibro (fino a 255 caratteri).

4. Press Enter to add the bookmark or click elsewhere.

Nota che puoi avere più di un segnalibro con lo stesso nome.

8.12.2 Uso e gestione dei segnalibri

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Spatial Bookmarks panel
allows you to:

• Zoom to a Bookmark: select the desired bookmark and then click Zoom To Bookmark. You can also zoom
to a bookmark by double-clicking on it.

• Delete a Bookmark: select the bookmark and click Delete Bookmark. Confirm your choice.

• Import or Export a bookmark: To share or transfer your bookmarks between computers you can use the
Import/Export Bookmarks pull down menu in the Spatial Bookmarks dialog. All the bookmarks are trans-
ferred.

8.13 Progetti nidificati

Se vuoi nidificare dei layer di altri progetti nel tuo progetto attuale, seleziona Layer → Includi layer e gruppi....

8.13.1 Layers inclusi

La finestra di dialogo ti permette di scegliere quali layer di altri progetti puoi includere. Di seguito un piccolo
esempio:

1. Press to look for a project from the Alaska dataset.
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2. Select the project file relations.qgs. You can see the content of the project (see figure_embed_dialog).

3. Press Ctrl and click on the layers airports and regions. Press [OK]. The selected layers are em-
bedded in the map legend and the map view now.

Figure 8.11: Select layers and groups to embed

Anche se i layer nidificati sono modificabili, non puoi modificarne le proprietà, come stile ed etichette.

8.13.2 Rimuovi i layer nidificati

Right-click on the embedded layer and choose Remove.

8.14 Decorazioni

The Decorations of QGIS include the Grid, the Copyright Label, the North Arrow and the Scale Bar. They are
used to ‘decorate’ the map by adding cartographic elements.

8.14.1 Reticolo

Reticolo ti permette di aggiungere un reticolo e le coordinata alla mappa.

Figure 8.12: The Grid Dialog

1. Seleziona dal menu Visualizza → Decorazioni→ Reticolo. Si aprirà un‘altra finestra (vedi fig-
ure_decorations_1).
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2. Attiva la casella di controllo Abilita reticolo e imposta i valori che preferisci in funzione dei layer caricati
sulla mappa.

3. Attiva la casella di controllo Scrivi coordinate e imposta le proprietà migliori in base agli elementi che
hai caricato sulla mappa.

4. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

8.14.2 Etichetta Copyright

Copyright label adds a copyright label using the text you prefer to the map.

Figure 8.13: The Copyright Dialog

1. Seleziona dal menu Visualizza → Decorazioni→ Etichetta copyright. Si aprirà un‘altra finestra (vedi fig-
ure_decorations_2).

2. Assicurati che la casella di controllo Abilita etichetta di copyright sia spuntata.

3. Digita il testo che vuoi aggiungere alla mappa. Puoi anche usare il linguaggio HTML come mostrato
nell’esempio.

4. Choose the placement of the label from the Placement combo box.

5. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

6. You can change the color to apply.

7. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas.

8.14.3 Freccia Nord

North Arrow places a simple north arrow on the map canvas. Currently, there is only one style available. You can
adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine the
direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas. You can refine the placement of the arrow by
setting a Horizontal and/or Vertical Marging from (Canvas) Edge. These values can be a distance in Millimeter
or Pixels or set as Percentage of the width or height of the map canvas.
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Figure 8.14: The North Arrow Dialog

8.14.4 Barra di Scala

Scale Bar adds a simple scale bar to the map canvas. You can control the style and placement, as well as the
labelling of the bar.

Figure 8.15: The Scale Bar Dialog

QGIS only supports displaying the scale in the same units as your map frame. So if the units of your layers are in
meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create a scale
bar to display distance in meters.

Per aggiungere una barra di scala:

1. Seleziona dal menu Visualizzazione → Decorazioni→ Barra di scala. Si aprirà cosi una finestra di dialogo
(see figure_decorations_4)

2. Assicurati che la casella di controllo Abilitare barra di scala sia spuntata.

3. Choose the style from the Scale bar style combo box.

4. Select the color for the bar Color of bar or use the default black color.

5. Set the Size of bar .

6. Optionally, check Automatically snap to round number on resize to display values easy-to-read.

7. Choose the placement from the Placement combo box.

8. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of

8.14. Decorazioni 49



QGIS User Guide, Release 2.14

the map canvas.

9. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

Suggerimento: Impostazioni delle decorazioni
Quando salvi un progetto .qgs, ogni impostazione relativa alle decorazioni viene salvata nel file e ripristinata
alla successiva apertura del progetto.

8.15 Authentication

QGIS has facility to store/retrieve authentication credentials in a secure manner. Users can securely save cre-
dentials into authentication configurations, which are stored in a portable database, can be applied to server or
database connections, and safely referenced by their ID tokens in project or settings files. For more information
see Authentication System.

A master password needs to be set up when initializing the authentication system and its portable database.

8.16 Save layer into file

Layers (raster or vector) can be saved in another format with the Save As... feature in the layer contextual menu
(by right-clicking in the layer in the layer tree) or in the Layer → Save As... menu.

The Save As dialog shows several parameters to change the behaviour when saving the layer. Common parameters
(raster and vector) are:

• Format

• Filename

• CRS

• Add save file to map to add the new layer to the canvas

• Extent (possible values are layer, Map view or custom extent)

• Create (for raster), Layer or Custom (for vector) Options which allow you to change some advanced options.
Advanced user can see the driver documentation in gdal-ogr documentation.

However, some parameters are specific to raster and vector formats:

• Raster specific parameters:

– Resolution (horizontal and vertical)

– Pyramid creation

– Output mode (raw data or rendered image)

• Vector specific parameters:

– Encoding

– Save only selected features

– Skip attribute creation

– Symbology export: can be used mainly for DXF export and for all file formats who manage OGR
feature styles (see note below) as DXF, KML, tab file formats:

* No symbology: default style of the application that reads the data

* Feature symbology: save style with OGR Feature Styles (see note below)

* Symbol Layer symbology: save with OGR Feature Styles (see note below) but export the same
geometry multiple times if there are multiple symbology symbol layers used
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– Geometry:

* force to multi-geometry,

* add z-dimension,

* add or remove a geometry column with the drop-down list. This is not linked with the current
geometry type of the layer. You can add an empty geometry column to an attribute table, remove
the geometry column of a spatial layer.

Nota: OGR Feature Styles are a way to store style directly in the data as a hidden attribute. Only some format
can handle this kind of information. KML, DXF and TAB files format are such format. For advanced user, you
can read the OGR Feature Styles specification document.

Nota: About DXF files
Vector layers can be exported to DXF files using another tool, the DXF Export ... in Project. The windows allow
the user to choose the layer file, the symbology mode (see the note above), the symbology scale, the encoding, the
visibility preset and the layers to include in the DXF file.

As an option, you can Use the layer title as name if set or Export features intersecting the current map extent.

8.17 Use of variables for dynamic content

You can define custom variables for use in expressions. Variables can be defined at the application global level,
project level, layer level and composition level. Just like CSS cascading rules, variables can be overwritten - eg,
a project level variable will overwrite any application level variables set. You can use these variables to build
text strings or other custom expressions using @ character before the variable name. For example in composer
creating a label with this content:

This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]

Will render the label like this:

This map was made using QGIS 2.14. The project file for this map is:
/gis/qgis-user-conference-2015.qgs

You can manage global variables from the Settings → Options menu, and project level variables from Project
properties (including adding your own custom variables).

Nota: you can read more information and find examples here Exploring variables in QGIS 2.12, part 1, part 2
and part 3.
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Figure 8.16: Edit variable at the project level
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CHAPTER 9

QGIS Configuration

QGIS is highly configurable through the Settings menu. Choose between Project Properties, Options and Cus-
tomization.

Nota: QGIS follows desktop guidelines for the location of options and project properties item. Consequently
related to the OS you are using, location of some of items described below could be in the Project or the Settings
menu.

9.1 Proprietà progetto

In the properties window for the project under Settings → Project Properties (kde) or Project →
Project Properties (Gnome, OS X or Windows), you can set project-specific options.

• In the General menu, the general settings let you:

– give a title to the project beside the project file path

– choose the color to use for features when they are selected

– choose the background color: the color to use for the map canvas

– set whether the path to layers in the project should be saved as absolute (full) or as relative to the
project file location. You may prefer relative path when both layers and project files can be moved or
shared or if the project is accessed from computers on different platforms.

– choose to avoid artifacts when project is rendered as map tiles. Note that checking this option can lead
to performance degradation.

Calculating areas and distances is a common need in GIS. However, these values are really tied to the
underlying projection settings. The Measurements frame lets you control these parameters. You can indeed
choose:

– the ellipsoid to use: it can be an existing one, a custom one (you’ll need to set values of the semi-major
and semi-minor axis) or None/Planimetric.

– the units for distance measurements for length and perimeter and the units for area measurements.
These settings, which default to the units set in QGIS options but then overrides it for the current
project, are used in:

* Attribute table field update bar

* Field calculator calculations

* Identify tool derived length, perimeter and area values

* Default unit shown in measure dialog
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The Coordinate display allows you to choose and customize the format of units to use to display the mouse
coordinate in the status bar and the derived coordinates shown via the identify tool.

Finally, you can define a project scale list, which overrides the global predefined scales.

Figure 9.1: General tab of Project Properties dialog

• La scheda SR permette di scegliere il sistema di riferimento e di abilitare la riproiezione al volo di raster e
vettori quando questi hanno un SR diverso.

• With the Identify layers menu, you set (or disable) which layers will respond to the identify tool. By default,
layers are set queryable.

• The Default Styles menu lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colors assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.

• The tab OWS Server allows you to define information about the QGIS Server WMS and WFS capabilities,
extent and CRS restrictions.

• La scheda Macro serve per modificare le macro di Python per il progetto. Attualmente sono disponibili tre
macro: openProject(), saveProject() e closeProject().

• La scheda Relazioni permette di impostare relazioni 1:n. Le relazioni sono definite nella finestra di dialogo
delle proprietà del progetto. Una volta impostate le relazioni per un vettore, la vista modulo (cioè quando si
interroga il vettore con lo strumento informazioni elemento) elencherà le relazioni in una finestra dedicata.
Le relazioni 1:n sono uno strumento molto prezioso che può essere utilizzato, per esempio, per tenere traccia
delle ispezioni storiche di un tratto stradale o di manutenzione delle tubature. Per maggiori informazioni
sulle relazioni 1:n dai un’occhiata alla sezione Creare relazioni uno a molti.
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Figure 9.2: Macro settings in QGIS

9.2 Opzioni dell’interfaccia grafica (GUI)

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. The tabs where you can customize your options are described below.

9.2.1 Menu Generale

Applicazione

• Select the Style (QGIS restart required) and choose between ‘Oxygen’,’Windows’,’Motif’,’CDE’,
‘Plastique’ and ‘Cleanlooks’ ( ).

• Define the Icon theme . Currently only ‘default’ is possible.

• Define the Icon size .

• Define the Font. Choose between Qt default and a user-defined font.

• Change the Timeout for timed messages or dialogs .

• Nascondi lo splash screen all’avvio

• Mostra suggerimenti all’avvio

• Titoli del gruppo box in grassetto

• Box gruppi secondo stile QGIS

• Use native color chooser dialogs

• Use live-updating color chooser dialogs

• Custom side bar style

• Experimental canvas rotation support (restart required)

File di progetto
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• Open project on launch (choose between ‘New’, ‘Most recent’ and ‘Specific’). When choosing

‘Specific’ use the to define a project.

• Crea un nuovo progetto dal progetto predefinito. Puoi scegliere Definisce il progetto attuale come
predefinito oppure Ripristina il predefinito. Sfoglia fra i tuoi file e specifica la cartella in cui sono presenti

i progetti da usare come modello. Se hai spuntato la casella di controllo Crea un nuovo progetto dal
progetto predefinito e hai salvato un progetto nella cartella dei modelli, comparirà la nuova voce Progetto
→ Nuovo da modello.

• Chiedi di salvare il progetto e cambia sorgente dati quando richiesto

• Prompt for confirmation when a layer is to be removed

• Avvisa quando viene aperto un file di progetto salvato con una vecchia versione di QGIS

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.

9.2.2 Menu Sistema

Ambiente

Il gruppo Ambiente mostra le variabili di ambiente e permette anche di configurarle (vedi fig-
ure_environment_variables). Questa opzione è particolarmente utile per piattaforme stile Mac, dove le appli-
cazioni GUI non ereditano necessariamente l’ambiente shell dell’utente. È utile anche per impostare/visualizzare
le variabili di ambiente usate da strumenti esterni, gestiti da Processing come, SAGA e GRASS. Infine è utile
anche per abilitare gli output del debug per specifiche sezione del codice sorgente.

• Usa variabili utente (necessario il riavvio - includere i separatori). Gestisci le variabili con i pulsanti
[Aggiungi] e [Rimuovi]. Il Variabili di ambiente attuali → mostra le variabili di ambiente già definite e

puoi scegliere di filtrarle spuntando la casella di controllo Mostrare le sole variabili specifiche di QGIS.

Percorsi verso i plugin

[Aggiungi] o [Rimuovi] Percorsi per cercare ulteriori librerie plugin C++

9.2.3 Menu Sorgente dati

Attributi delle geometrie e tabelle

• Apri la tabella degli attributi in una finestra agganciata (richiede il riavvio di QGIS)

• Copy geometry in WKT representation from attribute table. When using Copy selected rows to clipboard

from the Attribute table dialog, this has the result that the coordinates of points or vertices are also copied
to the clipboard.

• Attribute table behavior . There are three possibilities: ‘Show all features’, ‘Show selected features’
and ‘Show features visible on map’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Mostra i valori NULL come. Puoi definire un attributo con cui verranno visualizzati i valori NULL (nessun
valore).

Trattamento delle sorgenti dati
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Figure 9.3: System environment variables in QGIS
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• Scan for valid items in the browser dock . You can choose between ‘Check extension’ and ‘Check file
contents’.

• Scan for contents of compressed files (.zip) in browser dock . ‘No’, ‘Basic scan’ and ‘Full scan’ are
possible.

• Richiedi i sublayer raster al caricamento. Alcuni raster supportano i sublayer, chiamati subdataset in
GDAL. Un esempio sono i file netCDF: se sono presenti diverse variabili netCDF, GDAL riconosce ogni
variabile come un subdataset. L’opzione permette di gestire i sublayer quando uno di questi viene aperto.
Puoi scegliere fra:

– ‘Sempre’: chiede sempre (se sono presenti sublayer)

– ‘Se necessario’: chiede se il layer non ha bande, ma ha sublayer

– ‘Mai’: non chiede mai e non carica niente

– ‘Carica tutto’: non chiede, ma carica tutti i sublayer

• Ignore shapefile encoding declaration. If a shapefile has encoding information, this will be ignored by
QGIS.

• Add PostGIS layers with double click and select in extended mode

• Aggiungi layer Oracle con un doppio click e seleziona modalità estesa

• Execute expressions on server-side if possible

• create transaction groups automatically whenever possible (Experimental). When this mode is turned
on, all (postgres) layers from the same database are synchronised in their edit state, i.e. when one layer is
put into edit state, all are, when one layer is committed or one layer is rolled back, so are the others. Also,
instead of buffering edit changes locally, they are directly sent to a transaction in the database which gets
committed when the user clicks save layer.

Hidden Browser Path

This widget lists all the folder you chose to hide from the Browser panel. Removing a folder from the list will
make it available in the Browser panel.

9.2.4 Menu Visualizzazione

Rendering behavior

• Per impostazione predefinita i nuovi layer aggiunti alla mappa vengono visualizzati subito

• Usa il caching del disegno quando possibile per velocizzare la visualizzazione

• Visualizza i layyer in parallelo usando più processori della CPU

• Numero massimo di processori

• Intervallo dio aggiornamento della mappa (predefinito a 250 ms)

• Enable feature simplification by default for newly added layers

• Semplifica dal lato provider se possibile

• Semplifica dal lato provider se possibile

• Scala massima alla quale il layer dovrebbe essere semplificato

Impostazioni di visualizzazione

• Rendi le linee meno irregolari a spese delle prestazioni
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Raster

• Con Selezione banda RGB puoi scegliere il numero di bande rosse, verdi e blu.

Miglioramento contrasto

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Limiti di taglio del conteggio cumulativo pixel

• Moltiplicatore deviazione standard

Debugging

• Aggiornamento della visualizzazione della mappa

9.2.5 Menu Colori

This menu allows you to add some custom color that you can find in each color dialog window of the renderers.
You will see a set of predefined colors in the tab: you can delete or edit all of them. Moreover you can add the
color you want and perform some copy and paste operations. Finally you can export the color set as a gpl file or
import them.

9.2.6 Menu Mappa & Legenda

Aspetto della mappa (modificato dalle proprietà del progetto)

• Scegli un Colore della selezione e un Colore di sfondo

Legenda dei layer

• Double click action in legend . You can either ‘Open layer properties’ or ‘Open attribute table’ with
the double click.

• Puoi scegliere diverse opzioni per gli Stili elementi legenda:

– Nomi dei layer in maiuscolo

– Nomi dei layer in grassetto

– Nomi gruppo in grassetto

– Visualizza nomi di classificazione degli attributi

– Crea le icone raster (potrebbe essere lento)

9.2.7 Menu Strumenti mappa

This menu offers some options regarding the behavior of the Identify tool.
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• Raggio di ricerca per identificare e visualizzare le relative informazioni sulla mappa è un fattore di toller-
anza espressa come percentuale della larghezza mappa. Ciò significa che lo strumento di informazione
mostrerà i risultati se si fa clic all’interno di questa tolleranza.

• Colore di evidenziaione di scegliere con quale colore saranno evidenziati gli elementi identificati.

• Buffer determines a buffer distance to be rendered from the outline of the identify highlight.

• Minimum width determines how thick should the outline of a highlighted object be.

Strumenti di misura

• Colore elastico

• Posizioni decimali

• Keep base unit to not automatically convert large numbers (e.g., meters to kilometers)

• Preferred distance units (‘Meters’, ‘Feet’, ‘Nautical Miles’, ‘Degrees’ or ‘Map Units’ )

• Preferred area units (‘Square meters’, ‘Square feet’, ‘Square yards’, ‘Hectares’, ‘Map Units’ ...)

• Preferred angle units (‘Degrees’, ‘Radians’, ‘Gon/gradians’, ‘Minutes of arc’ ...)

Spostamento e zoom

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Fattore di zoom

Scale preimpostate

Here, you find a list of predefined scales. With the and buttons you can add or remove your personal
scales. You can also import or export scales from/to a .XML file. Note that you still have the possibility to remove
your changes and reset to the predefined list.

9.2.8 Menu Compositore

Opzioni predefinite del compositore

You can define the Default font here.

Reticolo

• Define the Grid style (‘Solid’, ‘Dots’, ‘Crosses’)

• Define the Grid color

Grid and guide defaults

• Define the Grid spacing

• Define the Grid offset for x and y

• Define the Snap tolerance

9.2.9 Menu Digitalizzazione

Creazione di geometrie

• Non aprire la finestra degli attributi dopo la creazione di ogni geometria

• Ripeti i valori degli attributi usati per ultimi
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• Validate geometries. Editing complex lines and polygons with many nodes can result in very slow rendering.
This is because the default validation procedures in QGIS can take a lot of time. To speed up rendering, it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

Elastico

• Definisci le proprietà dell’elastico, Spessore della linea e Colore della linea

Snapping

• Apri le opzioni di snap in una finestra agganciata (richiede il riavvio di QGIS)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Imposta la Tolleranza di snapping predefinita in unità di mappa o pixel

• Imposta il Raggio di ricerca per le modifiche dei vertici in unità di mappa o in pixel

Indicatori di vertice

• Utilizza indicatori solo per le geometrie selezionate

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’)

• Specifica le Dimensioni indicatore

Strumento per la curva di offset

The next 3 options refer to the Offset Curve tool in Digitalizzazione avanzata. Through the various settings, it is
possible to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Stile unione

• Segmenti di quadrante

• Limite di smusso

9.2.10 Menu GDAL

GDAL è una libreria di lettura e scrittura per file raster. In questa scheda puoi Modificare le opzioni di creazione
e Modificare le opzioni per le piramidi. Scegli quali driver GDAL devono essere utilizzati per un formato raster
specifico poiché spesso sono disponibili più driver GDAL per lo stesso formato.

9.2.11 Menu SR

SR predefinito per nuovi progetti

• Don’t enable ‘on the fly’ reprojection

• Automatically enable ‘on the fly’ reprojection if layers have different CRS

• Enable ‘on the fly’ reprojection by default

• Seleziona un SR e Inizia un nuovo progetto sempre con questo SR

SR per i nuovi layer

Questa sezione permette di specificare il comportamento di QGIS quando viene creato un nuovo layer oppure
quando viene caricato un layer privo di SR.

• Prompt for CRS

• Use project CRS

• Use default CRS
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Trasformazioni datum predefinite

• Chiedi la trasformazione del datum quando non è definito un valore di riferimento

• Se hai lavorato con la trasformazione del SR ‘al volo’ puoi vedere i risultati della trasformazione nella fines-
tra di sotto. Questa finestra mostra infatti le informazioni del ‘SR sorgente’, ‘SR destinazione’, ‘Trasfor-
mazione datum sorgente’ e ‘Trasformazione datum destinazione’.

9.2.12 Menu Lingua

• Sovrascrivi lingua in uso

• Informazioni sulla lingua correntemente impostata nel sistema

9.2.13 Authentication

In the Authentication tab you can set authentication configurations and manage PKI certificates. See Authentica-
tion System for more details.

9.2.14 Menu Rete

Generale

• Indirizzo di ricerca WMS (Quello predefinito è “http://geopole.org/wms/search?search=%1&type=rss”)

• Imposta il Timeout per le richieste di rete (ms) - il valore predefinito è 60000

• Imposta il Periodo di scadenza predefinito per piastrelle WMSC/WMTS (ore) - valore standard è 24

• Specifica il Numero massimo di tentativi in caso di errore nella richiesta della mattonella

• Definisci l’Utente-Agente

Impostazioni della cache

Specifica la Cartella e la Dimensione per la cache.

• Utilizza un proxy per l’accesso web, definizione di host, porta, utente e password.

• Set the Proxy type according to your needs.

– Default Proxy:Il proxy è determinato sulla base delle impostazioni in uso del proxy dell’applicazione

– Socks5Proxy: Proxy generico per ogni tipo di connessione. Supporta TCP, UDP, associazione a una
porta (connessione in entrata) e autenticazione.

– HttpProxy: Realizzato usando il comando “CONNECT”, supporta solamente connessioni TCP in us-
cita; supporta l’autenticatione.

– HttpCachingProxy: Realizzato usando normali comandi HTTP, è utile solamente nel contesto di richi-
este HTTP.

– FtpCachingProxy: Realizzato usando un proxy FTP, è utile solamente nel contesto di richieste FTP.

È possibile escludere alcuni URL aggiungendo il testo nella sezione dedicata (vedi Figure_Network_Tab).

Per informazioni più dettagliate sulle diverse impostazioni del proxy, fai riferimento al manuale della documen-
tazione delle librerie QT suhttp://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Suggerimento: UTILIZZO DEI PROXY
L’utilizzo dei proxy può risultare complicato. È utile testare i tipi di proxy elencati sopra e controllare il loro
funzionamento nel tuo caso specifico.
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Figure 9.4: Proxy-settings in QGIS
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You can modify the options according to your needs. Some of the changes may require a restart of QGIS before
they will be effective.

• Impostazioni sono salvate in file testo $HOME/.config/QGIS/QGIS2.conf

• puoi trovare le impostazioni in: $HOME/Library/Preferences/org.qgis.qgis.plist

• le impostazioni sono salvate nel resistro: HKEY\CURRENT_USER\Software\QGIS\qgis

9.3 Personalizzazione

The customization dialog lets you (de)activate almost every element in the QGIS user interface. This can be very
useful if you want to provide your end-users with a ‘light’ version of QGIS, containing only the icons, menus or
panels they need.

Nota: Before your changes are applied, you need to restart QGIS.

Figure 9.5: The Customization dialog

Ticking the Enable customization checkbox is the first step on the way to QGIS customization. This enables
the toolbar and the widget panel from which you can uncheck and thus disable some GUI items.

The configurable item can be:

• a Menu or some of its sub-menus from the Barra dei Menu

• a whole Panel (see Panels and Toolbars)

• the Status bar described in label_statusbar or some of its items

• a Toolbar: the whole bar or some of its icons

• or any widget from any dialog in QGIS: label, button, combobox...

With Switch to catching widgets in main application, you can click on an item in QGIS interface that you want to be hidden
and QGIS automatically unchecks the corresponding entry in the Customization dialog.

Once you setup your configuration, click [Apply] or [Ok] to validate your changes. This configuration becomes
the one used by default by QGIS at the next startup.

The modifications can also be saved in a .ini file using Save To File button. This is a handy way to share a

common QGIS interface among multiple users. Just click on Load from File from the destination computer in
order to import the .ini file. You can also run command line tools and save various setups for different use cases
as well.

Suggerimento: Easily restore predefined QGIS
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The initial QGIS GUI configuration can be restored by one of the methods below:

• unchecking Enable customization option in the Customization dialog or click the Check All button

• pressing the [Reset] button in the QSettings frame under Settings → Options menu, System tab

• launching QGIS at a command prompt with the following command line qgis --nocustomization

• setting to false the value of UI → Customization → Enabled variable under Settings → Options menu,
Advanced tab.

In most cases, you need to restart QGIS in order to have the change applied.
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CHAPTER 10

Lavorare con le proiezioni

QGIS allows users to define a global and project-wide CRS (coordinate reference system) for layers without a
pre-defined CRS. It also allows the user to define custom coordinate reference systems and supports on-the-fly
(OTF) projection of vector and raster layers. All of these features allow the user to display layers with different
CRSs and have them overlay properly.

10.1 Panoramica sul supporto alle proiezioni

QGIS has support for approximately 2,700 known CRSs. Definitions for each CRS are stored in a SQLite database
that is installed with QGIS. Normally, you do not need to manipulate the database directly. In fact, doing so may
cause projection support to fail. Custom CRSs are stored in a user database. See section Sistemi di riferimento
personalizzati for information on managing your custom coordinate reference systems.

The CRSs available in QGIS are based on those defined by the European Petroleum Search Group (EPSG) and
the Institut Geographique National de France (IGNF) and are largely abstracted from the spatial reference tables
used in GDAL. EPSG identifiers are present in the database and can be used to specify a CRS in QGIS.

In order to use OTF projection, either your data must contain information about its coordinate reference system or
you will need to define a global, layer or project-wide CRS. For PostGIS layers, QGIS uses the spatial reference
identifier that was specified when the layer was created. For data supported by OGR, QGIS relies on the presence
of a recognized means of specifying the CRS. In the case of shapefiles, this means a file containing the well-known
text (WKT) specification of the CRS. This projection file has the same base name as the shapefile and a .prj
extension. For example, a shapefile named alaska.shp would have a corresponding projection file named
alaska.prj.

Whenever you select a new CRS, the layer units will automatically be changed in the General tab of the Project
Properties dialog under the Project (Gnome, OS X) or Settings (KDE, Windows) menu.

10.2 Specifiche globali delle proiezioni

QGIS starts each new project using the global default projection. The global default CRS is EPSG:4326 - WGS 84
(proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), and it comes predefined in QGIS. This
default can be changed via the [Select...] button in the first section, which is used to define the default coordinate
reference system for new projects, as shown in figure_projection_1. This choice will be saved for use in subsequent
QGIS sessions.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Settings → Options.

Le opzioni mostrate in figura figure_projection_1 sono:

• Prompt for CRS

• Use project CRS

67



QGIS User Guide, Release 2.14

Figure 10.1: CRS tab in the QGIS Options Dialog

• Use default CRS displayed below

If you want to define the coordinate reference system for a certain layer without CRS information, you can also do
that in the General tab of the raster and vector properties dialog (see Menu Generale for rasters and Menu Generale
for vectors). If your layer already has a CRS defined, it will be displayed as shown in Finestra di dialogo generale.

Suggerimento: SR NELLA LEGENDA
Facendo click con il tasto destro su di un layer in legenda (sezione Layers Panel) hai a disposizione due scorci-
atoie per l’impostazione del SR. Imposta il SR del layer apre direttamente la finestra per la scelta del sistema di
riferimento (figura figure_projection_2), mentre Imposta il SR del progetto dal layer imposterà il SR del progetto
sulla base di quello del layer

10.3 Definire la riproiezione al volo (OTF)

QGIS supports OTF reprojection for both raster and vector data. However, OTF is not activated by default. To use

OTF projection, you must activate the Enable on the fly CRS transformation checkbox in the CRS tab of the

Project Properties dialog.

Hai tre modi diversi per farlo:

1. Select Project Properties from the Project (Gnome, OSX) or Settings (KDE, Windows) menu.

2. Cliccare sull’icona Stato SR nell’angolo in basso a destra della barra di stato.

3. Abilita la riproiezione al volo in modalità predefinita spuntando la casella di controllo Effettua sempre la
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riproiezione al volo nella scheda SR della finestra di dialogo Opzioni oppure spunta Abilita automaticamente
la riproiezione al volo se i layer hanno SR differente.

Se hai già caricato un layer e vuoi abilitare la riproiezione al volo, la scelta migliore è: aprire la scheda Sistema di
riferimento (SR) della finestra di dialogo Proprietà progetto, selezionare nell’elenco il SR attualmente impostato,

quindi attivare la casella di controllo Abilita la riproiezione al volo. Ogni layer caricato successivamente sarà

riproiettato al volo nel SR mostrato vicino all’icona Stato SR e quest’icona diventerà attiva a tutti gli effetti.

Figure 10.2: Project Properties Dialog

La scheda SR della finestra di dialogo Proprietà progetto contiene cinque importanti componenti, come puoi
vedere nella figura Figure_projection_2:

1. Abilita la riproiezione al volo — puoi utilizzare questa casella di controllo per abilitare o disabilitare la
riproiezione al volo. Quando è disabilitata, ogni layer verrà visualizzato in funzione del proprio sistema
di riferimento e le componenti descritte sotto non saranno attive. Quando è abilitata, ogni layer verrà
visualizzato nel sistema di riferimento specificato.

2. Filtro — se conosci il codice EPSG, l’identificatore o il nome del SR che vuoi impostare, puoi utilizzare
questa area di ricerca per trovarlo nell’elenco. Inserisci il codice EPSG, l’identificatore o il nome.

3. Sistemi di riferimento usati di recente — se ci sono dei SR che usi frequentemente, questi verranno
visualizzati in questa sezione della finestra di dialogo. Clicca su una voce per impostare il SR associato.

4. Coordinate reference systems of the world — This is a list of all CRSs supported by QGIS, including
Geographic, Projected and Custom coordinate reference systems. To define a CRS, select it from the list by
expanding the appropriate node and selecting the CRS. The active CRS is preselected.

5. Testo PROJ.4 - è la stringa SR usata dal motore di proiezione Proj4. È un testo di sola lettura, a solo scopo
informativo.

Suggerimento: Finestra di dialogo Proprietà del progetto
Se apri la finestra di dialogo Proprietà progetto dal menu Progetto, per poter visualizzare le impostazioni del SR
devi cliccare sulla scheda SR.

Se clicchi sull’icona Stato SR si aprirà automaticamente la scheda SR.

10.3. Definire la riproiezione al volo (OTF) 69



QGIS User Guide, Release 2.14

10.4 Sistemi di riferimento personalizzati

If QGIS does not provide the coordinate reference system you need, you can define a custom CRS. To define a

CRS, select Custom CRS... from the Settings menu. Custom CRSs are stored in your QGIS user database. In
addition to your custom CRSs, this database also contains your spatial bookmarks and other custom data.

Figure 10.3: Custom CRS Dialog

Defining a custom CRS in QGIS requires a good understanding of the PROJ.4 projection library. To begin, refer to
“Cartographic Projection Procedures for the UNIX Environment - A User’s Manual” by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

This manual describes the use of the proj.4 and related command line utilities. The cartographic parameters
used with proj.4 are described in the user manual and are the same as those used by QGIS.

La finestra di dialogo Definizione Sistema Riferimento Spaziale Personalizzato richiede solamente due parametri
per definire un SR personalizzato:

1. Il nome

2. I parametri cartografici in formato PROJ.4.

To create a new CRS, click the Add new CRS button and enter a descriptive name and the CRS parameters.

La voce Parametri deve iniziare con un blocco +proj=, per rappresentare il nuovo SR.
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Puoi testare i parametri del tuo SR per vedere se danno risultati validi. Per farlo, inserisci due valori noti di
latitudine e longitudine nel sistema WGS 84 rispettivamente in Nord ed Est. Clicca su [Calcola] e fai un paragone
dei risultati con i valori noti del tuo SR personalizzato.

10.5 Trasformazioni datum predefinite

OTF depends on being able to transform data into a ‘default CRS’, and QGIS uses WGS84. For some CRS there
are a number of transforms available. QGIS allows you to define the transformation used otherwise QGIS uses a
default transformation.

In the CRS tab under Settings → Options you can:

• set QGIS to ask you when it needs define a transformation using Ask for datum transformation when no
default is defined

• modificare la lista di trasformazioni specificate dall’utente.

QGIS asks which transformation to use by opening a dialogue box displaying PROJ.4 text describing the source
and destination transforms. Further information may be found by hovering over a transform. User defaults can be
saved by selecting Remember selection.
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CHAPTER 11

QGIS Browser

• QGIS Browser widget
• QGIS Browser as a standalone application

QGIS Browser is available as a standalone application and as a panel in QGIS Desktop. It lets you easily navigate
in your filesystem and manage geodata. You can have access to common vector files (e.g., ESRI shapefiles
or MapInfo files), databases (e.g., PostGIS, Oracle, SpatiaLite or MS SQL Spatial) and OWS/WCS|WMS|WFS
connections. You can also view your GRASS data (to get the data into QGIS, see Integrazione con GRASS GIS).

11.1 QGIS Browser widget

To activate QGIS Browser, right-click on QGIS toolbar and check Browser Panel or select it from View →
Panels or Settings → Panels (kde). In the Browser panel, you can now browse in your filesystem, databases and
web services and get your data into the map view with a simple drag-and-drop or double-click.

You can also open a QGIS project directly from the Browser panel by double-clicking its name or by drag-and-
drop into the map view.

At the top of the panel, you find some icons that help you to:

• Add Selected Layers. You can also add data into the map view by selecting Add Layer or Add selected
layers in the context menu.

• Refresh the browser tree

• search for specific data. Enter a search word or wildcard and the browser will filter the tree to only
show paths to matching DB tables, filenames or folders – other data or folders won’t be displayed. See the
Browser Panel(2) example on the figure_browser_panels. The comparison can be case-sensitive or not. It
can also be set to:

– normal: return any item containing the search text

– using wildcard(s): fine tune the search using ? and/or * characters to specify the position of the search
text

– using a regular expression

• Collapse the whole tree

• Enable and disable properties widget. When toggled on, a new widget is added at the bottom of the
panel showing, if applicable, metadatas of the selected item

Right-click an item in the browser tree helps you to:
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• in case of file or table, display its metadata or open it in your project. Tables can even be renamed, deleted
or truncated

• in case of folder, bookmark it into your favourites, hide it from the browser tree. Hidden folders can be
managed from the Settings → Options → Data Sources tab

• refresh, rename or delete schema.

You can also import files into databases or copy tables from one schema/database to another one with a simple
drag-and-drop. There is a second browser panel available to avoid long scrolling while dragging. Just select the
file and drag-and-drop from one panel to the other.

Figure 11.1: QGIS Browser panels side-by-side

11.2 QGIS Browser as a standalone application

It’s also possible to run the QGIS Browser as a standalone application. Like the Browser panel, the standalone
Browser helps you navigate through your filesystem and manage your geodata. It also helps you preview or create
them and open them in a QGIS project by drag-and-drop.

Avvia QGIS browser

• Digitare “qbrowser” nella finestra del terminale.

• Start the QGIS Browser using the Start menu or desktop shortcut.

• The QGIS Browser is available from your Applications folder.

In figure_browser_standalone_metadata, you can see the enhanced functionality of the standalone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see vectormetadatamenu). With the Preview tab, you
can have a look at your files without importing them into your QGIS project. It’s also possible to preview the
attributes of your files in the Attributes tab.
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Figure 11.2: QGIS Browser as a standalone application
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CHAPTER 12

Lavorare con i vettori

12.1 Formati supportati

QGIS uses the OGR library to read and write vector data formats, including ESRI shapefiles, MapInfo and Mi-
croStation file formats, AutoCAD DXF, PostGIS, SpatiaLite, Oracle Spatial and MSSQL Spatial databases, and
many more. GRASS vector and PostgreSQL support is supplied by native QGIS data provider plugins. Vector
data can also be loaded in read mode from zip and gzip archives into QGIS. As of the date of this document,
69 vector formats are supported by the OGR library (see OGR-SOFTWARE-SUITE in Letteratura e riferimenti
web). The complete list is available at http://www.gdal.org/ogr/ogr_formats.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL/OGR installation of your OS may not have been built to support the format
you want to use. Only those formats that have been well tested will appear in the list of file types when loading a
vector into QGIS. Other untested formats can be loaded by selecting *.*.

La sezione Integrazione con GRASS GIS ti mostra come lavorare con i dati di GRASS.

This section describes how to work with several common formats: ESRI shapefiles, PostGIS layers, SpatiaLite
layers, OpenStreetMap vectors, and Comma Separated data (CSV). Many of the features available in QGIS work
the same, regardless of the vector data source. This is by design, and it includes the identify, select, labelling and
attributes functions.

Nota: QGIS supports (multi)point, (multi)line, (multi)polygon, CircularString, CompoundCurve, CurvePolygon,
MultiCurve, MultiSurface feature types, all with Z and/or M values.

You should note also that some driver doesn’t support some of these feature types like CircularString, Compound-
Curve, CurvePolygon, MultiCurve, MultiSurface feature type. QGIS will convert them to (multi)polygon feature.

12.1.1 Loading a layer from a file

To load a layer from a file (like a Shapefile, a Mapinfo or a dxf layer), click on the Add Vector Layer toolbar
button; or type Ctrl+Shift+V. This will bring up a new window (see figure_vector_1).

From the available options check File. Click on [Browse]. That will bring up a standard open file dialog (see
figure_vector_2), which allows you to navigate the file system and load a shapefile or other supported data source.

The selection box Filter allows you to preselect some OGR-supported file formats.

You can also select the encoding for the file if desired.

Selecting a file from the list and clicking [Open] loads it into QGIS. Figure_vector_3 shows QGIS after loading
the alaska.shp file.

Suggerimento: Colori dei vettori
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Figure 12.1: Add Vector Layer Dialog

Figure 12.2: Open an OGR Supported Vector Layer Dialog
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Figure 12.3: QGIS with Shapefile of Alaska loaded

Quando aggiungi un vettore alla mappa, gli viene assegnato un colore casuale. Se aggiungi più vettori in una sola
volta, ciascuno avrà un colore diverso.

Once a file is loaded, you can zoom around it using the map navigation tools. To change the style of a layer,
open the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the
legend and choosing Properties from the context menu. See section Menu Stile for more information on setting
symbology of vector layers.

Suggerimento: Caricare vettori e progetti da periferiche esterne in OS X
In OS X le periferiche esterne montate accanto al disco fisso principale non sono visibili nel menu File → Apri
progetto. Stiamo lavorando per cercare di risolvere questo problema con OS X; come soluzione temporanea digita
/Volume nella casella Nome file e clicca invio. In questo modo potrai utilizzare le periferiche esterne.

Nota: DXF files containing several geometry types (point, line and/or polygon), the name of the layer will be
made from <filename.dxf> entities <geometry type>.

Nota: You can also drag and drop the file(s) into the Layers Panel from either the files browser or the QGIS
Browser panel. If the layer contains several geometry types, a new windows will ask you to select the sublayer.
This often occurs with GPX, Mapinfo or DXF files format.

Loading specific directory based layer

To load some specific format like ArcInfo Binary Coverage, UK. National Transfer Format, as well as the raw
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TIGER format of the US Census Bureau or OpenfileGDB, click on the Add Vector Layer toolbar button or press
Ctrl+Shift+V to open the Add Vector Layer dialog. Select Directory as Source type. Change the file type

filter Files of type to the format you want to open, for example ‘Arc/Info Binary Coverage’. Navigate to the
directory that contains the coverage file or the file, and select it.

Shapefile ESRI

The ESRI shapefile is still one of the most used vector file format in QGIS. However, this file format has some
limitation that some other file format have not (like Geopackage, spatialite). Support is provided by the OGR
Simple Feature Library (http://www.gdal.org/ogr/).

Uno shapefile è costituito da di un minimo di tre file:

1. .shp contente le geometrie

2. .dbf contenente gli attributi in formato dBase

3. .shx contenente l’indice

Uno shapefile può anche includere un file con suffisso .prj che contiene le informazioni sulla proiezione. Anche
se non è obbligatorio, è molto utile avere informazioni sulla proiezione del file. Un insieme di dati shapefile
può contenere anche altri tipi di file. Per ulteriori informazioni, vedi le specifiche tecniche di ESRI all’indirizzo
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Improving Performance for Shapefiles

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Segui questi passi per creare un indice spaziale:

• Load a shapefile by clicking on the Add Vector Layer toolbar button or pressing Ctrl+Shift+V.

• Apri la finestra di dialogo Proprietà layer facendo doppio click sul nome dello shapefile nella legenda o
cliccandoci con il tasto destro e scegliendo Proprietà dal menu contestuale.

• Nella scheda Generale clicca sul pulsante [Crea indice spaziale].

Problem loading a shape .prj file

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

12.1.2 File di testo delimitato

I dati tabellari sono un formato molto comune ed utilizzato proprio grazie alla loro semplicità e leggibilità – infatti
i dati possono essere visualizzati e modificati con un semplice editor di testo. Un file di testo delimitato è una
tabella di attributi in cui ogni colonna è separata da un preciso carattere mentre le righe sono separate da un nuovo
capoverso. Di solito la prima riga contiene i nomi delle colonne. Un formato molto comune è il CSV (Comma
Separated Values), dove ogni colonna è separata da una virgola.

Questi dati possono anche contenere informazioni sulla posizione in due forme principali:

• Come coordinate puntuali in colonne separate

• Come rappresentazione geometrica in Well-Known-Text (WKT)
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QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:

1. Il file deve avere una riga di intestazione per il nome dei campi. Questa deve essere la prima riga del testo.

2. La riga di intestazione deve contenere campi relativi alla definizione geometrica. Questi campi possono
avere un nome qualunque.

3. Le coordinate X e Y (se la geometria è identificata da coordinate) devono essere specificate come numeri.
Il sistema di coordinate non è importante.

As an example of a valid text file, we import the elevation point data file elevp.csv that comes with the QGIS
sample dataset (see section Dati campione):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Alcune cose da tenere in considerazione in merito al file di testo:

1. Il file di testo usato come esempio usa ; (punto e virgola) come delimitatore. Ma qualsiasi carattere può
essere usato per delimitare i campi.

2. La prima riga è la riga di intestazione. Questa contiene i campi X, Y e ELEV.

3. Nessun tipo di virgoletta (") dev’essere usata per delimitare i campi di testo.

4. Le coordinate X sono contenute nel campo X.

5. Le coordinate Y sono contenute nel campo Y.

Others valuable informations for advanced users

Features with curved geometries (CircularString, CurvePolygon and CompoundCurve) are supported. Here are
three examples of such geometry types as a delimited text with WKT geometries:

Label;WKT_geom
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Delimited Text supports also Z and M coordinates in geometries:

LINESTRINGM(10.0 20.0 30.0, 11.0 21.0 31.0)

Caricare un file di testo delimitato

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text_1.

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To
enable QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter
by activating Custom delimiters, or by activating Regular expression delimiter and entering text into the
Expression field. For example, to change the delimiter to tab, use \t (this is a regular expression for the tab
character).

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.
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Figure 12.4: Delimited Text Dialog

Finally, enter a layer name (e.g., elevp), as shown in figure_delimited_text_1. To add the layer to the map, click
[OK]. The delimited text file now behaves as any other map layer in QGIS.

Puoi anche tagliare gli spazi iniziali e finali dai campi spuntando la casella di controllo Rifinisci i campi.

Inoltre puoi anche spuntare la casella di controllo Scarta i campi vuoti. Se è necessario puoi forzare la lettura

della virgola come separatore decimale spuntando la casella di controllo La virgola è il separatore decimale.

If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Additionally, you can enable:

• Usa indice spaziale per migliorare le prestazioni di visualizzazione di selezione delle geometrie.

• Usa indice di raggruppamento

• Watch file to watch for changes to the file by other applications while QGIS is running.

12.1.3 Dati OpenStreetMap

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital road maps are available. The objective of the OSM project is to create a free editable map of the world
from GPS data, aerial photography or local knowledge. To support this objective, QGIS provides support for OSM
data.

Caricare vettori OpenStreetMap

QGIS integrates OpenStreetMap import as a core functionality.

• Per connetterti al server OSM e scaricare i dati, apri il menu Vettore → OpenStreetMap → Download dati.
Puoi saltare questo passaggio se hai già a disposizione un file XML .osm ottenuto con JOSM, Overpass
API o altre fonti.
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• Il menu Vettore → OpenStreetMap → Importa topologia da XML convertirà il tuo file .osm in un database
SpatiaLite e creerà una connessione a questo database.

• The menu Vector → Openstreetmap → Export topology to SpatiaLite then allows you to open the database
connection, select the type of data you want (points, lines, or polygons) and choose tags to import. This

creates a SpatiaLite geometry layer that you can add to your project by clicking on the Add SpatiaLite Layer

toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu (see section
Vettori SpatiaLite).

12.1.4 Vettori PostGIS

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are the spatial indexing, filter-
ing and query capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than they do with OGR layers in QGIS.

Creare una connessione

The first time you use a PostGIS data source, you must create a connection to the PostgreSQL database that

contains the data. Begin by clicking on the Add PostGIS Layer toolbar button, selecting the Add PostGIS
Layer... option from the Layer menu, or typing Ctrl+Shift+D. You can also open the Add Vector Layer dialog
and select Database. The Add PostGIS Table(s) dialog will be displayed. To access the connection manager,
click on the [New] button to display the Create a New PostGIS Connection dialog. The parameters required for a
connection are:

• Nome: Nome della connessione. Può essere uguale a quello del Database.

• Service: Service parameter to be used alternatively to hostname/port (and potentially database). This can
be defined in pg_service.conf. Check the Service connection file section for more details.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Porta: Numero della porta del server database PostgreSQ. La porta predefinita è 5432.

• Database: Nome del database.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speed-ups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. The following options
are available:

– disabilitato: prova solo una connessione SSL non criptata

– permesso: tenta una connessione non-SSL, se questa fallisce ne tenta una SSL

– preferito (predefinito): tenta una connessione SSL, se questa fallisce ne prova una non-SSL

– richiesto: tenta solo una connessione SSL

• Nome utente: Nome dell’utente usato per accedere al database.

• Password: Password usata dallo Username per collegarsi al database.

Se vuoi, puoi attivare le seguenti caselle di controllo:

• Salva nome utente

• Salva Password

• Cercare solamente nella tabella geometry_columns

• Non risolvere tipo di geometria senza restrizioni (GEOMETRY)
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• Cerca solamente nello schema

• Mostra anche tabelle senza geometria

• Usa i metadati stimati della tabella

Quando hai impostato tutti i parametri, puoi testare la connessione cliccando sul pulsante [Test Connessione].

Suggerimento: Use estimated table metadata to speed up operations
When initializing layers, various queries may be needed to establish the characteristics of the geometries stored
in the database table. When the Use estimated table metadata option is checked, these queries examine only a
sample of the rows and use the table statistics, rather than the entire table. This can drastically speed up operations
on large datasets, but may result in incorrect characterization of layers (eg. the feature count of filtered layers
will not be accurately determined) and may even cause strange behaviour in case columns that are supposed to be
unique actually are not.

Caricare un vettore PostGIS

Once you have one or more connections defined, you can load layers from the PostgreSQL database. Of
course, this requires having data in PostgreSQL. See section Importare dati in PostgreSQL for a discussion on
importing data into the database.

Per caricare vettori PostGIS, segui i seguenti passaggi:

• If the Add PostGIS layers dialog is not already open, selecting the Add PostGIS Layer... option from the
Layer menu or typing Ctrl+Shift+D opens the dialog.

• Scegli la connessione dal menu a tendina e clicca su [Connetti].

• Seleziona/deseleziona Mostra anche le tabelle senza geometria.

• Spunta la casella di controllo Opzioni di ricerca per specificare quali elementi caricare dal vettore oppure
usa [Imposta filtro] per avviare la finestra di dialogo Costruttore interrogazioni.

• Scegli il vettore che vuoi caricare dalla lista di quelli disponibili.

• Seleziona il vettore cliccando sul nome. Puoi selezionare più vettori tenendo premuto il tasto Shiftmentre
stai selezionando. Vedi la sezione Costruttore di interrogazioni per informazioni su come usare il Costrut-
tore di interrogazioni PostgreSQL.

• Clicca su [Aggiungi] per aggiungere il vettore alla mappa.

Suggerimento: Vettori PostGIS
Normally, a PostGIS layer is defined by an entry in the geometry_columns table. From version 0.9.0 on, QGIS
can load layers that do not have an entry in the geometry_columns table. This includes both tables and views.
Defining a spatial view provides a powerful means to visualize your data. Refer to your PostgreSQL manual for
information on creating views.

Service connection file

The service connection file allows PostgreSQL connection parameters to be associated with a single service name.
That service name can then be specified by a client and the associated settings will be used.

It’s called .pg_service.conf under *nix systems (GNU/Linux, macOS etc.) and pg_service.conf on
Windows.

The service file looks like:
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[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com
dbname=water
user=waterpass

Nota: There are two services in the above example: water_service and wastewater_service. You can
use these to connect from QGIS, pgAdmin etc. by specifying only the name of the service you want to connect to
(without the enclosing brackets). If you want to use the service with psql you need to do something like export
PGSERVICE=water_service before doing your psql commands.

Nota: You can find all the parameters here

Nota: If you don’t want to save the passwords in the service file you can use the .pg_pass option.

On *nix operating systems (GNU/Linux, macOS etc.) you can save the .pg_service.conf file in the user’s
home directory and the PostgreSQL clients will automatically be aware of it. For example, if the logged user is
web, .pg_service.conf should be saved in the /home/web/ directory in order to directly work (without
specifying any other environment variables).

You can specify the location of the service file by creating a PGSERVICEFILE environment variable (e.g. run
the export PGSERVICEFILE=/home/web/.pg_service.conf command under your *nix OS to tem-
porarily set the PGSERVICEFILE variable)

You can also make the service file available system-wide (all users) either by placing it at pg_config
--sysconfdir‘‘**/.pg_service.conf** or by adding the ‘‘PGSYSCONFDIR environ-
ment variable to specify the directory containing the service file. If service definitions with the same name exist
in the user and the system file, the user file takes precedence.

Avvertimento: There are some caveats under Windows:
• The service file should be saved as pg_service.conf and not as .pg_service.conf.
• The service file should be saved in Unix format in order to work. One way to do it is to open it with

Notepad++ and Edit -> EOL Conversion -> UNIX Format -> File save.
• After adding an environment variable you may also need to restart the computer.

Alcuni dettagli sui vettori PostgreSQL

This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time, QGIS should
simply provide you with a list of database tables that can be loaded, and it will load them on request. However,
if you have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any
QGIS messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to
load it.

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables,
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively, the ctid column can be used as primary
key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).

If the PostgreSQL layer is a view, the same requirement exists, but views do not have primary keys or columns
with unique constraints on them. You have to define a primary key field (has to be integer) in the QGIS dialog
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before you can load the view. If a suitable column does not exist in the view, QGIS will not load the layer. If this
occurs, the solution is to alter the view so that it does include a suitable column (a type of integer and either a
primary key or with a unique constraint, preferably indexed).

QGIS offers a checkbox Select at id that is activated by default. This option gets the ids without the attributes
which is faster in most cases. It can make sense to disable this option when you use expensive views.

Suggerimento: Backup del database PostGIS con layer salvati da QGIS
If you want to make a backup of your PostGIS database using the pg_dump and pg_restore commands, and
the default layer styles as saved by QGIS fail to restore afterwards, you need to set the XML option to DOCUMENT
and the restore will work.

QGIS allows to filter features already on server side. Check the Execute expressions on postgres server-side if
possible (Experimental) checkbox to do so. Only supported expressions will be sent to the database. Expressions
using unsupported operators or functions will gracefully fallback to local evaluation.

12.1.5 Importare dati in PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, including the DB Manager plugin and the
command line tools shp2pgsql and ogr2ogr.

DB Manager

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section Plugin DB Manager for more information.

shp2pgsql

Puoi usare lo strumento shp2pgsql di PostGIS per importare shapefile in un database PostGIS. Per esempio, per
importare uno shapefile chiamato lakes.shp in un database PostgreSQL chiamato gis_data, usa il seguente
comando:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Questo comando crea un nuovo vettore, chiamato lakes_new, nel database gis_data. Il nuovo vettore avrà
un identificatore del sistema di riferimento (Spatial Reference Identifier - SRID) corrispondente a 2964. Vedi la
sezione Lavorare con le proiezioni per ulteriori informazioni sui sistemi di riferimento spaziali e sulle proiezioni.

Suggerimento: Esportare dati da PostGIS
Come lo strumento di importazione shp2pgsql, esiste anche il comando che permette di esportare set di dati da
PostGIS come shapefile: pgsql2shp. Lo strumento è incluso con la tua versione di PostGIS.

ogr2ogr

Oltre a shp2pgsql e DB Manager c’è un altro strumento per caricare dati in PostGIS: ogr2ogr. Questo comando
fa parte dell’installazione di GDAL.

Per importare uno shapefile in PostGIS con ogr2ogr digita il seguente comando:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Questo comando importerà lo shapefile alaska.shp nel database PostGIS postgis usando come utente postgres
e come password topsecret sull’host myhost.de.
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Nota che OGR deve essere compilato con il supporto PostgreSQL per poter effettuare questa operazione. Puoi
verificarlo digitando

ogrinfo --formats | grep -i post

Se volessi usare il comando interno di PostgreSQL COPY al posto del metodo predefinito INSERT INTO, devi

impostare le variabili d’ambiente come segue (su piattaforme e ):

export PG_USE_COPY=YES

ogr2ogr non crea indici spaziali come shp2pgsl. Devi crearli manualmente, usando il comando SQL CREATE
INDEX dopo l’importazione, come passo aggiuntivo (sezione Migliorare le prestazioni).

Migliorare le prestazioni

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can im-
prove the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on each layer
in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed up spatial searches
of the data (GiST index information is taken from the PostGIS documentation available at http://postgis.net).

Suggerimento: You can use the DBManager to create an index to your layer. You should first select the layer
and click on Table > Edit table, go to Indexes tab and click on [Add spatial index].

La sintassi per la creazione di un indice GiST è:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Nota che per tabelle molto grandi, la creazione dell’indice può richiedere parecchio tempo. Non appena l’indice
è stato creato, dovresti effettuare un VACUUM ANALYZE. Vedi la documentazione di PostGIS (POSTGIS-
PROJECT Letteratura e riferimenti web) per ulteriori informazioni.

Segue un esempio di come creare un indice GiST:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

12.1.6 Vettori a cavallo dei 180° di longitudine

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_4, the tiny point on the far left of the map canvas (Chatham Islands) should be within the grid, to
the right of the New Zealand main islands.
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Figure 12.5: Map in lat/lon crossing the 180° longitude line

Una soluzione consiste nel trasformare i valori di longitudine utilizzando PostGIS e la funzione
ST_Shift_Longitude. Questa funzione legge i punti/vertici di ogni elemento di una geometria e se la coordi-
nata di longitudine è < 0° , aggiunge 360°. Il risultato sarà una versione 0° - 360° dei dati, che verranno poi
visualizzati su una mappa centrata a 180° .

Figure 12.6: Vettori a cavallo di 180° di longitudine usando la funzione ST_Shift_Longitude

Guida all’uso

• Importare i dati in PostGIS (Importare dati in PostgreSQL) usando, per esempio, il plugin DB Manager.

• Usa l’interfaccia da linea di comando di PostGIS per dare il seguente comando (nell’esempio -“TABLE” è
il nome della tua tabella PostGIS):

• Se tutto è andato a buon fine, riceverai la conferma sul numero di elementi che sono stati aggiornati. Potrai
cosi caricare la mappa e vedere le differenze (figura Figure_vector_5).

12.1.7 Vettori SpatiaLite

The first time you load data from a SpatiaLite database, begin by clicking on the Add SpatiaLite Layer

toolbar button, or by selecting the Add SpatiaLite Layer... option from the Layer menu, or by typing
Ctrl+Shift+L. This will bring up a window that will allow you either to connect to a SpatiaLite database
already known to QGIS, which you can choose from the drop-down menu, or to define a new connection to a new
database. To define a new connection, click on [New] and use the file browser to point to your SpatiaLite database,
which is a file with a .sqlite extension.

Per salvare un vettore in formato SpatialLite, clicca con il tasto destro del mouse sul vettore nella legenda e
seleziona l’opzione Salva con nome..., scegli il nome del file in output, seleziona SQLite come formato e il SR
che preferisci. Aggiungi anche SPATIALITE=YES nel riquadro Sorgente dati delle opzioni di creazione OGR.
Vedi http://www.gdal.org/ogr/drv_sqlite.html per ulteriori informazioni.
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QGIS also supports editable views in SpatiaLite.

Creare un nuovo vettore SpatiaLite

Per creare un nuovo vettore SpatiaLite, fai riferimento alla sezione Creare un nuovo layer SpatiaLite.

Suggerimento: SpatiaLite data management plugin
For SpatiaLite data management, you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or
DB Manager (core plugin, recommended). If necessary, they can be downloaded and installed with the Plugin
Installer.

12.1.8 Vettori Spatial MSSQL

QGIS also provides native MS SQL support. The first time you load MSSQL Spatial data, begin by clicking

on the Add MSSQL Spatial Layer toolbar button or by selecting the Add MSSQL Spatial Layer... option from the
Layer menu, or by typing Ctrl+Shift+M.

12.1.9 Vettori Oracle Spatial

The spatial features in Oracle Spatial aid users in managing geographic and location data in a native type within
an Oracle database. QGIS now has support for such layers.

Creare una connessione

The first time you use an Oracle Spatial data source, you must create a connection to the database that

contains the data. Begin by clicking on the Add Oracle Spatial Layer toolbar button, selecting the Add Oracle
Spatial Layer... option from the Layer menu, or typing Ctrl+Shift+O. To access the connection manager, click
on the [New] button to display the Create a New Oracle Spatial Connection dialog. The parameters required for
a connection are:

• Nome: Nome della connessione. Può essere uguale a quello del Database.

• Database: SID o SERVICE_NAME dell’istanza Oracle.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: Numero di porta su cui il database Oracle rimane in ascolto. La porta predefinita è 1521.

• Nome utente: Nome utente che accede al database.

• Password: Password usata dallo Username per collegarsi al database.

Come opzione, puoi spuntare le seguenti caselle di controllo:

• Salva nome utente specifica se vuoi salvare il nome utente del database nelle configurazioni di connes-
sione.

• Salva password specifica se vuoi salvare la password del database nelle configurazioni di connessione.

• Cerca solo nelle tabelle dei metadati restringe le tabelle visualizzate a quello che sono presenti nella
vista all_sdo_geom_metadata. Questo procedimento velocizza la visualizzazione iniziale delle tabelle
spaziali.

• Cerca solo tabelle dell’utente: nella ricerca di tabelle spaziali, si limita a quelle di proprietà dell’utente.

12.1. Formati supportati 89



QGIS User Guide, Release 2.14

• Mostra anche tabelle senza geometria specifica che anche le tabelle senza geometria devono essere
elencate.

• Usa i metadati stimati del vettore: quando il vettore è stato impostato, la tabella Oracle richiede diversi
metadati. Sono necessarie informazioni come il conteggio delle righe della tabella, il tipo di geometria
e l’estensione spaziale nella colonna geometria. Se la tabella contiene un grande numero di righe che
descrivono i metadati, stimare questi metadati porterà via molto tempo. Attivando questa opzione verranno
eseguite le seguenti rapide operazioni sulla tabella dei metadati: Il conteggio delle righe è determinato
da all_tables.num_rows. Le estensioni della tabella saranno sempre determinate con la funzione
SDO_TUNE.EXTENTS_OF anche se è stato applicato un filtro al vettore.

• Solo tipi di geometrie esistenti elenca solo i tipi di geometria esistenti e non permettere di aggiungerne
altre.

Avvertimento: In the Authentication tab, saving username and password will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Authentication System for more details.

Quando hai impostato tutti i parametri, puoi testare la connessione cliccando sul pulsante [Test Connessione].

Suggerimento: Impostazioni utente e sicurezza
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk.
Passwords are saved in clear text in the system configuration and in the project files! Your customized settings for
QGIS are stored based on the operating system:

• le impostazioni sono salvate nella tua cartella home nel file ~/.qgis2.

• le impostazioni sono salvate nel registro di sistema.

Caricare un vettore Oracle Spatial

Once you have one or more connections defined, you can load layers from the Oracle database. Of course,
this requires having data in Oracle.

Per caricare un vettore da Oracle Spatial, segui i seguenti passaggi:

• If the Add Oracle Spatial layers dialog is not already open, click on the Add Oracle Spatial Layer toolbar
button.

• Scegli la connessione dal menu a tendina e clicca su [Connetti].

• Seleziona/deseleziona Mostra anche le tabelle senza geometria.

• Spunta la casella di controllo Opzioni di ricerca per specificare quali elementi caricare dal vettore oppure
usa [Imposta filtro] per avviare la finestra di dialogo Costruttore interrogazioni.

• Scegli il vettore che vuoi caricare dalla lista di quelli disponibili.

• Seleziona il vettore cliccando sul nome. Puoi selezionare più vettori tenendo premuto il tasto Shiftmentre
stai selezionando. Vedi la sezione Costruttore di interrogazioni per informazioni su come usare il Costrut-
tore di interrogazioni Oracle.

• Clicca su [Aggiungi] per aggiungere il vettore alla mappa.

Suggerimento: Vettori Oracle Spatial
Normalmente un vettore Oracle Spatial è definito con una voce nella tabella USER_SDO_METADATA.
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12.2 The Symbol Library

12.2.1 The Style Manager

The Symbol Library is the place where users can manage and create generic symbols to be used in several QGIS
projects. You can open it with the Settings → Style Manager or from the Style tab in the vector layer’s Properties.
It allows users to:

• create, edit and remove symbols

• organize symbols in custom groups

• export and import symbols.

Figure 12.7: The Style Manager

Groups and smart groups

You can organize symbols into different categories. These categories, listed in the panel at the left, can be static
(called Group) or dynamic (named Smart Group). A group is smart when its symbols are dynamically fetched
according to conditions set. See figure_symbol_2:

To create a group, right click on an existing group or on the main Groups directory in the left of the dialog. You

can also select a group and click the Add Group button. The new group will be a sub-group of the selected one.

Create Smart Group is similar to creating group, but instead select Smart Groups. The dialog box allows user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
a group, have a string in its name, etc.). Any symbol that satisfies the entered condition(s) is automatically added
to the smart group.

Figure 12.8: Creating a Smart Group
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To remove a group or a smart group, right click on the group and select Remove Group or select it and push
Remove Group button.

Unlike the smart groups that automatically fetch their belonged symbols, simple groups are filled by the user. To
add a symbol into a group, you can either right click on a symbol, choose Apply Group and then the group name.

There is a second way to add several symbols into a group: just select the group, click and choose Group
Symbols. All symbols display a checkbox that allows you to add the symbol into the selected groups. When
selection is finished, you can click the same button, and choose Finish Grouping.

All the symbols that are not placed under a custom group belong to a default group named Ungrouped.

Add, Edit, Remove Symbol

Selecting a group returns in the right panel, if applicable, the list of symbols of the group (including its subgroups).
These symbols are organized in four different tabs:

• Marker for point symbols

• Line for linear symbols

• Fill for surface symbols

• and Color Ramp

To delete a symbol you no longer need, just select it and click Remove item (also available through right-click).
The symbol will be deleted from the local symbols database.

The symbol list can be modified by adding new symbols with Add item button or modifying existing ones with
Edit item. See The Symbol Selector for further information.

Share symbols

The Share item tool, at the right bottom of the Style Library dialog, offers options to easily share symbols with
others: users can indeed export their symbols and import symbols to their library.

Exporting symbols

You can export the selected symbols to PNG, SVG or XML file formats. Exporting to PNG or SVG (both not
available for color ramp symbols) creates a file for each selected symbol, and the SVG folder can be added to
SVG Paths in Settings → Options to e.g. share these symbols on a network. The XML format generates a single
file containing all the selected symbols. This file can then be imported in another user’s style library.

Importing symbols

You can extend your symbols library by importing new symbols. Just select Import from the drop-down list
at the right bottom of the dialog. In the new dialog, you’ll need to :

• indicate the source of the symbols (it can be a .xml file on the disk or an url),

• give the name of the group under which the symbols will be put

• select the symbols you want to add to your library

• and press Import.

Note that import and export options are also available through right-click.
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Figure 12.9: Importing symbols

Color Ramp

The Color ramp tab in the Style Manager presents different types of color ramps you can use to style layers.

To create a custom color ramp, activate the Color ramp tab and click the Add item button. The button reveals a
drop-down list to choose the ramp type: Gradient, Random, colorBrewer, or cpt-city.

The first three have options for number of steps and/or multiple stops in the color ramp. You can use the Invert
option while classifying the data with a color ramp. See figure_symbol_4 for an example of custom color ramp
and figure_symbol_4a for the cpt-city dialog.

Figure 12.10: Example of custom gradient color ramp with multiple stops

The cpt-city option opens a new dialog with hundreds of themes included ‘out of the box’.
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Figure 12.11: cpt-city dialog with hundreds of color ramps

94 Chapter 12. Lavorare con i vettori



QGIS User Guide, Release 2.14

12.2.2 The symbol Selector

The Symbol selector is the main dialog to design a symbol. You can create or edit Marker, Line or Fill Symbols.

Figure 12.12: Designing a Marker symbol

For each kind of symbols, you will find always the same dialog structure:

• at the top left side a dynamic symbol representation, updated as soon as symbol properties evolve

• under the symbol representation, the symbol tree shows symbol layers that are combined afterwards to shape
a new global symbol. A symbol can consist of several Symbol layers. Settings will be shown later in this
chapter.

• at the right you can setup some parameters that apply to the global symbol:

– unit: it can be millimeter, pixel or map unit

– transparency

– color: when this parameter is changed by the user, its value is echoed to all unlocked sub-symbols
color

– size and rotation for marker symbol

– width for line symbol

Note that the Data-defined override button beside the last layer-related parameters is inactive until the
symbol is applied to a layer. Once the symbol is connected to a layer, this button offers access to the size
assistant dialog which helps to create proportional or multivariate analysis rendering.

• under these parameters are displayed items of the symbols library you can choose from. This list of symbols
can be filtered by selecting a group in the drop-down list just above.

According to the level selected in the symbol tree, you’ll get enabled different tools at the bottom of the dialog to
:

• add new symbol layer: you can imbricate as many symbols as you want

• remove the selected symbol layer

• lock colors of symbol layer: a locked color stays unchanged when user changes the color at the global
(or upper) symbol level
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• duplicate a (group of) symbol layer(s)

• move up or down the symbol layer

• apply special effects to the symbol layer

• save the designed symbol into your symbol library

• or choose in the Advanced drop-down list, to clip features to canvas extent.

Suggerimento: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of
the whole symbol can be changed with the Size (for marker symbol) or the Width (for line symbol) menu in the
first level again. The size of the lower levels changes accordingly, while the size ratio is maintained.

More detailed settings can be made when clicking on the lower level in the Symbol tree. You can change each
Symbol layers properties and according to the symbol type, you get different settings.

Marker Symbols

Marker symbols have several symbol layer types:

• Ellipse marker

• Font marker

• Simple marker (default)

• SVG marker

• Vector Field marker

For each marker symbol, you can set the following properties:

• Symbol layer type: You have the option to use Ellipse markers, Font markers, Simple markers, SVG markers
and Vector Field markers.

• colors

• Size

• Outline style

• Outline width

• Angle

• Offset X,Y: You can shift the symbol in the x- or y-direction.

• Anchor point

• Data defined properties ...

Line Symbols

Line marker symbols have only two symbol layer types:

• Marker line

• Simple line (default)

The default symbol layer type draws a simple line whereas the other display a marker point regularly on the line.
You can choose different location: vertex, last and first vertex, interval, central point or on every curve point.
Marker line can have offset along the line or offset line. Finally, rotation allows you to change the orientation of
the symbol.

The following settings are available:

• colour
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• Pen width

• Offset

• Pen style

• Join style

• Cap style

• Use custom dash pattern

• Dash pattern unit

• Data defined properties ...

Polygon Symbols

Polygon marker symbols have also several symbol layer types:

• Centroid fill

• Gradient fill

• Line pattern fill

• Point pattern fill

• Raster image fill

• SVG fill

• Shapeburst fill

• Simple fill (default)

• Outline: Marker line (same as line marker)

• Outline: simple line (same as line marker)

The following settings are available:

• Colors for the border and the fill.

• Fill style

• Border style

• Border width

• Offset X,Y

• Data defined properties ...

Using the color combo box, you can drag and drop color for one color button to another button, copy-paste color,
pick color from somewhere, choose a color from the palette or from recent or standard color. The combo box
allows you to fill in the feature with transparency. You can also just click the button to open the palette dialog.
Note that you can import color from some external software like GIMP.

With the ‘Raster image fill’ you can fill polygons with a tiled raster image. Options include (data defined) file
name, opacity, image size (in pixels, mm or map units), coordinate mode (feature or view) and rotation.

‘Gradient Fill’ Symbol layer type allows you to select between a Two color and Color ramp setting. You

can use the Feature centroid as Referencepoint. All fills ‘Gradient Fill‘ Symbol layer type is also available
through the Symbol menu of the Categorized and Graduated Renderer and through the Rule properties menu of
the Rule-based renderer.

Other possibility is to choose a ‘shapeburst fill’ which is a buffered gradient fill, where a gradient is drawn from the
boundary of a polygon towards the polygon’s centre. Configurable parameters include distance from the boundary
to shade, use of color ramps or simple two color gradients, optional blurring of the fill and offsets.
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It is possible to only draw polygon borders inside the polygon. Using ‘Outline: Simple line’ select Draw line
only inside polygon.

Note: When geometry type is polygon, you can choose to disable the automatic clipping of lines/polygons to the
canvas extent. In some cases this clipping results in unfavourable symbology (eg centroid fills where the centroid
must always be the actual feature’s centroid).

12.3 Proprietà dei vettori

La finestra di dialogo :guilabel:‘Proprietà vettore’ fornisce le impostazioni generali per gestire l’aspetto degli
elementi del layer nella mappa (simbologia, etichettatura, diagrammi), l’interazione con il mouse (azioni, sugger-
imenti per la mappa). Fornisce anche informazioni sul layer.

Per accedere alla finestra di dialogo Proprietà vettore fai doppio click sul layer nella legenda oppure click destro
sul layer e seleziona Proprietà dal menu pop-up.

Suggerimento: Scorri rapidamente tra le diverse rappresentazioni del layer
Utilizzando il menu a tendina Stile → Aggiungi in fondo alla finestra di dialogo :guilabel:‘ Proprietà Layer‘, è
possibile salvare tutte le combinazioni di impostazioni delle proprietà dei livelli (simbologia, etichette, diagrammi,
campi, azioni .. .). Quindi, basta passare tra gli stili dal menu contestuale del layer in :guilabel: ‘Pannello layer’
per ottenere automaticamente rappresentazioni diverse dei tuoi dati.

12.3.1 Menu Generale

Usa questo menu per gestire le impostazioni principali dei vettori. Hai a disposizione diverse opzioni:

Informazioni del layer

• Cambia il nome visualizzato del vettore in visualizzato come

• Specifica la Sorgente layer del vettore

• Specifica la Codifica sorgente dati per abilitare codifiche specifiche e per poter leggere il file

Sistema di Riferimento

• Specifica il sistema di riferimento delle coordinate. Qui puoi vedere o cambiare la proiezione del vettore.

• Crea indice spaziale (solo per formati supportati da OGR)

• Aggiorna estensione del vettore

• Vedi o cambia la proiezione di un vettore cliccando su Specifica ...

Visibilità dipendente dalla scala

Puoi impostare la scala Massima (inclusa) e Minima (inclusa), definendo un intervallo di scala nel

quale i vettori saranno visibili. Al di fuori di questo intervallo, saranno invisibili. Il pulsante
Imposta alla scala corrente dell’estensione della mappa è di aiuto per usare la scala corrente della mappa come limite della vis-
ibilità di intervallo.
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Figure 12.13: Finestra di dialogo generale
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Costruttore di interrogazioni

Sotto la cornice Filtro delle geometrie della sorgente dati, il Costruttore di interrogazioni ti permette di creare
un sottoinsieme di elementi di una tabella, usando la clausola SQL ’WHERE’ e di visualizzare i risultati diretta-
mente sulla mappa. Finché l’interrogazione è attiva, saranno disponibili soltanto le geometrie che soddisfano tale
richiesta. Il risultato dell’interrogazione può essere salvato come un nuovo vettore.

The Query Builder is accessible through the eponym term at the bottom of the General menu in the Layer
Properties. Under Feature subset, click on the [Query Builder] button to open the Query builder. For example, if
you have a regions layer with a TYPE_2 field, you could select only regions that are borough in the Provider
specific filter expression box of the Query Builder. Figure_vector_general_2 shows an example of the Query
Builder populated with the regions.shp layer from the QGIS sample data. The Fields, Values and Operators
sections help you to construct the SQL-like query.

Figure 12.14: Costruttore di interrogazioni

La sezione Campi elenca tutti gli attributi del vettore. Se vuoi aggiungere un attributo nella casella delle clau-
sole SQL WHERE, fai doppio click sul nome dell’attributo, quindi usa le altre sezioni (Valori e Operatori) per
completare la clausola. In alternativa puoi scrivere direttamente l’interrogazione nella sezione ‘Espressioni filtro
specifiche del gestore’.

La sezione Valori elenca tutti i valori di un attributo. Clicca il pulsante [Tutto] se vuoi visualizzare tutti i valori
di un attributo altrimenti clicca sul pulsante [Campione] per caricare 25 valori univoci e casuali dell’attributo. Se
vuoi aggiungere un valore nella casella delle clausole SQL WHERE fai doppio click sul suo nome nella sezione
Valori.

La sezione Operatori elenca tutti gli operatori che puoi usare. Per aggiungere un operatore nella casella delle
clausole SQL WHERE, clicca sull’operatore che vuoi usare. Sono disponibili operatori relazionali (=, >, ...),
operatori per confrontare stringhe di testo (LIKE) ed operatori logici (AND, OR, ...).

Puoi usare il pulsante [Test] durante il processo di interrogazione, per visualizzare una finestra con il numero di
elementi che soddisfano l’interrogazione effettuata. Il pulsante [Pulisci] cancella il testo nella finestra di inter-
rogazione SQL WHERE. Il tasto [OK] chiude la finestra dell’interrogazione e seleziona gli elementi che soddis-
fano la ricerca. Il tasto [Cancel] chiude la finestra del costruttore di interrogazioni senza cambiare lo stato attuale
della selezione.
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QGIS si occupa dei sottoinsieme risultanti come se fosse l’intero layer. Ad esempio, se è stato attivato il fil-
tro per ‘Borough’, non è possibile visualizzare, interrogare, salvare o modificare Ankorage, perché questa è un
‘Municpality’ e quindi non fa parte del sottoinsieme.

L’unica eccezione è che se il vostro layer è parte di un database, utilizzando un sottoinsieme vi impedisce di
modificare il resto del layer.

12.3.2 Menu Stile

The Style menu provides you with a comprehensive tool for rendering and symbolizing your vector data. You
can use tools that are common to all vector data, as well as special symbolizing tools that were designed for the
different kinds of vector data. However all types share the following dialog structure: in the upper part, you
have a widget that helps you prepare the classification and the symbol to use for features and at the bottom the
Visualizzazione del layer widget.

Suggerimento: Esporta simbologia vettore
Hai la possibilità di esportare la simbologia del vettore da QGIS nei file Google *.kml, *.dxf e MapInfo *.tab.
Semplicemente, clicca con il tasto destro sul vettore per aprire il menu contestuale e clicca su Salva con nome...
per specificare il nome del file in uscita e il suo formato. Nella finestra di dialogo, usa il menu Esporta simbologia
per salvare la simbologia o come Simbologia elementi → o come Simbologia simboli del vettore →. Se hai
utilizzato dei simboli, si consiglia di utilizzare la seconda impostazione.

Visualizzazione delle geometrie

Il visualizzatore è responsabile della visualizzazione di una geometria insieme al simbolo corretto. Indipenden-
temente dal tipo di geometria del vettore, esistono quattro tipologie comuni di visualizzatori: simbolo singolo,
categorizzato, graduato e tramite regole. Per vettori di punti, sono disponibili i visualizzatori spostamento punto
e mappa di concentrazione, mentre i vettori di poligoni possono essere visualizzati anche con il visualizzatore
invertito.

Il visualizzatore a colorazione continua non c’è perché è a tutti gli effetti un caso speciale del visualizzatore
graduato. I visualizzatori categorizzato e graduato possono essere modificati con simboli specifici e con scale di
colore personalizzate - i colori per i simboli saranno realizzati in modo appropriato. Per ogni tipo di vettori (punti,
linee e poligoni), sono disponibili tipi di simboli. A seconda del visualizzatore selezionato, la finestra di dialogo
offre diverse sezioni aggiuntive.

Nota: Se cambi il tipo di visualizzatore mentre imposti lo stile di un vettore, le impostazioni effettuate per
il simbolo saranno mantenute. Questo funziona solo per un cambiamento. Se si ripete la modifica del tipo di
visualizzatore le impostazioni per il simbolo saranno perse.

Visualizzatore Simbolo Singolo

Il Visualizzatore Simbolo Singolo rappresenta tutti gli elementi di un layer tramite un unico simbolo definito
dall’utente. Vedi The symbol Selector per informazioni aggiuntive sulla rappresentazione del simbolo.

Suggerimento: modifica simbolo direttamente dal pannello livelli
Se nel tuo Pannello Livelli* hai vettori con categorie definite attraverso gli stili categorizzato, graduato o
tramite regole, puoi cambiare rapidamente il colore di riempimento del simbolo delle categorie cliccando
con il tasto destro su una categoria e scegliendo il colore che preferisci da un menu |colorWheel| :sup:‘ruota
colori‘. Cliccando con il tasto destro su una categoria avrai anche accesso alle opzioni **Nascondi tutti gli
elementi, Mostra tutti gli elementi e Modifica simbolo.

12.3. Proprietà dei vettori 101



QGIS User Guide, Release 2.14

Figure 12.15: Finestra di dialogo Simbolo singolo

Visualizzatore Categorizzato

Il Visualizzatore Categorizzato viene usato per visualizzare tutti gli elementi di un vettore, dove l’aspetto di
un simbolo definito dall’utente riflette i valori di un determinato attributo. Il menu Categorizzato ti permette di
scegliere:

• L’attributo (usando il menu a tendina per scegliere la colonna oppure la funzione Imposta espressione
per la colonna, vedi il capitolo ref:vector_expressions)

• Il simbolo (usando la finestra di dialogo The symbol Selector) che sarà quella utilizzato come predefinita
per ogni classe

• L’intervallo di colori (usando la Scala di colori) dal quale il colore applicato al simbolo è selezionato

Then click on Classify button to create classes from the distinct value of the attribute column. Each class can be
disabled unchecking the checkbox at the left of the class name.

Per cambiare simbolo, valore ed etichetta della classe, semplicemente fai doppio-click sull’oggetto che vuoi cam-
biare.

Il tasto destro mostra un menù contestuale con Copia/Incolla, Cambia colore, Cambia trasparenza, Cambia
unità, Cambia dimensione del simbolo**.

L’esempio in figura figure_symbology_2 mostra la finestra di dialogo della visualizzazione categorizzata del vet-
tore rivers dell’insieme di dati campione di QGIS.

Suggerimento: Selezionare e cambiare simboli multipli
La Simbologia ti permette di scegliere simboli multipli e di cliccare con il tasto destro per cambiare il coloro, la
trasparenza, la dimensione e lo spessore di quello che hai selezionato.

Suggerimento: Match categories to symbol name
In the [Advanced] menu, under the classes, you can choose one of the two first actions to match symbol name to
a category name in your classification. Matched to saved symbols match category name with a symbol name from
your Style Manager. Match to symbols from file match category name to a symbol name from an external file.
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Figure 12.16: Finestra di dialogo Simbologia Categorizzata

Graduated Renderer

The Graduated Renderer is used to render all the features from a layer, using an user-defined symbol whose
color or size reflects the assignment of a selected feature’s attribute to a class.

Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Inoltre, analogamente al Visualizzatore Categorizzato, ti permette di selezionare:

• L’attributo (usando il menu a tendina per scegliere la colonna oppure la funzione Imposta espressione
per la colonna)

• The symbol (using the Symbol selector dialog)

• Il formato legenda e la precisione

• Il metodo da usare per cambiare il simbolo: colore e dimensione

• I colori (usando la Scala di colori) se il metodo per il colore è selezionato

• The size (using the size domain and its unit

Then you can use the Histogram tab which shows an interactive histogram of the values from the assigned field or
expression. Class breaks can be moved or added using the histogram widget.

Nota: Puoi usare il pannello Sintesi delle Statistiche per ottenere maggiori informazioni sul tuo vettore. Vedi
Statistical Summary Panel.

Back to the Classes tab, you can specify the number of classes and also the mode for classifying features within
the classes (using the Mode list). The available modes are:

• Intervallo uguale: ogni classe ha la stessa dimensione ( per esempio valori da 0 a 16 e quattro classi, ogni
classe ha dimensione 4)

• Quantile: ogni classe avrà lo stesso numero di elementi (l’idea di un diagramma a scatola e baffi)

• Natural Breaks (Jenks): la varianza all’interno di ogni classe è minimo, mentre quella tra le classi è massima;

• Deviazione standard: le classi sono costruite in funzione della deviazione standard dei valori;
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• Pretty Breaks: Computes a sequence of about n+1 equally spaced nice values which cover the range of the
values in x. The values are chosen so that they are 1, 2 or 5 times a power of 10. (based on pretty from the
R statistical environment http://astrostatistics.psu.edu/datasets/R/html/base/html/pretty.html)

Nella parte centrale della finestra Stile, puoi vedere tutte i valori e le classi di suddivisione insieme ai loro intervalli,
etichette e simboli.

Clicca sul pulsante Classifica per creare la classi usando il metodo scelto. Ogni classe può essere disabilitata
spuntando la casella a sinistra del nome della classe.

Per cambiare simbolo, valore ed etichetta della classe, semplicemente fai doppio-click sull’oggetto che vuoi cam-
biare.

Il tasto destro mostra un menù contestuale con Copia/Incolla, Cambia colore, Cambia trasparenza, Cambia
unità, Cambia dimensione del simbolo**.

L’esempio in figure_symbology_3 mostra la finestra di dialogo di visualizzazione graduata per il vettore dei fiumi
dell’insieme di dati di esempio di QGIS.

Figure 12.17: Finestra di dialogo Simbologia Graduata

Suggerimento: Mappe tematiche usando un’espressione
Categorized and graduated thematic maps can be created using the result of an expression. In the properties dialog
for vector layers, the attribute chooser is extended with a Set column expression function. So you don’t need
to write the classification attribute to a new column in your attribute table if you want the classification attribute
to be a composite of multiple fields, or a formula of some sort.

Proportional Symbol and Multivariate Analysis

Proportional Symbol and Multivariate Analysis are not rendering types available from the Style rendering drop-
down list. However with the Size Assistant options applied over any of the previous rendering options, QGIS
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allows you to display your point and line data with such representation. Creating proportional symbol

Proportional rendering is done by first applying to the layer the Visualizzatore Simbolo Singolo. Once you set the

symbol, at the upper level of the symbol tree, the Data-defined override button available beside Size or Width
options (for point or line layers respectively) provides tool to create proportional symbology for the layer. An

assistant is moreover accessible through the menu to help you define size expression.

Figure 12.18: Varying size assistant

The assistant lets you define:

• The attribute to represent, using the Field listbox or the Set column expression function (see Expressions)

• the scale method of representation which can be ‘Flannery’, ‘Surface’ or ‘Radius’

• La dimensione minima e massima del simbolo

• L’intervallo di valori da rappresentare: La freccia rivolta verso il basso ti aiuta a riempire automaticamente
questi campi con i valori minimo (o zero) e massimo restituiti dall’attributo scelto o dall’espressione appli-
cata ai tuoi dati.

• Una dimensione unica per rappresentare i valori NULL.

Nella parte di destra della finestra di dialogo, puoi vedere una rappresentazione di anteprima delle geometrie
all’interno di un widget auto-aggiornante. Questa rappresentazione è aggiunta alla lista layer nella legenda layer
ed è anche utilizzata per determinare la rappresentazione del vettore nell’elemento della legenda del compositore
di stampe.

The values presented in the varying size assistant above will set the size ‘Data-defined override’ with:

coalesce(scale_exp(Importance, 1, 20, 2, 10, 0.57), 1)

Creating multivariate analysis

A multivariate analysis rendering helps you evaluate the relationship between two or more variables e.g., one can
be represented by a color ramp while the other is represented by a size.

The simplest way to create multivariate analysis in QGIS is to first apply a categorized or graduated rendering on
a layer, using the same type of symbol for all the classes. Then, clicking on the symbol [Change] button above
the classification frame, you get the The symbol Selector dialog from which, as seen above, you can activate and
set the size assistant option either on size (for point layer) or width (for line layer).

Like the proportional symbol, the size-related symbol is added to the layer tree, at the top of the categorized or
graduated classes symbols. And both representation are also available in the print composer legend item.

Rule-based rendering

The Rule-based Renderer is used to render all the features from a layer, using rule-based symbols whose
aspect reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements.
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The dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use
only the first-matched rule.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click on its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Expressions). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
matches. Since QGIS 2.8 the rules appear in a tree hierarchy in the map legend. Just double-click the rules in
the map legend and the Style menu of the layer properties appears showing the rule that is the background for the
symbol in the tree.

The example in figure_symbology_5 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

Figure 12.19: Rule-based Symbolizing options

Point displacement

The Point Displacement renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around one center symbol or on
several concentric circles.

Nota: You can still render features with other renderer like Single symbol, Graduated, Categorized or Rule-Based
renderer using the Renderer drop-down list then the Renderer Settings... button.

Inverted Polygon

The Inverted Polygon renderer allows user to define a symbol to fill in outside of the layer’s polygons. As
above you can select subrenderers, namely Single symbol, Graduated, Categorized, Rule-Based or 2.5 D renderer.
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Figure 12.20: Point displacement dialog

Figure 12.21: Inverted Polygon dialog
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Heatmap

With the Heatmap renderer you can create live dynamic heatmaps for (multi)point layers. You can specify
the heatmap radius in pixels, mm or map units, choose and edit a color ramp for the heatmap style and use a slider
for selecting a trade-off between render speed and quality. You can also define a maximum value limit and give a
weight to points using a field or an expression. When adding or removing a feature the heatmap renderer updates
the heatmap style automatically.

Figure 12.22: Heatmap dialog

2.5 D

Using the 2.5 D renderer it’s possible to create a 2.5 D effect on your layer’s features. You start by choosing
a Height value (in map units). For that you can use a fixed value, one of your layer’s fields, or an expression. You
also need to choose an Angle (in degrees) to recreate the viewer position (0° means west, growing in counter clock
wise). Use advanced configuration options to set the Roof Color and Wall Color. If you would like to simulate

solar radiation on the features walls, make sure to check the Shade walls based on aspect option. You can also
simulate a shadow by setting a Color and Size (in map units).

Suggerimento: Using 2.5 D effect with other renderers
Once you have finished setting the basic style on the 2.5 D renderer, you can convert this to another renderer
(single, categorized, graduated). The 2.5 D effects will be kept and all other renderer specific options will be
available for you to fine tune them (this way you can have for example categorized symbols with a nice 2.5 D
representation or add some extra styling to your 2.5 D symbols). To make sure that the shadow and the “building”
itself do not interfere with other nearby features, you may need to enable Symbols Levels ( Advanced → Symbol
levels...). The 2.5 D height and angle values are saved in the layer’s variables, so you can edit it afterwards in the
variables tab of the layer’s properties dialog.

Visualizzazione del layer

From the Style tab, you can also set some options that invariabily act on all features of the layer:
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Figure 12.23: 2.5 D dialog

• Trasparenza del layer : con questo strumento puoi decidere il grado di visibilità del
vettore. Usa questo cursore per adattare la trasparenza del vettore. Puoi anche impostare un valore preciso
di trasparenza nella casella presente a destra del cursore.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described in Blending Modes.

• Apply paint effects on all the layer features with the Draw Effects button.

• Control feature rendering order allows you, using features attributes, to define the z-order in which they

shall be rendered. Activate the checkbox and click on the button beside. You then get the Define
Order dialog in which you:

– choose a field or build an expression to apply to the layer features

– set in which order the fetched features should be sorted, i.e. if you choose Ascending order, the
features with lower value are rendered under those with upper value.

– define when features returning NULL value should be rendered: first or last.

You can add several rules of ordering. The first rule is applied to all the features in the layer, z-ordering
them according to the value returned. Then, for each group of features with the same value (including those
with NULL value) and thus same z-level, the next rule is applied to sort its items among them. And so on...

Once the Define Order dialog is applied, a summary of the expression(s) used to control the layer rendering

is retranscribed in the textbox beside Control feature rendering order option.

Other Settings

Symbols levels

For renderers that allow stacked symbol layers (only heatmap doesn’t) there is an option to control the rendering
order of each symbol’s levels.
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Figure 12.24: Layer rendering options

For most of the renderers, you can access the Symbols levels option by clicking the [Advanced] button below
the saved symbols list and choosing Symbol levels. For the Rule-based rendering the option is directly available
through [Symbols levels] button, while for Point displacement renderer the same button is inside the Rendering
settings dialog.

To activate symbols levels, select the Enable symbol levels. Each row will show up a small sample of the
combined symbol, its label and the individual symbols layer divided into columns with a number next to it. The
numbers represent the rendering order level in which the symbol layer will be drawn. Lower values levels are
drawn first, staying at the bottom, while higher values are drawn last, on top of the others.

Figure 12.25: Finestra di dialogo dei livelli simbolo

Nota: Se i livelli simbolo sono disattivati, saranno mostrati i simboli completi secondo il rispettivo ordine delle
geometrie. I simboli sovrapposti copriranno quelli al di sotto di essi. Inoltre, simboli simili non si “uniranno” li
uni con gli altri.

Effetti disegno

Al fine di migliorare la rappresentazione dei vettori ed evitare (o perlomeno ridurre) il ricorso ad altri software per

la rappresentazione finale delle mappe, QGIS fornisce un’altra potente funzionalità: l’opzione Effetti Disegno,
che aggiunge effetti grafici per personalizzare la visualizzazione di vettori.

L’opzione è disponibile nella finestra di dialogo Proprietà del vettore –> Stile, all’interno del gruppo Visualiz-
zazione del layer (si applica all’intero layer) oppure in proprietà simbolo del layer (si applica alla geometria
corrispondente). Puoi combinare entrambi gli usi.

Paint effects can be activated by checking the Draw effects option and clicking the Customize effects button,
that will open the Effect Properties Dialog (see figure_effects_1). The following effect types, with custom options
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Figure 12.26: Differenza tra i livelli simboli attivati (A) e disattivati (B)

are available:

• Sorgente: Mostra lo stile originale della geometria in accordo alla configurazione delle proprietà del vettore.
La trasparenza dello stile può essere regolata.

Figure 12.27: Draw Effects: Source dialog

• Blur: Adds a blur effect on the vector layer. The options that someone can change are the Blur type (Stack
or Gaussian blur), the strength and transparency of the blur effect.

• Colorize: This effect can be used to make a version of the style using one single hue. The base will always

be a grayscale version of the symbol and you can use the Grayscale to select how to create it (options

are: ‘lightness’, ‘luminosity’ and ‘average’). If Colorise is selected, it will be possible to mix another
color and choose how strong it should be. You can also control the Brightness, contrast and saturation
levels of the resulting symbol.

• Drop Shadow: Using this effect adds a shadow on the feature, which looks like adding an extra dimension.
This effect can be customized by changing the offset degrees and radius, determining where the shadow
shifts towards to and the proximity to the source object. Drop Shadow also has the option to change the blur
radius, the transparency and the color of the effect.

• Inner Shadow: This effect is similar to the Drop Shadow effect, but it adds the shadow effect on the inside
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Figure 12.28: Draw Effects: Blur dialog

Figure 12.29: Draw Effects: Colorize dialog
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Figure 12.30: Draw Effects: Drop Shadow dialog

of the edges of the feature. The available options for customization are the same as the Drop Shadow effect.

Figure 12.31: Draw Effects: Inner Shadow dialog

• Inner Glow: Adds a glow effect inside the feature. This effect can be customized by adjusting the spread
(width) of the glow, or the Blur radius. The latter specifies the proximity from the edge of the feature where
you want any blurring to happen. Additionally, there are options to customize the color of the glow, with a
single color or a color ramp.

• Outer Glow: This effect is similar to the Inner Glow effect, but it adds the glow effect on the outside of the
edges of the feature. The available options for customization are the same as the Inner Glow effect.

• Transform: Adds the possibility of transforming the shape of the symbol. The first options available
for customization are the Reflect horizontal and Reflect vertical, which actually create a reflection on the
horizontal and/or vertical axes. The 4 other options are:

– Shear: slants the feature along the x and/or y axis
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Figure 12.32: Draw Effects: Inner Glow dialog

Figure 12.33: Draw Effects: Outer Glow dialog

114 Chapter 12. Lavorare con i vettori



QGIS User Guide, Release 2.14

– Scale: enlarges or minimizes the feature along the x and/or y axis by the given percentage

– Rotation: turns the feature around its center point

– and Translate changes the position of the item based on a distance given on the x and/or the y axis.

Figure 12.34: Draw Effects: Transform dialog

There are some common options available for all draw effect types. Transparency and Blend mode options work
similar to the ones described in Visualizzazione del layer and can be used in all draw effects except for the trans-
form one.

One or more draw effects can used at the same time. You activate/deactivate an effect using its checkbox in the

effects list. You can change the selected effect type by using the Effect type option. You can reorder the

effects using Move up and Move down buttons, and also add/remove effects using the Add effect and
Remove effect buttons.

There is also a Draw mode option available for every draw effect, and you can choose whether to render
and/or to modify the symbol. Effects render from top to bottom.’Render only’ mode means that the effect will be
visible while the ‘Modify only’ mode means that the effect will not be visible but the changes that it applies will
be passed to the next effect (the one immediately below). The ‘Render and Modify’ mode will make the effect
visible and pass any changes to the next effect. If the effect is in the top of the effects list or if the immediately
above effect is not in modify mode, then it will use the original source symbol from the layers properties (similar
to source).

12.3.3 Menu Etichette

The Labels core application provides smart labeling for vector point, line and polygon layers, and only requires
a few parameters. This application also supports on-the-fly transformed layers. The following menus are used to
configure the labeling of vector layers:

• Testo

• Formattazione

• Contorno

• Sfondo

• Ombra
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• Posizionamento

• Visualizzazione

To label a layer start QGIS and load a vector layer. Activate the layer in the legend and click on the
Layer Labeling Options icon in the QGIS toolbar menu or activate the Labels tab in the layer properties dialog.

The first step is to choose the labeling method from the drop-down list. There are four options available:

• No labels

• Show labels for this layer

• Rule-based labeling

• and Discourage other labels from covering features in this layer: allows to set a layer as just an obstacle
for other layer’s labels without rendering any labels of its own.

Select the Show labels for this layer option and then select an attribute column to use for labeling from the Label
with drop-down list. Click if you want to define labels based on expressions - See Definire le etichette tramite
espressioni.

The following steps describe simple labeling without using the Data defined override functions, which are situated
next to the drop-down menus - see Etichettare in funzione dei dati for an use-case.

Text menu

You can define the text style in the Text menu (see Figure_labels_1). Use the Type case option to influence the text
rendering. You have the possibility to render the text ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
Use the Blending Modes to create effects known from graphics programs.

Formatting menu

In the Formatting menu, you can define a character for a line break in the labels with the ‘Wrap on character’
function. You can format the Line Height and the alignment. For the latter typical values are available plus Follow
label placement. When set to this mode, text alignment for labels will be dependent on the final placement of the
label relative to the point. E.g., if the label is placed to the left of the point then the label will be right aligned, and
if it is placed to the right of the point then the label will be left aligned.

For line vector layers you can include line directions symbols. There are options specifying the type of symbol
and the symbol placement.

Use the Formatted numbers option to format the numbers in an attribute table. Here, decimal places may be
inserted. If you enable this option, three decimal places are initially set by default.

Buffer menu

To create a buffer, just activate the Draw text buffer checkbox in the Buffer menu. The buffer color is variable.

Here, you can also use blend modes. If the color buffer’s fill checkbox is activated, it will interact with partially
transparent text and give mixed color transparency results. Turning off the buffer fill fixes that issue (except where
the interior aspect of the buffer’s stroke intersects with the text’s fill) and also allows you to make outlined text.

Background menu

In the Background menu, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
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Figure 12.35: Smart labeling of vector point layers
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Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see Blending Modes).

Shadow menu

Use the Shadow menu for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode.

Placement menu

Choose the Placement menu for configuring label placement and labeling priority. Note that the placement options
differ according to the type of vector layer, namely point, line or polygon.

Posizionamento per vettor di punti

Con il modo di posizionamento Cartografico le etichette dei punti vengono generate con la migliore relazione
visuale con l’elemento puntuale, seguendo le regole di posizionamento cartografico ideali. Le etichette possono
essere collocate a una certa Distanza sia dall’elemento puntuale sia dai limiti del simbolo utilizzato per rapp-
resentare l’elemento. Quest’ultima opzione è particolarmente utile quando la dimensione del simbolo non sono
fisse, ad es. se il simbolo è impostato da una dimensione definita dai dati o quando si utilizzano diversi simboli in
uno stile categorizzato.

Per impostazione predefinita, i posizionamenti sono effettuati nel seguente ordine:

1. in alto a destra

2. in alto a sinistra

3. in basso a destra

4. in basso a sinistra

5. al centro a destra

6. al centro a sinistra

7. in alto, leggermente a destra

8. in basso, leggermente a sinistra

Tuttavia, la priorità di posizionamento può essere personalizzata o impostata per un singolo elemento, utilizzando
un elenco definito di posizioni prioritarie. Questo consente inoltre di utilizzare solo determinati posizionamenti,
ad esempio. Per gli elementi costieri è possibile impedire che le etichette vengano collocate sulla terra.

L’impostazione Intorno al punto posiziona l’etichetta in un raggio uguale (impostato in Distanza) intorno
all’elemento. Il posizionamento dell’etichetta può anche essere limitato utilizzando l’opzione Quadrant.

Nel posizionamento Offset dal punto, puoi posizionare le etichette ad uno scostamento fisso dall’elemento
puntuale. Puoi selezionare Quadrante in cui inserire l’etichetta. Puoi anche impostare le distanze X e Y dello
scostamento tra i punti e le loro etichette e puoi modificare l’angolo del posizionamento delle etichette con
l’impostazione “guilabel:‘ Rotazione‘. Pertanto, puoi posizionare l’etichetta in un quadrante selezionato con una
rotazione definita.
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Posizionamento per vettori di linee

Le opzioni di etichetta per i vettori di linee includono Parallelo, Curvato o Orizzontale. Per le opzioni

Parallelo e Curvato puoi scegliere la posizione Sopra la linea, Sulla linea e Sotto la linea.
| : Guilabel: orizzontale. Puoi selezionare più opzioni contemporaneamente. In questo caso, QGIS cercherà
la posizione ottimale dell’etichetta. Per il posizionamento parallelo e curvato puoi utilizzare l’orientamento della
linea per la posizione dell’etichetta. Inoltre, puoi definire un Angolo massimo tra i caratteri curvi quando selezioni

Curvato (vedi Figure_labels_2).

Per tutte e tre le opzioni di posizionamento puoi impostare una distanza minima per ripetere le etichette. La
distanza può essere in ‘‘ mm‘‘ o in ‘‘ unità mappa‘‘.

Figure 12.36: Etichettatura di vettore di linee

Posizionamento per vettori poligonali

Puoi scegliere una delle seguenti opzioni per inserire le etichette nei poligoni: Offset dal centroide, Ori-
zontale (lento), Intorno al centroide, Libero and Usando il perimetro.

Nelle impostazioni :guilabel:’Offset dal centroide’ puoi specificare se il centroide è di :guilabel:’poligono
visibile’ sulla mappa o :guilabel:’intero poligono‘. Ciò significa che il centroide viene utilizzato per il poligono
che si può vedere sulla mappa o il centroide è determinato per l’intero poligono, non importa se si può vedere
tutto l’elemento sulla mappa. Puoi inserire l’etichetta in un quadrante specifico e definire scostamento e rotazione.
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L’impostazione Attorno al centroide posiziona l’etichetta ad una distanza specificata intorno al centroide. An-
cche qui puoi definire :guilabel:’poligono visibile’ sulla mappa o :guilabel:’intero poligono‘.

Con l’impostazione Usando il perimetro, puoi definire una posizione e una distanza per l’etichetta. Puoi

scegliere Sopra la linea, Sulla linea, Sotto la linea e Posizione dipendente dall’orientazione della
linea. Puoi specificare la distanza tra l’etichetta e il perimetro, nonché l’intervallo di ripetizione per l’etichetta.

Figure 12.37: Etichettatura di vettore poligonale

Nella sezione Priorità puoi definire la priorità con cui vengono posizionate le etichette per tutti e tre i tipi di layer
vettoriali (punto, linea, poligono). Questa opzione di posizionamento interagisce con le etichette degli altri layer
vettoriali nella mappa. Se ci sono etichette di diversi layer nella stessa posizione, verrà visualizzata l’etichetta con
la priorità più alta e gli altri saranno lasciati fuori.

Menu visualizzazione

Nel menu Visualizzazione puoi indicare quando le etichette possono essere visualizzate e la loro interazione con
altre etichette e gli elementi.

In Opzioni etichetta, trovi le impostazioni di visibilità visibilità in base alla scala e la :guilabel:Visibilita basate
sulla dimensione del pixel ”.

Label z-index determina l’ordine in cui vengono visualizzate le etichette, nonché in relazione ad altre etichette
degli elementi del layer (utilizzando l’espressione definita in funzione dei dati) come con le etichette di altri
livelli. Le etichette con un z-index più alto vengono visualizzate sopra le etichette (di qualsiasi layer) con z-index
inferiore.

Inoltre, se 2 etichette hanno corrispondenti z-indici, allora:

• Se provengono dallo stessolayer, l’etichetta più piccola verrà disegnata sopra l’etichetta più grande

• Se vengono da diversi layer, le etichette verranno disegnate nello stesso ordine dei loro stessi layer (rispet-
tando l’ordine impostato nella leggenda della mappa).
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Tieni presente che questa impostazione non permette alle etichette di essere disegnate sotto gli elementi di altri
vettori, ma controlla semplicemente l’ordine in cui le etichette vengono disegnate sopra tutte le geometrie dei
vettori.

While rendering labels and in order to display readable labels, QGIS automatically evaluates the position of the

labels and can hide some of them in case of collision. You can however choose to Show all labels for this
layer (including colliding labels) in order to manually fix their placement.

With data-defined expressions in Show label and Always Show you can fine tune which labels should be rendered.

Under Feature options, you can choose to label every part of a multi-part feature and limit the number of features
to be labeled. Both line and polygon layers offer the option to set a minimum size for the features to be labeled,
using Suppress labeling of features smaller than. For polygon features, you can also filter the labels to show
according to whether they completely fit within the feature or not. For line features, you can choose to Merge
connected lines to avoid duplicate labels, rendering a quite airy map in conjunction with the Distance or Repeat
options in Placement tab.

From the Obstacles frame, you can manage the covering relation between labels and features. Activate the
Discourage labels from covering features option to decide whether features of the layer should act as obstacles
for any label (including labels from other features in the same layer). An obstacle is a feature QGIS tries as far as
possible to not place labels over. Instead of the whole layer, you can define a subset of features to use as obstacles,

using the data-defined override control next to the option.

The priority control slider for obstacles allows you to make labels prefer to overlap features
from certain layers rather than others. A Low weight obstacle priority means that features of the layer are less
considered as obstacles and thus more likely to be covered by labels. This priority can also be data-defined, so
that within the same layer, certain features are more likely to be covered than others.

For polygon layers, you can choose the type of obstacle features could be by minimising the labels placement:

• over the feature’s interior: avoids placing labels over interior of polygon (prefers placing labels totally
outside or just slightly inside polygon)

• or over the feature’s boundary: avoids placing labels over boundary of polygon (prefers placing labels
outside or completely inside the polygon). It can be e.g. useful for regional boundary layers, where the
features cover an entire area. In this case it’s impossible to avoid placing labels within these features, and it
looks much better to avoid placing them over the boundaries between features.

Definire le etichette tramite espressioni

QGIS consente di utilizzare espressioni per etichettare le geometrie. Fai clic sull’icona nel menu Etichette

della finestra di dialogo delle proprietà. In figure_labels_4 vedi un’espressione di esempio per etichettare le regioni
dell’Alaska con nome e dimensione dell’area, in base al campo ‘NAME_2’, un testo descrittivo e la funzione Area
$ in combinazione con ‘‘ format_number ()‘‘ per renderlo più bello.

E’ semplice lavorare con Etichettatura tramite espressioni. Devi fare attenzione:

• Devi combinare tutti gli elementi (stringhe, campi e funzioni) con una funzione di stringa di concatenazione
come ‘‘ concat‘‘, ‘‘ +‘‘ o ‘‘ ||‘‘. Ricorda che in alcune situazioni (valore nullo o numerico coinvolto) non
tutti questi strumenti corrispondono alle tue necessità

• le stringhe sono scritte in ‘apostrofo semplice’

• i campi sono scritti in “virgolette doppie” o senza apostrofo.

Guarda alcuni esempi:

# label based on two fields ’name’ and ’place’ with a comma as separator
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ with other texts
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Figure 12.38: Uso di espressioni per l’etichettatura

’My name is ’ + "name" + ’and I live in ’ + "place"
’My name is ’ || "name" || ’and I live in ’ || "place"
concat(’My name is ’, name, ’ and I live in ’, "place")

-> My name is John Smith and I live in Paris

# label based on two fields ’name’ and ’place’ with other texts
# combining different concatenation functions
concat(’My name is ’, name, ’ and I live in ’ || place)

-> My name is John Smith and I live in Paris
-> My name is John Smith # if the field ’place’ is NULL

# multi-line label based on two fields ’name’ and ’place’ with a descriptive text
concat(’My name is ’, "name", ’\n’ , ’I live in ’ , "place")
-> My name is John Smith

I live in Paris

# label based on a field and the $area function
# to show the place name and its rounded area size in a converted unit.
’The area of ’ || "place" || ’ has a size of ’ || round($area/10000) || ’ ha’

-> The area of Paris has a size of 10500 ha

# create a CASE ELSE condition. If the population value in field
# population is <= 50000 it is a town, otherwise a city.
concat(’This place is a ’, CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END)

-> This place is a town

Come puoi vedere nel costruttore di espressioni, puoi creare espressioni semplici o molto complesse con tentissime
funzioni utili, per etichettare i tuoi dati in QGIS. Vedi il capitolo Expressions per ulteriori esempi e informazioni
sulle espressioni.
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Etichettare in funzione dei dati

Con le funzioni definito in fuinzione dei dati, le impostazioni per l’etichettatura vengono sovrascritte da campi
della tabella degli attributi. Puoi attivare e disattivare la funzione con il tasto destro del mouse. Sposta il mouse so-
pra il simbolo e visualizza le informazioni relative alla forzatura definita dal dato, compreso il campo di definizione
corrente. L’esempio di seguito descrive la funzione di forzatura definita in funzione dei datiper i dati per la fun-

zione Move label function (see figure_labels_5 ).

1. Importa il lakes.shp dall’insieme di dati di esempio di QGIS.

2. Fai doppio clic sul layer per aprire le proprietà del livello. Clicca su Etichette e :guilabel:‘ Posizionamento‘.
Seleziona Offset dal centride.

3. Cerca :guilabel: voci Definito in funzione dei dati ‘. Fai clic sull’icona | dataDefined| per definire il tipo di
campo per :guilabel:‘Coordinate. Scegli ‘xlabel’ per X e ‘ylabel’ per Y. Le icone sono ora evidenziate in
giallo.

4. Fai zoom su un lago

5. Set editable the layer using the Toggle Editing button.

6. Vai alla barra delle etichette e fai clic sull’icona . Ora puoi spostare manualmente l’etichetta in un’altra
posizione (vedere figura_labelle_6). La nuova posizione dell’etichetta viene salvata nelle colonne ‘xlabel’
e ‘ylabel’ della tabella degli attributi.

Figure 12.39: Etichettatura di vettori poligonali sovrascritti in funzione dei dati

Etichettatura tramite regole

Con Etichettatura gtramite regole puoi definire più configurazioni delle etichette e applicarle selettivamente sulla
base di espressioni filtro , come in: ref:Stile tramite regole <rule_based_rendering>.

Puoi impostare le regole selezionando l’opzione nella parte superiore del pannello etichette (vedi figure_labels_7).
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Figure 12.40: Muovi etichette

Figure 12.41: Pannello etichettatura tramite regole
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Per creare una regola, attiva una riga esistente facendo doppio clic su di essa oppure facendo clic su ‘+’ e clic-
cando sulla nuova regola. All’interno del pannello puoi impostare l’espressione filtro e le relative configurazioni
dell’etichetta.

Figure 12.42: Modifica regola

12.3.4 Menu Campi

con il menu Campi, puoi manipolare i campi della tabella degli attributi dell’insieme di dati selezionato.

Puoi usare i pulsanti Nuovo campo e Elimina campo quando i dati sono in Modalità di modifica.

Widget modifica

Nel menu Campi hai la possibilità di usare un widget per la modifica. In questo modo puoi specificare un tipo
paricolare di colonna in funzione dei dati che contiene. Se clicchi sul pulsante [modifica contenuto] si aprirà una
finestra di dialogo in cui puoi scegliere fra diversi widget:

• Casella di controllo: mostra una casella di controllo: se spunti la casella allora l’attributo verrà aggiunto
alla colonna, altrimenti verrà rimosso.

• Classificazione: visualizza un menu a tendina con i valori usati per la classificazione se hai scelto ‘Catego-
rizzato’ come tipo di visualizzatore nel menu Stile delle proprietà del vettore.

• Colore virtualizza un pulsante che permette di scegliere un colore da un finestra Selettore di colore
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Figure 12.43: Finestra di dialogo per modificare un campo

• Date/Time: Displays a line field which can open a calendar widget to enter a date, a time or both. Column
type must be text. You can select a custom format, pop-up a calendar, etc.

• Enumerazione: apre un menu a tendina con i valori che possono essere usati nelle tipologie delle colonne.
Attualmente questa funzione è supportata solo da PostgreSQL.

• Nome file: seleziona un file dal tuo computer grazie alla finestra dedicata.

• Nascosto: rende invisibile la colonna, quindi non potrai vederne il contenuto.

• Foto: campo che contiene un percorso ad una foto. Puoi specificare sia la larghezza che l’altezza del campo.

• Intervallo: ti permette di impostare dei valori di un preciso intervallo numerico. Il widget può apparire
come un cursore o come un campo modificabile.

• Relation Reference: This widget lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Creare relazioni uno a molti.

• ** Text Edit ** (default): apre un campo di modifica testo che consente di modificare un testo semplice o
più righe da utilizzare. Se si sceglie più linee si può anche scegliere i contenuti html.

• Valori univoci: puoi selezionare uno dei valori già presenti nella tabella degli attributi. Se la voce ‘Modi-
ficabile’ è attiva, allora comparirà anche una casella con l’autocompletamento, altrimenti verrà visualizzato
un menu a tendina.

• Generatore UUID: genera un campo UUID (Universally Unique Idetifiers) di sola lettura, se il campo è
vuoto.

• Mappa valori: un menu a tendina con oggetti predefiniti. Puoi associare una descrizione ad valore: nel
menu a tendina potrai scegliere fra le varie descrizioni, ma nella tabella degli attributi verrà scritto il valore
associato. Puoi specificare i valori manualmente oppure caricarli da un file CSV.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column. Several options are available to change the standard behaviours: allow null value, order by
value, allow multiple selections and use of autocompleter. The forms will display either a drop-down list or
a line edit field when completer checkbox is enabled.
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• Vista web: il campo contiene un URL di una pagina internet. Puoi aggiustare la larghezza e l’altezza.

Nota: QGIS has an advanced ‘hidden’ option to define your own field widget using python and add it to this
impressive list of widgets. It is tricky but it is very well explained in following excellent blog that explains how
to create a real time validation widget that can be used like described widgets. See http://blog.vitu.ch/10142013-
1847/write-your-own-qgis-form-elements

Suggerimento: Relative Path in widgets
If the path which is selected with the file browser is located in the same directory as the .qgs project file or below,
paths are converted to relative paths. This increases portability of a qgs project with multimedia information
attached. This is enabled only for File Name, Photo and Web View at this moment.

With the Attribute editor layout, you can now define built-in forms (see figure_fields_2). This is useful for data
entry jobs or to identify objects using the option auto open form when you have objects with many attributes. You
can create an editor with several tabs and named groups to present the attribute fields.

Choose ‘Drag and drop designer’ and an attribute column. Use the icon to create a category to insert a tab or
a named group (see figure_fields_3). When creating a new category, QGIS will insert a new tab or named group
for the category in the built-in form. The next step will be to assign the relevant fields to a selected category with

the icon. You can create more categories and use the same fields again.

Other options in the dialog are ‘Autogenerate’ and ‘Provide ui-file’.

• ‘Autogenerate’ just creates editors for all fields and tabulates them.

• The ‘Provide ui-file’ option allows you to use complex dialogs made with the Qt-Designer. Us-
ing a UI-file allows a great deal of freedom in creating a dialog. For detailed information, see
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.

QGIS dialogs can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. The form code can be specified in three different ways:

• load from the environment (for example in startup.py or from a plugin)

• load from an external file, a file chooser will appear in that case to allow you to select a Python file from
your filesystem

• load from inline code, a Python editor will appear where you can directly type your form code

In all cases you must enter the name of the function that will be called (open in the example below).

An example is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: open

12.3.5 Menu Join

The Joins menu allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target

layer. Now you can also specify a subset of fields from the joined layer based on the checkbox Choose which
fields are joined. As a result of the join, all information from the join layer and the target layer are displayed in
the attribute table of the target layer as joined information. If you specified a subset of fields only these fields are
displayed in the attribute table of the target layer.
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Figure 12.44: Finestra di dialogo per creare categorie con la maschera di inserimento

Figure 12.45: Resulting built-in form with tabs and named groups
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QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins_1).

Figure 12.46: Join an attribute table to an existing vector layer

Inoltre, la finestra di dialogo aggiungi vettore da unire ti permette di:

• Layer unito in memoria virtuale

• Crea un indice nel campo unito

• Choose which fields are joined

• Create a Custom field name prefix

12.3.6 Menu Diagrammi

Il menu Diagrammi permette di sovrapporre diagrammi a un vettore (figura figure_diagrams_1).

The current core implementation of diagrams provides support for:

• pie charts, a circular statistical graphic divided into slices to illustrate numerical proportion. The arc length
of each slice is proportional to the quantity it represents,

• text diagrams, a horizontaly divided circle showing statistics values inside

• and histograms.

For each type of diagram, the menu is divided into five tabs:
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Attributes

Attributes defines which variables to display in the diagram. Use add item button to select the desired fields into
the ‘Assigned Attributes’ panel. Generated attributes with Expressions can also be used.

You can move up and down any row with click and drag, sorting how atributes are displayed. You can also change
the label in the ‘Legend’ column or the attibute color by double-clicking the item.

This label is the default text displayed in the legend of the print composer or of the layer tree.

Figure 12.47: Vector properties dialog with diagram menu

Appearance

Appearance defines how the diagram looks like. It provides general settings that do not interfere with the statistic
values such as:

• the graphic transparency, its outline width and color

• the width of the bar in case of histogram

• the circle background color in case of text diagram, and the font used for texts

• the orientation of the left line of the first slice represented in pie chart. Note that slices are displayed
clockwise.

In this menu, you can also manage the diagram visibility:

• by removing diagrams that overlap others or Show all diagrams even if they overlap each other

• by setting the scale visibility

Size

Size is the main tab to set how the selected statistics are represented. The diagram size units can be ‘Map Units’
or ‘Millimeters’. You can use :

• Fixed size, an unique size to represent the graphic of all the features, except when displaying histogram

• or Scaled size, based on an expression using layer attributes.
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Figure 12.48: Vector properties dialog with diagram menu, Size tab

Posizionamento

Placement helps to define diagram position. According to the layer geometry type, it offers different options for
the placement:

• ‘Over the point’ or ‘Around the point’ for point geometry. The latter variable requires a radius to follow.

• ‘Over the line’ or ‘Around the line’ for line geometry. Like point feature, the last variable requires a distance
to respect and user can specify the diagram placement relative to the feature (‘above’, ‘on’ and/or ‘below’
the line) It’s possible to select several options at once. In that case, QGIS will look for the optimal position
of the diagram. Remember that here you can also use the line orientation for the position of the diagram.

• ‘Over the centroid’, ‘Around the centroid’ (with a distance set), ‘Perimeter’ and anywhere ‘Inside polygon’
are the options for polygon features.

The diagram can also be placed using feature data by filling the X and Y fields with an attribute of the feature.

The placement of the diagrams can interact with the labeling, so you can detect and solve position conflicts
between diagrams and labels by setting the Priority slider or the z-index value.

Options

The Options tab has settings only in case of histogram. You can choose whether the bar orientation should be
‘Up’, ‘Down’, ‘Right’ and ‘Left’.

Suggerimento: Switch quickly between diagrams
Given that almost all the settings above are common to the different types of diagram, when designing your
diagram, you can easily change the diagram type and check which one is more appropriate to your data without
any loss.

Case Study

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing tempera-
ture data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Dati
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campione).

1. First, click on the Load Vector icon, browse to the QGIS sample dataset folder, and load the two vector
shape layers alaska.shp and climate.shp.

2. Fai doppio click sul vettore climate nella legenda per aprire la finestra di dialogo Proprietà layer.

3. Click on the Diagrams menu, activate Show diagrams for this layer, and from the Diagram type
combo box, select ‘Text diagram’.

4. Nella scheda Aspetto scegli un blu chiaro come colore di sfondo e nella scheda Dimensione imposta 18 mm
come dimensione fissa.

5. Nella scheda Posizione scegli ‘Intorno al punto’ come posizionamento.

6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

So, in the Attributes tab first select T_F_JAN and click the button, then repeat with T_F_JUL and
finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can adapt the chart size in the Size tab. Activate the Scaled size and set the size of the diagrams on
the basis of the maximum value of an attribute and the Size option. If the diagrams appear too small on the

screen, you can activate the Increase size of small diagrams checkbox and define the minimum size of
the diagrams.

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_3 gives an idea of the result.

10. Clicca su [OK].

Figure 12.49: Diagrammi di temperatura sovrapposti su una mappa

Ricordati che puoi usare anche l’opzione Posizione definita da attributo per posizionare i diagrammi. Inoltre puoi
anche impostare la visibilità dei diagrammi in funzione di determinate scale dalla scheda Aspetto.

The size and the attributes can also be an expression. Use the button to add an expression. See Expressions
chapter for more information and example.
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12.3.7 Menu Azioni

QGIS ti offre la possibilità di creare azioni sulla base degli attributi associati ai singoli elementi del vettore.
Potrai cosi creare un grande numero di azioni, per esempio, avviare un programma con argomenti come gli attributi
di un vettore o inviare parametria una applicazione di rete.

Figure 12.50: Panoramica della finestra di dialogo Azioni con esempi

Le azioni sono utili quando vuoi avviare un’applicazione esterna oppure aprire una pagina web sulla base di uno
o più valori associati al vettore. Ci sono sei tipologie di azioni che puoi usare nel seguente modo:

• Le azioni Generic, Mac, Windows e Unix avviano un processo esterno.

• Le azioni python eseguono un’espressione python,

• Le azioni generic e python sono visibili ovunque.

• Le azioni Mac, Windows e Unix sono visibili solo sulle rispettive piattaforme (cioè puoi definire le azioni,
ma sarai in grado di vedere i risultati solamente sulla piattaforma dalla quale è stato lanciato l’editor).

Ci sono diversi esempi presenti nella finestra di dialogo. Puoi caricarli cliccando su [Aggiungi azioni predefinite].
Un esempio è eseguire una ricerca sul web basata su un valore presente nella tabella degli attributi. Di seguito una
spiegazione.
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Definire le azioni

Puoi definire le azioni dalla finestra di dialogo Proprietà layer. Per definire un’azione, apri questa finestra e clicca
sul menu Azioni. Dal sottomenu Proprietà azione scegli ‘Generico’ come tipo e inserisci un nome per l’azione.
L’azione deve contenere il nome dell’applicazione che verrà eseguita quando lancerai l’azione. Puoi aggiungere
uno o più campi come argomenti per l’applicazione. L’azione inizierà sempre con il carattere % seguito dal nome
del campo che verrà sostituito dal valore del campo stesso. I caratteri speciali %% verranno sostituiti dal valore
del campo che hai scelto dalla tabella degli attributi (vedi using_actions). Puoi usare le doppie virgolette, “ per
raggruppare il testo in un singolo argomento per il programma, script o comando. Le doppie virgolette saranno
ignorate se precedute dal carattere \.

Se sono presenti nomi di campi che possono essere interpretati come sotto-stringhe di altri nomi di campi (ad
es. col1 e col10) devi racchiudere il nome (e il carattere %) tra parentesi quadre (es. [%col10]). Questo
impedirà che il nome di campo %col10 possa essere confuso con %col1 con uno 0 alla fine. Le virgolette
saranno rimosse da QGIS man mano che inserirai i valori del campo. Se vuoi che i campi sostituiti vengano
racchiusi entro parentesi quadre, aggiungi una seconda coppia di parentesi quadre: [[%col10]].

La finestra di dialogo Informazione sui risultati che compare quando usi lo strumento Informazioni elementi ha una
voce (Derivato) che contiene informazioni che dipendono dal tipo di vettore interrogato. Puoi accedere ai valori
di questa voce in modo simile a come accedi ad altri campi della tabella attributi anteponendo al nome del campo
(Derivato). Per esempio un vettore di punti ha due campi, X e Y, e puoi usare il loro valore nell’azione con
l’espressione %(Derivato).X e %(Derivato).Y. Gli attributi derivati sono disponibili solo nella finestra
Informazione sui risultati e non nella finestra Tabella degli attributi.

Due esempi di azioni sono di seguito indicati:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

Nel primo esempio, verrà lanciato il browser konqueror che aprirà un URL. L’URL crea una ricerca Google sul
valore del campo nam nel vettore. Il programma o lo script richiamato dall’azione deve essere nel path delle
variabili d’ambiente altrimenti dovrai specificare il percorso completo del programma. Il primo esempio infatti
è accessibile anche con /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam.
In questo modo sei sicuro che l’applicazione konqueror verrà eseguita quando si richiama l’azione..

Nel secondo esempio viene usata la notazione %% che non richiede l’indicazione di un particolare campo. Quando
richiami l’azione, il %% sarà rimpiazzato dal valore selezionato sia nella finestra Informazioni risultati sia nella
tabella degli attributi.

Uso delle azioni

Le azioni possono essere richiamate sia dalla finestra Informazioni sui risultati che dalla Tabella degli at-
tributi (ricordati che puoi aprire queste finestre rispettivamente cliccando sullo strumento |mActionIdentify|
Informazioni elementi |mActionOpenTable| Apri tabella degli attributi o |mAction| Avvia azione sull’elemento). Per eseguire l’azione,
clicca con il tasto destro del mouse sul risultato e scegli l’azione dal menu contestuale. Le azioni sono indicate
nel menu a tendina con il nome inserito. Clicca sull’azione che vuoi eseguire.

Se stai richiamando un’azione che usa l’annotazione %%, fai click con il tasto destro sul valore del campo nella
finestra Informazioni risultati oppure dalla finestra Tabella attributi e scegli l’applicazione o lo script da assegnare.

In questo altro esempio viene mostrato come estrarre dati da un vettore per inserirli in un file usando il terminale e

il comando echo (quindi funzionerà su e forse su ). Il vettore in questione ha i seguenti campi nella tabella
attributi: nome della specie taxon_name, latitudine lat e longitudine long. Vuoi eseguire una selezione
spaziale delle specie (taxon) presenti in determinate posizioni, esportando i risultati in un file di testo (evidenziate
in giallo sulla mappa di QGIS). Ecco l’azione giusta per questo scopo:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Selezionando solo alcune posizioni, l’esecuzione dell’azione precedente genera un file di output fatto così:
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Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Come esercizio puoi creare un’azione che lancia una ricerca su Google in base al vettore lakes. Prima di tutto
devi impostare l’URL necessario per eseguire una ricerca basata su una parola chiave. Puoi copiare facilmente
l’espressione facendo una ricerca semplice dalla pagina di Google. La pagina dei risultati avrà un indirizzo, visibile
nella barra indirizzi del browser, del tipo: http://google.com/search?q=qgis, in cui QGIS è la parola ricercata. Ora
puoi procedere:

1. Assicurarti di aver caricato il vettore lakes.

2. Apri la finestra di dialogo Proprietà layer facendo doppio click sul vettore o cliccandoci sopra con il tasto
destro del mouse e scegliendo Proprietà dal menu contestuale.

3. Clicca sul menu Azioni.

4. Inserisci un nome descrittivo per l’azione, ad esempio Ricerca Google.

5. Devi fornire il nome del programma esterno, in questo caso Firefox. Se il programma non è presente nel
tuo path, devi inserire il path assoluto.

6. Dopo il nome dell’applicazione esterna, aggiungi l’URL della ricerca di Google, senza includere il termine
della ricerca:http://google.com/search?q=

7. A questo punto il testo nel campo Azioni dovrebbe apparire così: firefox
http://google.com/search?q=

8. Clicca sul menu a tendina che contiene i nomi dei campi dell vettore lakes, posizionato immediatamente
a sinistra del pulsante [Inserisci campo].

9. Dal menu a tendina, seleziona ‘NAMES’ e clicca su [Inserisci campo].

10. Il testo dell’azione dovrebbe ora apparire come segue:

firefox http://google.com/search?q=%NAMES

11. Per concludere questa azione, clicca sul pulsante [Aggiungi alla lista di azioni].

Questo ultimo passo completa l’azione che è ora pronta per essere usata. Il testo finale dell’azione dovrebbe
apparire così:

firefox http://google.com/search?q=%NAMES

A questo punto puoi usare l’azione. Chiudi la finestra Proprietà layer e usa lo zoom su un’area a scelta. Assicurati
che il vettore lakes sia attivo ed identifica con l’apposito strumento un lago qualsiasi. Nella finestra risultante
dovrebbe essere visibile l’azione:

Cliccando sull’azione, verrà lanciato Firefox all’URL http://www.google.com/search?q=Tustumena. Puoi anche
aggiungere altri campi all’azione, aggiungendo un + alla fine della stringa che definisce l’azione, selezionando
quindi un altro campo e cliccando sul pulsante [Inserisci campo]. Nel nostro esempio non c’è alcun altro campo
sul quale avrebbe senso fare una ricerca.

Puoi definire più di un’azione per ogni vettore, ognuna delle quali verrà mostrata nella finestra Informazioni sui
risultati.

Puoi anche richiamare le azioni dalla tabella degli attributi selezionando una riga e cliccando col tasto destro,
allora puoi scegliere un’azione dal menu a tendina.

Puoi creare tantissimi tipi di azione. Per esempio se hai un vettore di punti che fa riferimento alle posizioni
dove sono state scattate foto o immagini, insieme al nome stesso del file, puoi creare un’azione per avviare un
programma che visualizzerà l’immagine. Puoi usare le azioni anche per lanciare report sul web per uno o più
campi della tabella degli attributi, definendole allo stesso modo dell’esempio per la ricerca con Google.

Ci sono esempi anche molto più complicati, per esempio usando le azioni Python.
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Figure 12.51: Seleziona un elemento e scegli un’azione

Normalmente quando usi un’azione per aprire un file con un’applicazione esterna, puoi usare un path assoluto o
relativo. Nel secondo caso, il path è relativo alla posizione dell’eseguibile dell’applicazione esterna. Ma come
si fa se devi usare un path relativo al vettore selezionato (se è un file, come uno shapefile o Spatialite)? Ecco il
trucco:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None)

path = os.path.dirname(str(layerpath))
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Ricordati che l’azione è del tipo Python, quindi devi cambiare le variabili command e imagerelpath.

E se il percorso relativo deve essere relativo al file di progetto (salvato)? Il codice per l’azione Python diventa:

command="firefox"
imagerelpath="images/test_image.jpg"
projectpath=qgis.core.QgsProject.instance().fileName()
import os.path
path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None
image=os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Un altro esempio di azione python è quello che ti permette di aggiungere nuovi layer al progetto. In questo esempio
aggiungeremo sia un vettore che un raster. Il nome dei file da aggiungere al progetto e il nome da assegnare ai
layer è specificato dai dati (filename e layname sono nomi di colonne della tabella dagli attributi del vettore dove
l’azione è stata creata):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,
’[% "layername" %]’, ’ogr’)

Per aggiungere un raster (in questo caso un’immagine TIF), diventa:
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qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,
’[% "layername" %]’)

12.3.8 Menu Visualizza

This menu is specifically created for Map Tips. It includes a nice feature: Map Tip display text in HTML.
While you can still choose a Field to be displayed when hovering over a feature on the map, it is also possible
to insert HTML code that creates a complex display when hovering over a feature. To activate Map Tips, select
the menu option View → Map Tips.

Figure Display 1 and 2 show an example of HTML code and how it behaves in map canvas.

Figure 12.52: HTML code for map tip

Figure 12.53: Map tip made with HTML code
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12.3.9 Menu Visualizzazione

QGIS offers support for on-the-fly feature generalisation. This can improve rendering times when drawing many

complex features at small scales. This feature can be enabled or disabled in the layer settings using the Simplify
geometry option. There is also a global setting that enables generalisation by default for newly added layers (see
section Opzioni dell’interfaccia grafica (GUI)).

Figure 12.54: Layer Geometry Simplification dialog

Nota: Feature generalisation may introduce artefacts into your rendered output in some cases. These may include
slivers between polygons and inaccurate rendering when using offset-based symbol layers.

While rendering extremely detailed layers (e.g. polygon layers with a huge number of nodes), this can cause
composer exports in PDF/SVG format to be huge as all nodes are included in the exported file. This can also make
the resultant file very slow to work with/open in other programs.

Checking Force layer to render as raster forces these layers to be rasterised so that the exported files won’t
have to include all the nodes contained in these layers and the rendering is therefore sped up.

You can also do this by forcing the composer to export as a raster, but that is an all-or-nothing solution, given that
the rasterisation is applied to all layers.

12.3.10 Menu Metadati

The Metadata menu consists of Description, Attribution, MetadataURL, LegendUrl and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and loca-
tion, number of features, feature type, and editing capabilities. The Extents table provides you with information
on the layer extent and the Layer Spatial Reference System, which is information about the CRS of the layer. This
can provide a quick way to get useful information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalogue. If you want to use a title
from an XML metadata file, you have to fill in a link in the DataUrl field.

Use Attribution to get attribute data from an XML metadata catalogue.

In MetadataUrl, you can define the general path to the XML metadata catalogue. This information will be saved
in the QGIS project file for subsequent sessions and will be used for QGIS server.
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In the LegendUrl section, you can provide the url of a legend image in the url field. You can use the Format
drop-down option to apply the appropriate format of the image. Currently png, jpg and jpeg image formats are
supported.

Figure 12.55: Metadata menu in vector layers properties dialog

12.3.11 Save and Share Layer Properties

Managing Custom Styles

When a layer is added to map canvas, QGIS uses by default a random symbol/color to render its features. You can
however set a default symbol in Project → Properties → Default styles that will be applied to each newly added
layer according to its geometry type.

But, most of the time, you’d prefer to have a custom and more complex style that can be applied automatically or
manually (with less efforts) to the layers. You can achieve this goal using the Style combobox at the bottom of the
Layer Properties dialog. This combobox provides you with functions to create, load and manage styles.

A style stores any information set in the layer properties dialog to render or interact with the features (including
symbology, labeling, action, diagram... settings).

By default, the style applied to a loaded layer is named default. Once you have got the ideal and appropriate

rendering for your layer, you can save it by clicking the Style combobox and choose:

• Rename Current: The active style gets renamed and updated with the current options

• Add: A new style is created using the current options.

At the bottom of the Style drop-down list, you see the styles set for the layer and the active one is checked. Once
you have more than one style defined for a layer, a Remove Current option can help you delete those you no
longer want.

Note that each time you validate the layer properties dialog, the active style is updated with the changes you’ve
done.
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Figure 12.56: Style combobox options

You can create as many styles as you wish for a layer but only one can be active at a time. Combined to layer
visibility preset, this offers a quick and powerful way to manage complex projects with few layers (no need to
duplicate any layer in the map legend).

Suggerimento: Manage styles from layer context menu
Right-click on the layer in Layers Panel to add, rename or remove layer style. You can also edit feature symbols.

Storing Style in a File or a Database

While these styles are saved inside the project and can be copied and pasted from layer to layer in the project,
it’s also possible to save them outside the project so that they can be loaded in another project. Clicking the

Style → Save Style saves the symbol as a QGIS layer style file (.qml) or SLD file (.sld). SLDs can be
exported from any type of renderer – single symbol, categorized, graduated or rule-based – but when importing
an SLD, either a single symbol or rule-based renderer is created. That means that categorized or graduated styles
are converted to rule-based. If you want to preserve those renderers, you have to stick to the QML format. On the
other hand, it can be very handy sometimes to have this easy way of converting styles to rule-based.

If the datasource of the layer is a database (PostGIS or Spatialite for example), you can also save your layer style
inside a table of the database. Just click on Save Style combobox and choose Save in database item then fill in the
dialog to define a style name, add a description, an ui file if applicable and check if the style is the default style.
You can add several style in the database. However each table can have only one default style.

When loading a layer in QGIS, if a default style already exists for this layer, QGIS will load the layer and its style.
After you modified the layer style, you can Save as Default, creating a new style that becomes the default one or
Restore Default style if you’re not satisfied.

Suggerimento: Quickly share a layer style within the project
You can also share layer style within a project without importing a file or database style: right-click on the layer
in the Layers Panel and, from the Styles combobox , copy the style of a layer and paste it to a group or a selection
of layers: the style is applied to all the layers that are of the same type (vector vs raster) as the original layer and,
in case of vector, have the same geometry type (point, line or polygon).
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Figure 12.57: Save Style in database Dialog

12.4 Expressions

The Expressions feature is available from many parts in QGIS. It can be accessed using the Expression Builder, the
Select By Expression..., the Geometry generator symbol layer option, the Field calculator or the Data defined override

tool. Based on layer data and prebuilt or user defined functions, it offers a powerful way to manipulate attribute
value, geometry and variables in order to dynamically change the geometry style, the content or position of the
label, the value for diagram, the height of a composer item, select some features, create virtual field ...

Some examples:

• From Field Calculator, calculate a “pop_density” field using existing “total_pop” and “area_km2” fields:

"total_pop" / "area_km2"

• Update the field “density_level” with categories according to the “pop_density” values:

CASE WHEN "pop_density" < 50 THEN ’Low population density’
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN ’Medium population density’
WHEN "pop_density" >= 150 THEN ’High population density’

END

• Apply a categorized style to all the features according to whether their average house price is smaller or
higher than 10000C per square metre:

"price_m2" > 10000

• Using the “Select By Expression...” tool, select all the features representing areas of “High population
density” and whose average house price is higher than 10000C per square metre:

"density_level" = ’High population density’ and "price_m2" > 10000

Likewise, the previous expression could also be used to define which features should be labeled or shown in the
map. Using expressions offers you a lot of possibilities.

The Expressions feature offers access to the:

• Expression tab which lists functions to use

• Function Editor tab which helps to create custom functions to use in the expressions.

12.4.1 Functions List

The Expression tab contains functions as well as layer’s fields and values. It contains widgets to:
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Figure 12.58: The Expression tab

• type expressions using functions and/or fields. A preview of the expression’s result is displayed at the
bottom of the dialog.

• select the appropriate function among a list. A search box is available to filter the list and quickly find a
particular function or field. Double-clicking on the item’s name adds it to the expression being written.

• display help for each function selected. When a field is selected, this widget shows a sample of its values.
Double-clicking a value adds it to the expression.

To help to quickly find a function, they are organized in groups. In Operators, you find mathematical operators.
Look in Math for mathematical functions. The Conversions group contains functions that convert one data type
to another. The String group provides functions for data strings, such as Date and Time handles date and time
data. In the Geometry group, you find functions for geometry objects. With Record group functions, you can add
a numeration to your data set while Fields and Values group helps view all attributes of the attribute table. The
Customs group lists the functions created or imported by the user. There are many other groups, listed below.

Operators

This group contains operators (e.g., +, -, *). Note that for most of the mathematical functions below, if one of the
inputs is NULL then the result is NULL.
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Function Description
a + b Addition of two values (a plus b)
a - b Subtraction of two values (a minus b).
a * b Multiplication of two values (a multiplied by b)
a / b Division of two values (a divided by b)
a % b Remainder of division of a by b (eg, 7 % 2 = 1, or 2 fits into 7 three times with remainder

1)
a ^ b Power of two values (for example, 2^2=4 or 2^3=8)
a < b Compares two values and evaluates to 1 if the left value is less than the right value (a is

smaller than b)
a <= b Compares two values and evaluates to 1 if the left value is less than or equal to the right

value
a <> b Compares two values and evaluates to 1 if they are not equal
a = b Compares two values and evaluates to 1 if they are equal
a != b a and b are not equal
a > b Compares two values and evaluates to 1 if the left value is greater than the right value (a

is larger than b)
a >= b Compares two values and evaluates to 1 if the left value is greater than or equal to the

right value
a ~ b a matches the regular expression b
|| Joins two values together into a string. If one of the values is NULL the result will be

NULL
‘\n’ Inserts a new line in a string
LIKE Returns 1 if the first parameter matches the supplied pattern
ILIKE Returns 1 if the first parameter matches case-insensitive the supplied pattern (ILIKE can

be used instead of LIKE to make the match case-insensitive)
a IS b Tests whether two values are identical. Returns 1 if a is the same as b
a OR b Returns 1 when condition a or b is true
a AND b Returns 1 when condition a and b are true
NOT Negates a condition
column name
“column name”

Value of the field column name, take care to not be confused with simple quote, see
below

‘string’ a string value, take care to not be confused with double quote, see above
NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN
(value[,value])

a is below the values listed

a NOT IN
(value[,value])

a is not below the values listed

Some examples:

• Joins a string and a value from a column name:

’My feature’’s id is: ’ || "gid"

• Test if the “description” attribute field starts with the ‘Hello’ string in the value (note the position of the %
character):

"description" LIKE ’Hello%’

Conditionals

This group contains functions to handle conditional checks in expressions.
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Function Description
CASE WHEN ... THEN ...
END

Evaluates an expression and returns a result if true. You can test multiple
conditions

CASE WHEN ... THEN ...
ELSE ... END

Evaluates an expression and returns a different result whether it’s true or
false. You can test multiple conditions

coalesce Returns the first non-NULL value from the expression list
if Tests a condition and returns a different result depending on the conditional

check
regexp_match Returns true if any part of a string matches the supplied regular expression

Some example:

• Send back a value if the first condition is true, else another value:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’ END

Mathematical Functions

This group contains math functions (e.g., square root, sin and cos).

Function Description
abs Returns the absolute value of a number
acos Returns the inverse cosine of a value in radians
asin Returns the inverse sine of a value in radians
atan Returns the inverse cosine of a value in radians
atan2(y,x) Returns the inverse tangent of y/x by using the signs of the two arguments to determine the

quadrant of the result
az-
imuth(a,b)

Returns the north-based azimuth as the angle in radians measured clockwise from the vertical
on point a to point b

ceil Rounds a number upwards
clamp Restricts an input value to a specified range
cos Returns the cosine of a value in radians
degrees Converts from radians to degrees
exp Returns exponential of a value
floor Rounds a number downwards
ln Returns the natural logarithm of the passed expression
log Returns the value of the logarithm of the passed value and base
log10 Returns the value of the base 10 logarithm of the passed expression
max Returns the largest value in a set of values
min Returns the smallest value in a set of values
pi Returns the value of pi for calculations
radians Converts from degrees to radians
rand Returns the random integer within the range specified by the minimum and maximum argument

(inclusive)
randf Returns the random float within the range specified by the minimum and maximum argument

(inclusive)
round Rounds to number of decimal places
scale_exp Transforms a given value from an input domain to an output range using an exponential curve
scale_linear Transforms a given value from an input domain to an output range using linear interpolation
sin Returns the sine of an angle
sqrt Returns the square root of a value
tan Returns the tangent of an angle

Color Functions

This group contains functions for manipulating colors.

144 Chapter 12. Lavorare con i vettori



QGIS User Guide, Release 2.14

Function Description
color_cmyk Returns a string representation of a color based on its cyan, magenta, yellow and black

components
color_cmyka Returns a string representation of a color based on its cyan, magenta, yellow, black and alpha

(transparency) components
color_hsl Returns a string representation of a color based on its hue, saturation, and lightness attributes
color_hsla Returns a string representation of a color based on its hue, saturation, lightness and alpha

(transparency) attributes
color_hsv Returns a string representation of a color based on its hue, saturation, and value attributes
color_hsva Returns a string representation of a color based on its hue, saturation, value and alpha

(transparency) attributes
color_part Returns a specific component from a color string, eg the red component or alpha component
color_rgb Returns a string representation of a color based on its red, green, and blue components
color_rgba Returns a string representation of a color based on its red, green, blue, and alpha (transparency)

components
darker Returns a darker (or lighter) color string
lighter Returns a lighter (or darker) color string
project_color Returns a color from the project’s color scheme
ramp_color Returns a string representing a color from a color ramp
set_color_partSets a specific color component for a color string, eg the red component or alpha component

Conversions

This group contains functions to convert one data type to another (e.g., string to integer, integer to string).

Function Description
to_date Converts a string into a date object
to_datetime Converts a string into a datetime object
to_int Converts a string to integer number
to_interval Converts a string to an interval type (can be used to take days, hours, months, etc. of a date)
to_real Converts a string to a real number
to_string Converts number to string
to_time Converts a string into a time object

Custom functions

This group contains functions created by the user. See function_editor for more details.

Date and Time Functions

This group contains functions for handling date and time data.

Function Description
age Returns as an interval the difference between two dates or datetimes
day Extracts the day from a date or datetime, or the number of days from an interval
day_of_week Returns a number corresponding to the day of the week for a specified date or datetime
hour Extracts the hour from a datetime or time, or the number of hours from an interval
minute Extracts the minute from a datetime or time, or the number of minutes from an interval
month Extracts the month part from a date or datetime, or the number of months from an interval
now() Returns current date and time
second Extracts the second from a datetime or time, or the number of seconds from an interval
week Extracts the week number from a date or datetime, or the number of weeks from an interval
year Extracts the year part from a date or datetime, or the number of years from an interval

Some example:

• Get the month and the year of today in the format “10/2014”
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month(now()) || ’/’ || year(now())

Fields and Values

Contains a list of fields from the layer.

Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box.

To display the values of a field, you just click on the appropriate field and choose between Load top 10 unique
values and Load all unique values. On the right side, the Field Values list opens with the unique values. At the
top of the list, a search box helps filtering the values. To add a value to the expression you are writing, double
click its name in the list.

Sample values can also be accessed via right-click. Select the field name from the list, then right-click to access a
context menu with options to load sample values from the selected field.

Fields name should be double-quoted in the expression. Values or string should be simple-quoted.

Fuzzy Matching Functions

This group contains functions for fuzzy comparisons between values.

Function Description
ham-
ming_distance

Returns the number of characters at corresponding positions within the input strings where
the characters are different

levensheim Returns the minimum number of character edits (insertions, deletions or substitutions)
required to change one string to another. Measure the similarity between two strings

longest_common_substringReturns the longest common substring between two strings
soundex Returns the Soundex representation of a string

General Functions

This group contains general assorted functions.

Function Description
eval Evaluates an expression which is passed in a string. Useful to expand dynamic parameters

passed as context variables or fields
layer_propertyReturns a property of a layer or a value of its metadata. It can be layer name, crs, geometry

type, feature count...
var Returns the value stored within a specified variable. See variable functions below

Geometry Functions

This group contains functions that operate on geometry objects (e.g., length, area).

Function Description
$area Returns the area size of the current feature
$geometry Returns the geometry of the current feature (can be used for processing with other functions)
$length Returns the length of the current line feature
$perimeter Returns the perimeter of the current polygon feature
$x Returns the x coordinate of the current feature
$x_at(n) Returns the x coordinate of the nth node of the current feature’s geometry
$y Returns the y coordinate of the current feature
$y_at(n) Returns the y coordinate of the nth node of the current feature’s geometry
area Returns the area of a geometry polygon feature. Calculations are in the Spatial Reference System of this geometry

Continua alla pagina successiva
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Table 12.1 – continua dalla pagina precedente
Function Description
bounds Returns a geometry which represents the bounding box of an input geometry. Calculations are in the Spatial Reference System of this Geometry
bounds_height Returns the height of the bounding box of a geometry. Calculations are in the Spatial Reference System of this Geometry
bounds_width Returns the width of the bounding box of a geometry. Calculations are in the Spatial Reference System of this Geometry
buffer Returns a geometry that represents all points whose distance from this geometry is less than or equal to distance. Calculations are in the Spatial Reference System of this geometry
centroid Returns the geometric center of a geometry
closest_point Returns the point on a geometry that is closest to a second geometry
combine Returns the combination of two geometries
contains(a,b) Returns 1 (true) if and only if no points of b lie in the exterior of a, and at least one point of the interior of b lies in the interior of a
convex_hull Returns the convex hull of a geometry (this represents the minimum convex geometry that encloses all geometries within the set)
crosses Returns 1 (true) if the supplied geometries have some, but not all, interior points in common
difference(a,b) Returns a geometry that represents that part of geometry a that does not intersect with geometry b
disjoint Returns 1 (true) if the geometries do not share any space together
distance Returns the minimum distance (based on spatial ref) between two geometries in projected units
end_point Returns the last node from a geometry
exterior_ring Returns a line string representing the exterior ring of a polygon geometry. If the geometry is not a polygon then the result will be null
extrude(geom,x,y) Returns an extruded version of the input (Multi-)Curve or (Multi-)Linestring geometry with an extension specified by x and y
geom_from_gml Returns a geometry created from a GML representation of geometry
geom_from_wkt Returns a geometry created from a well-known text (WKT) representation
geom_to_wkt Returns the well-known text (WKT) representation of the geometry without SRID metadata
geometry Returns a feature’s geometry
geometry_n Returns the nth geometry from a geometry collection, or null if the input geometry is not a collection
interior_ring_n Returns the geometry of the nth interior ring from a polygon geometry, or null if the geometry is not a polygon
intersection Returns a geometry that represents the shared portion of two geometries
intersects Tests whether a geometry intersects another. Returns 1 (true) if the geometries spatially intersect (share any portion of space) and 0 if they don’t
intersects_bbox Tests whether a geometry’s bounding box overlaps another geometry’s bounding box. Returns 1 (true) if the geometries spatially intersect (share any portion of space) their bounding box and 0 if they don’t
is_closed Returns true if a line string is closed (start and end points are coincident), false if a line string is not closed and null if the geometry is not a line string
length Returns length of a line geometry feature (or length of a string)
m Returns the m value of a point geometry
make_line Creates a line geometry from a series of point geometries
make_point(x,y,z,m) Returns a point geometry from x and y values (and optional z and m values)
make_point_m(x,y,m) Returns a point geometry from x and y coordinates and m values
make_polygon Creates a polygon geometry from an outer ring and optional series of inner ring geometries
nodes_to_points Returns a multipoint geometry consisting of every node in the input geometry
num_geometries Returns the number of geometries in a geometry collection, or null if the input geometry is not a collection
num_interior_rings Returns the number of interior rings in a polygon or geometry collection, or null if the input geometry is not a polygon or collection
num_points Returns the number of vertices in a geometry
num_rings Returns the number of rings (including exterior rings) in a polygon or geometry collection, or null if the input geometry is not a polygon or collection
order_parts Orders the parts of a MultiGeometry by a given criteria
overlaps Tests whether a geometry overlaps another. Returns 1 (true) if the geometries share space, are of the same dimension, but are not completely contained by each other
perimeter Returns the perimeter of a geometry polygon feature. Calculations are in the Spatial Reference System of this geometry
point_n Returns a specific node from a geometry
point_on_surface Returns a point guaranteed to lie on the surface of a geometry
relate Tests or returns the Dimensional Extended 9 Intersection Model (DE-9IM) representation of the relationship between two geometries
reverse Reverses the direction of a line string by reversing the order of its vertices
segments_to_lines Returns a multi line geometry consisting of a line for every segment in the input geometry
shortest_line Returns the shortest line joining two geometries. The resultant line will start at geometry 1 and end at geometry 2
start_point Returns the first node from a geometry
sym_difference Returns a geometry that represents the portions of two geometries that do not intersect
touches Tests whether a geometry touches another. Returns 1 (true) if the geometries have at least one point in common, but their interiors do not intersect
transform Returns the geometry transformed from the source CRS to the destination CRS
translate Returns a translated version of a geometry. Calculations are in the Spatial Reference System of this geometry
union Returns a geometry that represents the point set union of the geometries
within (a,b) Tests whether a geometry is within another. Returns 1 (true) if geometry a is completely inside geometry b
x Returns the x coordinate of a point geometry, or the x coordinate of the centroid for a non-point geometry
x_min Returns the minimum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry

Continua alla pagina successiva
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Table 12.1 – continua dalla pagina precedente
Function Description
x_max Returns the maximum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y Returns the y coordinate of a point geometry, or the y coordinate of the centroid for a non-point geometry
y_min Returns the minimum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y_max Returns the maximum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
z Returns the z coordinate of a point geometry

Some examples:

• Return the x coordinate of the current feature’s centroid:

x($geometry)

• Send back a value according to feature’s area:

CASE WHEN $area > 10 000 THEN ’Larger’ ELSE ’Smaller’ END

Record Functions

This group contains functions that operate on record identifiers.

Function Description
$current-
feature

Returns the current feature being evaluated. This can be used with the ‘attribute’ function to
evaluate attribute values from the current feature.

$id Returns the feature id of the current row
$map Returns the id of the current map item if the map is being drawn in a composition, or “canvas” if

the map is being drawn within the main QGIS window
$rownum Returns the number of the current row
$scale Returns the current scale of the map canvas
attribute Returns the value of a specified attribute from a feature.
get_feature Returns the first feature of a layer matching a given attribute value.
uuid Generates a Universally Unique Identifier (UUID) for each row. Each UUID is 38 characters long

Some examples:

• Return the first feature in layer “LayerA” whose field “id” has the same value as the field “name” of the
current feature (a kind of jointure):

get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) )

• Calculate the area of the joined feature from the previous example:

area( geometry( get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) ) ) )

String Functions

This group contains functions that operate on strings (e.g., that replace, convert to upper case).
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Function Description
concat Concatenates several strings to one
format Formats a string using supplied arguments
for-
mat_date

Formats a date type or string into a custom string format

for-
mat_number

Returns a number formatted with the locale separator for thousands (also truncates the number
to the number of supplied places)

left(string,
n)

Returns a substring that contains the n leftmost characters of the string

length Returns length of a string (or length of a line geometry feature)
lower converts a string to lower case
lpad Returns a string with supplied width padded using the fill character
reg-
exp_replace

Returns a string with the supplied regular expression replaced

reg-
exp_substr

Returns the portion of a string which matches a supplied regular expression

replace Returns a string with the supplied string replaced
right(string,
n)

Returns a substring that contains the n rightmost characters of the string

rpad Returns a string with supplied width padded using the fill character
strpos Returns the index of a regular expression in a string
substr Returns a part of a string
title Converts all words of a string to title case (all words lower case with leading capital letter)
trim Removes all leading and trailing white space (spaces, tabs, etc.) from a string
upper Converts string a to upper case
wordwrap Returns a string wrapped to a maximum/ minimum number of characters

Recent Functions

This group contains recently used functions. Any expression used in the Expression dialog is added to the list,
sorted from the more recent to the less one. This helps to quickly retrieve any previous expression.

Variables Functions

This group contains dynamic variables related to the application, the project file and other settings. It means that
some functions may not be available according to the context:

• from the Select by expression dialog

• from the Field calculator dialog

• from the layer properties dialog

• from the print composer

To use these functions in an expression, they should be preceded by @ character (e.g, @row_number). Are
concerned:

Function Description
atlas_feature Returns the current atlas feature (as feature object)
atlas_featureid Returns the current atlas feature ID
atlas_featurenumber Returns the number of pages in composition
atlas_filename Returns the current atlas file name
atlas_geometry Returns the current atlas feature geometry
atlas_pagename Returns the current atlas page name
atlas_totalfeatures Returns the total number of features in atlas
grid_axis Returns the current grid annotation axis (eg, ‘x’ for longitude, ‘y’ for latitude)

Continua alla pagina successiva
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Function Description
grid_number Returns the current grid annotation value
item_id Returns the composer item user ID (not necessarily unique)
item_uuid Returns the composer item unique ID
layer_id Returns the ID of current layer
layer_name Returns the name of current layer
layout_dpi Returns the composition resolution (DPI)
layout_numpages Returns the number of pages in the composition
layout_pageheight Returns the composition height in mm
layout_pagewidth Returns the composition width in mm
map_id Returns the ID of current map destination. This will be ‘canvas’ for canvas renders, and the item ID for composer map renders
map_extent_center Returns the point feature at the center of the map
map_extent_height Returns the current height of the map
map_extent_width Returns the current width of the map
map_rotation Returns the current rotation of the map
map_scale Returns the current scale of the map
project_filename Returns the filename of current project
project_folder Returns the folder for current project
project_path Returns the full path (including file name) of current project
project_title Returns the title of current project
qgis_os_name Returns the current Operating system name, eg ‘windows’, ‘linux’ or ‘osx’
qgis_platform Returns the QGIS platform, eg ‘desktop’ or ‘server’
qgis_release_name Returns the current QGIS release name
qgis_version Returns the current QGIS version string
qgis_version_no Returns the current QGIS version number
symbol_angle Returns the angle of the symbol used to render the feature (valid for marker symbols only)
symbol_color Returns the color of the symbol used to render the feature
user_account_name Returns the current user’s operating system account name
user_full_name Returns the current user’s operating system user name
row_number Stores the number of the current row

12.4.2 Function Editor

With the Function Editor, you are able to define your own Python custom functions in a comfortable way.

Figure 12.59: The Function Editor tab
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The function editor will create new Python files in .qgis2\python\expressions folder and will auto load
all functions defined when starting QGIS. Be aware that new functions are only saved in the expressions
folder and not in the project file. If you have a project that uses one of your custom functions you will need to also
share the .py file in the expressions folder.

Here’s a short example on how to create your own functions:

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2, feature, parent):

pass

The short example creates a function ‘myfunc’ that will give you a function with two values. When using the
args=’auto’ function argument the number of function arguments required will be calculated by the number of
arguments the function has been defined with in Python (minus 2 - feature, and parent).

This function then can be used with the following expression:

myfunc(’test1’, ’test2’)

Your function will be implemented in the Custom functions group of the Expression tab after using the Run Script
button.

Further information about creating Python code can be found in the PyQGIS-Developer-Cookbook.

The function editor is not only limited to working with the field calculator, it can be found whenever you work
with expressions.

12.5 Lavorare col la tabella degli attributi

The attribute table displays features of a selected layer. Each row in the table represents one map feature, and
each column contains a particular piece of information about the feature. Features in the table can be searched,
selected, moved or even edited.

To open the attribute table for a vector layer, make the layer active by clicking on it in the map legend area. Then,

from the main Layer menu, choose Open Attribute Table. It is also possible to right click on the layer and

choose Open Attribute Table from the drop-down menu, and to click on the Open Attribute Table button
in the Attributes toolbar.

This will open a new window that displays the feature attributes for the layer (figure_attributes_1). The number
of features and the number of selected features are shown in the attribute table title.

Figure 12.60: Attribute Table for regions layer

The buttons at the top of the attribute table window provide the following functionality:
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• Toggle editing mode to enable editing functionalities (also with Ctrl+e)

• Save Edits (also with Ctrl+s)

• Reload the table

• Add feature

• Delete selected features (also with Ctrl+d)

• Select features using an Expression

• Select all (also with Ctrl+a)

• Invert selection (also with Ctrl+r)

• Unselect all (also with Ctrl+u)

• Move selected to top (also with Ctrl+t)

• Pan map to the selected rows (also with Ctrl+p)

• Zoom map to the selected rows (also with Ctrl+j)

• Copy selected rows to clipboard (also with Ctrl+c)

• Paste from clipboard to a new row (also with Ctrl+v)

• Delete Column for PostGIS layers and for OGR layers with GDAL version >= 1.9 (also with Ctrl+l)

• New Column for PostGIS layers and for OGR layers with GDAL version >= 1.6 (also with Ctrl+w)

• Open field calculator (also with Ctrl+i)

Below these buttons is the Field Calculator bar (enabled only in editing mode), which allows calculations to be
quickly applied to either all or selected features attributes in the table. This bar uses the same expressions as the

Field Calculator (see Field Calculator).

Suggerimento: Skip WKT geometry

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard button.
You can copy the information without vector geometries if you deactivate Settings → Options → Data sources

menu Copy geometry in WKT representation from attribute table.

12.5.1 Selecting features in an attribute table

Each selected row in the attribute table displays the attributes of a selected feature in the layer. If the set of
features selected in the main window is changed, the selection is also updated in the attribute table. Likewise, if
the set of rows selected in the attribute table is changed, the set of features selected in the main window will be
updated.

Rows can be selected by clicking on the row number on the left side of the row. Multiple rows can be marked by
holding the Ctrl key. A continuous selection can be made by holding the Shift key and clicking on several
row headers on the left side of the rows. All rows between the current cursor position and the clicked row are
selected. Moving the cursor position in the attribute table, by clicking a cell in the table, does not change the row
selection. Changing the selection in the main canvas does not move the cursor position in the attribute table.
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The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort order
(downward pointing means descending values from the top row down, upward pointing means ascending values
from the top row down).

For a simple search by attributes on only one column, choose the Column filter → from the menu in the bottom
left corner. Select the field (column) on which the search should be performed from the drop-down menu, and hit
the [Apply] button. Then, only the matching features are shown in the attribute table.

To make a selection, you have to use the Select features using an Expression icon on top of the attribute table.
Select features using an Expression allows you to define a subset of a table using a Function List like in the Field Calculator

(see Field Calculator). The query result can then be saved as a new vector layer. For example, if you want to find
regions that are boroughs from regions.shp of the QGIS sample data, you have to open the Fields and Values
menu and choose the field that you want to query. Double-click the field ‘TYPE_2’ and also [Load all unique
values] . From the list, choose and double-click ‘Borough’. In the Expression field, the following query appears:

"TYPE_2" = ’Borough’

Here you can also use the Function list → Recent (Selection) to make a selection that you used before. The
expression builder remembers the last 20 used expressions.

The matching rows will be selected, and the total number of matching rows will appear in the title bar of the
attribute table, as well as in the status bar of the main window. For searches that display only selected features on
the map, use the Query Builder described in section Costruttore di interrogazioni.

To show selected records only, use Show Selected Features from the menu at the bottom left. See next section for
more information on filter feature.

The field calculator bar allows you to make calculations on the selected rows only. For example, you can alter the
number of the ID field of the layer regions.shp with the expression

ID+5

as shown in figure_attributes_1 .

12.5.2 Filter features

At the bottom of the attribute table, you have a dropdown list of different filter:

• Show All Features;

• Show Selected Features;

• Show Features visible on map;

• Show Edited and New Features;

• Field Filter;

• Advanced filter (Expression);

The first four are self explanatory, the two last are expression filters. Field Filter allows user to choose a column
name in the list and add a simple form to the right of the drop-down list to filter with a like expression parameter.
This filter will create an expression filter as an Advanced filter. The last kind of filter will open an expression
window, see Expressions for more information.

12.5.3 Tab/form mode

By default the attribute window displays a table layout. In some case one should prefer to use a form layout to
help edit some features more easily.

You can switch to form layout by clicking in the bottom right, on and switch back to table layout with .
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12.5.4 Zoom to feature

To zoom into a feature, without having to select it, right-click on the feature you want to zoom in, within the
attribute table, and select Zoom to feature.

12.5.5 Save selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coordi-
nate reference system (CRS). Just open the right mouse menu of the layer and click on Save as to define the name

of the output file, its format and CRS (see section Layers Panel). To save the selection ensure that the Save
only selected features is selected. It is also possible to specify OGR creation options within the dialog.

12.5.6 Paste into new layer

Features that are on the clipboard may be pasted into a new layer. To do this, first make a layer editable. Select
some features, copy them to the clipboard, and then paste them into a new layer using Edit → Paste Features as
and choosing New vector layer or New memory layer.

This applies to features selected and copied within QGIS and also to features from another source defined using
well-known text (WKT).

12.5.7 Editing attribute values

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.

A virtual field is a field based on an expression calculated on the fly, meaning that its value is automatically updated
as soon as the underlying parameter changes. The expression is set once; you no longer need to recalculate the
field each time underlying values change. For example, you may want to use a virtual field if you need area to
be evaluated as you digitize features or to automatically calculate a duration between dates that may change (e.g.,
using now() function).

Nota: Use of Virtual Fields
• Virtual fields are not permanent in the layer attributes, meaning that they’re only saved and available in the

project file they’ve been created.

• A field can be set virtual only at its creation and the expression used can’t be changed later: you’ll need to
delete and recreate that field.

The field calculator is available on any layer that supports edit. When you click on the field calculator icon the
dialog opens (see figure_attributes_2). If the layer is not in edit mode, a warning is displayed and using the field
calculator will cause the layer to be put in edit mode before the calculation is made.

The quick field calculation bar on top of the attribute table is only visible if the layer is in edit mode.

In quick field calculation bar, you first select the existing field name then open the expression dialog to create your
expression or write it directly in the field then click on [Update All], [Update Selected] or [Update Filtered]
button according to your need.

Field Calculator

Based on the Expression Builder dialog, the field calculator dialog offers a complete interface to define an expres-
sion and apply it to an existing or a newly created field. To use the field calculator dialog, you first must select
whether you want to only update selected features, create a new attribute field where the results of the calculation
will be added or update an existing field.
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Figure 12.61: Field Calculator
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If you choose to add a new field, you need to enter a field name, a field type (integer, real or string), the total field
width, and the field precision (see figure_attributes_2). For example, if you choose a field width of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

A short example illustrates how field calculator works when using the Expression tab. We want to calculate the
length in km of the railroads layer from the QGIS sample dataset:

1. Load the shapefile railroads.shp in QGIS and press Open Attribute Table.

2. Click on Toggle editing mode and open the Field Calculator dialog.

3. Select the Create a new field checkbox to save the calculations into a new field.

4. Add length as Output field name and real as Output field type, and define Output field width to be 10
and Precision, 3.

5. Now double click on function $length in the Geometry group to add it into the Field calculator expression
box.

6. Complete the expression by typing / 1000 in the Field calculator expression box and click [Ok].

7. You can now find a new field length in the attribute table.

12.5.8 Working with non spatial attribute tables

QGIS allows you also to load non-spatial tables. This currently includes tables supported by OGR and delimited
text, as well as the PostgreSQL, MSSQL and Oracle provider. The tables can be used for field lookups or just
generally browsed and edited using the table view. When you load the table, you will see it in the legend field. It

can be opened with the Open Attribute Table tool and is then editable like any other layer attribute table.

As an example, you can use columns of the non-spatial table to define attribute values, or a range of values that are
allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Menu Campi to find out more.

12.5.9 Formattazione condizionale di celle

Puoi abilitare il pannello conditional formatting cliccando su nella parte superiore destra della finestra della
tabella degli attributi (non disponibile nella vista modulo).

Il nuovo pannello ti permette di aggiungere nuove regole per la formattazione condizionale dei campi o compilare
righe dall’espressioni di campi. Aggiungendo una nuova regola apri un modulo per definire:

• il nome della regola,

• una condizione dalla finestra calcolatore,

• una formattazione preimpostata

• alcuni altri parametri per migliorare, cambiare o impostare la formattazione:

– sfondo e colori del testo,

– uso di icone,

– grassetto, corsivo sottolineato o barrato,

– colori testo,

– carattere.
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Figure 12.62: Formattazione condizionale di una tabella degli attributi

12.5.10 Creare relazioni uno a molti

Le relazioni sono una tecnica usata spesso nei database. Il concetto è che geometrie (righe) di diversi layer (tabelle)
possono relazionarsi a vicenda.

Come esempio hai un livello con tutte le regioni dell’Alaska (poligono) con alcuni attributi sul suo nome e il tipo
regione e un ID univoco (che funge da chiave primaria).

Chiavi esterne

Avrai un altro layer di punti o tabella con informazioni sugli aeroporti che si trovano nelle varie regioni. Se vuoi
aggiungere la regione, devi creare una relazione uno a molti utilizzando chiavi esterne, perché ci sono diversi
aeroporti nella maggior parte delle regioni.

Figure 12.63: Regione dell’Alaska con areoporti

In aggiunta agli attributi già esistenti nella tabella degli attributi di airports un’altro campo fk_region campo agisce
come chiave esterna (se disponi di un database, probabilmente definirai un vincolo su di esso).
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Questo campo fk_region conterrà sempre l’id di una regione. Esso può essere visto come un puntatore alla
regione di appartenenza.Puoi progettare un modulo di modifica personalizzato per l’editing e QGIS lo configurerà.
Funziona con diversi file sorgente (in modo da poter utilizzare anche shapefile e csv) e tutto quello che devi fare è
dire QGIS le relazioni tra le tabelle.

Layer

QGIS fa differenza tra una tabella e un vettore. Fondamentalmente, un vettore è una tabella con una geometria.
Così puoi aggiungere la tua tabella come un vettore. Puoi caricare la shapefile ‘region’ (con geometrie) e la
tabella csv ‘airport’ (senza le geometrie) e una chiave esterna (fk_region) per il layer region. Ciò significa che
ogni aeroporto appartiene ad una sola regione mentre ogni regione può avere più aeroporti (una tipica relazione
uno a molti).

Definition (Relation Manager)

La prima cosa da fare è vedere come sono le realzoni tra layer in QGIS. Puoi farlo in Progetto → Proprietà
progetto. Apri il menu Relazioni e clicca su Aggiungi.

• Nome sarà usato come titolo. Dovrebbe essere una stringa che descrive le finalità della relazione. In questo
caso la chiamerai “Airports”.

• Layer figlio è quello con il campo chiave esterna. Nel nostro caso questo è il layer airpots

• Campo di riferimento dirà quale campo indicherà l’altro layer e in questo caso è fk_region

• Layer padre è quello a cui punta la chiave primaria e in questo caso il layer regions

• Campo a cui si fa riferimento è la chiave primaria che è ID del layer di riferimento padre

• id verrà utilizzata per scopi interni e deve essere unica. Potrebbe essere necessaria per costruire i moduli
personalizzati una volta che questo è supportato. Se la lasci vuota, ne verrà generata una automaticamente,
ma è puoi assegnarne unaper semplificarne la gestione.

Figure 12.64: Relation Manager
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Forms

Now that QGIS knows about the relation, it will be used to improve the forms it generates. As we did not change
the default form method (autogenerated) it will just add a new widget in our form. So let’s select the layer region
in the legend and use the identify tool. Depending on your settings, the form might open directly or you will have
to choose to open it in the identification dialog under actions.

Figure 12.65: Identification dialog regions with relation to airports

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly

• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.

• The button will delete the selected airport permanently.

• The symbol will open a new dialog where you can select any existing airport which will then be assigned
to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• The two buttons to the right switch between table view and form view where the later let’s you view all the
airports in their respective form.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.
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Figure 12.66: Identification dialog airport with relation to regions

12.6 Modifica

QGIS supports various capabilities for editing OGR, SpatiaLite, PostGIS, MSSQL Spatial and Oracle Spatial
vector layers and tables.

Nota: The procedure for editing GRASS layers is different - see section Digitalizzare e modificare layer vettoriali
GRASS for details.

Suggerimento: Modifiche concorrenti
This version of QGIS does not track if somebody else is editing the same feature at the same time as you are. The
last person to save its edits wins.

12.6.1 Settare la tolleranza dello snapping e il raggio di ricerca degli elementi

For an optimal and accurate edit of the vector layer geometries, we need to set an appropriate value of snapping
tolerance and search radius for features vertices.

Tolleranza di snapping

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying to
connect to when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools that work with tolerance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options..., Digitizing
tab. You can select between ‘To vertex’, ‘To segment’ or ‘To vertex and segment’ as default snap mode.
You can also define a default snapping tolerance and a search radius for vertex edits. The tolerance can be
set either in map units or in pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t
have to be changed after zoom operations. In our small digitizing project (working with the Alaska dataset),
we define the snapping units in feet. Your results may vary, but something on the order of 300 ft at a scale
of 1:10000 should be a reasonable setting.

2. A layer-based snapping tolerance that overrides the global snapping options can be defined by choosing
Settings → Snapping options. It enables and adjusts snapping mode and tolerance on a layer basis (see
figure_edit_1 ). This dialog offers three different modes to select the layer(s) to snap to:

• Current layer: only the active layer is used, a convenient way to ensure topology within the layer being
edited

• All layers: a quick and simple setting for all visible layers in the project so that the pointer snaps to all
vertices and/or segments. In most cases it is sufficient to use this snapping mode.
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• Advanced: if you need to edit a layer and snap its vertices to another layer, ensure the target layer
is checked and increase the snapping tolerance to a greater value. Furthermore, snapping will never
occur to a layer that is not checked in the snapping options dialog, regardless of the global snapping
tolerance. So be sure to mark the checkbox for those layers that you need to snap to.

Figure 12.67: Edit snapping options on a layer basis (Advanced mode)

Suggerimento: Control the list of layers to snap
The Snapping Options dialog is by default populated with parameters (mode, tolerance, units) set in the global
Digitizing tab. To avoid layers being checked by default in the Advanced mode and hence set snappable, define
the Default Snap mode to Off.

Snapping tolerance can be set in pixels or map units (the units of the map view). While in the Advanced
layer selection mode, it is possible to use a snapping tolerance that refers to layer units, the units of the
reprojected layer when ‘on-the-fly’ CRS transformation is on.

Raggio di ricerca

Search radius is the distance QGIS uses to search for the closest vertex you are trying to select when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing. Snap
tolerance and search radius are set in map units or pixels, so you may find you need to experiment to get them set
right. If you specify too big of a tolerance, QGIS may snap to the wrong vertex, especially if you are dealing with
a large number of vertices in close proximity. Set search radius too small, and it won’t find anything to move.

The search radius for vertex edits in layer units can be defined in the Digitizing tab under Settings → Options.
This is the same place where you define the general, project-wide snapping tolerance.

12.6.2 Modifiche topologiche

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, activate the Avoid Intersections option.

Abilitare la modifica topologica

The option Enable topological editing is for editing and maintaining common boundaries in features mosaics.
QGIS ‘detects’ shared boundary by the features, so you only have to move a common vertex/segment once, and
QGIS will take care of updating the neighboring features.
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Evitare le intersezioni per i nuovi poligoni

A second topological option called Avoid intersections prevents you to draw new features that overlap an
existing one. It is for quicker digitizing of adjacent polygons. If you already have one polygon, it is possible
with this option to digitize the second one such that both intersect, and QGIS then cuts the second polygon to
the boundary of the existing one. The advantage is that you don’t have to digitize all vertices of the common
boundary.

Nota: If the new geometry is totally covered by existing ones, it gets cleared and the new feature will have no
geometry when allowed by the provider, otherwise saving modifications will make QGIS pop-up an error message.

Avvertimento: Use cautiously the Avoid Intersections option
Because the option cuts or clears geometry of any overlaping feature from any polygon layer, do not forget to
uncheck this option once you no longer need it otherwise, you can get unexpected geometries.

Enable snapping on intersections

Another option is to use Enable snapping on intersection. It allows you to snap on an intersection of back-
ground layers, even if there’s no vertex on the intersection.

Geometry Checker

A core plugin can help the user to find the geometry invalidity. You can find more information on this plugin at
Geometry Checker Plugin.

12.6.3 Modifica di un layer esistente

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a
slip of the mouse. However, you can choose to edit any layer as long as the data provider supports it, and the
underlying data source is writable (i.e., its files are not read-only).

In general, tools for editing vector layers are divided into a digitizing and an advanced digitiz-
ing toolbar, described in section Digitalizzazione avanzata. You can select and unselect both under
View → Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Icona Azione Icona Azione

Current edits Attiva modifica

Add Feature: Capture Point Add Feature: Capture Line

Add Feature: Capture Polygon Muove elementi

Add Circular String Add Circular String By Radius

Strumento vertici Elimina elementi selezionati

Taglia elementi Copia elementi

Incolla elementi Save layer edits

Strumenti di base per la modifica di layer vettoriali

Note that while using any of the digitizing tools, you can still zoom or pan in the map canvas without losing the
focus on the tool.

All editing sessions start by choosing the Toggle editing option found in the context menu of a given layer, from
the attribute table dialog, the digitizing toolbar or the Edit menu.
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Once the layer is in edit mode, additional tool buttons on the editing toolbar will become available and markers
will appear at the vertices of all features unless Show markers only for selected features option under Settings →
Options... → Digitizing menu is checked.

Suggerimento: Salvataggio ad intervalli regolari

Remember to Save Layer Edits regularly. This will also check that your data source can accept all the changes.

Aggiungere elementi

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to add new feature (point, line
and polygon) into the current layer.

The next buttons Add circular string or Add circular string by radius allow users to add line or polygon features with a
circular geometry.

To create features with these tools, you first digitize the geometry then enter its attributes. To digitize the geometry,
left-click on the map area to create the first point of your new feature.

For linear or curved geometries, keep on left-clicking for each additional point you wish to capture or use au-
tomatic tracing capability to accelerate the digitization. You can switch back and forth between linear Add fea-
ture tool and curved Add circular string... tools to create compound curved geometry. Pressing Delete or
Backspace key reverts the last node you add. When you have finished adding points, right-click anywhere on
the map area to confirm you have finished entering the geometry of that feature.

Nota: Curved geometries are stored as such only in compatible data provider
Although QGIS allows to digitize curved geometries within any editable data format, you need to be using a data
provider (e.g. PostGIS, GML or WFS) that supports curves to have features stored as curved, otherwise QGIS
segmentizes the circular arcs. The memory layer provider also supports curves.

Suggerimento: Customize the digitizing rubber band
While capturing polygon, the by-default red rubber band can hide underlying features or places you’d like to
capture a point. This can be fixed by setting a lower opacity (or alpha channel) to the rubber band’s Fill Color in
Settings → Options → Digitizing menu. You can also avoid the use of the rubber band by checking Don’t update
rubber band during node editing.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. However, in the Digitizing menu under the Settings →
Options menu, you can also activate:

• Suppress attributes pop-up windows after each created feature to avoid the form opening

• or Reuse last entered attribute values to have fields automatically filled at the opening of the form and
just have to type changing values.

With the Move Feature(s) icon on the toolbar, you can move existing features.

Strumento vertici

For shapefile-based or MapInfo layers as well as SpatiaLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle

Spatial tables, the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It
is possible to simply select multiple vertices at once and to move, add or delete them altogether. The node tool
also works with ‘on the fly’ projection turned on and supports the topological editing feature. This tool is, unlike
other tools in QGIS, persistent, so when some operation is done, selection stays active for this feature and tool.
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Figure 12.68: Enter Attribute Values Dialog after digitizing a new vector feature

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero. Otherwise, QGIS will not be able to tell which vertex is being edited and will display a warning.

Suggerimento: Indicatori dei vertici
The current version of QGIS supports three kinds of vertex markers: ‘Semi-transparent circle’, ‘Cross’ and ‘None’.
To change the marker style, choose Options from the Settings menu, click on the Digitizing tab and select the
appropriate entry.

Operazioni di base

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl when clicking to toggle the selection state of vertices (vertices
that are currently unselected will be selected as usual, but also vertices that are already selected will become
unselected).

• Adding vertices: To add a vertex, simply double click near an edge and a new vertex will appear on the
edge near to the cursor. Note that the vertex will appear on the edge, not at the cursor position; therefore, it
should be moved if necessary.

• Deleting vertices: Select the vertices and click the Delete key. Deleting all the vertices of a feature
generates, if compatible with the datasource, a geometryless feature. Note that this doesn’t delete the

complete feature, just the geometry part; To delete a complete feature use the Delete Selected tool.

• Moving vertices: Select all the vertices you want to move, click on a selected vertex or edge and drag in the
direction you wish to move. All the selected vertices will move together. If snapping is enabled, the whole
selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Suggerimento: Move features with precision

The Move Feature tool doesn’t currently allow to snap features while moving. Using the Node Tool, select
ALL the vertices of the feature, click a vertex, drag and snap it to a target vertex: the whole feature is moved and
snapped to the other feature.
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The Vertex Editor

With activating the Node Tool on a feature, QGIS opens the Vertex Editor panel listing all the vertices of the
feature with their x, y (z, m if applicable) coordinates and r (for the radius, in case of circular geometry). Simply
select a row in the table does select the corresponding vertex in the map canvas, and vice versa. Simply change
a coordinate in the table and your vertex position is updated. You can also select multiple rows and delete them
altogether.

Figure 12.69: Vertex editor panel showing selected nodes

Tagliare, copiare ed incollare elementi

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Suggerimento: Transform polygon into line and vice-versa using copy/paste
Copy a line feature and paste it in a polygon layer: QGIS pastes in the target layer a polygon whose boundary
corresponds to the closed geometry of the line feature. This is a quick way to generate different geometries of the
same data.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format. WKT features from outside QGIS
can also be pasted to a layer within QGIS.

When would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer
at a time and copy/paste features between layers. Why would we want to do this? Say we need to do some work
on a new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer
and use copy/paste to plop the needed lakes into it.

As an example, we will copy some lakes to a new layer:

1. Caricare il layer dal quale vogliamo copiare gli elementi (layer sorgente)

2. Caricare o creare il layer nel quale vogliamo incollare gli elementi copiati (layer di destinazione)

3. Impostare entrambi i layer in modalità modifica

4. Rendere attivo il layer sorgente cliccando sul relativo nome nella legenda

5. Use the Select Features by area or single click tool to select the feature(s) on the source layer

6. Click on the Copy Features tool

12.6. Modifica 165



QGIS User Guide, Release 2.14

7. Rendere attivo il layer di destinazione cliccando sul relativo nome nella legenda

8. Click on the Paste Features tool

9. Terminare le modifiche e salvare

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - the feature
and its attributes - gets copied, make sure the schemas match.

Nota: Congruenza degli elementi incollati
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However, if the destination layer is a different projection, then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.

Suggerimento: Copy string attribute into another
If you have created a new column in your attribute table with type ‘string’ and want to paste values from another
attribute column that has a greater length the length of the column size will be extended to the same amount. This
is because the GDAL Shapefile driver starting with GDAL/OGR 1.10 knows to auto-extend string and integer
fields to dynamically accommodate for the length of the data to be inserted.

Cancellare elementi selezionati

If we want to delete an entire feature (attribute and geometry), we can do that by first selecting the geometry using

the regular Select Features by area or single click tool. Selection can also be done from the attribute table. Once you

have the selection set, press Delete or Backspace key or use the Delete Selected tool to delete the features.
Multiple selected features can be deleted at once.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So, we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

Salvare i layer modificati

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g., disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

Suggerimento: Integrità dei dati
It is always a good idea to back up your data source before you start editing. While the authors of QGIS have
made every effort to preserve the integrity of your data, we offer no warranty in this regard.
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Saving multiple layers at once

This feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all changes

you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that the

digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers, Cancel
for Selected Layer(s) is an easy way.

The same functions are available for editing all layers of the project.

12.6.4 Digitalizzazione avanzata

Icona Azione Icona Azione

Enable Advanced Digitizing Tools Enable Tracing

Annulla Ripristina

Ruota elemento/i Semplifica geometrie

Aggiungi buco Aggiungi una parte

Fill Ring Elimina buco

Elimina parte Modifica la forma

Curva di offset Spezza elemento

Split Parts Unisci le geometrie selezionate

Unisci gli sttributi delle geometrie selezionate Ruota i simboli per i punti

Barra degli strumenti di digitalizzazione avanzata

Annullare e rispristinare

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_4). This widget is not displayed by
default; it can be displayed by right clicking on the toolbar and activating the Undo/Redo checkbox. Undo/Redo
is however active, even if the widget is not displayed.

Figure 12.70: Redo and Undo digitizing steps

When Undo is hit or Ctrl+z (or Cmd+z) pressed, the state of all features and attributes are reverted to the
state before the reverted operation happened. Changes other than normal vector editing operations (for example,
changes done by a plugin) may or may not be reverted, depending on how the changes were performed.
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To use the undo/redo history widget, simply click to select an operation in the history list. All features will be
reverted to the state they were in after the selected operation.

Ruota elemento/i

Use Rotate Feature(s) to rotate one or multiple features in the map canvas. Press the Rotate Feature(s) icon and
then click on the feature to rotate. Either click on the map to place the rotated feature or enter an angle in the user
input widget. If you want to rotate several features, they shall be selected first.

If you enable the map tool with feature(s) selected, its (their) centroid appears and will be the rotation anchor
point. If you want to move the anchor point, hold the Ctrl button and click on the map to place it.

If you hold Shift before clicking on the map, the rotation will be done in 45 degree steps, which can be modified
afterwards in the user input widget.

To abort feature rotation, you need to click on Rotate Feature(s) icon.

Semplifica geometrie

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
remains valid. With the tool you can also simplify many features at once or multi-part features.

First, click on the feature or drag a rectangle over the features. A dialog where you can define a tolerance in map
units, layer units or pixels pops up and a colored and simplified copy of the feature(s), using the given
tolerance, appears over them. QGIS calculates the amount of vertices that can be deleted while maintaining the
geometry. The higher the tolerance is the more vertices can be deleted. When the expected geometry fits your
needs just click the [OK] button. The tolerance you used will be saved when leaving a project or when leaving an
edit session. So you can go back to the same tolerance the next time when simplifying a feature.

To abort feature simplification, you need to click on Simplify Feature icon.

Nota: unlike the feature simplification option in Settings → Options → Rendering menu which simplifies the

geometry just for rendering, the Simplify Feature tool really modifies feature’s geometry in data source.

Aggiungi una parte

You can Add Part to a selected feature generating a multipoint, multiline or multipolygon feature. The new part
must be digitized outside the existing one which should be selected beforehand.

The Add Part can also be used to add a geometry to a geometryless feature. First, select the feature in the
attribute table and digitize the new geometry with the Add Part tool.

Elimina parte

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). This tool works with all multi-part geometries: point, line and polygon. Furthermore, it can be used to
totally remove the geometric component of a feature. To delete a part, simply click within the target part.
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Aggiungi buco

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.

Fill Ring

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Using this tool, you simply have to digitize a polygon within an existing one. Thus you need not first use the
Add Ring icon and then the Add feature function anymore.

Elimina buco

The Delete Ring tool allows you to delete rings within an existing polygon, by clicking inside the hole. This
tool only works with polygon and multi-polygon features. It doesn’t change anything when it is used on the outer
ring of the polygon.

Modifica la forma

You can reshape line and polygon features using the Reshape Features icon on the toolbar. It replaces the line or
polygon part from the first to the last intersection with the original line. With polygons, this can sometimes lead
to unintended results. It is mainly useful to replace smaller parts of a polygon, not for major overhauls, and the
reshape line is not allowed to cross several polygon rings, as this would generate an invalid polygon.

Per modificare, ad esempio, il bordo di un poligono basta cliccare un primo punto all’interno del poligono, cliccare
un secondo punto all’esterno del poligono, tracciare il profilo della nuova forma, rientrare nel poligono e cliccare
con il tasto destro del mouse per terminare l’operazione. Lo strumento aggiungerà automaticamente nuovi nodi
laddove la nuova linea interseca il bordo del poligono. È, inoltre, possibile rimuovere parte di un poligono in-
iziando la nuova linea all’esterno del poligono, aggiungendo vertici all’interno e terminando la linea all’esterno
con il tasto destro del mouse.

Nota: The reshape tool may alter the starting position of a polygon ring or a closed line. So, the point that is
represented ‘twice’ will not be the same any more. This may not be a problem for most applications, but it is
something to consider.

Dividere elementi

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the edited layer). It is thus ideally suited for the creation of distance line layers. The User Input dialog
pops-up, showing the displacement distance.

To create a shift of a line layer, you must first go into editing mode and activate the Offset Curve tool. Then click
on a feature to shift it. Move the mouse and click where wanted or enter the desired distance in the user input

widget. Your changes may then be saved with the Save Layer Edits tool.

QGIS options dialog (Digitizing tab then Curve offset tools section) allows you to configure some parameters
like Join style, Quadrant segments, Miter limit.
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Spezza elemento

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.

Split parts

In QGIS it is possible to split the parts of a multi part feature so that the number of parts is increased. Just draw a

line across the part you want to split using the Split Parts icon.

Unire elementi

The Merge Selected Features tool allows you to merge features. A new dialog will allow you to choose which value
to choose between each selected features or select a function (Minimum, Maximum, Median, Sum, Skip Attribute)
to use for each column. If features don’t have a common boundaries, a multipolygon will be created.

Unire attributi di elementi

The Merge Attributes of Selected Features tool allows you to apply same attributes to features without merging their

boundaries. First, select several features. Then press the Merge Attributes of Selected Features button. Now QGIS asks
you which attributes are to be applied to all selected objects. As a result, all selected objects have the same attribute
entries.

Ruota i simboli per i punti

Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. You must first define
a rotation column from the attribute table of the point layer in the Advanced menu of the Style menu of the Layer

Properties. Also, you will need to go into the ‘SVG marker’ and choose Data defined properties .... Activate
Angle and choose ‘rotation’ as field. Without these settings, the tool is inactive.

Figure 12.71: Ruota i simboli per i punti

To change the rotation, select a point feature in the map canvas and rotate it, holding the left mouse button pressed.
A red arrow with the rotation value will be visualized (see Figure_edit_5). When you release the left mouse button
again, the value will be updated in the attribute table.

Nota: Se si tiene premuto il tasto Ctrl, la rotazione avverrà per step di 15 gradi.
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Automatic Tracing

Usually, when using capturing map tools (add feature, add part, add ring, reshape and split), you need to click
each vertex of the feature.

Using the automatic tracing mode you can speed up the digitization process. Enable the Tracing tool by pushing
the icon or pressing t key and snap to a vertex or segment of a feature you want to trace along. Move the mouse
over another vertex or segment you’d like to snap and instead of an usual straight line, the digitizing rubber band
represents a path from the last point you snapped to the current position. QGIS actually uses the underlying
features topology to build the shortest path between the two points. Click and QGIS places the intermediate
vertices following the path. You no longer need to manually place all the vertices during digitization.

Tracing requires snapping to be activated in traceable layers to build the path. You should also snap to an existing
vertex or segment while digitizing and ensure that the two nodes are topologically connectable following existing
features, otherwise QGIS is unable to connect them and thus traces a single straight line.

Nota: Adjust map scale or snapping settings for an optimal tracing
If there are too many features in map display, tracing is disabled to avoid potentially long tracing structure prepa-
ration and large memory overhead. After zooming in or disabling some layers the tracing is enabled again.

Suggerimento: Quickly enable or disable automatic tracing by pressing t key
By pressing t key, tracing can be enabled/disabled anytime even while digitizing one feature, so it is possible to
digitize some parts of the feature with tracing enabled and other parts with tracing disabled. Tools behave as usual
when tracing is disabled.

12.6.5 The Advanced Digitizing panel

When capturing new geometries or geometry parts you also have the possibility to use the Advanced Digitizing
panel. You can digitize lines exactly parallel or at a specific angle or lock lines to specific angles. Furthermore
you can enter coordinates directly so that you can make a precise definition for your new geometry.

Figure 12.72: The Advanced Digitizing panel

Nota: The tools are not enabled if the map view is in geographic coordinates.

12.6.6 Creating new Vector layers

QGIS allows you to create new shapefile layers, new SpatiaLite layers, new GPX layers and New Temporary
Scratch Layers. Creation of a new GRASS layer is supported within the GRASS plugin. Please refer to section
Creare un nuovo layer vettoriale GRASS for more information on creating GRASS vector layers.
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Creare un nuovo Shapefile

To create a new shape layer for editing, choose New → New Shapefile Layer... from the Layer menu. The
New Vector Layer dialog will be displayed as shown in Figure_edit_6. Choose the type of layer (point, line or
polygon) and the CRS (coordinate reference system).

Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

Figure 12.73: Creating a new Shapefile layer Dialog

To complete the creation of the new shapefile layer, add the desired attributes by clicking on the [Add to attributes
list] button and specifying a name and type for the attribute. A first ‘id’ column is added as default but can be

removed, if not wanted. Only Type: real , Type: integer , Type: string and Type:date
attributes are supported. Additionally and according to the attribute type, you can also define the width and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the shapefile. QGIS will automatically add a .shp extension to the name you specify. Once the layer has been
created, it will be added to the map, and you can edit it in the same way as described in section Modifica di un
layer esistente above.

Creare un nuovo layer SpatiaLite

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_edit_7.

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
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Figure 12.74: Creating a New SpatiaLite layer Dialog
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attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Modifica di un layer esistente above.

Further management of SpatiaLite layers can be done with the DB Manager. See Plugin DB Manager.

Creating a new GPX layer

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, you can choose where to save the new GPX layer.

Creating a new Temporary Scratch Layer

Empty, editable memory layers can be defined using Layer → Create Layer → New Temporary Scratch Layer.
Here you can even create Multipoint, Multiline and Multipolygon Layers beneath Point, Line and

Polygon Layers. Temporary Scratch Layers are not saved and will be discarded when QGIS is closed. See also
Paste into new layer.

12.7 Layer virtuali

Un tipo speciale di vettore ti consente di definire un layer come il risultato di un’interrogazione avanzata, utiliz-
zando il linguaggio SQL su tutti i vettori che QGIS è in grado di aprire. Questi layer sono chiamati layer virtuali:
non caricano dati propri e possono essere visti come una visualizzazione di altri layer.

12.7.1 Creare un layer virtuale

Apri la finestra di creazione di layer virtuale cliccando su Aggiungi layer virtuale in menù Layer o dalla barra
degli strumenti corrispondente.

La finestra di dialogo ti consente di specificare un’interrogazione SQL. Questa interrogazione può utilizzare il
nome (o id) dei vettori esistenti, così come i nomi dei campi di layer.

Ad esempio, se disponi di un vettore denominato regions, puoi creare un nuovo layer virtuale con una
query SQL come SELECT * FROM regions WHERE id < 100. L’interrogazione SQL verrà eseguito,
qualunque sia la struttura di base del vettore regions e anche se questo struttura di base non supporta diretta-
mente le query SQL.

Puoi creare unioni e interrogazioni complesse usando direttamente i nomi dei layer che devono essere uniti.

12.7.2 Linquaggi supportati

Il motore di base utilizza SQLite e SpatiaLite per operare.

Significa che puoi usare tutte le SQL comprensibili alla tua installazione locale di SQLite.

Puoi usare funzioni di SQLite e anche funzioni spaziali da SpatiaLite in un’interrgogazione di layer virtuale. Per
esempio, la creazione di un layer di punti da uno di un solo attributo può essere fatto con una interrogazione tipo:
SELECT id, MakePoint(x, y, 4326) as geometry FROM coordinates

Puoi usare Funzioni del Calcolatore QGIS in un interrogazione per layer virtuale.

Per riferirti alla colonna del dato spaziale, usa il nome geometry.
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Contrariamente a una semplice interrogazione SQL, tutti i campi di una interrogazione per layer virtuale devono
essere nominati. Non dimenticarti di utilizzare la parola chiave as per dare un nome alle colonne se sono il
risultato di una chiamata o di una funzione di calcolo.

12.7.3 Questioni

Con parametri predefiniti, il motore del layer virtuale proverà a rilevare il tipo delle diverse colonne
dell’interrogazione, incluso il tipo di colonna geometria se presente.

Questo viene fatto analizando l’interrogazione se possibile o recuperando la prima riga dell’interrogazione (LIMIT
1) in ultima istanza. Il recupero della prima riga del risultato per creare lo strato può essere indesiderabile per
motivi di prestazioni.

La finestra per creare un layer virtuale ti permette di specificare diversi parametri.

• colonna univoca: questa opzione ti permette di specificare quale campo dell’interrogazione rappresenta
i valori interi univoci che QGIS può utilizzare come identificatore di riga. Per default, viene utilizzato
un valore intero autoincrementale. Specificando una colonna identificatore univoco potrai velocizzare la
selezione di righe.

• nessuna geometria: questa opzione forza il layer virtuale a ignorare qualsiasi campo geometria. Il layer
risultante sarà solamente un layer tabella.

• colonna geometrie*: qusta opzione ti permette di identificare la colonna spaziale del layer.

• Tipo: qusta opzione ti permette di specificare il tipo spaziale del layer virtuale.

• CR: quest’opzione ti permette di specificare il sistema di riferimento delle coordinate del layer virtuale.

12.7.4 Commenti

The virtual layer engine tries to determine the type of each column of the query. If it fails, the first row of the
query is fetched to determine column types.

Puoi specificare direttamente nell’interrogazione il tipo di una particolare colonna usando qualche commento
speciale.

La sintassi è la seguente: /*:type*/. Devi metterlo subito dopo il nome della colonna. type può essere int
per interi, real per numeri a virgola mobile o text.

Per esempio: SELECT id+1 as nid /*:int*/ FROM table

Puoi anche impostare il tipo e il sistema di riferimento delle coordinate della colonna geometria con commenti spe-
ciali con la seguente sintassi /*:gtype:srid*/‘ dove gtype è il tipo spaziale (point, linestring, polygon,
multipoint, multilinestring o multipolygon) e srid un intero rappresentante il codice EPSG del
sistema di riferimento delle coordinate.

12.7.5 Uso degli indici

Nel costruire un layer virtuale, puoi usare gli indici nei seguenti modi:

• Se usi un comando = su una colonna chiave del layer, i dati forniti si baseranno su un particolare id (Filter-
Fid)

• per gli altri comandi (>, <=, !=, etc.) o su una colonna senza chiave, puoi usare una richiesta costruita da
un’espressione per richiedere i dati al vettore di partenza. Ciò significa che puoi usare gli indici, se esistono,
sul database di partenza.

Esiste una sintassi specifica per gestire predicati spaziali e attivare l’uso di un indice spaziale: per
ogni layer virtuale esiste una colonna nascosta denominata _search_frame_. Questa colonna
può essere paragonato ad un rettangolo di selezione. Esempio: select * from vtab where
_search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)
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Comandi spaziali binari come ST_Intersects sono molto accellerati se usati assieme con gli indici spaziali
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CHAPTER 13

Lavorare con i dati raster

13.1 Lavorare con i dati raster

This section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including ArcInfo Binary Grid, ArcInfo ASCII Grid, GeoTIFF, ERDAS IMAGINE, and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

Attualmente, la libreria GDAL supporta più di 100 formati raster (vedi GDAL-SOFTWARE-SUITE Letteratura e
riferimenti web). La lista completa è disponibile alla pagina web http://www.gdal.org/formats_list.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL installation of your OS may not have been built to support the format you want
to use. Only those formats that have been well tested will appear in the list of file types when loading a raster into
QGIS. Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

Per caricare e lavorare con dati raster di GRASS, fai riferimento alla sezione Integrazione con GRASS GIS.

13.1.1 Cosa sono i dati raster?

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid is the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

13.1.2 Loading raster data in QGIS

Raster layers are loaded either by clicking on the Add Raster Layer icon or by selecting the Layer → Add
Raster Layer menu option. More than one layer can be loaded at the same time by holding down the Ctrl or
Shift key and clicking on multiple items in the Open a GDAL Supported Raster Data Source dialog.

Una volta caricato il raster puoi cliccare sul suo nome nella legenda con il tasto destro del mouse per selezionare
ed attivare opzioni specifiche, o per aprire la finestra per l’impostazione delle proprietà.

Menu contestuale per layer raster

• Zoom all’estensione del layer
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• Zoom alla scala migliore (100%)

• Stira usando l’estensione attuale

• Aggiungi alla panoramica

• Rimuovi

• Duplica

• Set Layer CRS

• Imposta il SR del progetto dal layer

• Salva come ...

• Proprietà

• Rinomina

• Copia lo stile

• Add New Group

• Espandi tutto

• Comprimi tutto

• Aggiorna l’ordine del disegno

13.2 Proprietà raster

Per visualizzare ed impostare le proprietà di un raster, fai doppio click sul nome del raster nella legenda o cliccaci
sopra con il tasto destro e scegli Proprietà dal menu contestuale. Si aprirà cosi la finestra di dialogo Proprietà del
layer (vedi figure_raster_1).

Ci sono diversi menu nella finestra di dialogo:

• Generale

• Stile

• Trasparenza

• Piramidi

• Istogramma

• Metadati

13.2.1 Menu Generale

Informazioni del layer

Il menu Generale contiene informazioni basilari del raster selezionato, inclusa la sorgente del file, il nome visual-
izzato nella legenda (che puoi modificare) e il numero di colonne, righe e valori nulli.

Sistema Riferimento Coordinate

Qui puoi trovare il sistema di riferimento spaziale (SR) visualizzato in formato stringa PROJ.4. Se l’impostazione
non è corretta la puoi modificare con il pulsante [Specifica].
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Figure 13.1: Finestra di dialogo proprietà del raster

Visibilità dipendente dalla scala

In questo menu puoi attivare la funzione che imposta la visibilità del raster in funzione della scala. Spuntando la
casella di controllo puoi impostare l’intervallo di scala in cui vuoi che il raster venga visualizzato nella mappa.

Nella parte inferiore puoi vedere un’anteprima del raster, la sua simbologia e la tavolozza.

13.2.2 Menu Stile

Visualizzazione banda

QGIS offre quattro Tipo visualizzazione. La scelta dipende dal tipo di dato.

1. Colori banda multipla - se il file è caricato come multibanda e ha diverse bande di colori (per esempio
un’immagine satellitare con molte bande diverse)

2. Tavolozza - se un file ha una tavolozza indicizzata (per esempio una mappa topografica digitale)

3. Banda singola grigia - l’immagine verrà visualizzata come grigia; QGIS sceglierà questa visualizzazione
se il file non dispone né di una banda multipla né di una tavolozza indicizzata o continua (per esempio,
utilizzata per una mappa del rilievo ombreggiata)

4. Banda singola falso colore - puoi usare questo visualizzatore per i file che hanno una tavolozza continua o
una mappa di colore (per esempio una mappa delle altimetrie)

Colori banda multipla

Con il visualizzatore colore banda multipla verranno visualizzate le tre bande selezionate dell’immagine, ognuna
delle quali corrisponde alle componenti rosso, verde e blu che verranno usate per creare i colori dell’immagine
stessa. Puoi scegliere fra diversi metodi di Miglioramento contrasto: ‘Nessun miglioramento’, ‘Stira a MinMax’,
‘Stira e taglia a MinMax’ e ‘Taglia a MinMax’.

Questa sscelta ti offre una vasta gamma di opzioni per modificare l’aspetto del tuo raster. Innanzitutto, devi avere
l’intervallo di dati dalla tua immagine. Puoi farlo scegliendo Extent e premendo [Carica]. QGIS può usare come
:guilabel: Accuratezza il Min e il :guilabel: Max dei valori delle bande Stimato (più veloce) o :guilabel:
Attuale (più lento)

Ora puoi scalare i colori con l’aiuto della sezione Carica i valori min/max. Molte immagini hanno alcuni dati
molto bassi e elevati. Puoi eliminare questi valori anomali usando il Taglio complessivo’. L’intervallo pre-
definito è impostato da 2% a 98% è può essere adattato manualmente. Con questa impostazione, il carattere
grigio dell’immagine può scomparire. Con l’opzione di scala |radioButtonOff| :guilabel:‘Min/max, QGIS crea
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Figure 13.2: Visualizzazione raster - Colori banda multipla
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una tabella di colore con tutti i dati inclusi nell’immagine originale (ad esempio, QGIS crea una tabella di colore
con 256 valori, disponendo di bande a 8 bit). Puoi inoltre calcolare la tabella dei colori utilizzando Media +/-
deviazione standard x . Quindi, solo i valori all’interno della deviazione standard o all’interno di più devi-
azioni standard sono considerati per la tabella dei colori. Questo è utile quando si dispone di una o due celle con
valori anormalmente elevati in una griglia raster che hanno un impatto negativo sulla visualizzazione del raster.

Puoi elaborare tutto con l’estensione Current.

Suggerimento: Visualizzare una singola banda di un raster multibanda
Se vuoi vedere solamente una banda singola di un’immagine multibanda (per esempio, rossa) potresti pensare di
impostare le bande verde e blu come “Non impostato”. Ma questo non è il miglior modo di agire. Per visualizzare
la banda rossa, seleziona il visualizzatore ‘Banda grigia singola’ e poi seleziona il rosso come colore da usare al
posto del grigio.

Tavolozza

Questa è l’opzione normale di visualizzazione i file a banda singola che includono già una tabella di colori, dove
ad ogni valore di pixel viene assegnato un determinato colore. In questo caso, la tavolozza viene visualizzata
automaticamente. Se vuoi modificare i colori assegnati a determinati valori, basta fare doppio click sul colore e
viene visualizzata la finestra di dialogo Scegli colore. Inoltre, in QGIS puoi assegnare un’etichetta ai valori di
colore. L’etichetta compare quindi nella leggenda dello strato raster.

Figure 13.3: Visualizzatore raster - Tavolozza

Miglioramento contrasto

Nota: When adding GRASS rasters, the option Contrast enhancement will always be set automatically to stretch
to min max, regardless of if this is set to another value in the QGIS general options.
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Banda singola grigia

This renderer allows you to render a single band layer with a Color gradient: ‘Black to white’ or ‘White to black’.
You can define a Min and a Max value by choosing the Extent first and then pressing [Load]. QGIS can
Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Figure 13.4: Raster Renderer - Singleband gray

With the Load min/max values section, scaling of the color table is possible. Outliers can be eliminated using the
Cumulative count cut setting. The standard data range is set from 2% to 98% of the data values and can be

adapted manually. With this setting, the gray character of the image can disappear. Further settings can be made
with Min/max and Mean +/- standard deviation x . While the first one creates a color table with
all of the data included in the original image, the second creates a color table that only considers values within
the standard deviation or within multiple standard deviations. This is useful when you have one or two cells with
abnormally high values in a raster grid that are having a negative impact on the rendering of the raster.

Banda singola falso colore

This is a render option for single-band files, including a continuous palette. You can also create individual color
maps for the single bands here. Sono disponibili tre tipologie di interpolazione di colore:

1. Discreto

2. Lineare

3. Esatto

In the left block, the button Add values manually adds a value to the individual color table. The button
Remove selected row deletes a value from the individual color table, and the Sort colormap items button sorts the color
table according to the pixel values in the value column. Double clicking on the value column lets you insert a
specific value. Double clicking on the color column opens the dialog Change color, where you can select a color
to apply on that value. Further, you can also add labels for each color, but this value won’t be displayed when you

use the identify feature tool. You can also click on the button Load color map from band, which tries to load the table

from the band (if it has any). And you can use the buttons Load color map from file or Export color map to file to load
an existing color table or to save the defined color table for other sessions.

In the right block, Generate new color map allows you to create newly categorized color maps. For the Classi-

fication mode ‘Equal interval’, you only need to select the number of classes and press the button

Classify. You can invert the colors of the color map by clicking the Invert checkbox. In the case of the Mode
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Figure 13.5: Raster Renderer - Singleband pseudocolor
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‘Continous’, QGIS creates classes automatically depending on the Min and Max. Defining Min/Max values
can be done with the help of the Load min/max values section. A lot of images have a few very low and high data.
These outliers can be eliminated using the Cumulative count cut setting. The standard data range is set from
2% to 98% of the data values and can be adapted manually. With this setting, the gray character of the image can
disappear. With the scaling option Min/max, QGIS creates a color table with all of the data included in the
original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8 bit bands). You can
also calculate your color table using the Mean +/- standard deviation x . Then, only the values within
the standard deviation or within multiple standard deviations are considered for the color table.

Visualizzazione colore

Per ogni Visualizzazione banda, è disponibile una Visualizzazione colore.

Puoi anche ottenere effetti speciali per i tuoi raster usando una delle modalità fusione (vedi Proprietà dei vettori).

Further settings can be made in modifying the Brightness, the Saturation and the Contrast. You can also use a
Grayscale option, where you can choose between ‘By lightness’, ‘By luminosity’ and ‘By average’. For one hue
in the color table, you can modify the ‘Strength’.

Ricampionamento

La sezione Ricampionamento ha effetto quando ingrandisci o rimpicciolisci l’immagine. I metodi di ricampiona-
mento ottimizzano l’aspetto della mappa perché calcolano una nuova matrice di grigi attraverso una trasformazione
geometrica.

Figure 13.6: Raster Rendering - Resampling

Applicando il metodo ‘vicino più prossimo’ la mappa potrebbe avere una struttura con molti pixel quando viene
ingrandita. Questo aspetto può essere migliorato usando i metodi ‘Bilineare’ o ‘Cubico’ perché creano delle
geometrie più appuntite e offuscate. Il risultato è un’immagine più morbida. Puoi applicare questo metodo, per
esempio, a mappe raster topografiche.

13.2.3 Menu Trasparenza

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible though the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

Inoltre puoi inserire nel menu Valori nulli aggiuntivi un valore che deve essere trattato come Valore nullo.
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Puoi definire la trasparenza in maniera ancora più dettagliata e personalizzata nella sezione Opzioni di trasparenza
personalizzate, nella quale puoi impostare il grado di trasparenza di ogni singola cella (o pixel).

As an example, we want to set the water of our example raster file landcover.tif to a transparency of 20%.
The following steps are necessary:

1. Carica il file

2. Apri la finestra di dialogo Proprietà facendo doppio click sul nome del raster nella legenda o cliccando su
di esso con il tasto destro del mouse e scegliendo Proprietà dal menu contestuale.

3. Seleziona il menu Trasparenza.

4. Scegli ‘Nessuno’ dal menu Banda trasparenza.

5. Click the Add values manually button. A new row will appear in the pixel list.

6. Inserisci il valore nelle colonne ‘Da’ e ‘A’ (nell’esempio viene usato 0) e aggiusta la trasparenza al 20%.

7. Clicca sul pulsante [Applica] per visualizzare il risultato.

Ripeti i passaggi 5 e 6 per aggiustare più valori con trasparenze personalizzate.

As you can see, it is quite easy to set custom transparency, but it can be quite a lot of work. Therefore, you

can use the button Export to file to save your transparency list to a file. The button Import from file loads your
transparency settings and applies them to the current raster layer.

13.2.4 Menu Piramidi

Large resolution raster layers can slow navigation in QGIS. By creating lower resolution copies of the data (pyra-
mids), performance can be considerably improved, as QGIS selects the most suitable resolution to use depending
on the level of zoom.

Per creare piramidi devi avere i permessi di scrittura nella cartella contenente il dato originale: in questa cartella
verranno salvate le copie a bassa risoluzione.

Sono disponibili i seguenti metodi di ricampionamento:

• Vicino più prossimo (metodo Nearest Neighbour)

• Media

• Gauss

• Cubico

• Modo

• Nessuno

If you choose ‘Internal (if possible)’ from the Overview format menu, QGIS tries to build pyramids internally.
You can also choose ‘External’ and ‘External (Erdas Imagine)’.

La costruzione delle piramidi può alterare il dato originale in maniera irreversibile, quindi ti raccomandiamo di
fare una copia del raster originale prima di eseguire l’operazione.

13.2.5 Menu Istogramma

The Histogram menu allows you to view the distribution of the bands or colors in your raster. The histogram is
generated automatically when you open the Histogram menu. All existing bands will be displayed together. You

can save the histogram as an image with the button. With the Visibility option in the Prefs/Actions menu,
you can display histograms of the individual bands. You will need to select the option Show selected band.
The Min/max options allow you to ‘Always show min/max markers’, to ‘Zoom to min/max’ and to ‘Update style
to min/max’. With the Actions option, you can ‘Reset’ and ‘Recompute histogram’ after you have chosen the
Min/max options.
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Figure 13.7: The Pyramids Menu

Figure 13.8: Raster Histogram
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13.2.6 Menu Metadati

La scheda Metadati mostra una serie di informazioni sul raster, incluse le statistiche di ogni banda. Da questo menu
hai accesso a diverse sezioni: Descrizione, Assegnazione, URL Metadati e Proprietà. Nella sezione Proprietà le
statistiche sono ottenute da una base ‘che si deve ancora conoscere’, quindi è meglio che le statistiche di questo
raster non siano ancora state calcolate.

Figure 13.9: Raster Metadata

13.3 Analisi raster

13.3.1 Raster Calculator

The Raster Calculator in the Raster menu allows you to perform calculations on the basis of existing raster pixel
values (see figure_raster_10). The results are written to a new raster layer with a GDAL-supported format.

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

In the Result layer section, you will need to define an output layer. You can then define the extent of the calculation
area based on an input raster layer, or based on X,Y coordinates and on columns and rows, to set the resolution of
the output layer. If the input layer has a different resolution, the values will be resampled with the nearest neighbor
algorithm.

The Operators section contains all available operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Stay tuned for more operators to come!

With the Add result to project checkbox, the result layer will automatically be added to the legend area and
can be visualized.

Examples

Convert elevation values from meters to feet
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Figure 13.10: Raster Calculator
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Creating an elevation raster in feet from a raster in meters, you need to use the conversion factor for meters to feet:
3.28. The expression is:

"elevation@1" * 3.28

Using a mask

If you want to mask out parts of a raster – say, for instance, because you are only interested in elevations above 0
meters – you can use the following expression to create a mask and apply the result to a raster in one step.

("elevation@1" >= 0) * "elevation@1"

In other words, for every cell greater than or equal to 0, set its value to 1. Otherwise set it to 0. This creates the
mask on the fly.

If you want to classify a raster – say, for instance into two elevation classes, you can use the following expression
to create a raster with two values 1 and 2 in one step.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

In other words, for every cell less than 50 set its value to 1. For every cell greater than or equal 50 set its value to
2.

13.3.2 Raster Alignment

This tool is able to take several rasters as input and to align them perfectly, that means:

• reproject to the same CRS,

• resample to the same cell size and offset in the grid,

• clip to a region of interest,

• rescale values when required.

All rasters will be saved in another files.

First, open the tools from Raster → Align Raster... and click on the Add new raster button to choose one existing
raster in QGIS. Select an output file to save the raster after the alignment, the resampling method and if the tools

need to Rescale values according to the cell size. You can Edit file settings and Remove an existing file from the list.

Then in the main Align raster window, you can choose one or more options:

• Select the Reference Layer,

• Transform into a new CRS,

• Setup a different Cell size,

• Setup a different Grid Offset,

• Clip to Extent,

• Output Size,

• Add aligned raster to the map canvas.
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CHAPTER 14

Lavorare con i dati OGC

14.1 QGIS as OGC Data Client

L’Open Geospatial Consortium (OGC), è un’organizzazione internazionale che raggruppa più di 300 organiz-
zazioni commerciali, governative, no-profit ed enti di ricerca. I suoi membri sviluppano e implementano standard
per contenuti e servizi geospaziali, analisi GIS e scambio dati.

OGC ha elaborato un numero crescente di specifiche per la descrizione di un modello dati di base per elementi
geografici: le specifiche sono orientate a garantire l’interoperabilità nell’ambito della tecnologia geospaziale.
Ulteriori informazioni all’indirizzo http://www.opengeospatial.org/.

Important OGC specifications supported by QGIS are:

• WMS — Web Map Service (Client WMS/WMTS)

• WMTS — Web Map Tile Service (Client WMS/WMTS)

• WFS — Web Feature Service (Client WFS e WFS-T)

• WFS-T — Web Feature Service - Transactional (Client WFS e WFS-T)

• WCS — Web Coverage Service (Client WCS)

• SFS — Simple Features for SQL (Vettori PostGIS)

• GML — Geography Markup Language

OGC services are increasingly being used to exchange geospatial data between different GIS implementations and
data stores. QGIS can deal with the above specifications as a client, being SFS (through support of the PostgreSQL
/ PostGIS data provider, see section Vettori PostGIS).

14.1.1 Client WMS/WMTS

Panoramica sul servizio WMS

QGIS currently can act as a WMS client that understands WMS 1.1, 1.1.1 and 1.3 servers. In particular, it has
been tested against publicly accessible servers such as DEMIS.

A WMS server acts upon requests by the client (e.g., QGIS) for a raster map with a given extent, set of layers,
symbolization style, and transparency. The WMS server then consults its local data sources, rasterizes the map,
and sends it back to the client in a raster format. For QGIS, this format would typically be JPEG or PNG.

WMS is generically a REST (Representational State Transfer) service rather than a full-blown Web service. As
such, you can actually take the URLs generated by QGIS and use them in a web browser to retrieve the same
images that QGIS uses internally. This can be useful for troubleshooting, as there are several brands of WMS
server on the market and they all have their own interpretation of the WMS standard.

I layer WMS possono essere aggiunti molto semplicemente, una volta disponibile l’indirizzo (URL) per accedere
al server WMS, una connessione adatta e posto che il server usi HTTP come meccanismo di trasferimento dati.
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Additionally, QGIS will cache your WMS responses (i.e. images) for 24h as long as the GetCapabilities request is
not triggered. The GetCapabilities request is triggered everytime the [Connect] button in the [Add layer(s) from
WMS(T)S Server] dialog is used to retrieve the WMS server capabilities. This is an automatic feature meant to
optimize project loading time. If a project is saved with a WMS layer, the corresponding WMS tiles will be loaded
from the cache the next time the project is opened as long as they are no older than 24H.

Panoramica sul servizio WMTS

QGIS can also act as a WMTS client. WMTS is an OGC standard for distributing tile sets of geospatial data.
This is a faster and more efficient way of distributing data than WMS because with WMTS, the tile sets are pre-
generated, and the client only requests the transmission of the tiles, not their production. A WMS request typically
involves both the generation and transmission of the data. A well-known example of a non-OGC standard for
viewing tiled geospatial data is Google Maps.

Per visualizzare i dati a diverse scale, l’insieme delle mattonelle WMTS vengono prodotte con scale molto differ-
enti fra loro in modo che per il client GIS sia più facile effettuare la richiesta.

Questo diagramma mostra il concetto delle mattonelle:

Figure 14.1: Concetto dell’insieme delle mattonelle WMTS

The two types of WMTS interfaces that QGIS supports are via Key-Value-Pairs (KVP) and RESTful. These two
interfaces are different, and you need to specify them to QGIS differently.

1. In order to access a WMTS KVP service, a QGIS user must open the WMS/WMTS interface and add the
following string to the URL of the WMTS tile service:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un esempio di questo tipo di indirizzo è:

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Per vedere se il layer topo2 funziona correttamente in questo WMTS, aggiungi la stringa indicata che il
servizio WMTS deve usare al posto del servizio WMS.

2. Il servizio RESTful WMTS segue un modulo diverso, ovvero un URL diretto. Il formato raccomandato da
OGC è:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

This format helps you to recognize that it is a RESTful address. A RESTful WMTS is accessed in QGIS by
simply adding its address in the WMS setup in the URL field of the form. An example of this type of address
for the case of an Austrian basemap is http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.
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Nota: You can still find some old services called WMS-C. These services are quite similar to WMTS (i.e., same
purpose but working a little bit differently). You can manage them the same as you do WMTS services. Just add
?tiled=true at the end of the url. See http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification for more
information about this specification.

Quando leggi WMTS, puoi anche pensare a WMS-C.

Selezionare server WMS/WMTS

The first time you use the WMS feature in QGIS, there are no servers defined.

Begin by clicking the Add WMS layer button on the toolbar, or selecting Layer → Add WMS Layer....

Si aprirà la finestra di dialogo: Aggiungi Layer da server. Puoi aggiungere alcuni server cliccando sul pulsante
[Aggiungi server predefiniti]. Verranno quindi aggiunti due server WMS, il server DM Solutions Group ed
il server Lizardtech. Per definire un nuovo server WMS nella sezione Layer, clicca sul pulsante [Nuovo] ed
inserisci i parametri di connessione del server WMS desiderato, seguendo le indicazioni della tabella _OGC_1_:

Nome Un nome per la connessione. Questo nome verrà utilizzato nel menù a tendina dei server in
modo da distinguere i vari server WMS.

URL URL del server che fornisce i dati. Deve essere un indirizzo raggiungibile nello stesso
formato che verrebbe usato per aprire una connessione telnet o pingare un host.

Username Nome utente per accedere un WMS protetto. Questo parametro è opzionale.
Password Password per accedere ad un WMS protetto. Questo parametro è opzionale.

Ignora URI
GetMap

Ignora la URI GetMap riportata nelle capabilities. Viene utilizzato l’URI del campo
URL precedente.

Ignora URI
GetFeature-
Info

Ignora la URI GetFeatureInfo riportata nelle capabilities. Viene utilizzato l’URI del
campo URL precedente

Table OGC 1: Parametri di connessione WMS

If you need to set up a proxy server to be able to receive WMS services from the internet, you can add your proxy
server in the options. Choose Settings → Options and click on the Network & Proxy tab. There, you can add your

proxy settings and enable them by setting Use proxy for web access. Make sure that you select the correct

proxy type from the Proxy type drop-down menu.

Once the new WMS server connection has been created, it will be preserved for future QGIS sessions.

Suggerimento: A PROPOSITO DI INDIRIZZI DEI SERVER WMS

Quando inserisci l’indirizzo URL del server assicurati di usare l’indirizzo di base. Ad esempio non devi inserire
frammenti tipo request=GetCapabilities o version=1.0.0 nell’indirizzo.

Avvertimento: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See ref:authentication_index for more details.

Caricare layer WMS/WMTS

Una volta riempiti tutti i campi dei parametri richiesti, usa il pulsante [Connetti] per caricare le capabilities dei
server selezionati. Queste includono: le codifiche delle immagini, i layer, gli stili e le proiezioni. Dal momento
che è un operazione eseguita in rete, la velocità di esecuzione dipende dalla velocità della tua connessione. Mentre
vengono scaricati i dati dal server WMS, puoi vedere l’avanzamento nella parte inferiore della finestra di dialogo.
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Il vostro schermo adesso dovrebbe essere simile a quello rappresentato nella figura_OGR_1, che mostra la risposta
fornita dal server WMS dell’European Soil Portal.

Figure 14.2: Dialog for adding a WMS server, showing its available layers

Codifica immagine

La sezione Codifica immagine elenca i formati supportati sia dal client che dal server. La scelta è in funzione dei
requisiti di accuratezza.

Suggerimento: Codifica immagine
Un server WMS offre normalmente la scelta fra immagini JPEG o PNG. Il formato JPEG è un formato di com-
pressione lossy, mentre il formato PNG riproduce fedelmente i dati raster.

È meglio usare il formato JPEG per dati di natura fotografica e/o se la perdita parziale di qualità dell’immagine non
causa problemi. Questa scelta riduce normalmente di cinque volte il volume di dati trasferiti rispetto al formato
PNG.

L’uso del formato PNG permette una visualizzazione più precisa ed è da usare se non ci sono problemi per
l’incremento dei dati trasferiti.

Opzioni

La sezione Opzioni mette a disposizione il campo testo Nome layer per dare un nome al layer WMS. Questo nome
apparirà nella legenda a caricamento avvenuto.

Sotto il nome del layer puoi scegliere la Dimensione delle tile, (per esempio 256x256) in modo da dividere la
richiesta WMS in richieste multiple.
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Il campo Limite di elementi per GetFeatureInfo definisce quali elementi del server interrogare.

Selezionando un layer WMS dalla lista apparirà un campo con il sistema di proiezione predefinito dal server. Se
il pulsante [Cambia...] è attivo, allora puoi scegliere un altro SR fornito dal server.

Finally you can activate Use contextual WMS-Legend if the WMS Server supports this feature. Then only the
relevant legend for your current map view extent will be shown and thus will not include legend items for things
you can’t see in the current map.

Ordine dei Layer

La scheda Ordine layer elenca i diversi layer disponibili sul server WMS a cui sei connesso. Puoi notare che
alcuni layer sono espandibili; questo significa che puoi visualizzare quei layer con diversi stili di immagine.

You can select several layers at once, but only one image style per layer. When several layers are selected, they
will be combined at the WMS server and transmitted to QGIS in one go.

Suggerimento: Ordine dei layer WMS
I layer WMS caricati sono sovrapposti in base all’ordine in cui sono elencati nella sezione Layer, ovvero dall’alto
verso il basso. Se vuoi cambiare l’ordine di visualizzazione, usa la scheda Ordine layer.

Trasparenza

In this version of QGIS, the Global transparency setting from the Layer Properties is hard coded to be always on,
where available.

Suggerimento: Trasparenza dei layer WMS
La possibilità di rendere trasparenti i layer WMS dipende dalla codifica tramite la quale sono stati caricati: PNG
e GIF gestiscono la trasparenza mentre il JPEG no.

Sistema di Riferimento

A coordinate reference system (CRS) is the OGC terminology for a QGIS projection.

Ogni layer WMS può avere diversi SR, in funzione delle capacità del server.

Per scegliere uno dei SR disponibili, clicca su [Cambia...] per fare apparire una finestra simile a quella della
figura 3 in Lavorare con le proiezioni. La differenza principale è che saranno mostrati solo i SR supportati dal
server al quale sei connesso.

Ricerca Server

Within QGIS, you can search for WMS servers. Figure_OGC_2 shows the Server Search tab with the Add Layer(s)
from a Server dialog.

As you can see, it is possible to enter a search string in the text field and hit the [Search] button. After a short
while, the search result will be populated into the list below the text field. Browse the result list and inspect your
search results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS
list] button and change back to the Layers tab. QGIS has automatically updated your server list, and the selected
search result is already enabled in the list of saved WMS servers in the Layers tab. You only need to request the list
of layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.

Si tratta fondamentalmente di un front end alle API di http://geopole.org.

Set di tile

Quando usi servizi WMTS (Cached WMS) come

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities
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Figure 14.3: Dialog for searching WMS servers after some keywords

you are able to browse through the Tilesets tab given by the server. Additional information like tile size, formats
and supported CRS are listed in this table. In combination with this feature, you can use the tile scale slider by
selecting Settings → Panels (KDE) or View → Panels (Gnome, Windows and MacOSX), then choosing Tile Scale
Panel. This gives you the available scales from the tile server with a nice slider docked in.

Uso dello strumento di identificazione

Once you have added a WMS server, and if any layer from a WMS server is queryable, you can then use the
Identify tool to select a pixel on the map canvas. A query is made to the WMS server for each selection made. The
results of the query are returned in plain text. The formatting of this text is dependent on the particular WMS
server used. Selezione formato

Se il server supporta diversi formati in output, un menu a tendina verrà automaticamente aggiunto alla finestra
delle informazioni risultati in modo che i diversi formati possano essere memorizzati nel progetto. Supporto
formato GML

The Identify tool supports WMS server response (GetFeatureInfo) in GML format (it is called Feature in the
QGIS GUI in this context). If “Feature” format is supported by the server and selected, results of the Identify tool
are vector features, as from a regular vector layer. When a single feature is selected in the tree, it is highlighted
in the map and it can be copied to the clipboard and pasted to another vector layer. See the example setup of the
UMN Mapserver below to support GetFeatureInfo in GML format.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):
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# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Proprietà del server

Una volta aggiunto un server WMS, puoi visualizzarne le proprietà cliccando con il tasto destro sul suo nome
nella legenda e selezionando Proprietà. Scheda Metadati

La scheda Metadati mostra molte informazioni sul server WMS: queste informazioni sono fornite dal server
stesso in risposta alla richiesta di GetCapabilities fatta da QGIS. Puoi ricavare molte informazioni leggendo gli
standard WMS (vediOPOPEN-GEOSPATIAL-CONSORTIUM Letteratura e riferimenti web). Di seguito alcune
definizioni utili:

• Proprietà del server

– Versione WMS — La versione WMS supportata dal server.

– Image Formats — The list of MIME-types the server can respond with when drawing the map.
QGIS supports whatever formats the underlying Qt libraries were built with, which is typically at least
image/png and image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently, QGIS supports the text-plain type.

• Propertà layer

– Selezionato — Indica se il layer era selezionato quando il server è stato aggiunto al progetto.

– Visible — Whether or not this layer is selected as visible in the legend (not yet used in this version of
QGIS).

– Può interrogare —Indica se il layer fornisce o meno informazioni se si usa lo strumento Informazioni
elementi.

– Can be Transparent — Whether or not this layer can be rendered with transparency. This version of
QGIS will always use transparency if this is Yes and the image encoding supports transparency.

– Can Zoom In — Whether or not this layer can be zoomed in by the server. This version of QGIS
assumes all WMS layers have this set to Yes. Deficient layers may be rendered strangely.

– Conteggio a cascata — I server WMS possono fungere da proxy per altri server WMS dai quali
ottengono i dati raster per un certo layer. La voce mostra quindi quante richieste per questo layer
vengono inoltrate ai nodi per ottenere un risultato.

– Fixed Width, Fixed Height — Whether or not this layer has fixed source pixel dimensions. This
version of QGIS assumes all WMS layers have this set to nothing. Deficient layers may be rendered
strangely.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g., UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.
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– Disponibilità in CRS — Sistemi di riferimento nel quale il layer può essere rappresentato dal server
WMS, elencati nel formato nativo WMS.

– Disponibile in stile — Stili visuali applicabili al layer dal server WMS.

Mostra la legenda WMS nella legenda e nel compositore di stampe

The QGIS WMS data provider is able to display a legend graphic in the table of contents’ layer list and in the
map composer. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and
the layer has getCapability url specified, so you additionally have to select a styling for the layer.

Se legendGraphic è disponibile, viene mostrato sotto il layer. È piuttosto piccolo e dovrai cliccarci sopra per
aprirlo nelle dimensioni reali (fatto dovuto alle limitazioni QgsLegendInterface). Cliccando sulla legenda del
layer si aprirà una finestra con la legenda alla massima risoluzione.

In the print composer, the legend will be integrated at it’s original (downloaded) dimension. Resolution of the
legend graphic can be set in the item properties under Legend –> WMS LegendGraphic to match your printing
requirements

La legenda mostrerà informazioni contestuali riferite alla scala attuale. La legenda WMS verrà mostrata solo se
il server WMS ha le capability GetLegendGraphic e se il layer ha le capability dell’url getCapability specificate,
cosi puoi anche scegliere uno stile per il layer.

Limitazioni del client WMS

Not all possible WMS client functionality had been included in this version of QGIS. Some of the more noteworthy
exceptions follow.

Modificare le impostazioni del layer WMS

Once you’ve completed the Add WMS layer procedure, there is no way to change the settings. A work-around is
to delete the layer completely and start again.

Server WMS che richiedono un’autenticazione

Attualmente sono accessibili server pubblici e server protetti. Puoi accedere ai server protetti con autenticazione
pubblica. Puoi aggiungere le credenziali (opzionali) quando carichi un server WMS. Vedi sezione Selezionare
server WMS/WMTS per ulteriori dettagli.

Suggerimento: Accesso ai layer OCG protetti
Se devi accedere a layer protetti con password, puoi usare InteProxy come proxy trasparente, che supporta molti
metodi di autenticazione diversi. Ulteriori informazioni sono disponibili nel manuale di InteProxy nel sito web
http://inteproxy.wald.intevation.org.

Suggerimento: WMS Mapserver QGIS
Since Version 1.7.0, QGIS has its own implementation of a WMS 1.3.0 Mapserver. Read more about this in
chapter QGIS as OGC Data Server.

14.1.2 Client WCS

Un servizio WCS fornisce accesso a dati raster che sono utili per la visualizzazione lato client, come input
per modelli scientifici e per molti altri usi. Quali sono le caratteristiche che distinguono un servizio WCS dai
servizi WFS e WMS? Mentre i servizi WFS e WMS sono istanze server, il servizio WCS permette al client di
scegliere le porzioni di server che contengono le informazioni desiderate. Queste informazioni possono essere
filtrate attraverso limiti spaziali o altre tipologie di interrogazioni.
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QGIS has a native WCS provider and supports both version 1.0 and 1.1 (which are significantly different), but
currently it prefers 1.0, because 1.1 has many issues (i.e., each server implements it in a different way with various
particularities).

The native WCS provider handles all network requests and uses all standard QGIS network settings (especially
proxy). It is also possible to select cache mode (‘always cache’, ‘prefer cache’, ‘prefer network’, ‘always net-
work’), and the provider also supports selection of time position, if temporal domain is offered by the server.

Avvertimento: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See ref:authentication_index for more details.

14.1.3 Client WFS e WFS-T

In QGIS, a WFS layer behaves pretty much like any other vector layer. You can identify and select features, and
view the attribute table. Since QGIS 1.6, editing WFS-T is also supported.

Normalmente la procedura per l’aggiunta di un layer WFS è molto simile a quella vista per i WMS. La differenza
sta nel fatto che non ci sono server predefiniti, quindi devi aggiungere manualmente i server noti.

Caricare un layer WFS

Come esempio puoi caricare il server WFS DM Solutions e visualizzare un layer. L’indirizzo da inserire è:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Clicca sullo strumento Aggiungi layer WFS nella barra dei layer ed apparirà la finestra di dialogo Aggiungi
layer WFS da server.

2. Clicca su [Nuovo].

3. Inserisci il nome ‘DM Solutions’.

4. Inserisci l’indirizzo precedentemente indicato.

5. Clicca su [OK].

6. Choose ‘DM Solutions’ from the Server Connections drop-down list.

7. Clicca su [Connetti].

8. Aspetta che vengano caricati tutti i layer.

9. Seleziona dalla lista il layer Parks.

10. Clicca su [Applica] per aggiungere il layer alla mappa.

Ogni impostazione proxy presente nelle preferenze viene automaticamente riconosciuta.

Avvertimento: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See ref:authentication_index for more details.

You’ll notice the download progress is visualized in the lower left of the QGIS main window. Once the layer is
loaded, you can identify and select a province or two and view the attribute table.

Questo significa che attualmente è supportato solo WFS 1.0.0. Al momento non ci sono stati ancora molti test
relativi a versioni di WFS basate su altri server. In caso di problemi con il plugin, non esitare a contattare il team
di sviluppo. Vedi la sezione Aiuto e supporto per ulteriori informazioni sulle mailinglist.

Suggerimento: Cercare server WFS
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Figure 14.4: Adding a WFS layer

You can find additional WFS servers by using Google or your favourite search engine. There are a number of lists
with public URLs, some of them maintained and some not.

14.2 QGIS as OGC Data Server

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, im-
plements advanced cartographic features for thematic mapping. The QGIS Server is a FastCGI/CGI (Common
Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd).
It has Python plugin support allowing for fast and efficient development and deployment of new features. The
original development of QGIS Server was funded by the EU projects Orchestra, Sany and the city of Uster in
Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS.

In the following sections, we will provide a sample configuration to set up a QGIS Server on Debian/Ubuntu
Linux. For user contributed installation instructions on other platforms or distributions, we recommend reading
one of the following URLs:

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://www.itopen.it/qgis-server-python-plugins-ubuntu-setup/

14.2.1 QGIS Server installation on Debian/Ubuntu

At this point, we will give a short and simple sample installation how-to for a minimal working configuration using
Apache2 on Debian Squeeze (or with negligible variations on Ubuntu 14.04). Many other OSs provide packages
for QGIS Server, too. If you have to build it all from source, please refer to the URLs above.

Firstly, add the following debian GIS repository:
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$ cat /etc/apt/sources.list.d/debian-gis.list
deb http://qgis.org/debian trusty main
deb-src http://qgis.org/debian trusty main

$ # Add keys
$ sudo gpg --keyserver keyserver.ubuntu.com --recv-key 3FF5FFCAD71472C4
$ sudo gpg --export --armor 3FF5FFCAD71472C4 | sudo apt-key add -

$ # Update package list
$ sudo apt-get update && sudo apt-get upgrade

Now, install QGIS Server:

$ sudo apt-get install qgis-server python-qgis

Installation of a HelloWorld example plugin for testing the servers. You create a directory to hold server plugins.
This will be specified in the virtual host configuration and passed on to the server through an environment variable:

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
$ # In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer

Install the Apache server in a separate virtual host listening on port 80. Enable the rewrite module to pass HTTP
BASIC auth headers:

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

This is the virtual host configuration, stored in /etc/apache2/sites-available/001-qgis-server.conf
:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
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Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>

Now enable the virtual host and restart Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Test the server with the HelloWorld plugin:

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

You can have a look at the default GetCapabilities of the QGIS server at:
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

Suggerimento: If you work with a feature that has many nodes then modifying and adding a new feature will
fail. In this case it is possible to insert the following code into the 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

14.2.2 Creating a WMS/WFS/WCS server from a QGIS project

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.

Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

Avvertimento: If you’re using the QGIS project with styling based on SVG files using relative paths then you
should know that the server considers the path relative to its qgis_mapserv.fcgi file (not to the qgs file). So, if
you deploy a project on the server and the SVG files are not placed accordingly, the output images may not
respect the Desktop styling. To ensure this doesn’t happen, you can simply copy the SVG files relative to the
qgis_mapserv.fcgi. You can also create a symbolic link in the directory where the fcgi file resides that points
to the directory containing the SVG files (on Linux/Unix).

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRSs from the Coordinate Reference System Selector, or click Used to
add the CRSs used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetProjectSettings response, and
they can be used by the GetPrint request to create prints, using one of the print composer layouts as a template.
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Figure 14.5: Definitions for a QGIS Server WMS/WFS/WCS project
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This is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries.

You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format chosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of its attributes, this information will also be shown
in the GetFeatureInfo output.

QGIS supports the following requests for WMS service:

• GetCapabilities

• GetMap

• GetFeatureInfo

• GetLegendGraphic (SLD profile)

• DescribeLayer (SLD profile)

• GetStyles (custom QGIS profile)

WFS capabilities

In the WFS capabilities area you can select the layers you want to publish as WFS, and specify if they will allow
update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS capabilities
section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

QGIS supports the following requests for WFS service:

• GetCapabilities

• DescribeFeatureType

• GetFeature

• Transaction

WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Salva la sessione nel file di progetto alaska.qgs. Per fornire il progetto come WMS/WFS, devi creare
un’altra cartella /usr/lib/cgi-bin/project con privilegi di amministrazione e aggiungere il file di pro-
getto alaska.qgs e una copia del file qgis_mapserv.fcgi. Questo è tutto!

Now we test our project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in Caricare layer
WMS/WMTS, Client WFS e WFS-T and Client WCS to QGIS and load the data. The URL is:

204 Chapter 14. Lavorare con i dati OGC



QGIS User Guide, Release 2.14

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

QGIS supports the following requests for WCS service:

• GetCapabilities

• DescribeCoverage

• GetCoverage

GetCapabilities Caching

In order to improve response time, QGIS Server caches the responses to the GetCapabilities requests.
When such a request comes, QGIS Server is caching the response and marking the cache valid. At the same time,
it watches if the project file changes. If the project is changed then the cache is marked as invalid and QGIS Server
waits for a new request in order to recreate the cache.

OWS impostato correttamente

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you don’t want a
specific attribute to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See the Annotation Tools section in Strumenti generali for instructions on creating annotations.
For annotations to be displayed as watermarks on the WMS output, the Fixed map position check box in the
Annotation text dialog must be unchecked. This can be accessed by double clicking the annotation while one of
the annotation tools is active. For SVG annotations, you will need either to set the project to save absolute paths
(in the General menu of the Project → Project Properties dialog) or to manually modify the path to the SVG
image so that it represents a valid relative path.

14.2.3 Server configuration and supported parameters

QGIS Server supports some vendor parameters and requests that greatly enhance the possibilities of customising
its behavior. The following paragraphs list the vendor parameters and the environment variables supported by the
server.

Extra parameters supported by all request types

• FILE_NAME parameter: if set, the server response will be sent to the client as a file attachment with the
specified file name.

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.

Esempio:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

Nota: You can define a QGIS_PROJECT_FILE as an environment variable to tell the server executable where
to find the QGIS project file. This variable will be the location where QGIS will look for the project file. If not
defined it will use the MAP parameter in the request and finally look at the server executable directory.
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Parametri extra supportati dalla richiesta WMS GetMap

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OGC WMS 1.3.0 specification:

• Parametri DPI: puoi usare i parametri DPI per specificare la risoluzione di output.

Esempio:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• parametro OPACITÀ: puoi impostare l’opacità per un singolo layer o per un gruppo di layer. I valori vanno
da 0 (completamente trasparente) a 255 (completamente opaco).

Esempio:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

• FILTER parameter: (Available in QGIS 1.8 and above). Subsets of layers can be selected with the
FILTER parameter. Syntax is basically the same as for the QGIS subset string. However, there
are some restrictions to avoid SQL injections into databases via QGIS server:

Text strings need to be enclosed with quotes (single quotes for strings, double quotes for attributes)
A space between each word / special character is mandatory. Allowed Keywords and special char-
acters are ‘AND’,’OR’,’IN’,’=’,’<’,’>=’, ‘>’,’>=’,’!=*,’(‘,’)’. Semicolons in string expressions are not
allowed

Esempio:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&FILTER=mylayer1:"OBJECTID" = 3;mylayer2:’text’ = ’blabla’&....

Nota: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is
there. QGIS server then returns info about the matching features and generates a combined bounding box in the
xml output.

• SELECTION parameter: (Available in QGIS 1.8 and above) Vector features can be selected by passing
comma separated lists with feature ids in GetMap and GetPrint.

Esempio:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6&...

Extra parameters supported by the WMS GetFeatureInfo request

QGIS Server WMS GetFeatureInfo requests supports the following extra optional parameters to define the toler-
ance for point, line and polygon layers:

• FI_POINT_TOLERANCE parameter: Tolerance for point layers GetFeatureInfo request, in pixels.

• FI_LINE_TOLERANCE parameter: Tolerance for linestring layers GetFeatureInfo request, in pixels.

• FI_POLYGON_TOLERANCE parameter: Tolerance for polygon layers GetFeatureInfo request, in pixels.

GetPrint request

QGIS server has the capability to create print composer output in pdf or pixel format. Print composer windows
in the published project are used as templates. In the GetPrint request, the client has the possibility to specify
parameters of the contained composer maps and labels.

Example:

The published project has two composer maps. In the GetProjectSettings response, they are listed as possible print
templates:
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<WMS_Capabilities>
...
<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>
<ComposerMap width="49" height="46" name="map1"/></ComposerTemplate>
</ComposerTemplates>
...
</WMS_Capabilities>

The client has now the information to request a print output:

http://myserver.com/cgi/qgis_mapserv.fcgi?...&REQUEST=GetPrint&TEMPLATE=Druckzusammenstellung 1&map0:EXTENT=xmin,ymin,xmax,ymax&map0:ROTATION=45&FORMAT=pdf&DPI=300

Parameters in the GetPrint request are:

• <map_id>:EXTENT gives the extent for a composer map as xmin,ymin,xmax,ymax.

• <map_id>:ROTATION map rotation in degrees

• <map_id>:GRID_INTERVAL_X, <map_id>:GRID_INTERVAL_Y Grid line density for a composer
map in x- and y-direction

• <map_id>:SCALE Sets a mapscale to a composer map. This is useful to ensure scale based visibility of
layers and labels even if client and server may have different algorithms to calculate the scale denominator

• <map_id>:LAYERS, <map_id>:STYLES possibility to give layer and styles list for composer map (use-
ful in case of overview maps which should have only a subset of layers)

GetLegendGraphics request

Several additional parameters are available to change the size of the legend elements:

• BOXSPACE space between legend frame and content (mm)

• LAYERSPACE versical space between layers (mm)

• LAYERTITLESPACE vertical space between layer title and items following (mm)

• SYMBOLSPACE vertical space between symbol and item following (mm)

• ICONLABELSPACE horizontal space between symbol and label text (mm)

• SYMBOLWIDTH width of the symbol preview (mm)

• SYMBOLHEIGHT height of the symbol preview (mm)

These parameters change the font properties for layer titles and item labels:

• LAYERFONTFAMILY / ITEMFONTFAMILY font family for layer title / item text

• LAYERFONTBOLD / ITEMFONTBOLD ‘TRUE’ to use a bold font

• LAYERFONTSIZE / ITEMFONTSIZE Font size in point

• LAYERFONTITALIC / ITEMFONTITALIC ‘TRUE’ to use italic font

• LAYERFONTCOLOR / ITEMFONTCOLOR Hex color code (e.g. #FF0000 for red)

• LAYERTITLE / RULELABEL (from QGIS 2.4) set them to ‘FALSE’ to get only the legend graphics
without labels

Contest based legend. These parameters let the client request a legend showing only the symbols for the features
falling into the requested area:

• BBOX the geographical area for which the legend should be built

• CRS / SRS the coordinate reference system adopted to define the BBOX coordinates
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• WIDTH / HEIGHT if set these should match those defined for the GetMap request, to let QGIS Server
scale symbols according to the map view image size.

Contest based legend features are based on the UMN MapServer implementation:

GetProjectSettings request

This request type works similar to GetCapabilities, but it is more specific to QGIS Server and allows a client to
read additional information which is not available in the GetCapabilities output:

• initial visibility of layers

• information about vector attributes and their edit types

• information about layer order and drawing order

• list of layers published in WFS

DXF Export

It is possible to export layers in the DXF format using the GetMap Request. Only layers that have read access in
the WFS service are exported in the DXF format. Here is a valid REQUEST and a documentation of the available
parameters:

http://your.server.address/wms/liegenschaftsentwaesserung/abwasser_werkplan?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&LAYERS=Haltungen,Normschacht,Spezialbauwerke&STYLES=&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.25832905&WIDTH=1042&HEIGHT=811&FORMAT=application/dxf&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY;SCALE:250&FILE_NAME=werkplan_abwasser.dxf

Parameters:

• FORMAT=application/dxf

• FILE_NAME=yoursuggested_file_name_for_download.dxf

• FORMAT_OPTIONS=see options below, key:value pairs separated by Semicolon

FORMAT_OPTIONS Parameters:

• SCALE:scale to be used for symbology rules, filters and styles (not an actual scaling of the data - data
remains in the original scale).

• MODE:NOSYMBOLOGY|FEATURESYMBOLOGY|SYMBOLLAYERSYMBOLOGY corresponds
to the three export options offered in the QGIS Desktop DXF export dialog.

• LAYERSATTRIBUTES:yourcolumn_with_values_to_be_used_for_dxf_layernames - if not specified,
the original QGIS layer names are used.

• USE_TITLE_AS_LAYERNAME if enabled, the title of the layer will be used as layer name.

Extra parameters supported by the WFS GetFeature request

In the WFS GetFeature request, QGIS Server accepts two extra parameters in addition to the standard parameters
according to the OGC WFS 1.0.0 specification:

• GeometryName parameter: this parameter can be used to get the extent or the centroid as the geometry or
no geometry if none if used (ie attribute only). Allowed values are extent, centroid or none.

• StartIndex parameter: STARTINDEX is standard in WFS 2.0, but it’s an extension for WFS 1.0.0 which
is the only version implemented in QGIS Server. STARTINDEX can be used to skip some features in the
result set and in combination with MAXFEATURES will provide for the ability to use WFS GetFeature to
page through results. Note that STARTINDEX=0 means start with the first feature, skipping none.
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QGIS Server logging

To log requests sent to the server, set the following environment variables:

• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that the server has proper permis-
sions for writing to file. File should be created automatically, just send some requests to server. If it’s not
there, check permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. Available values are:

– 0 INFO (log all requests),

– 1 WARNING,

– 2 CRITICAL (log just critical errors, suitable for production purposes).

Esempio:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Nota:
• When using Fcgid module use FcgidInitialEnv instead of SetEnv!

• Server logging is also enabled if executable is compiled in release mode.

Short name for layers, groups and project

A number of elements have both a <Name> and a <Title>. The Name is a text string used for machine-to-
machine communication while the Title is for the benefit of humans.

For example, a dataset might have the descriptive Title “Maximum Atmospheric Temperature” and be requested
using the abbreviated Name “ATMAX”. User can already set title for layers, groups and project.

OWS name is based on the name used in layer tree. This name is more a label for humans than a name for
machine-to-machine communication.

QGIS Server supports:

• short name line edits to layers properties

• WMS data dialog to layer tree group (short name, title, abstract) By right clicking on a layer group and
selecting the Set Group WMS data option you will get:
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• short name line edits to project properties- add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*"
to short name line edit accessible through a static method

• add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*" to short name line edit accessible through a
static method

• add a TreeName element in the fullProjectSettings

If a short name has been set for layers, groups and project it is used by QGIS Sever as the layer name.

Connection to service file

In order to make apache aware of the PostgreSQL service file (see the Service connection file section) you need to
make your *.conf file look like:

SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
AllowOverride None

.....

Add fonts to your linux server

Keep in mind that you may use QGIS projects that point to fonts that may not exist by default on other machines.
This means that if you share the project, it may look different on other machines (if the fonts don’t exist on the
target machine).

In order to ensure this does not happen you just need to install the missing fonts on the target machine. Doing this
on desktop systems is usually trivial (double clicking the fonts).

For linux, if you don’t have a desktop environment installed (or you prefer the command line) you need to:

• On Debian based systems:

sudo su
mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/truetype/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v

• On Fedora based systems:

sudo su
mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v

Environment variables

You can configure some aspects of QGIS server by setting environment variables. For example, to set QGIS
server on Apache to use /path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

or, if using fcgi:
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FcgidInitialEnv QGIS_OPTIONS_PATH "/path/to/config/"

This is a list of the variables supported by QGIS server:

• QGIS_OPTIONS_PATH: Specifies the path to the directory with settings. It works the
same way as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini.

• QUERY_STRING: The query string, normally passed by the web server. This variable can be useful while
testing QGIS server binary from the command line.

• QGIS_PROJECT_FILE: the .qgs project file, normally passed as a parameter in the query string, you can
also set it as an environment variable (for example by using mod_rewrite Apache module).

• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that server has proper permissions
for writing to file. File should be created automatically, just send some requests to server. If it’s not there,
check permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. See QGIS Server logging

• MAX_CACHE_LAYERS: Specify the maximum number of cached layers (default: 100).

• DISPLAY: This is used to pass (fake) X server display number (needed on Unix-like systems).

• QGIS_PLUGINPATH: Useful if you are using Python plugins for the server, this sets the folder that is
searched for Python plugins.
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CHAPTER 15

Lavorare con i dati GPS

15.1 Plugin GPS

15.1.1 Cos’è un GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

15.1.2 Caricamento dei dati GPS da file

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, a button with a small handheld GPS
device will show up in the toolbar and in Layer → Create Layer → :

• GPS Tools

• Create new GPX Layer

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Dati campione for more informa-
tion about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS_1).

2. Navigare all’interno della cartella qgis_sample_data/gps/, selezionare il file GPX
national_monuments.gpx e cliccare [Apri].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.

Nota: GPS units allow you to store data in different coordinate systems. When downloading a GPX file
(from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX
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Figure 15.1: The GPS Tools dialog window

file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

15.1.4 Importare dati GPS

Per importare dei dati che non sono dei file GPX, utilizza lo strumento Importa altro file presente nella finestra
di dialogo degli Strumenti GPS. Qui, puoi scegliere il file da importare (e il formato del files), il tipo di dato da
estrarre da esso, dove vuoi salvare il file una volta convertito in GPX e il nome che vuoi dare al nuovo vettore.
Nota che non tutti i formati di dati GPS supportano tutti e tre i tipi di dato, così per alcuni formati potrai scegliere
solo uno e due tipi.

15.1.5 Scaricare dati GPS da un dispositivo

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use the
Download from GPS tab of the GPS Tools dialog (see Figure_GPS_2). Here, we select the type of GPS device,
the port that it is connected to (or USB if your GPS supports this), the feature type that you want to download, the
GPX file where the data should be stored, and the name of the new layer.

GPSBabel comunica con il GPS in base al tipo di dispositivo che viene selezionato nel menu. Se nessuna delle
opzioni disponibili è compatibile con il proprio dispositivo GPS è possibile creare un nuovo tipo (vedi sezione
:ref:‘defining-new-device).

La porta potrebbe essere il nome del file o qualche altro termine che il tuo sistema operativo riconosce come porta
fisica alla quale è connesso il dispositivo GPS. Essa potrebbe essere un’uscita USB, nel caso di dispositivi abilitati
per l’USB.

• Nei sistemi Linux è qualcosa di simile a /dev/ttyS0 or /dev/ttyS1

• In Windows è COM1 or COM2.

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.
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Figure 15.2: Lo strumento di scaricamento

15.1.6 Caricare dati GPS sul dispositivo

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

15.1.7 Definire un nuovo tipo di dispositivo

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type sarà sostituito da -w se stai scaricando dei waypoints, -r se stai scaricando delle routes e -t se stai
scaricando dei tracks. Queste sono le opzioni che comunicano a GPSBabel quali elementi scaricare.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

Il comando di upload è il comando che viene utilizzato per caricare dati sul dispositivo. Vengono utilizzati i stessi
tasti, ma %in è utilizzato per indicare il nome del file GPX che contiene il layer in caricamento, e %out viene
sostituito dal nome della porta.

Puoi avere maggiori informazioni su GPSBabel e sulle opzioni utilizzabili tramite linea di comando sul sito
http://www.gpsbabel.org.

Una volta che avrai creato una nuova periferica, essa apparirà nella lista dei dispositivi presente sia nella scheda
Scarica dal GPS sia nella scheda Carica sul GPS.
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15.1.8 Scaricare points/tracks dall’unità GPS

Come descritto nei paragrafi precedenti QGIS usa GPSBabel per scaricare punti/track direttamente nel progetto.
QGIS si configura con impostazioni predefinite per scaricare da dispositivi Garmin. Purtroppo vi è un bug #6318
<http://hub.qgis.org/issues/6318> che non permette di creare altre impostazioni, così al momento è llimitato solo
alle unità USB Garmi scaricare direttamente QGIS utilizzando gli strumenti GPS.

Garmin GPSMAP 60cs

MS Windows

Installare i drivers Garmin USB dal sito http://www8.garmin.com/support/download_details.jsp?id=591

Connettere l’unità. Aprire gli Strumenti GPS e impostare Periferica GPS=garmin serial‘ e‘‘Porta=usb:.
Riempire i campi :guilabel:‘Nome layer‘ and :guilabel:‘File di output‘.
A volte si possono avere dei problemi nel salvataggio dei dati in certe
cartelle, si consiglia di utilizzare un percorso del tipo ‘‘c:\temp.

Ubuntu/Mint GNU/Linux

Per prima cosa occorre risolvere un problema inerente i permessi di accesso alla periferica, seguendo quanto
scritto qui https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. Puoi provare a creare un file
/etc/udev/rules.d/51-garmin.rules contenente il seguente codice:

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

Successivamente occorre essere sicuri che il modulo del kernel ‘‘garmin_gps‘ non sia caricato

rmmod garmin_gps

e quindi puoi utilizzare gli strumenti GPS. Purtroppo sembra che ci sia un bug # 7182
<http://hub.qgis.org/issues/7182> _ e di solito QGIS si blocca più volte prima della fine.

Data logger BTGP-38KM (solo Bluetooth)

MS Windows

Il baco già discusso non consente di scaricare i dati tramite QGIS, per cui è necessario utilizzare GPSBabel dalla
riga di comando o tramite la sua interfaccia. Il comando da eseguire è

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Utilizzare lo stesso comando (o gli stessi parametri, se usate la GUI di GPSBabel). Su Linux potrebbe capitare di
vedere un messaggio tipo

skytraq: Too many read errors on serial port

Si tratta solo di spegnere e riaccendere il data logger e ritentare

BlueMax GPS-4044 datalogger (sia BT che USB)

MS Windows

Nota: Ha bisogno di installare i propri driver prima di essere utilizzato su Windows 7. Si veda il sito del
costruttore per il file corretto da scaricare.

Scaricando con GSPBabel, sia con USB che BT, si ottiene sempre un errore tipo

216 Chapter 15. Lavorare con i dati GPS

http://www8.garmin.com/support/download_details.jsp?id=591
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux


QGIS User Guide, Release 2.14

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsuccessfully with code 1

Ubuntu/Mint GNU/Linux

con USB

Dopo aver collecato il cavo, usare il comando dmesg per capire quale porta viene utilizzata, ad esempio
/dev/ttyACM3. Poi, come al solito, utilizzare GPSBabel dalla riga di comando o dalla GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Con Bluetooth

Utilizzare il Gestore di dispositivi Blueman per accoppiare il dispositivo e renderlo disponibile tramite una porta
di sistema, poio eserguire GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

15.2 Tracciamento live GPS

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

There are four possible screens in this GPS tracking window:

• GPS position coordinates and an interface for manually entering vertices and features

• GPS signal strength of satellite connections

• GPS polar screen showing number and polar position of satellites

• GPS options screen (see figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Avvertimento: If you want to record your position to the canvas, you have to create a new vector layer first
and switch it to editable status to be able to record your track.

15.2.1 Posizione e attributi aggiuntivi

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

15.2.2 Potenza del segnale GPS

Here, you can see the signal strength of the satellites you are receiving signals from.
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Figure 15.3: GPS tracking position and additional attributes

Figure 15.4: GPS tracking signal strength
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15.2.3 Finestra delle coordinate polari del GPS

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.

Figure 15.5: GPS tracking polar window

15.2.4 Opzioni GPS

In case of connection problems, you can switch between:

• Autodetect

• Internal

• Serial device

• gpsd (selecting the Host, Port and Device your GPS is connected to)

Cliccare nuovamente [Connect] per iniziare la connessione al ricevitore GPS.

You can activate Automatically save added features when you are in editing mode. Or you can activate
Automatically add points to the map canvas with a certain width and color.

Activating Cursor, you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.

Finally, you can activate Log file and define a path and a file where log messages about the GPS tracking are
logged.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

15.2.5 Connect to a Bluetooth GPS for live tracking

With QGIS you can connect a Bluetooth GPS for field data collection. To perform this task you need a GPS
Bluetooth device and a Bluetooth receiver on your computer.

At first you must let your GPS device be recognized and paired to the computer. Turn on the GPS, go to the
Bluetooth icon on your notification area and search for a New Device.
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Figure 15.6: GPS tracking options window
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On the right side of the Device selection mask make sure that all devices are selected so your GPS unit will
probably appear among those available. In the next step a serial connection service should be available, select it
and click on [Configure] button.

Remember the number of the COM port assigned to the GPS connection as resulting by the Bluetooth properties.

After the GPS has been recognized, make the pairing for the connection. Usually the authorization code is 0000.

Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

If QGIS can’t receive GPS data, then you should restart your GPS device, wait 5-10 seconds then try to connect
again. Usually this solution work. If you receive again a connection error make sure you don’t have another
Bluetooth receiver near you, paired with the same GPS unit.

15.2.6 Using GPSMAP 60cs

MS Windows

Easiest way to make it work is to use a middleware (freeware, not open) called GPSGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

As for Windows the easiest way is to use a server in the middle, in this case GPSD, so

sudo apt-get install gpsd

Then load the garmin_gps kernel module

sudo modprobe garmin_gps

And then connect the unit. Then check with dmesg the actual device being used bu the unit, for example
/dev/ttyUSB0. Now you can launch gpsd

gpsd /dev/ttyUSB0

And finally connect with the QGIS live tracking tool.

15.2.7 Using BTGP-38KM datalogger (only Bluetooth)

Using GPSD (under Linux) or GPSGate (under Windows) is effortless.

15.2.8 Using BlueMax GPS-4044 datalogger (both BT and USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.

Ubuntu/Mint GNU/Linux

For USB

The live tracking works both with GPSD
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gpsd /dev/ttyACM3

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/ttyACM3).

For Bluetooth

The live tracking works both with GPSD

gpsd /dev/rfcomm0

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/rfcomm0).
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Authentication System

16.1 Authentication System Overview

Figure 16.1: Anatomy of authentication system

16.1.1 Authentication database

The new authentication system stores authentication configurations in an SQLite database file located, by default,
at:

<user home>\.qgis2\qgis-auth.db

This authentication database can be moved between QGIS installations without affecting other current QGIS user
preferences, as it is completely separate from normal QGIS settings. A configuration ID (a random 7-character
alphanumeric string) is generated when initially storing a configuration to the database. This represents the con-
figuration, thereby allowing the ID to be stored in plain text application components, (such as project, plugin, or
settings files) without disclosure of its associated credentials.
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Nota: The parent directory of the qgis-auth.db can be set using the following environment variable,
QGIS_AUTH_DB_DIR_PATH, or set on the command line during launch with the --authdbdirectory
option.

16.1.2 Master password

To store or access sensitive information within the database, a user must define a master password. A new master
password is requested and verified when initially storing any encrypted data to the database. Only when sensitive
information is accessed is the user prompted for the master password, which is then cached for the remainder of
the session (until application is quit), unless the user manually chooses an action to clear its cached value. Some
instances of using the authentication system do not require input of the master password, such as when selecting an
existing authentication configuration, or applying a configuration to a server configuration (such as when adding
a WMS layer).

Figure 16.2: Input new master password

Nota: A path to a file containing the master password can be set using the following environment variable,
QGIS_AUTH_PASSWORD_FILE.

Managing the master password

Once set, the master password can be reset; the current master password will be needed prior to resetting. During
this process, there is an option to generate a complete backup of the current database.

Figure 16.3: Resetting master password

If the user forgets the master password, there is no way to retrieve or override it. There is also no means of
retrieving encrypted information without knowing the master password.

If a user inputs their existing password incorrectly three times, the dialog will offer to erase the database.
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Figure 16.4: Password prompt after three invalid attempts

16.1.3 Authentication Configurations

You can manage authentication configurations from Configurations in the Authentication tab of the QGIS Options
dialog (Settings → Options).

Figure 16.5: Configurations editor

Use the button to add a new configuration, the button to remove configurations, and the button to
modify existing ones.

The same type of operations for authentication configuration management (Add, Edit and Remove) can be done
when configuring a given service connection, such as configuring an OWS service connection. For that, there are
action buttons within the configuration selector for fully managing configurations found within the authentication
database. In this case, there is no need to go to the configurations in Authentication tab of QGIS options unless
you need to do more comprehensive configuration management.

When creating or editing an authentication configuration, the info required is a name, an authentication method
and any other info that the authentication method requires (see more about the available authentication types in
Authentication Methods).
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Figure 16.6: Adding config from within Configuration editor

Figure 16.7: WMS connection dialog showing [Add], [Edit], and [Remove] authentication configuration buttons

226 Chapter 16. Authentication System



QGIS User Guide, Release 2.14

16.1.4 Authentication Methods

Available authentications are provided by C++ plugins much in the same way data provider plugins are sup-
ported by QGIS. The method of authentication that can be selected is relative to the access needed for the re-
source/provider, e.g. HTTP(S) or database, and whether there is support in both QGIS code and a plugin. As such,
some authentication method plugins may not be applicable everywhere an authentication configuration selector is
shown. A list of available authentication method plugins and their compatible resource/providers can be accessed
going to Settings – > Option and, in the Authentication tab, click the Installed plugins button.

Figure 16.8: Available method plugins list

Plugins can be created for new authentication methods that do not require QGIS to be recompiled. Since the
support for plugins is currently (since QGIS 2.12) C++-only, QGIS will need to be restarted for the new dropped-
in plugin to become available to the user. Ensure your plugin is compiled against the same target version of QGIS
if you intend to add it to an existing target install.

Figure 16.9: Basic HTTP authentication configs

Nota: The Resource URL is currently an unimplemented feature that will eventually allow a particular configu-
ration to be auto-chosen when connecting to resources at a given URL.

16.1.5 Master Password and Auth Config Utilities

Under the Options menu (Settings → Options) in the Authentication tab, there are several utility actions to manage
the authentication database and configurations:

• Input master password — Opens the master password input dialog, independent of performing any auth db
command. Clear cached master password—Unsets the master password if it has been set via input dialog.
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Figure 16.10: PKI paths authentication configs

Figure 16.11: PKI PKCS#12 file paths authentication configs

Figure 16.12: Stored Identity authentication configs
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Figure 16.13: Utilities menu

Reset master password—Opens a dialog to change the master password (the current password must be
known) and optionally back up the current database.

• Clear cached authentication configurations — Clears the internal lookup cache for configurations used to
speed up network connections. This does not clear QGIS’s core network access manager’s cache, which
requires a relaunch of QGIS.

• Reset master password - Replaces the current master password for a new one. The current master password
will be needed prior to resetting and a backup of database can be done.

• Remove all authentication configurations — Clears the database of all configuration records, without re-
moving other stored records.

• Erase authentication database — Schedules a backup of the current database and complete rebuild of the
database table structure. These actions are scheduled for a later time, so as to ensure other operations like
project loading do not interrupt the operation or cause errors due to a temporarily missing database.

Figure 16.14: DB erase verification menu

16.1.6 Using authentication configurations

Typically, an authentication configuration is selected in a configuration dialog for a network services (such as
WMS). However, the selector widget can be embedded anywhere authentication is needed or in non-core func-
tionality, like in third-party PyQGIS or C++ plugins.

When using the selector, No authentication is displayed in the pop-up menu control when nothing is selected,
when there are no configurations to choose from, or when a previously assigned configuration can no longer be
found in the database. The Type and Id fields are read-only and provide a description of the authentication method
and the config’s ID respectively.

16.1.7 Python bindings

All classes and public functions have sip bindings, except QgsAuthCrypto, since management of the master
password hashing and auth database encryption should be handled by the main app, and not via Python. See
Security Considerations concerning Python access.

16.1. Authentication System Overview 229



QGIS User Guide, Release 2.14

Figure 16.15: Auth config selector with no autentication

Figure 16.16: Auth config selector with config selected

16.2 User Authentication Workflows

Figure 16.17: Generic user workflow

16.2.1 HTTP(S) authentication

One of the most common resource connections is via HTTP(S), e.g. web mapping servers, and authentication
method plugins often work for these types of connections. Method plugins have access to the HTTP request
object and can manipulate both the request as well as its headers. This allows for many forms of internet-based
authentication. When connecting via HTTP(S) using the standard username/password authentication method will
attempt HTTP BASIC authentication upon connection.
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Figure 16.18: Configuring a WMS connection for HTTP BASIC

16.2.2 Database authentication

Connections to database resources are generally stored as key=value pairs, which will expose usernames and
(optionally) passwords, if not using an authentication configuration. When configuring with the new auth system,
the key=value will be an abstracted representation of the credentials, e.g. authfg=81t21b9

16.2.3 PKI authentication

When configuring PKI components within the authentication system, you have the option of importing compo-
nents into the database or referencing component files stored on your filesystem. The latter may be useful if such
components change frequently, or where the components will be replaced by a system administrator. In either
instance you will need to store any passphrase needed to access private keys within the database.

All PKI components can be managed in separate editors within the Certificate Manager, which can be accessed
in the Authentication tab in QGIS Options dialog (Settings → Options) by clicking the [Manage certificates]
button.

In the Certificate manager, there are editors for Identities, Servers and Authorities. Each of these are contained
in their own tabs, and are described below in the order they are encountered in the workflow chart above. The tab
order is relative to frequently accessed editors once you are accustomed to the workflow.

Nota: Because all authentication system edits write immediately to the authentication database, there is no need
to click the Options dialog [OK] button for any changes to be saved. This is unlike other settings in the Options
dialog.

Authorities

You can manage available Certificate Authorities (CAs) from the Authorities tab in the Certificate manager from
the Authentication tab of the QGIS Options dialog.
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Figure 16.19: Configuring a Postgres SSL-with-PKI connection

As referenced in the workflow chart above, the first step is to import or reference a file of CAs. This step is
optional, and may be unnecessary if your PKI trust chain originates from root CAs already installed in your
operating system (OS), such as a certificate from a commercial certificate vendor. If your authenticating root CA
is not in the OS’s trusted root CAs, it will need to be imported or have its file system path referenced. (Contact
your system administrator if unsure.)

By default, the root CAs from your OS are available; however, their trust settings are not inherited. You should
review the certificate trust policy settings, especially if your OS root CAs have had their policies adjusted. Any
certificate that is expired will be set to untrusted and will not be used in secure server connections, unless you
specifically override its trust policy. To see the QGIS-discoverable trust chain for any certificate, select it and click

the Show information for certificate.

You can edit the trust policy for any selected certificate within the chain. Any change in trust policy to

a selected certificate will not be saved to the database unless the Save certificate trust policy change to database button is
clicked per selected certification. Closing the dialog will not apply the policy changes.

You can review the filtered CAs, both intermediate and root certificates, that will be trusted for secure connections

or change the default trust policy by clicking the Options button.

Avvertimento: Changing the default trust policy may result in problems with secure connections.

You can import CAs or save a file system path from a file that contains multiple CAs, or import individual CAs.
The standard PEM format for files that contain multiple CA chain certifications has the root cert at the bottom of
the file and all subsequently signed child certificates above, towards the beginning of the file.

The CA certificate import dialog will find all CA certificates within the file, regardless of order, and also offers the
option to import certificates that are considered invalid (in case you want to override their trust policy). You can
override the trust policy upon import, or do so later within the Authorities editor.
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Figure 16.20: PKI configuration workflow
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Figure 16.21: Opening the Certificate Manager

Figure 16.22: Authorities editor
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Figure 16.23: Certificate info dialog

Figure 16.24: Saving the trust policy changes

Figure 16.25: Authorities options menu
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Figure 16.26: Import certificates dialog

Nota: If you are pasting certificate information into the PEM text field, note that encrypted certificates are not
supported.

Identities

You can manage available client identity bundles from the Identities tab in the Certificate manager from the
Authentication tab of the QGIS Options dialog. An identity is what authenticates you against a PKI-enabled
service and usually consists of a client certificate and private key, either as separate files or combined into a single
“bundled” file. The bundle or private key is often passphrase-protected.

Once you have any Certificate Authorities (CAs) imported you can optionally import any identity bundles into the
authentication database. If you do not wish to store the identities, you can reference their component file system
paths within an individual authentication configuration.

When importing an identity bundle, it can be passphrase-protected or unprotected, and can contain CA certificates
forming a trust chain. Trust chain certifications will not be imported here; they can be added separately under the
Authorities tab.

Upon import the bundle’s certificate and private key will be stored in the database, with the key’s storage encrypted
using the QGIS master password. Subsequent usage of the stored bundle from the database will only require input
of the master password.

Personal identity bundles consisting of PEM/DER (.pem/.der) and PKCS#12 (.p12/.pfx) components are sup-
ported. If a key or bundle is passphrase-protected, the password will be required to validate the component prior
to import. Likewise, if the client certificate in the bundle is invalid (for example, its effective date has not yet
started or has elapsed) the bundle can not be imported.

16.2.4 Handling bad layers

Occasionally, the authentication configuration ID that is saved with a project file is no longer valid, possibly
because the current authentication database is different than when the project was last saved, or due to a credentials
mismatch. In such cases the Handle bad layers dialog will be presented upon QGIS launch.
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Figure 16.27: Identities editor

Figure 16.28: PEM/DER identity import
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Figure 16.29: PKCS#12 identity import

Figure 16.30: Handle bad layers with authentication
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If a data source is found to have an authentication configuration ID associated with it, you will be able to edit it.
Doing so will automatically edit the data source string, much in the same way as opening the project file in a text
editor and editing the string.

Figure 16.31: Edit bad layer’s authentication config ID

16.2.5 Changing authentication config ID

Occasionally, you will need to change the authenticationn configuration ID that is associated with accessing a
resource. There are instances where this is useful:

• Resource auth config ID is no longer valid - This can occur when you have switched auth databases add
need to align a new configuration to the ID already associated with a resource.

• Shared project files - If you intended to share projects between users, e.g. via a shared file server, you can
predefine a 7-character (containing a-z and/or 0-9) that is associated with the resource. Then, individual
users change the ID of an authentication configuration that is specific to their credentials of the resource.
When the project is opened, the ID is found in the authentication database, but the credentials are different
per user.

Figure 16.32: Changing a layer’s authentication config ID (unlocked yellow text field)
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Avvertimento: Changing the auth config ID is considered an advanced operation and should only be done
with full knowledge as to why it is necessary. This is why there is a lock button that needs clicked, to unlock
the ID’s text field prior to editing the ID.

16.2.6 QGIS Server support

When using a project file, with layers that have authentication configurations, as a basis for a map in QGIS Server,
there are a couple of additional setup steps necessary for QGIS to load the resources:

• Authentication database needs to be available

• Authentication database’s master password needs to be available

When instantiating the authentication system, Server will create or use qgis-auth.db in ~/.qgis2/ or the
directory defined by the QGIS_AUTH_DB_DIR_PATH environment variable. It may be that the Server’s user has
no HOME directory, in which case, use the environment variable to define a directory that the Server’s user has
read/write permissions and is not located within the web-accessible directories.

To pass the master password to Server, write it to the first line of file at a path on the file system readable by the
Server processes user and defined using the QGIS_AUTH_PASSWORD_FILE environment variable. Ensure to
limit the file as only readable by the Server’s process user and to not store the file within web-accessible directories.

Nota: QGIS_AUTH_PASSWORD_FILE variable will be removed from the Server environment immediately
after accessing

16.2.7 SSL server exceptions

Figure 16.33: SSL server exception

You can manage SSL server configurations and exceptions from the Servers tab in the Authentication section of
the QGIS Options dialog.

Sometimes, when connecting to an SSL server, there are errors with the SSL “handshake” or the server’s certifi-
cate. You can ignore those errors or create an SSL server configuration as an exception. This is similar to how
web browsers allow you to override SSL errors, but with more granular control.

Avvertimento: You should not create an SSL server configuration unless you have complete knowledge of
the entire SSL setup between the server and client. Instead, report the issue to the server administrator.

Nota: Some PKI setups use a completely different CA trust chain to validate client identities than the chain used
to validate the SSL server certificate. In such circumstances, any configuration created for the connecting server
will not necessarily fix an issue with the validation of your client identity, and only your client identity’s issuer or
server administrator can fix the issue.
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You can pre-configure an SSL server configuration by clicking the button. Alternatively, you can add a
configuration when an SSL error occurs during a connection and you are presented with an SSL Error dialog
(where the error can be ignored temporarily or saved to the database and ignored):

Figure 16.34: Manually adding configuration

Once an SSL configuration is saved to the database, it can be edited or deleted.

If you want to pre-configure an SSL configuration and the import dialog is not working for your server’s con-
nection, you can manually trigger a connection via the Python Console by running the following code (replace
https://bugreports.qt-project.org with the URL of your server):

from PyQt4.QtNetwork import *
req = QNetworkRequest(QUrl(’https://bugreports.qt-project.org’))
reply = QgsNetworkAccessManager.instance().get(req)

This will open an SSL error dialog if any errors occur, where you can choose to save the configuration to the
database.

16.3 Security Considerations

Once the master password is entered, the API is open to access authentication configs in the authentication
database, similar to how Firefox works. However, in the initial implementation, no wall against PyQGIS ac-
cess has been defined. This may lead to issues where a user downloads/installs a malicious PyQGIS plugin or
standalone app that gains access to authentication credentials.

The quick solution for initial release of feature is to just not include most PyQGIS bindings for the authentication
system.
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Figure 16.35: Adding configuration during SSL error

Figure 16.36: Existing SSL configuration
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Figure 16.37: Editing an existing SSL configuration

Another simple, though not robust, fix is to add a combobox in Settings → Options → Authentication (defaults to
“never”):

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Such an option’s setting would need to be saved in a location non-accessible to Python, e.g. the authentication
database, and encrypted with the master password.

• Another option may be to track which plugins the user has specifically

• allowed to access the authentication system, though it may be tricky to deduce which plugin is actually
making the call.

• Sandboxing plugins, possibly in their own virtual environments, would reduce ‘cross-plugin’ hacking of
authentication configs from another plugin that is authorized. This might mean limiting cross-plugin com-
munication as well, but maybe only between third-party plugins.

• Another good solution is to issue code-signing certificates to vetted plugin authors. Then validate the plu-
gin’s certificate upon loading. If need be the user can also directly set an untrusted policy for the certificate
associated with the plugin using existing certificate management dialogs.

• Alternatively, access to sensitive authentication system data from Python

• could never be allowed, and only the use of QGIS core widgets, or duplicating authentication system in-
tegrations, would allow the plugin to work with resources that have an authentication configuration, while
keeping master password and authentication config loading in the realm of the main app.

The same security concerns apply to C++ plugins, though it will be harder to restrict access, since there is no
function binding to simply be removed as with Python.

16.3.1 Restrictions

The confusing licensing and exporting issues associated with OpenSSL apply. In order for Qt to work with SSL
certificates, it needs access to the OpenSSL libraries. Depending upon how Qt was compiled, the default is to
dynamically link to the OpenSSL libs at run-time (to avoid the export limitations).

QCA follows a similar tactic, whereby linking to QCA incurs no restrictions, because the qca-ossl (OpenSSL)
plugin is loaded at run-time. The qca-ossl plugin is directly linked to the OpenSSL libs. Packagers would be the
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ones needing to ensure any OpenSSL-linking restrictions are met, if they ship the plugin. Maybe. I don’t really
know. I’m not a lawyer.

The authentication system safely disables itself when qca-ossl is not found at run-time.
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CHAPTER 17

Integrazione con GRASS GIS

GRASS integration provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Let-
teratura e riferimenti web). The integration consists of two parts: provider and plugin. The provider allows to
browse, manage and visualize GRASS raster and vector layers. The plugin can be used to create new GRASS
locations and mapsets, change GRASS region, create and edit vector layers and analyze GRASS 2-D and 3-D data
with more than 400 GRASS modules. In this section, we’ll introduce the provider and plugin functionalities and
give some examples of managing and working with GRASS data.

The provider supports GRASS version 6 and 7, the plugin supports GRASS 6 and 7 (starting from QGIS 2.12).
QGIS distribution may contain provider/plugin for either GRASS 6 or GRASS 7 or for both versions at the same
time (binaries have different file names). Only one version of the provider/plugin may be loaded on runtime
however.

17.1 Demo dataset

As an example, we will use the QGIS Alaska dataset (see section Dati campione). It includes a
small sample GRASS LOCATION with three vector layers and one raster elevation map. Create a
new folder called grassdata, download the QGIS ‘Alaska’ dataset qgis_sample_data.zip from
http://download.osgeo.org/qgis/data/ and unzip the file into grassdata.

More sample GRASS LOCATIONs are available at the GRASS website at
http://grass.osgeo.org/download/sample-data/.

17.2 Caricare layer raster e vettoriali GRASS

If the provider is loaded in QGIS, the location item with GRASS icon is added in the browser tree under each
folder item which contains GRASS location. Go to the folder grassdata and expand location alaska and
mapset demo.

You can load GRASS raster and vector layers like any other layer from the browser either by double click on layer
item or by dragging and dropping to map canvas or legend.

Suggerimento: Caricare dati GRASS
If you don’t see GRASS location item, verify in Help → About → Providers if GRASS vector provider is loaded.

17.3 Importing data into a GRASS LOCATION via drag and drop

This section gives an example of how to import raster and vector data into a GRASS mapset.

1. In QGIS browser navigate to the mapset you want to import data into.
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2. In QGIS browser find a layer you want to import to GRASS, note that you can open another instance of the
browser (Browser Panel (2)) if source data are too far from the mapset in the tree.

3. Drag a layer and drop it on the target mapset. The imported may take some time for larger layers, you will
see animated icon in front of new layer item until the import finishes.

Where raster data are in different CRS, they can be reprojected using an Approximate (fast) or Exact (precise)
transformation. If a link to the source raster is created (using r.external), the source data are in the same CRS and
the format is known to GDAL, the source data CRS will be used. You can set these options in the Browser tab in
GRASS Options.

If a source raster has more bands, a new GRASS map is created for each layer with .<band number> suffix and

group of all maps with icon is created. External rasters have a different icon .

17.4 Managing GRASS data in QGIS browser

• Copying maps: GRASS maps may be copied between mapsets within the same location using drag and
drop.

• Deleting maps: Right click on a GRASS map and select Delete from context menu.

• Renaming maps: Right click on a GRASS map and select Rename from context menu.

17.5 GRASS Options

GRASS options may be set in GRASS Options dialog, which can be opened by right clicking on the location or
mapset item in the browser and then choosing GRASS Options.

17.6 Avviare il plugin GRASS

To use GRASS functionalities in QGIS, you must select and load the GRASS plugin using the Plugin Manager.

To do this, go to the menu Plugins → Manage and Install Plugins..., select GRASS and click [OK].

The following main features are provided with the toolbar menu when you start the GRASS plugin:

• Open Mapset

• New Mapset

• Close Mapset

• Open GRASS Tools

• Display Current GRASS Region

• GRASS Options

17.7 Opening GRASS mapset

A GRASS mapset must be opened to get access to GRASS Tools in the plugin (the tools are disabled if no mapset
is open). You can open a mapset from the browser: right click on mapset item and then choose Open mapset from
context menu.
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17.8 LOCATION e MAPSET in GRASS

GRASS data are stored in a directory referred to as GISDBASE. This directory, often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATIONs. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics or subregions, or
as workspaces for individual team members (see Neteler & Mitasova 2008 in Letteratura e riferimenti web). In
order to analyse vector and raster layers with GRASS modules, you generally have to import them into a GRASS
LOCATION. (This is not strictly true – with the GRASS modules r.external and v.external you can
create read-only links to external GDAL/OGR-supported datasets without importing them. This is not the usual
way for beginners to work with GRASS, therefore this functionality will not be described here.)

Figure 17.1: Dati di GRASS all’interno della LOCATIoN Alaska

17.9 Importare dati nelle LOCATION GRASS

See section Importing data into a GRASS LOCATION via drag and drop to find how data can be easily imported
by dragging and dropping in the browser.

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset in traditional way, using standard GRASS modules. Therefore, we use the
landcover raster map landcover.img and the vector GML file lakes.gml from the QGIS ‘Alaska’ dataset
(see Dati campione).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION ‘alaska’, as
MAPSET ‘demo’ and click [OK].

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section The GRASS Toolbox) dialog
appears.

5. To import the raster map landcover.img, click the module r.in.gdal in the Modules Tree tab. This
GRASS module allows you to import GDAL-supported raster files into a GRASS LOCATION. The module
dialog for r.in.gdal appears.

6. Browse to the folder raster in the QGIS ‘Alaska’ dataset and select the file landcover.img.
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7. As raster output name, define landcover_grass and click [Run]. In the Output tab, you
see the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. When it says Successfully finished, click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. To import the vector GML file lakes.gml, click the module v.in.ogr in the Modules Tree tab. This
GRASS module allows you to import OGR-supported vector files into a GRASS LOCATION. The module
dialog for v.in.ogr appears.

10. Browse to the folder gml in the QGIS ‘Alaska’ dataset and select the file lakes.gml as OGR file.

11. As vector output name, define lakes_grass and click [Run]. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

17.9.1 Creare una nuova LOCATION GRASS

As an example, here is the sample GRASS LOCATION alaska, which is projected in the Albers Equal Area
projection using feet as units. This sample GRASS LOCATION alaska will be used for all examples and exer-
cises in the following GRASS-related sections. It is useful to download and install the dataset on your computer
(see Dati campione).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Visualize the alaska.shp shapefile (see section Loading a layer from a file) from the QGIS Alaska
dataset (see Dati campione).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Select an existing GRASS database (GISDBASE) folder grassdata, or create one for the new
LOCATION using a file manager on your computer. Then click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Aggiungere
un nuovo MAPSET) or to create a new LOCATION altogether. Select Create new location (see fig-
ure_grass_location_2).

6. Enter a name for the LOCATION – we used ‘alaska’ – and click [Next].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Lavorare con le proiezioni)).

9. In Filter, insert 2964 to select the projection.

10. Cliccare su [Next].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current QGIS extent], to apply the extent of the
loaded layer alaska.shp as the GRASS default region extent.

12. Cliccare su [Next].

13. We also need to define a MAPSET within our new LOCATION (this is necessary when creating a new
LOCATION). You can name it whatever you like - we used ‘demo’. GRASS automatically creates a special
MAPSET called PERMANENT, designed to store the core data for the project, its default spatial extent and
coordinate system definitions (see Neteler & Mitasova 2008 in Letteratura e riferimenti web).
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14. Controllare il riassunto per assicurarsi che le impostazioni siano corrette e cliccare su [Finish].

15. The new LOCATION, ‘alaska’, and two MAPSETs, ‘demo’ and ‘PERMANENT’, are created. The currently
opened working set is ‘demo’, as you defined.

16. Si noti che alcuni strumenti della barra di GRASS precedentemente disabilitati sono ora attivi.

Figure 17.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Importare dati nelle LOCATION GRASS). You can
also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’, included in the
QGIS ‘Alaska’ dataset Dati campione, and move on to section Il modello dati vettoriale di GRASS.

17.9.2 Aggiungere un nuovo MAPSET

A user has write access only to a GRASS MAPSET which he or she created. This means that besides access to
your own MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify
or remove only the maps in your own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (see Neteler & Mitasova 2008 in Letteratura e riferimenti web, and section Lo strumento Regione
di GRASS).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Select the GRASS database (GISDBASE) folder grassdata with the LOCATION ‘alaska’, where we
want to add a further MAPSET called ‘test’.

4. Cliccare su [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_location_2) and
click [Next].

6. Enter the name text for the new MAPSET. Below in the wizard, you see a list of existing MAPSETs and
corresponding owners.

7. Cliccare su [Next], controllare il riassunto per assicurarsi che le impostazioni siano corrette e cliccare su
[Finish].

17.10 Il modello dati vettoriale di GRASS

It is important to understand the GRASS vector data model prior to digitizing. In general, GRASS uses a topolog-
ical vector model. This means that areas are not represented as closed polygons, but by one or more boundaries.
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A boundary between two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be
connected and closed without gaps. An area is identified (and labelled) by the centroid of the area.

Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so-called ‘layers’ inside one GRASS vector map.
So in GRASS, a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully. (Although it is possible to mix geometry elements, it is unusual and, even in GRASS, only used in
special cases such as vector network analysis. Normally, you should prefer to store different geometry elements
in different layers.)

It is possible to store several ‘layers’ in one vector dataset. For example, fields, forests and lakes can be stored in
one vector. An adjacent forest and lake can share the same boundary, but they have separate attribute tables. It is
also possible to attach attributes to boundaries. An example might be the case where the boundary between a lake
and a forest is a road, so it can have a different attribute table.

The ‘layer’ of the feature is defined by the ‘layer’ inside GRASS. ‘Layer’ is the number which defines if there is
more than one layer inside the dataset (e.g., if the geometry is forest or lake). For now, it can be only a number. In
the future, GRASS will also support names as fields in the user interface.

Attributes can be stored inside the GRASS LOCATION as dBase, SQLite3 or in external database tables, for
example, PostgreSQL, MySQL, Oracle, etc.

Gli attributi contenuti nelle tabelle del database sono collegati alla geometria per il tramite di un valore ’category’.

’Category’ (key, ID) è un valore intero collegato alle primitive geometriche ed è usato come collegamento ad una
colonna chiave nella tabella del database.

Suggerimento: Conoscere il modello dati vettoriale di GRASS
The best way to learn the GRASS vector model and its capabilities is to download one of the many GRASS
tutorials where the vector model is described more deeply. See http://grass.osgeo.org/documentation/manuals/ for
more information, books and tutorials in several languages.

17.11 Creare un nuovo layer vettoriale GRASS

To create a new GRASS vector layer, select one of following items from mapset context menu in the browser:

• New Point Layer

• New Line Layer

• New Polygon Layer

and enter a name in the dialog. A new vector map will be created and layer will be added to canvas and editing
started. Selecting type of the layer does not restrict geometry types which can be digitized in the vector map. In
GRASS, it is possible to organize all sorts of geometry types (point, line and polygon) in one vector map. The
type is only used to add the layer to the canvas, because QGIS requires a layer to have a specific type.

It is also possible to add layers to existing vector maps selecting one of the items described above from context
menu of existing vector map.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Creating new Vector layers).

17.12 Digitalizzare e modificare layer vettoriali GRASS

GRASS vector layers can be digitized using the standard QGIS digitizing tools. There are however some particu-
larities, which you should know about, due to
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• GRASS topological model versus QGIS simple feature

• complexity of GRASS model

– multiple layers in single maps

– multiple geometry types in single map

– geometry sharing by multiple features from multiple layers

The particularities are discussed in the following sections.

Save, discard changes, undo, redo

Avvertimento: All the changes done during editing are immediately written to vector map and related at-
tribute tables.

Changes are written after each operation, it is however, possible to do undo/redo or discard all changes when
closing editing. If undo or discard changes is used, original state is rewritten in vector map and attribute tables.

There are two main reasons for this behaviour:

• It is the nature of GRASS vectors coming from conviction that user wants to do what he is doing and it is
better to have data saved when the work is suddenly interrupted (for example, blackout)

• Necessity for effective editing of topological data is visualized information about topological correctness,
such information can only be acquired from GRASS vector map if changes are written to the map.

Barra degli strumenti di digitalizzazione

The ‘Digitizing Toolbar’ has some specific tools when a GRASS layer is edited:
Icona Strumento Azione

Nuovo punto Digitalizza un nuovo punto

Nuova linea Digitalizza una nuova linea

Nuovo contorno Digitize new boundary

Nuovo centroide Digitalizza un nuovo centroide (imposta l’etichetta per un’area esistente)

New Closed Boundary Digitize new closed boundary

Tabella Strumenti per la digitalizzazione in GRASS

Suggerimento: Digitalizzare poligoni in GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon. Then you add a centroid
(label point) into the closed boundary. The reason for this is that a topological vector model links the attribute
information of a polygon always to the centroid and not to the boundary.

Category

Category, often called cat, is sort of ID. The name comes from times when GRASS vectors had only singly
attribute “category”. Category is used as a link between geometry and attributes. A single geometry may have
multiple categories and thus represent multiple features in different layers. Currently it is possible to assign only
one category per layer using QGIS editing tools. New features have automatically assigned new unique category,
except boundaries. Boundaries usually only form areas and do not represent linear features, it is however possible
to define attributes for a boundary later, for example in different layer.

New categories are always created only in currently being edited layer.

It is not possible to assign more categories to geometry using QGIS editing, such data are properly represented as
multiple features, and individual features, even from different layers, may be deleted.

Attributes

Attributes of currently edited layer can only be modified. If the vector map contains more layers, features of other
layers will have all attributes set to ‘<not editable (layer #)>’ to warn you that such attribute is not editable. The
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reason is, that other layers may have and usually have different set of fields while QGIS only supports one fixed
set of fields per layer.

If a geometry primitive does not have a category assigned, a new unique category is automatically assigned and
new record in attribute table is created when an attribute of that geometry is changed.

Suggerimento: If you want to do bulk update of attributes in table, for example using ‘Field Calculator’ (Field
Calculator), and there are features without category which you don’t want to update (typically boundaries), you
can filter them out by setting ‘Advanced Filter’ to cat is not null.

Editing style

The topological symbology is essential for effective editing of topological data. When editing starts, a specialized
‘GRASS Edit’ renderer is set on the layer automatically and original renderer is restored when editing is closed.
The style may be customized in layer properties ‘Style’ tab. The style can also be stored in project file or in
separate file as any other style. If you customize the style, do not change its name, because it is used to reset the
style when editing is started again.

Suggerimento: Do not save project file when the layer is edited, the layer would be stored with ‘Edit Style’
which has no meaning if layer is not edited.

The style is based on topological information which is temporarily added to attribute table as field ‘topo_symbol’.
The field is automatically removed when editing is closed.

Suggerimento: Do not remove ‘topo_symbol’ field from attribute table, that would make features invisible
because the renderer is based on that column.

Snapping

To form an area, vertices of connected boundaries must have exactly the same coordinates. This can be achieved
using snapping tool only if canvas and vector map have the same CRS. Otherwise, due conversion from map
coordinates to canvas and back, the coordinate may become slightly different due to representation error and CRS
transformations.

Suggerimento: Use layer’s CRS also for canvas when editing.

Limitations

Simultaneous editing of multiple layers within the same vector at the same time is not supported. This is mainly
due to the impossibility of handling multiple undo stacks for a single data source.

On Linux and Mac OSX only one GRASS layer can be edited at time. This is due to a bug in GRASS which
does not allow to close database drivers in random order. This is being solved with GRASS developers.

Suggerimento: Permessi di modifica in GRASS
You must be the owner of the GRASS MAPSET you want to edit. It is impossible to edit data layers in a MAPSET
that is not yours, even if you have write permission.

17.13 Lo strumento Regione di GRASS

The region definition (setting a spatial working window) in GRASS is important for working with raster layers.
Vector analysis is by default not limited to any defined region definitions. But all newly created rasters will have
the spatial extension and resolution of the currently defined GRASS region, regardless of their original extension
and resolution. The current GRASS region is stored in the $LOCATION/$MAPSET/WIND file, and it defines
north, south, east and west bounds, number of columns and rows, horizontal and vertical spatial resolution.
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It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

The region can be modified in ‘Region’ tab in ‘GRASS Tolls’ dock widget. Type in the new region bounds and
resolution, and click [Apply]. If you click on [Select the extent by dragging on canvas] you can select a new
region interactively with your mouse on the QGIS canvas dragging a rectangle.

The GRASS module g.region provides a lot more parameters to define an appropriate region extent and reso-
lution for your raster analysis. You can use these parameters with the GRASS Toolbox, described in section The
GRASS Toolbox.

17.14 The GRASS Toolbox

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.

Figure 17.3: GRASS Toolbox and Module Tree

17.14.1 Lavorare con i moduli GRASS

The GRASS shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user-friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs within the GRASS plugin Toolbox.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.14 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

It is also possible to customize the GRASS Toolbox content. This procedure is described in section Personalizzare
gli strumenti GRASS.

As shown in figure_grass_toolbox_1, you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.
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By clicking on a graphical module icon, a new tab will be added to the Toolbox dialog, providing three new
sub-tabs: Options, Output and Manual.

Opzioni

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

Figure 17.4: GRASS Toolbox Module Options

The provided module parameters are often not complete to keep the dialog simple. If you want to use further
module parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Output

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manuale

The Manual tab shows the HTML help page of the GRASS module. You can use it to check further module
parameters and flags or to get a deeper knowledge about the purpose of the module. At the end of each module
manual page, you see further links to the Main Help index, the Thematic index and the Full index.
These links provide the same information as the module g.manual.

Suggerimento: Mostrare i risultati immediatamente
Se si desidera visualizzare il risultato di un’analisi immediatamente nella vista mappa, è possibile cliccare sul
pulsante Visualizza Output nella porzione inferiore della scheda.
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Figure 17.5: GRASS Toolbox Module Output

Figure 17.6: GRASS Toolbox Module Manual
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17.14.2 Esempi di utilizzo di moduli GRASS

Gli esempi che seguono mostrano le potenzialità di alcuni moduli GRASS.

Creare curve di livello

The first example creates a vector contour map from an elevation raster (DEM). Here, it is assumed that you have
the Alaska LOCATION set up as explained in section Importare dati nelle LOCATION GRASS.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now open the Toolbox with the Open GRASS tools button.

• In the list of tool categories, double-click Raster → Surface Management → Generate vector contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Lavorare con i
moduli GRASS).

• In the Name of input raster map enter gtopo30.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Inserire in Nome del vettoriale in output il nome ctour_100.

• Click [Run] to start the process. Wait for several moments until the message Successfully finished
appears in the output window. Then click [View Output] and [Close].

Dal momento che la regione è pittosto estesa, il comando richiede del tempo. Una volta terminata l’operazione è
possibile modificare le proprietà del nuovo layer vettoriale come descritto in Proprietà dei vettori.

Next, zoom in to a small, mountainous area in the center of Alaska. Zooming in close, you will notice that the
contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps while keeping
their overall shape. The tool uses several different algorithms with different purposes. Some of the algorithms
(i.e., Douglas Peuker and Vertex Reduction) simplify the line by removing some of the vertices. The resulting
vector will load faster. This process is useful when you have a highly detailed vector, but you are creating a very
small-scale map, so the detail is unnecessary.

Suggerimento: Semplifica geometrie
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms, there is Chaiken’s, which does just that (also
Hermite splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even
more slowly.

• Open the GRASS Toolbox and double-click the categories Vector → Develop map → Generalization, then
click on the v.generalize module to open its options window.

• Controllare che ‘ctour_100’ appaia come Nome della mappa vettoriale in input.

• From the list of algorithms, choose Chaiken’s. Leave all other options at their default, and scroll down to
the last row to enter in the field Name for output vector map ‘ctour_100_smooth’, and click [Run].

• The process takes several moments. Once Successfully finished appears in the output windows,
click [View output] and then [Close].

• È possibile modificare il colore del layer vettoriale in modo da renderlo ben visibile sul raster si sfondo. Si
potrà notare come le curve di livello ora appaiano meno spigolose.

Suggerimento: Altri usi di r.contour
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Figure 17.7: GRASS module v.generalize to smooth a vector map

The procedure described above can be used in other equivalent situations. If you have a raster map of precipitation
data, for example, then the same method will be used to create a vector map of isohyetal (constant rainfall) lines.

Creating a Hillshade 3-D effect

Several methods are used to display elevation layers and give a 3-D effect to maps. The use of contour lines, as
shown above, is one popular method often chosen to produce topographic maps. Another way to display a 3-D
effect is by hillshading. The hillshade effect is created from a DEM (elevation) raster by first calculating the slope
and aspect of each cell, then simulating the sun’s position in the sky and giving a reflectance value to each cell.
Thus, you get sun-facing slopes lighted; the slopes facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS Toolbox, and under the
Raster category, double-click to open Spatial analysis → Terrain analysis.

• Cliccare r.shaded.relief per aprire il modulo.

• Change the azimuth angle 270 to 315.

• Inserire gtopo30_shade per il nuovo raster delle ombreggiature e cliccare su [Esegui].

• Quando il processo sarà completato, aggiungere il raster ombreggiatura alla vista mappa.

• To view both the hillshading and the colors of the gtopo30 together, move the hillshade map below the
gtopo30 map in the table of contents, then open the Properties window of gtopo30, switch to the
Transparency tab and set its transparency level to about 25%.

Si dovrebbe vedere gtopo30 sopra la mappa di ombreggiatura in scala di grigi. Per riuscire a visualizzare
appieno gli effetti dell’ombreggiatura, deselezionare gtopo30_shade.

Usare la shell di GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

The module r.shaded.relief can take a parameter zmult, which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.

• Load the gtopo30 elevation raster as above, then start the GRASS Toolbox and click on the
GRASS shell. In the shell window, type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press [Enter].
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Figure 17.8: The GRASS shell, r.shaded.relief module
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• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• As explained above, move the shaded relief raster below the gtopo30 raster in the table of contents, then
check the transparency of the colored gtopo30 layer. You should see that the 3-D effect stands out more
strongly compared with the first shaded relief map.

Figure 17.9: Displaying shaded relief created with the GRASS module r.shaded.relief

Statistiche raster in una mappa vettoriale

Il prossimo esempio tratta di un modulo GRASS che può aggregare dati raster ed aggiungere colonne di statistiche
per ogni poligono di una mappa vettoriale.

• Importare in GRASS lo shapefile trees nella cartella shapefiles Importare dati nelle LOCATION
GRASS.

• Now an intermediate step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).

• From the Toolbox, choose Vector → Manage features, and open the module v.centroids.

• Inserire come Nome del vettoriale in output ‘forest_areas’ e lanciare il modulo.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
Menu Stile of the vector section.)

• Next, reopen the GRASS Toolbox and open Vector → Vector update by other maps.

• Click on the v.rast.stats module. Enter gtopo30 and forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click [Run]. This is a computa-
tionally heavy operation, which will run for a long time (probably up to two hours).

• Finally, open the forest_areas attribute table, and verify that several new columns have been added,
including elev_min, elev_max, elev_mean, etc., for each forest polygon.

17.14.3 Personalizzare gli strumenti GRASS

Nearly all GRASS modules can be added to the GRASS Toolbox. An XML interface is provided to parse the
pretty simple XML files that configure the modules’ appearance and parameters inside the Toolbox.

Un esempio di file XML che genera il modulo v.buffer (v.buffer.qgm) ha il seguente aspetto:
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<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.
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CHAPTER 18

ambiente Processing di QGIS

18.1 Introduzione

Questo capitolo introduce l’ambiente di processing QGIS, un ambiente di elaborazione di dati geografici grazie al
quale potrai usare algoritmi nativi di QGIS e algoritmi di terze parti. In questo modo le attività di analisi spaziale
saranno molto più produttive e facile da realizzare.

Nella sezione seguente esamineremo come usare gli elementi grafici di questo ambiente e come ottenere il mas-
simo da ciascuno di essi.

Ci sono quattro elementi base nell’interfaccia grafica dell’ambiente, che vengono usati per lanciare algoritmi con
differenti finalità. La scelta tra uno strumento e un altro dipende dal tipo di analisi che vuoi effettuare e dalle
caratteristiche particolari dei singoli utenti e progetti. Tutti questi elementi (esclusa l’interfaccia dei processi in
serie, che come vedremo viene caricata da strumenti o dalla finestra di dialogo dell’algoritmo) possono essere
selezionati dal menu Processing (Vedrai più di quattro voci. Le altre non sono usate per eseguire algoritmi e
saranno spiegate nel seguito del capitolo).

• Strumenti. È l’elemento principale dell’interfaccia grafica. Lo potrai usare per eseguire un singolo algoritmo
o per lanciare un processo in serie basato sullo stesso algoritmo.

• Modellatore grafico. Puoi combinare molti algoritmi usando il modellatore grafico. In questo modo potrai
definire un flusso di lavoro anche molto complesso, creando un singolo processo che in realtà coinvolge più
sotto-processi.

• Storico e log. Tutte le azioni eseguite usando uno qualsiasi degli elementi sono raccolte in un file di cronolo-
gia e le potrai facilmente richiamare in un secondo momento.

• Intercaccia del processo in serie. Questa interfaccia ti permette di eseguire processi in serie e di automatiz-
zare l’esecuzione di un particolare algoritmo su più insiemi di dati.

Nelle sezioni seguenti rivedremo in dettaglio ciascuno di questi elementi.

18.2 Strumenti

La finestra Strumenti è l’elemento principale della interfaccia grafica di Processing, ed è l’elemento che probabil-
mente userai quotidianamente. La finestra ti mostra l’elenco degli algoritmi disponibili raggruppati in differenti
sezioni ed è il punto di partenza per lanciare gli algoritmi sia come singoli processi che come processi in serie,
ovvero processi che implicano l’esecuzione dello stesso algoritmo su diversi insiemi di dati.

The toolbox contains all the available algorithms, divided into so-called “Providers”.

Providers can be (de)activated in the settings dialog. A label in the bottom part of the toolbox will remind you
of that whenever there are inactive providers. Use the link in the label to open the settings window and set up
providers. We will discuss the settings dialog later in this manual.
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Figure 18.1: Strumenti di Processing
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Figure 18.2: Modellatore Grafico

Figure 18.3: Cronologia Processing
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Figure 18.4: Interfaccia del processo in serie

By default only, providers that do not rely on third-party applications (that is, those that only require QGIS el-
ements to be run) are active. ALgorithms requiring external applications might need additional configuration.
Configuring providers is explained in a later chapter in this manual.

Nella parte superiore degli Strumenti, potrai trovare spazio in cui inserire del testo. Per facilitare la ricerca di un
algoritmo, puoi inserire qui una parola o una frase specifica: vedrai subito che il numero degli algoritmi si ridurrà
al numero di quelli che contengono il testo che hai inserito.

If there are algorithms that match your search but belong to a provider that is not active, an additional label will
be shown in the lower part of the toolbox.

If you click on the link in that label, the list of algorithms will also include those from inactive providers, which
will be shown in light gray. A link to active each inactive provider is also shown.

Per eseguire un algoritmo è sufficiente un doppio click con il mouse sul suo nome.

18.2.1 La finestra di configurazione di un algoritmo

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the ‘Polygon centroids’ algorithm).

This dialog is used to set the input values that the algorithm needs to be executed. It shows a list of input values
and configuration parameters to be set. It of course has a different content, depending on the requirements of the
algorithm to be executed, and is created automatically based on those requirements.

Anche se il numero e tipo dei parametri dipende dal tipo di algoritmo, la struttura di base è simile per tutti. I
parametri della tabella possono essere uno dei seguenti tipi.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

Vedrete un pulsante per ciascun selezionatore di vettori come mostrato nella figura.
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Figure 18.5: Processing Toolbox
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Figure 18.6: Processing Toolbox showing search results
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Figure 18.7: Processing Toolbox showing search results
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Figure 18.8: Parameters Dialog

Figure 18.9: Vector iterator button
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Se l’algoritmo ne contiene molti, potrai selezionarne anche solamente uno. Se il pulsante corrispondente a un
vettore in input è attivo, allora l’algoritmo verrà eseguito iterativamente su tutte le sue geometrie, invece di una
sola volta per tutto il vettore. Il numero di output dipende da quante volte eseguirai l’algoritmo. Questo ti permette
di automatizzare il processo quando tutte le geometrie in un vettore devono essere elaborate separatamente.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• Opzione, da scegliere in una lista di possibili opzioni.

• A numerical value, to be introduced in a text box. You will find a button by its side. Clicking on it, you
will see a dialog that allows you to enter a mathematical expression, so you can use it as a handy calculator.
Some useful variables related to data loaded into QGIS can be added to your expression, so you can select
a value derived from any of these variables, such as the cell size of a layer or the northernmost coordinate
of another one.

Figure 18.10: Number Selector

• Un intervallo, con i valori minimo e massimo da inserire in due corrispondenti caselle di testo.

• Una stringa di testo, da inserire in un’apposita casella.

• Un campo, da scegliere dalla tabella degli attributi di un vettore, o da una singola tabella selezionata con un
altro parametro.

• Un sistema di riferimento di coordinate. Puoi inserire direttamente il codice EPSG o selezionarlo dalla
finestra di dialogo dei SR che puoi aprire cliccando sul pulsante nella parte destra.

• Regione, da inserire mediante i suoi estremi xmin, xmax, ymin, ymax. Premendo il pulsante sulla destra
apparirà una finestra che ti permette di scegliere fra: usare la regione attualmente presente nella mappa
oppure modificare gli estremi selezionando un rettangolo direttamente con il mouse.

Figure 18.11: Extent selector

Se scegliete la prima opzione verrà mostrata la seguente finestra di scelta rapida.

18.2. Strumenti 269



QGIS User Guide, Release 2.14

Figure 18.12: Extent List

Se scegliete la seconda opzione, la finestra dei parametri sparirà, così potrai scegliere l’area tramite il mouse.
Una volta selezionato il rettangolo, la finestra di dialogo riapparirà completa dei limiti della regione appena
definita.

Figure 18.13: Extent Drag

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

Figure 18.14: Multiple Selection

• Una piccola tabella da completare a cura dell’utente. Queste tabelle sono usate per definire, ad esempio,
parametri tipo tabelle di riferimento o kernel di convoluzione.

Cliccate sul bottone sul lato destro per vedere la tabella e aggiornare i suoi valori.
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Figure 18.15: Fixed Table

A seconda dell’algoritmo, potrai modificare il numero delle righe, usando i pulsanti sul lato destro della
finestra.

Along with the parameters tab, you will find another tab named ‘Log’. Information provided by the algorithm
during its execution is written in this tab, and allow you to track the execution and be aware and have more details
about the algorithm as it runs. Notice that not all algorithms write information to this tab, and many of them might
run silently without producing any output other than the final files.

On the right hand side of the dialog you wil find a short description of the algorithm, which will help you un-
derstand its purpose and its basic ideas. If such a description is not available, the description panel will not be
shown.

Some algorithms might have a more detailed help file, which might include description of every parameter it uses,
or examples. In that case, you will find a Help tab in the parameters dialog.

Nota sulle proiezioni

Algorithms that are run from the processing framework — this is also true of most of the external applications
whose algorithms are exposed through it— do not perform any reprojection on input layers and assume that all
of them are already in a common coordinate system and ready to be analyzed. Whenever you use more than one
layer as input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same
coordinate system.

Note that, due to QGIS’s on-the-fly reprojecting capabilities, although two layers might seem to overlap and match,
that might not be true if their original coordinates are used without reprojecting them onto a common coordinate
system. That reprojection should be done manually, and then the resulting files should be used as input to the
algorithm. Also, note that the reprojection process can be performed with the algorithms that are available in the
processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the Processing settings dialog, unchecking the Show CRS option.

Se provi a lanciare un algoritmo usando due o più layer con diversi SR , comparirà una finestra di avviso.

Potrai comunque eseguire l’algoritmo, ma sappi che nella maggior parte dei casi ciò produrrà cattivi risultati,
come ad esempio layer di uscita inconsistenti, proprio perché questi non sono sovrapposti.
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18.2.2 Dati generati dagli algoritmi

I dati generati da un algoritmo possono appartere a una delle seguenti tipologie:

• Raster

• Un vettore

• Tabella

• File HTML (usato per risultati testuali e grafici)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but in the case of
vector layers, and when they are generated by native algorithms (algorithms not using external applications) you
can also save to a PostGIS or Spatialite database, or a memory layer.

To select an output channel, just click on the button on the right side of the text box, and you will see a small
context menu with the available options.

In the most usual case, you will select saving to a file. If you select that option, you will be prompted with a
save file dialog, where you can select the desired file path. Supported file extensions are shown in the file format
selector of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension will be appended to the file path, and the file format corresponding to that extension
will be used to save the layer or table. Default extensions are .dbf for tables, .tif for raster layers and .shp
for vector layers. These can be modified in the setting dialog, selecting any other of the formats supported by
QGIS.

If you do not enter any filename in the output text box (or select the corresponding option in the context menu),
the result will be saved as a temporary file in the corresponding default file format, and it will be deleted once you
exit QGIS (take care with that, in case you save your project and it contains temporary layers).

You can set a default folder for output data objects. Go to the settings dialog (you can open it from the Processing
menu), and in the General group, you will find a parameter named Output folder. This output folder is used as the
default path in case you type just a filename with no path (i.e., myfile.shp) when executing an algorithm.

Durante l’esecuzione di un algoritmo che usa un vettore in modo iterativo, il percorso del file inserito è usato
come percorso di base per tutti i file generati, i quali sono nominati usando il nome del vettore e aggiungendo
poi un numero che rappresenta l’indice di iterazione. L’estensione del file (e il formato) viene usata per tutti i file
generati.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

Per tutti gli altri tipi di output, troverai una casella di controllo che potrai usare per indicare se caricare o meno il
file una volta che è stato generato dall’algoritmo. Come impostazione predefinita, tutti i file vengono aperti.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).
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18.2.3 Configurazione dell’ambiente di elaborazione

Come è stato detto, il menu di configurazione dà accesso ad una nuova finestra di dialogo in cui puoi configurare
la modalità con la quale funzionano gli algoritmi. I parametri di configurazione sono strutturati in blocchi separati
che puoi selezionare sul lato sinistro della finestra di dialogo.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by SEXTANTE and added to the QGIS canvas,
it will be rendered with that style.

Gli stili di visualizzazione possono essere configurati individualmente per ogni algoritmo e per ciascuno dei suoi
output. Basta fare click con il pulsante destro del mouse sul nome dell’algoritmo nella casella degli strumenti e
selezionare la voce Modifica gli stili di visualizzazione per l’output. Vedrete una finestra come quella mostrata di
seguito.

Figure 18.16: Rendering Styles

Selezionate il file di stile (.qml) che vuoi assegnare ad ogni risultato e premi [OK].

Altri parametri di configurazione nel gruppo Generale sono elencati di seguito:

• Use filename as layer name. Il nome di ogni layer risultante creato da un algoritmo è definito dall’algoritmo
stesso. In alcuni casi puoi usare un nome unico, il che significa che verrà utilizzato lo stesso nome i output,
a prescindere dal layer in input. In altri casi, il nome potrebbe dipendere dal nome del layer in input o
da alcuni parametri utilizzati dell’algoritmo. Se hai selezionato la casella di controllo, il nome verrà preso
invece dal nome del file di output. Nota che, se l’output viene salvato in un file temporaneo, il nome di
questo file temporaneo è di solito lungo e privo di significato in moda da evitare conflitti con altri nomi di
file già esistenti.

• Keep dialog open after running algorithm. Once an algorithm has finished execution and its output layers
are loaded into the QGIS project, the algorithm dialog is closed. If you want to keep it open (to run the
algorithm again with different parameters, or to better check the output that is written to the log tab), check
this option

• Use only selected features. Se hai selezionato questa opzione, l’esecuzione dell’algoritmo avverrà solamente
sulle geometrie selezionate. Se non hai selezionato nessuna geometria, allora l’algoritmo agirà sull’intero
vettore.

• Pre-execution script file e Post-execution script file. Questi parametri fanno riferimento alla possibilità di
scrivere script e sono spiegati nella sezione che tratta lo scripting e la console.
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Oltre alla sezione Generale nella finestra di dialogo, ne troverai uno per ogni fornitore di algoritmi. Ogni pro-
gramma contiene una casella di controllo Activate che puoi usare per far apparire o meno gli algoritmi di quel
programma negli Strumenti. Inoltre alcuni fornitori di algoritmi hanno elementi specifici di configurazione che ti
spiegheremo successivamente.

18.3 Modellatore grafico

Il modellatore grafico ti consente di creare modelli complessi utilizzando un’interfaccia semplice e facile da usare.
Quando lavori con un GIS, la maggior parte delle operazioni di analisi non sono isolate, ma piuttosto fanno parte
di una catena di operazioni. Usando il modellatore grafico, la successione dei processi può essere confezionata
in un unico processo, quindi è più conveniente eseguire come un processo singolo anche su diversi input. Non
importa quanti passi e diversi algoritmi coinvolge, un modello è eseguito come un unico algoritmo, risparmiando
così tempo e fatica, soprattutto per i modelli più grandi.

Puoi aprire il modellatore grafico dal menu di Processing.

Il modellatore ha un’area grafica di lavoro dove sono visualizzati la struttura del modello ed il flusso delle oper-
azioni che lo rappresenta. Si può usare un pannello con due riquadri sulla sinistra della finestra per aggiungere
nuovi elementi al modello.

Figure 18.17: Modellatore

La creazione di un modello comporta due passaggi:

1. Definizione degli input necessari. Tutti gli input verranno aggiunti alla finestra dei parametri, in questo
modo puoi impostare i valori durante l’esecuzione del modello. Il modello stesso è un algoritmo, quindi la
finestra dei parametri viene automaticamente generata come accade con tutti gli algoritmi disponibili.

2. Definizione del flusso di lavoro. Usando i dati in input del modello, il flusso di lavoro è definito aggiungendo
algoritmi e scegliendo come questi devono usare gli input o gli output generati da altri algoritmi già presenti
nel modello.
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18.3.1 Definizione dei dati di ingresso

Il primo passo per creare un modello è quello di definire tutti gli input. Nella parte sinistra del modellatore trovi
la scheda Inputs dove potrai scegliere i vari elementi.

• Raster

• Vettori

• Stringhe di testo

• Campi di tabelle

• Tabelle

• Estensione

• Numero

• Booleano

• File

Facendo doppio click su uno di questi elementi, apparirà una finestra di dialogo che servirà a definire le sue
caratteristiche. A seconda del parametro, la finestra conterrà un solo elemento (la descrizione, ovvero quello che
vedrai durante l’esecuzione del modello) oppure più elementi. Per esempio, aggiungendo un valore numerico,
come puoi vedere nella figura seguente, oltre alla descrizione del parametro, dovrai definire un valore di partenza
ed un intervallo di valori validi.

Figure 18.18: Parametri del modello

Per ogni dato di ingresso aggiunto, appare un nuovo elemento nel pannello grafico del modellatore.

Puoi inoltre aggiungere input trascinandolo dall’elenco e rilasciandolo nella mappa del modellatore, nella po-
sizione in cui vuoi posizionarlo.

18.3.2 Definizione del flusso operativo

Una volta definiti gli input, devi scegliere gli algoritmi che intendi usare. Gli algoritmi si trovano nella casella
Algoritmi, raggruppati allo stesso modo come in Strumenti.
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Figure 18.19: Parametri del modello

Figure 18.20: Parametri del modello
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Per aggiungere un algoritmo a un modello, fai doppio click sul suo nome o trascinalo, proprio come hai fatto du-
rante l’aggiunta di input. Apparirà una finestra di dialogo, simile a quella che viene visualizzata quando si esegue
l’algoritmo dagli strumenti. Quella mostrata di seguito corrisponde all’algoritmo SAGA ‘indice di convergenza’.

Figure 18.21: Parametri del modello

Come puoi vedere, ci sono diverse differenze. Al posto della casella di output dove potevi specificare il percorso
dei layer e tabelle, qui c’è una semplice casella di testo. Se il layer generato da questo algoritmo è solamente
un layer temporaneo che deve essere usato come input da un altro algoritmo, allora non inserire niente in questa
casella. Se riempi questa casella significa che il risultato è finale e che il testo che hai inserito corrisponderà
all’output finale.

Anche il valore di ogni parametro è leggermente diverso, dal momento che che ci sono importanti differenze fra il
contesto del modello e quello degli Strumenti. Vediamo come inserire i valori per ogni tipologia di parametro.

• Layer (raster e vettoriali) e tabelle. Devi selezionarle da una lista, ma in questo caso i valori possibili
non sono i layer o le tabelle attualmente aperte in QGIS, bensì la lista dei dati di ingresso del modello
corrispondente per tipo, o altri layer e tabelle generate da algoritmi già aggiunti al modello.

• Valori numerici. Puoi inserire questi valori direttamente nella casella di testo. Questa casella però funziona
anche come elenco in modo che tu possa selezionare ogni valore numerico del modello. In questo caso, il
parametro considererà il valore che hai inserito durante l’esecuzione del modello.

• Stringa. Come nel caso dei valori numerici, puoi inserire una stringa o scegliere un stringa fra quelle
disponibili.

• Table filed. Il parametro parent layer dipende da altri layer caricati nel modello e quindi lo potrai definire
solamente in un secondo momento. Inserisci prima il nome del parametro e poi scegli il parent layer dal
menu a tendina. Nel menu avrai a disposizione tutti i layer caricati nel modello.

In tutti i casi troverai un parametro aggiunti chiamato Parent algorithms, non disponibile quando avvii un algo-
ritmo dagli Strumenti. Questo parametro ti permette di definire l’ordine in cui gli algoritmi vengono eseguiti, in
quanto scegli tu la nidificazione degli algoritmi. In altre parole, puoi forzare l’esecuzione di un algoritmo prima
di un altro.

Quando usi l’output di un algoritmo come input per un altro algoritmo, allora il primo algoritmo è implicitamente
trattato come Parent algorithm del secondo (e lo puoi anche vede dalla direzione della freccia nella finestra del
modello). Tuttavia, in alcuni casi un algoritmo può dipendere da un altro algoritmo anche se non richiede output
(per esempio, un algoritmo che esegue un’interrogazione SQL su un database PostGIS e un altro che importa
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un layer nel database stesso). In questo caso, basta che selezioni l’algoritmo precedente nel parametro Parent
algorithms e i due passaggi verranno eseguiti nell’ordine corretto.

Una volta assegnati valori corretti a tutti i parametri, premi [OK] e l’algoritmo verrà aggiunto alla finestra.
L’algoritmo sarà collegato a tutti gli altri elementi del pannello, sia algoritmi sia dati in input, che creano risultati
usati come input dall’algoritmo.

Gli elementi possono essere trascinati in un’altra posizione all’interno della mappa, per cambiare il modo in cui
viene visualizzata la struttura del modulo e renderlo più chiaro e intuitivo. I collegamenti tra gli elementi vengono
aggiornati automaticamente. Puoi ingrandire e ridurre utilizzando la rotellina del mouse.

Puoi eseguire l’algoritmo in ogni momento premendo il pulsante [Run]. Tuttavia, per poterlo usare dagli Stru-
menti, devi prima salvarlo e poi chiudere la finestra di dialogo del modellatore in modo da consentire al sistema
di aggiornare la configurazione.

18.3.3 Salvataggio e caricamento di modelli

Usa il pulsante [Salva] per salvare il modello ed il pulsante [Apri] per aprire un modello esistente. I modelli sono
salvati con l’estensione .model. Se hai già salvato il modello non ti verrà più chiesto il nome del file da salvare,
infatti il modello verrà automaticamente sovrascritto sul file già esistente.

Prima di salvare un modello, devi inserire un nome ed un gruppo di appartenenza usando le caselle di testo nella
parte alta della finestra.

I modelli salvati nella cartella modelli (cartella predefinita dove vengono salvati i modelli) appariranno in
Strumenti, nel gruppo corrispondente. Quando apri gli Strumenti, vengono cercati tutti i file con estensione
.model e poi caricati nella finestra. Visto che un modello è inteso come un algoritmo, lo puoi aggiungere agli
Strumenti come un algoritmo qualsiasi.

Puoi specificare la cartella dei modelli nella finestra di configurazione di Processing, presente nel gruppo Model-
latore.

I modelli caricati dalla cartella models appariranno non solo negli Strumenti, ma anche nell’albero degli al-
goritmi della scheda Algorithms presente nella finestra del modellatore. Questo significa che puoi includere un
modello all’interno di un altro modello, proprio come se fosse un semplice algoritmo.

18.3.4 Aggiornare il modello

Puoi modificare il modello mentre lo stai creando, ridefinendo il flusso e le relazioni fra gli algoritmi e i dati che
definiscono il modello stesso.

Se premi il tasto destro del mouse su un algoritmo nel grafico che rappresenta il modello, apparirà un menu come
quello sotto riportato:

Figure 18.22: Click destro sul modello

Selezionando l’opzione Remove rimuoverai l’algoritmo selezionato. Non potrai rimuovere un algoritmo se altri
algoritmi dipendono da lui, ovvero quando un algoritmo vuole come input il risultato di un altro algoritmo. Se
provi a rimuovere comunque uno di questi algoritmi, apparirà una finestra di avviso.

Selezionando l’opzione Modifica o semplicemente premendo due volte sull’icona dell’algoritmo apparirà la fines-
tra dei parametri dell’algoritmo in modo che puoi cambiarne i valori. Non tutti i valori disponibili nel modello
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Figure 18.23: L’algoritmo non può essere eliminato

appariranno in questo caso come dati disponibili. Layer o valori generati ad un passaggio successivo del flusso
del modello che possono causare dipendenze circolari non saranno disponibili.

Selezionate i nuovi valori e premete il pulsante [OK] come al solito. La connessione fra gli elementi del modello
cambieranno di conseguenza anche nel pannello grafico.

Un modello può essere eseguito parzialmente, disattivando alcuni dei suoi algoritmi. Per farlo, seleziona l’opzione
Disattiva nel menu di scelta rapida che viene visualizzato quando fai click destro e su un elemento di algoritmo.
L’algoritmo selezionato e tutti quelli del modello che ne dipendono verranno visualizzati in grigio e non verranno
eseguiti come parte del modello.

Figure 18.24: Algoritmo disattivato

Quando fai click destro su un algoritmo che non è attivo, vedrai l’opzione Attiva che puoi utilizzare per attivarlo.

18.3.5 Informazioni ed aiuto per l’aggiornamento del modello

Puoi anche aggiungere una documentazione ai tuoi modelli. Premi il pulsante [Edit model help] per aprire la
finestra di dialogo corrispondente.

Figure 18.25: Editor della guida
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Sulla parte destra vedrai una semplice pagina HTML, creata usando la descrizione dei parametri di input e di
output dell’algoritmo insieme ad alcuni parametri aggiuntivi come la sua descrizione e l’autore. La prima volta
che apri l’editor di aiuto, vedrai tutti i campi vuoti. Li puoi riempire usando le voci corrispondenti presenti nella
parte sinistra della finestra di dialogo. Seleziona un elemento nella parte superiore e poi inserisci la descrizione
nella casella di testo.

La guida del modello è salvata come parte del modello stesso

18.3.6 Esporta il modello come scipt python

Come vedrai in un capitolo successivo, gli algoritmi di elaborazione possono essere richiamati dalla console
QGIS python e nuovi algoritmi di elaborazione possono essere creati anche utilizzando python. Un modo rapido
per creare uno script python è creare un modello e quindi esportarlo come un file python

Per farlo, fare clic sul pulsante Esporta come script python. Seleziona il file di output nella finestra di dialogo
del selettore di file e l’elaborazione scriverà i comandi di python che eseguono le stesse operazioni definite nel
modello corrente.

18.3.7 A proposito degli algoritmi disponibili

Potrai notare che alcuni algoritmi eseguibili dagli Strumenti non appaiono nell’elenco di quelli disponibili quando
stai creando un modello. Per essere incluso in un modello, un algoritmo deve avere una semantica corretta in modo
da poter essere correttamente collegato a tutti gli altri nel flusso di lavoro. Se un algoritmo non ha una semantica
corretta (ad esempio, se il numero dei layer generati non può essere conosciuto in anticipo) allora non lo potrai
usare all’interno del modello e quindi non apparirà nell’elenco di quelli disponibili.

Inoltre, ci sono altri algoritmi presenti nel modellatore grafico ma non negli Strumenti. Questi sono gli algoritmi
pensati per essere usati solamente come parte di un modello e non hanno senso in altri contesti. Un esempio è
l’algoritmo ‘Calcolatore’. È infatti una semplice calcolatrice che puoi usare per cambiare valori numerici (inseriti
da te o creati da qualche algoritmo). Questo strumento è molto utile in un modello ma non ha molto senso al di
fuori di questo contesto.

18.4 L’interfaccia per i processi in serie

18.4.1 Introduzione

Puoi eseguire come processi in serie tutti gli algoritmi (compresi i modelli). Questo significa che puoi eseguire
ogni algoritmo usando non solo un singolo input, ma anche più di uno. Questa funzionalità è particolarmente utile
quando hai bisogno di processare grandi quantità di dati; non dovrai più eseguire l’algoritmo singolarmente ogni
volta.

Per eseguire un algoritmo come un processo in serie, selezionarlo e col pulsante di destra del mouse scegliere la
voce Execute as batch process dal menu che apparirà.

Figure 18.26: Batch Processing Right Click

If you have the execution dialog of the algorithm open, you can also start the batch processing interface from
there, clicking on the Run as batch process... button.
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Figure 18.27: Batch Processing From Algorithm Dialog

18.4.2 La tabella dei parametri

Eseguire un processo in serie è un’operazione simile ad un’esecuzione singola di un algoritmo. Devi definire i
valori dei parametri, ma in questo caso, devi definire non solo un singolo valore per ciascunodi essi, ma un insieme
di valori, uno per ogni volta che l’algoritmo verrà eseguito. I valori sono introdotti per mezzo di una tabella del
tipo di quella mostrata oltre.

Ogni riga della tabella rappresenta una singola esecuzione dell’algoritmo mentre ogni cella contiene il valore di
uno dei parametri caratteristici dell’algoritmo. In un certo senso, è simile alla finestra di dialogo dei parametri
utilizzata quando si lancia un algoritmo da Strumenti, ma organizzata in maniera differente.

Come impostazione predefinita, la tabella contiene solo due righe. Puoi aggiungere o cancellare righe utilizzando
i pulsanti della parte inferiore della finestra.

Una volta definita la dimensione della tabella, la devi riempire con i valori desiderati.

18.4.3 Compilazione della tabella dei parametri

Per la maggior parte dei parametri, la selezione del valore corretto è banale. Basta semplicemente scrivere il valore
o selezionarlo dalla lista delle opzioni disponibili, a seconda del tipo di parametro.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button
on the right hand of the cell, which will show a context menu with two option: one for selecting from the layers
currently opened and another to select from the filesystem. This second option, when selected, shows a typical
file chooser dialog. Multiple files can be selected at once. If the input parameter represents a single data object
and several files are selected, each one of them will be put in a separate row, adding new ones if needed. If the
parameter represents a multiple input, all the selected files will be added to a single cell, separated by semicolons
(;).

Layer identifiers can be directly typed in the parameter text box. You can enter the full path to a file or the name of
a layer that is currently loaded in the current QGIS project. The name of the layer will be automatically resolved
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Figure 18.28: Batch Processing

to its source path. Notice that, if several layers have the same name, this might cause unexpected results due to
ambiguity.

Output data objects are always saved to a file and, unlike when executing an algorithm from the toolbox, saving
to a temporary file or database is not permitted. You can type the name directly or use the file chooser dialog that
appears when clicking on the accompanying button.

Una volta selezionato il file di output, appare una nuova finestra di dialogo che permette l’autocompletamento
delle altre celle nella stessa colonna (stesso parametro).

Figure 18.29: Salvataggio di processi in serie

Se mantieni il valore predefinito (‘Do not autocomplete’), Processing metterà il nome del file selezionato nella
cella selezionata dalla tabella dei parametri. Se selezioni una qualunque delle altre opzioni, tutte le celle sottostanti
a quella selezionata saranno riempite automaticamente basandosi sul criterio definito. In questo modo, è molto
più agevole riempire la tabella e puoi definire il processo in serie con meno fatica.

Puoi eseguire il riempimento automatico semplicemente aggiungendo numeri correlati al percorso del file se-
lezionato oppure aggiungendo il valore di un altro campo alla stessa riga. Questo è particolarmente utile per dare
un nome agli output che ricordi quello degli input.
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Figure 18.30: Batch Processing File Path

18.4.4 Esecuzione di un processo in serie

Per eseguire un processo in serie, una volta introdotti tutti i valori necessari, clicca semplicemente su [OK].
Processing mostrerà l’avanzamento globale del processo in serie nella barra di avanzamento nella parte inferiore
della finestra di dialogo.

18.5 Usare gli algoritmi di Processing dalla console dei comandi

La console permette ad utenti esperti di aumentare la propria produttività e di eseguire operazioni complesse che
non possono essere eseguite utilizzando uno qualsiasi degli altri elementi dell’interfaccia grafica di Processing. I
modelli che richiamano diversi algoritmi possono essere definiti utilizzando l’interfaccia della riga di comando, e
le operazioni aggiuntive, come i loop e le frasi condizionali possono essere aggiunte per creare flussi di lavoro più
flessibili e potenti.

Non c’è una console di Processing in QGIS, ma tutti i comandi di Processing sono disponibili al posto di quelli
nativi di QGIS della console di python. Questo significa che puoi incorporare questi comandi nella tua console
di lavoro e collegare gli algoritmi di Processing a tutte le altre funzionalità (inclusi i metodi della API di QGIS)
disponibili.

Il codice che puoi eseguire dalla console di python, anche se non richiama un metodo specifico di Processing, può
essere convertito in un nuovo algoritmo che potrai richiamare in seguito dagli Strumenti, dal Modellatore grafico
o da qualunque altra parte, proprio come ogni altro algoritmo. Alcuni algoritmi che trovi in Strumenti sono in
effetti degli script semplici.

In questa sezione verrà spiegato come usare gli algoritmi di Processing dalla console di Python e anche come
scrivere un algoritmo usando Python.

18.5.1 Richiamare algoritmi dalla console di python

La prima cosa da fare è importare le funzioni di Processing con la seguente istruzione:

>>> import processing

Now, there is basically just one (interesting) thing you can do with that from the console: execute an algorithm.
That is done using the runalg() method, which takes the name of the algorithm to execute as its first parameter,
and then a variable number of additional parameters depending on the requirements of the algorithm. So the first
thing you need to know is the name of the algorithm to execute. That is not the name you see in the toolbox, but
rather a unique command–line name. To find the right name for your algorithm, you can use the alglist()
method. Type the following line in your console:

>>> processing.alglist()

Il risultato dovrebbe essere.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
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Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Questa è l’elenco di tutti gli algoritmi disponibili in ordine alfabetico, con il corrispondente nome da utilizzare
nella riga di comando.

Puoi usare una stringa come parametro per questo comando. Invece di restituire l’elenco completo degli algoritmi,
verranno visualizzati solo quelli che includono tale stringa. Se, per esempio, stai cercando un algoritmo per
calcolare la pendenza da un DEM, inserisci alglist ("slope") per ottenere il seguente risultato:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

Il risultato potrebbe cambiare a seconda degli algoritmi disponibili.

Ora è più facile ora trovare sia l’algoritmo che cercavi sia il suo nome da utilizzare nella riga di comando, in
questo caso saga: slopeaspectcurvature.

Una volta che sai qual è il nome dell’algoritmo da utilizzare nella riga di comando, la prossima cosa da fare è
conoscere la giusta sintassi per eseguirlo. Questo significa conoscere quali sono i parametri necessari e l’ordine
in cui questi devono essere dichiarati quando si esegue il comando runalg (). Processing ha un comando
per descrivere un algoritmo in dettaglio, che puoi usare per ottenere un elenco dei parametri che un algoritmo
richiede e gli output che genererà. Puoi usare il comando alghelp (nome_algoritmo). Usa solo il nome
dell’algoritmo nella riga di comando, non il nome descrittivo completo.

Chiamando il metodo saga:slopeaspectcurvature come parametro, otterrai la seguente descrizione:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Ora hai tutto il necessario per eseguire qualsiasi algoritmo. Come già accennato, c’è solo un unico comando per
eseguire algoritmi: ‘‘ runalg () ‘‘. La sua sintassi è la seguente:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

L’elenco dei parametri e degli output da aggiungere dipende dall’algoritmo che vuoi eseguire, ed è esattamente la
lista che il comando alghelp() restituisce, nello stesso ordine, come mostrato.

A seconda del tipo di parametro, i valori sono inseriti in maniera diversa. Il seguente elenco dà una rapida
panoramica di come inserire valori per ogni tipo di parametro in input:

• Layer raster, layer vettoriale o tabella. Basta usare una stringa con il nome che identifica l’oggetto da
utilizzare (il nome che ha nell’area di legenda di QGIS ) o il nome di un file (se il layer corrispondente non
è aperto, sarà aperto, ma non aggiunto alla mappa ). Se si dispone di un’istanza di un oggetto di QGIS che
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rappresenta il layer, è anche possibile utilizzarla come parametro. Se l’input è opzionale e non si desidera
utilizzare alcun dato, utilizzare ‘‘None ‘‘.

• Selezione. Se un algoritmo ha un parametro di selezione, dovresti inserire il valore di questo parametro
usando un valore intero. Per conoscere le opzioni disponibili puoi usare il comando algoptions()
come mostrato nel seguenti esempio:

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In questo caso, l’algoritmo ha uno di questi parametri con sette opzioni, ordinate partendo da zero.

• Input multipli. Il valore è una stringa con descrittori in input separati da un punto e virgola (;). Come nel
caso di layer singoli o tabelle, ogni descrittore in input può essere il nome dell’oggetto o il suo percorso.

• Campo di una Tabella da XXX. Inserisci una stringa con il nome del campo da usare. Il parametro è sensibile
alle lettere maiuscole.

• Tabella fissa. Inserisci l’elenco di tutti i valori delle tabelle separati da una virgola (,) e racchiusi fra
virgolette ("). I valori partono dalla riga in alto e proseguono da sinistra verso destra. Puoi usare un array
2-D per i valori che rappresentano la tabella.

• SR. Inserisci il codice EPSG del SR desiderato.

• Estensione. Usa un stringa con valori xmin, xmax, ymin e ymax separati da virgole (,).

Parametri booleani, di file, di stringa e numerici non hanno bisogno di ulteriori spiegazioni.

I parametri di input, come stringhe, booleani, o valori numerici hanno valori predefiniti. Per utilizzarli, specifica
‘‘ None‘‘ nella corrispondente voce di parametro.

Per per salvare i dati in output, digita il percorso del file da utilizzare, così come viene fatto in Strumenti. Se vuoi
salvare il risultato in un file temporaneo, utilizzare None. L’estensione del file determina il formato del file. Se
inserisci un’estensione del file non inclusa tra quelle supportate dall’algoritmo, verrà utilizzato il formato di file
predefinito per il tipo di output e sarà aggiunta al percorso del file specificato la sua estensione corrispondente .

A differenza di quando un algoritmo viene eseguito dagli Strumenti, gli output non vengono aggiunti alla mappa
quando esegui lo stesso algoritmo dalla console python. Se vuoi aggiungere l’output alla mappa lo devi fare da
solo dopo l’esecuzione dell’algoritmo. Per farlo, puoi usare i comandi delle API di QGIS oppure, più facilmente,
usare uno dei seguenti metodi.

Il metodo runalg restituisce un dizionario con i nomi degli output (quelli visti nella descrizione dell’algoritmo)
come chiavi e il percorso degli output come valori. Puoi caricare questi layer con il metodo load().

18.5.2 Funzioni aggiuntive per la gestione dei dati

Accanto alle funzioni usate per richiamare gli algoritmi, importare il pacchetto processing significa anche
importare funzioni aggiuntive che permettono di lavorare con maggiore facilità con i dati, specialmente con i
vettori. Sono semplicemente funzioni che incorporano le funzionalità delle API di QGIS, ma con una sintassi più
semplice. Dovresti usare queste funzioni quando sviluppi nuovi algoritmi proprio perché è più facile lavorare con
i dati in input.

Di sotto trovi un elenco di alcuni di questi comandi. Ulteriori informazioni possono essere trovate sotto le classi
del pacchetto processing/tools e anche negli script di esempio forniti con QGIS.

• getObject(obj): restituisce un oggetto QGIS (layer o tabella) da precedenti, che può essere un nome
di file o il nome dell’oggetto nella lista dei layer di QGIS.
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• values(layer, fields): restituisce i valori nella tabella degli attributi di un vettore dei campi inter-
essati. Puoi eseguire i campi come nome o come indici basati su zero. Restituisce un dict di elenchi, con gli
identificatori dei campi come chiavi. Considera la selezione esistente.

• features(layer): ti restituisce un iteratore sulla geometria di vettore, considerando la selezione es-
istente.

• uniqueValues(layer, field): restituisce un elenco di valori unici per un dato attributo. Gli at-
tributi possono essere un nome di campo o di un indice con base zero. Considera la selezione esistente.

18.5.3 Creare script ed eseguirli da Strumenti

Puoi creare i tuoi algoritmi scrivendo il codice python corrispondente e aggiungendo solo poche righe extra che
forniscono le informazioni sulla semantica dell’algoritmo. In Strumenti puoi trovare il menu Crea nuovo script nel
gruppo Script. Se fai doppio click su questo menu di aprirà una finestra di dialogo dove potrai inserire il codice.
Salvando lo script nella cartella scripts (cartella predefinita per il salvataggio degli script) con l’estensione
.py verrà automaticamente creato l’algoritmo corrispondente.

Il nome dell’algoritmo (quello che vedrai in Strumenti) viene creato dal nome del file, rimuovendo l’estensione
del file e sostituendo i trattini bassi con spazi vuoti.

Questo di seguito è il codice che calcola l’Indice di Umidità Topografica (Topographic Wetness Index, TWI)
direttamente da un DEM.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Come puoi vedere, durante il calcolo vengono usati tre algoritmi, tutti di SAGA. L’ultimo calcola il TWI, ma
richiede un raster delle pendenze e uno di accumulo dei flussi. Anche se non hai questi layer, li puoi ricavare
direttamente dal DEM grazie agli algoritmi di SAGA.

La parte del codice in cui avviene questo processo non è difficile da capire, una volta lette le sezioni precedenti di
questo capitolo. Le prime linee, tuttavia, hanno bisogno di qualche spiegazione aggiuntiva. Queste forniscono a
Processing le informazioni di cui ha bisogno per trasformare il codice in un algoritmo che potrai eseguire da uno
dei suoi componenti, come gli Strumenti o il modellatore grafico.

Queste righe iniziano con un doppio commento di python (##) a hanno la seguente struttura:

[parameter_name]=[parameter_type] [optional_values]

Ecco un elenco di tutti i tipi di parametri supportati dagli script di Processing, la loro sintassi ed alcuni esempi.

• raster. Un raster.

• vector. Un vettore.

• table. Una tabella.

• number. Un valore numerico Devi fornire un valore predefinito, per esempio, depth=number 2.4.

• string. una stringa. Come per i valori numerici, devi fornire un valore predefinito, per esempio,
name=string Victor.

• boolean. un valore booleano. Aggiungi True o False dopo per scegliere il valore predefinito. Per
esempio, verbose=boolean True.

• multiple raster. Un insieme di raster in input.

• multiple vector. A set of input vector layers.
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• field. Un campo nella tabella degli attributi di un vettore. Il nome del vettore deve essere aggiunto dopo
il tag field. Ad esempio, una volta chiamato il vettore in input con mylayer=vector, puoi usare
myfield=field mylayer per aggiungere come parametro un campo di quel vettore.

• folder. Una cartella.

• file. Un nome di un file.

Il nome del parametro è il nome che ti verrà mostrato durante l’esecuzione dell’algoritmo, ed è anche il nome
della variabile da usare nel codice dello script. Il valore che hai inserito per quel parametro sarà assegnato a una
variabile con quel nome.

Quando viene mostrato il nome del parametro, il nome verrà modificato per migliorare l’aspetto, sostituendo i
trattini con degli spazi. Quindi, per esempio, se vuoi visualizzare il parametro A numerical value, puoi
inserire il nome della variabile anche cosi: A_numerical_value.

I valori dei layer e delle tabelle sono stringhe che contengono il percorso dell’oggetto corrispondente. Per trasfor-
marlo in un oggetto QGIS puoi usare la funzione processing.getObjectFromUri(). Anche gli input
multipli hanno valori di stringhe che contengono il percorso dell’oggetto selezionato, separati da punto e virgola
(”;”).

Gli output sono definiti in maniera simile, usando i seguenti tag:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

Il valore assegnati alle variabili in output è sempre una stringa con il percorso del file. Corrisponderà a un percorso
temporaneo nel caso in cui non hai inserito il nome del file.

Quando dichiari un output, l’algoritmo cercherà di aggiungerlo a QGIS una volta eseguito. Questa è la ragione
per cui, anche se il comando runalg() non carica i layer finali, il layer TWI (nel caso dell’esempio precedente)
verrà caricato, poiché è salvato nel file che hai scelto, ovvero il valore dell’output corrispondente.

Non usare il comando load() negli algoritmi degli script, usalo solo quando lavori con la riga di comando. Se
un layer viene creato come output di un algoritmo, dovrebbe essere dichiarato come tale. Altrimenti non potrai
usare l’algoritmo nel modellatore grafico dal momento che la sua sintassi (come definita dai tag spiegato sopra)
non corrisponde a ciò che l’algoritmo in realtà crea.

Gli output nascosti (numeri e stringhe) non hanno un valore. Sei tu che devi assegnarli un valore. Per farlo, basta
impostare il valore di una variabile con il nome utilizzato per dichiarare quell’output. Per esempio, se hai usato
questa dichiarazione,

##average=output number

la linea seguente imposterà il valore dell’output a 5:

average = 5

Oltre ai tag per i parametri e gli output, è anche possibile definire il gruppo in cui verrà mostrato l’algoritmo,
utilizzando il tag group.

Se l’algoritmo impiega molto tempo per essere eseguito, è una buona idea fornire questa informazione. Hai
a disposizione due comandi globali denominati progress con due metodi disponibili : setText(text) e
setPercentage(percent) per modificare il testo e la barra di avanzamento.

Ti abbiamo fornito diversi esempi. Controllali per vedere alcuni esempi reali di come creare algoritmi che uti-
lizzano queste classi di Processing. Puoi fare clic con il tasto destro su un qualsiasi algoritmo e selezionare Edit
script per modificare il codice o solo per vederlo.
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18.5.4 Documentare gli script

Come nel caso dei modelli, puoi creare una documentazione aggiuntiva per gli script, per spiegare che cosa fanno
e come usarli. Nella finestra di modifica dello script trovi il pulsante [Edit script help]. Cliccaci per aprire una
finestra di editing dell’help. Controlla il capitolo sul modellatore grafico per sapere di più su questa finestra di
dialogo e come usarla.

Gli help file vengono salvati nella stessa cartella dello stesso script, aggiungendo l’estensione .help al nome del
file. Puoi modificare la guida dello script prima di salvarlo per la prima volta. Se in seguito chiudi la finestra di
modifica dello script senza salvarlo (cioè lo scarti), perderai il contenuto già scritto della guida. Se hai già salvato
lo script e se questo è associato ad un nome di file, il salvataggio è fatto automaticamente.

18.5.5 Script agganciati pre e post esecuzione

Gli script possono essere usati come agganci pre e post esecuzione di funzioni prima e dopo che un algoritmo
venga eseguito. Li puoi usare per automatizzare dei compiti da espletare all’esecuzione di un algoritmo.

La sintassi è identica alla sintassi spiegato sopra, ma hai a disposizione anche una variabile globale chiamata alg
che rappresenta l’algoritmo che è appena (o che sarà) stato eseguito.

Nel gruppo General del menu di configurazione di Processing trovi due voci chiamate Pre-execution script file e
Post-execution script file dove puoi inserire il nome del file dello script che deve essere eseguito.

18.6 Il gestore della cronologia di Processing

18.6.1 La cronologia di Processing

Ogni volta che esegui un algoritmo, le informazioni sul processo sono salvate dal gestore della cronologia. Ven-
gono salvati anche i parametri usati, la data ed il tempo di esecuzione.

In questo modo è facile tenere traccia e controllare tutto il lavoro eseguito tramite l’ambiente di Processing, e
riprodurlo.

Il gestore della cronologia è un insieme di registri raggruppati per data di esecuzione: in questo modo è molto
facile trovare l’informazione su uno specifico algoritmo eseguito in un particolare momento.

L’informazione sul processo è conservata come una espressione a riga di comando, anche se l’algoritmo è stato
avviato tramite Strumenti. Questo è molto utile se stai imparando ad usare la riga di comando perché puoi vedere
il comando di un algoritmo eseguito tramite Strumenti.

Oltre a poter scorrere l’elenco del registro, puoi rieseguire i processi semplicemente facendo doppio click sul loro
nome.

18.6.2 Il log di Processing

The history dialog only contains the execution calls, but not the information produced by the algorithm when
executed. That information is written to the QGIS log, in a Processing tab.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is written to the log each time you
run one of those algorithms. To avoid cluttering the log with that information, you can disable it for each provider,
looking for the corresponding option in the provider entry of the settings dialog.

Alcuni algoritmi, anche se vengono correttamente eseguiti e forniscono un risultato, possono aggiungere delle
informazioni nel log se rilevano potenziali problemi con i dati. Guarda i messaggi se vedi che il risultato non è
quello atteso.
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Figure 18.31: Cronologia
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18.7 Writing new Processing algorithms as python scripts

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed to define the semantics of the algorithm. You can find a Create new script
menu under the Tools group in the Script algorithms block of the toolbox. Double-click on it to open the script
edition dialog. That’s where you should type your code. Saving the script from there in the scripts folder (the
default one when you open the save file dialog), with .py extension, will automatically create the corresponding
algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing underscores with blank spaces.

Let’s have the following code, which calculates the Topographic Wetness Index (TWI) directly from a DEM

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates the TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these, but since we have the DEM, we
can calculate them by calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
chapter. The first lines, however, need some additional explanation. They provide the information that is needed to
turn your code into an algorithm that can be run from any of the GUI components, like the toolbox or the graphical
modeler.

These lines start with a double Python comment symbol (##) and have the following structure

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processing scripts, their syntax and some examples.

• raster. A raster layer

• vector. A vector layer

• table. A table

• number. A numerical value. A default value must be provided. For instance, depth=number 2.4

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor

• longstring. Same as string, but a larger text box will be shown, so it is better suited for long strings,
such as for a script expecting a small code snippet.

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True.

• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• extent. A spatial extent defined by xmin, xmax, ymin, ymax

• folder. A folder

• file. A filename
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• crs. A Coordinate Reference System

• selection. A dropdown menu that allows the user to select from a pre-populated list. For example
units=selection sq_km;sq_miles;sq_degrees

• name. Name of the script. This will be displayed as the algorithm name in the processing toolbox. For
example My Algorithm Name=name

• group. Folder name where the script will appear in the Processing Toolbox. For Example, adding
Utils=groups will put the script within a Utils folder within Scripts.

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
underscores with spaces. So, for instance, if you want the user to see a parameter named A numerical value,
you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the filepaths to all selected objects, separated by semicolons (;).

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

• output extent

The value assigned to the output variables is always a string with a filepath. It will correspond to a temporary
filepath in case the user has not entered any output filename.

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

The last tag that you can use in your script header is ##nomodeler. Use that when you do not want your
algorithm to be shown in the modeler window. This should be used for algorithms that do not have a clear syntax
(for instance, if the number of layers to be created is not known in advance, at design time), which make them
unsuitable for the graphical modeler

18.8 Handing data produced by the algorithm

When you declare an output representing a layer (raster, vector or table), the algorithm will try to add it to QGIS
once it is finished. That is the reason why, although the runalg() method does not load the layers it produces,
the final TWI layer will be loaded, since it is saved to the file entered by the user, which is the value of the
corresponding output.

Do not use the load() method in your script algorithms, but just when working with the console line. If a layer
is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly
use the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.
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Hidden outputs (numbers and strings) do not have a value. Instead, it is you who has to assign a value to them. To
do so, just set the value of a variable with the name you used to declare that output. For instance, if you have used
this declaration,

##average=output number

the following line will set the value of the output to 5:

average = 5

18.9 Comunicare con l’utente

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two available methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

If you have to provide some information to the user, not related to the progress of the algorithm, you can use the
setInfo(text) method, also from the progress object.

If your script has some problem, the correct way of propagating it is to raise an exception of type
GeoAlgorithmExecutionException(). You can pass a message as argument to the constructor of the
exception. Processing will take care of handling it and communicating with the user, depending on where the
algorithm is being executed from (toolbox, modeler, Python console...)

18.10 Documenting your scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to find out more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Note that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated with a filename, saving is done automatically.

18.11 Example scripts

Several examples are available in the on-line collection of scripts, which you can access by selecting the Get script
from on-line script collection tool under the Scripts/tools entry in the toolbox.

Please, check them to see real examples of how to create algorithms using the processing framework classes. You
can right-click on any script algorithm and select Edit script to edit its code or just to see it.
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18.12 Best practices for writing script algorithms

Here’s a quick summary of ideas to consider when creating your script algorithms and, especially, if you want to
share with other QGIS users. Following these simple rules will ensure consistency across the different Processing
elements such as the toolbox, the modeler or the batch processing interface.

• Do not load resulting layers. Let Processing handle your results and load your layers if needed.

• Always declare the outputs your algorithm creates. Avoid things such as declaring one output and then
using the destination filename set for that output to create a collection of them. That will break the correct
semantics of the algorithm and make it impossible to use it safely in the modeler. If you have to write an
algorithm like that, make sure you add the ##nomodeler tag.

• Do not show message boxes or use any GUI element from the script. If you want to communicate with the
user, use the setInfo() method or throw an GeoAlgorithmExecutionException

• As a rule of thumb, do not forget that your algorithm might be executed in a context other than the Processing
toolbox.

18.13 Pre- and post-execution script hooks

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax is identical to the syntax explained above, but an additional global variable named alg is available,
representing the algorithm that has just been (or is about to be) executed.

In the General group of the processing config dialog you will find two entries named Pre-execution script file and
Post-execution script file where the filename of the scripts to be run in each case can be entered.

18.14 Configurazione di applicazioni esterne

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external applications are managed by their own algorithm provider.

Questa sezione ti mostrerà come configurare Processing per includere queste appliaczioni aggiuntive e spiegherà
alcune caratteristiche particolari degli algoritmi basati su di essi. Una volta configurato correttamente il sistema,
sarai in grado di eseguire algoritmi esterni da altri componente, come Strumenti o il Modellatore grafico, proprio
come si fa con qualsiasi altro algoritmo spaziale.

By default, all algorithms that rely on an external application not shipped with QGIS are not enabled. You can
enable them in the settings dialog. Make sure that the corresponding application is already installed in your
system.

18.14.1 Nota per gli utenti Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms from these providers will be ready to be run without needing any further configuration. If
installing through OSGeo4W application, make sure you select for installation SAGA, GRASS and OTB as well.

If you want to know more about how these providers work, or if you want to use some algorithms not included in
the simplified toolbox (such as R scripts), keep on reading.
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18.14.2 Nota sui formati dei file

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

L’uso di layer raster GRASS è, per esempio, un caso in cui potreste avere problemi e non essere in grado di
completare il vostro lavoro se lanciate un algoritmo esterno usando in input questo layer. Per questa ragione questi
layer non appariranno disponibili agli algoritmi

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common formats that can later be transformed
by QGIS automatically. As in the case of input layers, if this conversion is needed, that might increase the
processing time.

18.14.3 Nota sulla selezione di layer vettore

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

In altri casi, è necessaria l’esportazione delle sole caratteristiche selezionate, che comporta un allungamento dei
tempi di esecuzione

18.14.4 SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself and your QGIS installer did not include it, the path to the SAGA executable
must be configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named
SAGA Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you
are ready to run SAGA algorithms from QGIS.

If you are running Linux, SAGA binaries are not included with Processing, so you have to download and install
the software yourself. Please check the SAGA website for more information.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folder entries.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.
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Le limitazioni del sistema di griglia di SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

The definition of that common grid system is controlled by the user, and you will find several parameters in the
SAGA group of the settings window to do so. There are two ways of setting the target grid system:

• Setting it manually. You define the extent by setting the values of the following parameters:

– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Notice that QGIS will resample input layers to that extent, even if they do not overlap with it.

• Setting it automatically from input layers. To select this option, just check the Use min covering grid system
for resampling option. All the other settings will be ignored and the minimum extent that covers all the
input layers will be used. The cell size of the target layer is the maximum of all cell sizes of the input layers.

Per gli algoritmi che non operano su molteplici layers o che non necessitano di un’unica griglia, non verrà operato
alcun campionamento.

Limitazioni per i raster multi-banda

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).

Limitations in cell size

SAGA assumes that raster layers have the same cell size in the X and Y axis. If you are working with a layer with
different values for horizontal and vertical cell size, you might get unexpected results. In this case, a warning will
be added to the processing log, indicating that an input layer might not be suitable to be processed by SAGA.

Registrazioni di controllo

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

Molti altri fornitori di algoritmi che usano applicazioni esterne e le chiamano tramite la linea di comando hanno
simili opzioni, così che troverete esse anche in altri posizioni nella lista di impostazioni di processing.
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18.14.5 R. Creating R scripts

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can run
(except for a few examples). Instead, you should write your scripts and call R commands, much like you would do
from R, and in a very similar manner to what we saw in the section dedicated to processing scripts. This section
shows you the syntax to use to call those R commands from QGIS and how to use QGIS objects (layers, tables)
in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell QGIS where your R binaries are located.
You can do this using the R folder entry in the processing configuration dialog. Once you have set that parameter,
you can start creating and executing your own R scripts.

Nota: for Windows user, usually the R executable file is in the C:Program FilesRR-3.2 folder. Add just
the folder and NOT the binary!

Ancora una volta, la cosa è diversa in Linux e dovete solo assicurarvi che la cartella di R sia inclusa nella variabile
di ambiente PATH; se eseguendo il comando R in una console, R si avvia, allora siete pronti per partire.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

R script files have the extension .rsx, and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can set this folder in the R settings group
(available from the processing settings dialog), just like you do with the folder for regular processing scripts.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the Processing
scripts that we have already seen, so they will not be described here again.

Please have a look at the R Intro and the R Syntax Training Manual Chapters to have more information on how to
write your own R scripts-

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of
a parameter is also the name of the variable that we can use in R for accessing the value of that parameter (thus,
you should avoid using reserved R words as parameter names).

Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Tables are opened using the read.csv() command. If a table entered by the user is not in CSV format, it will
be converted prior to importing it into R.

Additionally, raster files can be read using the readGDAL() command instead of brick() by using the
##usereadgdal.
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If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilenames tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

Dalla precedente informazione, è possibile capire la prima riga del nostro primo file script di esempio (prima riga
che non inizia con un commento Python).

pts=spsample(polyg,numpoints,type="random")

La variabile polygon contiene un oggetto SpatialPolygonsDataFrame che può essere usato per chiamare
la funzione spsample o similmente la funzione numpoints che indica il numero di punti da aggiungere alla
griglia creata.

Since we have declared an output of type vector named out, we have to create a variable named out and store a
Spatial*DataFrame object in it (in this case, a SpatialPointsDataFrame). You can use any name for
your intermediate variables. Just make sure that the variable storing your final result has the same name that you
used to declare it, and that it contains a suitable value.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
##dontuserasterpackage option. If you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

If you have used the ##passfilenames option, outputs are generated using the raster package (with
writeRaster()), even though it is not used for the inputs.

If your algorithm does not generate any layer, but rather a text result in the console instead, you have to indicate
that you want the console to be shown once the execution is finished. To do so, just start the command lines that
produce the results you want to print with the > (‘greater’) sign. The output of all other lines will not be shown.
For instance, here is the description file of an algorithm that performs a normality test on a given field (column) of
the attributes of a vector layer:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Se il vostro algoritmo produce qualche tipo di risultato grafico (usando la funzione plot()) dovete aggiungere
la linea seguente:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Sia i risultati grafici che quelli da console saranno mostrati nel gestore risultati di processing.

For more information, please check the script files provided with Processing. Most of them are rather simple and
will greatly help you understand how to create your own scripts.

Nota: rgdal and raster libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R dis-
tribution). However, other additional libraries that you might need have to be explicitly loaded by typing,
library(ggplot2). If the package is not already installed on your machine, Processing will download and
install it. In this way the package will be also available in R Standalone. Be aware that if the package has to be
downloaded, the first time you run the script it might take a long time.
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18.14.6 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionally, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

Se state usando Linux dovete solo assicurarvi che GRASS è correttamente installato e che può essere attivato
senza problemi da una console.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behavior you prefer, just check the Use
min covering region option in the GRASS configuration parameters.

18.14.7 GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

18.14.8 Orfeo Toolbox

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are running Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Then, configure the path to the folder where OTB command-line tools and libraries are installed:

• Usually OTB applications folder points to /usr/lib/otb/applications and OTB command line
tools folder is /usr/bin.

• If you use any of the installers that include OTB, such as OSGeo4W, there is no need for further con-
figuration. Processing will detect the path automatically and will not show the corresponding configuration
entries. Otherwise, fill the OTB applications folder and OTB command line tools folder parameters with the
to the corresponding values for your installation.

18.14.9 TauDEM

TauDEM (Terrain Analysis Using Digital Elevation Models) is a tools for the extraction and analysis of hydrolog-
ical information from Digital Elevation Models (DEM). TauDEM can be used from QGIS if you have it installed
in your system and configured QGIS properly, so it can find all necessary files.

There are two versions of TauDEM tools: singlefile (TauDEM 5.0.6 or 5.1.2) and multifile (TauDEM 5.2.0). The
difference between these versions in the supported inputs/outputs. Single files version accepts only single raster
file and write single file as output. Multifile version accepts a directory with rasters and writes directory with
rasters as output. Such directory should contain rasters that will be treated as a single DEM grid.
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TauDEM Processing provider supports both single- and multifile versions of TauDEM and even allows to use them
simultaneously.

Nota: While TauDEM Processing provider supports TauDEM 5.0.6, 5.1.2 and 5.2.0 we recommend to use 5.1.2
and/or 5.2.0 as this versions have some new tools available, like Gage Watershed and TWI.

Installing TauDEM under Windows

Please visit the TauDEM homepage and download desired version of the precompiled binaries for your platform
(32-bit or 64-bit), usually this is “Command Line Executables”. Also you need to download Microsoft HPC Pack
2012 MS-MPI. First install Microsoft HPC Pack 2012 MS-MPI by runing mpi_x64.Msi for 64-bit platforms
and mpi_x86.Msi for 32-bit platforms.

Nota: If you want to use TauDEM 5.0.6

Installing TauDEM under Linux

Unfortunately there are no packages for most Linux distributions, so you should compile TauDEM by yourself.
As TauDEM uses MPI it is necessary to install first any MPI implementation e.g MPICH or OpenMPI. Use your
favorite package manager to install MPICH or OpenMPI.

Download TauDEM 5.2.0 source code package from GitHub repository and extract archive contents. Open termi-
nal and cd into src directory inside extracted folder. Create build directory and cd into it

mkdir build
cd build

Configure your build (change install prefix if necessary) and compile

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..
make

When compilation finished install TauDEM tools by running

sudo make install

Nota: Executable files will be installed into bin subdirectory inside prefix you specified at the con-
figure stage. For example if you specified prefix /opt/taudem5.2 than binaries will be installed into
/opt/taudem5.2/bin.

To use singlefile version — download source package here and perform above mentioned steps to compile and
install it.

Old TauDEM 5.0.6 also available. But before compiling this version it is necessary to edit some source files.

Open the linearpart.h file, and after line

#include "mpi.h"

add a new line with

#include <stdint.h>

così avrete

#include "mpi.h"
#include <stdint.h>

Save the changes and close the file. Now open tiffIO.h, find line #include "stdint.h" and replace
quotes ("") with <>, so you’ll get
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#include <stdint.h>

Save the changes and close the file.

Now configure, compile and install TauDEM 5.0.6 using same commands as described above.

Configuring TauDEM provider

Once TauDEM is installed, start QGIS, open the Processing options dialog from Processing → Options... and
configure the TauDEM algorithm provider. In the Providers group find TauDEM (hydrologic analysis) block, and
expand it. Here you will see all settings related to TauDEM.

First, ensure that algorithms are enabled, and activate provider if necessary.

Next step is to configure MPI. The MPICH/OpenMPI bin directory setting used to define location of the mpiexec
program. In most Linux distributions you can safely leave this empty, as mpiexec available in your PATH.

The Number of MPI parallel processes to use is a second setting related to MPI. It defines number of processes
that will be used to execute TauDEM commands. If you don’t know which value to use, it is better to leave this
value unchanged.

Now we need to configure the path to the folder(s) where TauDEM command-line tools are installed. As we
already mention TauDEM provider supports both single- and multifile TauDEM, so there are two settings for
TauDEM folders:

• TauDEM command line tools folder used to set location of the singlefile tools

• TauDEM multifile command line tools folder used to set location of the multifile tools

If you have both TauDEM versions installed in different directories it is possible to specify both options.

The last step is to define which TauDEM version to use:

• with Enable multifile TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM multifile command line tools folder. Multifile tools have same name as singlefile
with “(multifile)” suffix added

• with Enable single TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM command line tools folder.

It is possible to enable both tools simultaneously. In this case you will have two instances of each tool in toolbox
and can use them in your analysis.

Nota: Be careful with developing Processing models using TauDEM!
As single- and multifile versions have different inputs, model created with singlefile algorithms will not work if
only multifile algorithms are available. If you plan to share your model please specify which TauDEM version
should be used or, better, provide two versions of your model: for single- and multifile TauDEM.

18.15 La riga di comando

Processing comprende un strumento pratico che permette di eseguire gli algoritmi senza dover utilizzare la finestra
strumenti, ma semplicemente digitando il nome dell’algoritmo che si desidera eseguire.

Questo strumento è conosciuto come il Riga di comando, ed è solo una semplice riga di testo con completamento
automatico in cui puoi digitare il comando desiderato.

The Commander is started from the Processing menu or, more practically, by pressing Shift + Ctrl + M
(you can change that default keyboard shortcut in the QGIS configuration if you prefer a different one). To close
it, just press ESC. Apart from executing Processing algorithms, the Commander gives you access to most of the
functionality in QGIS, which means that it gives you a practical and efficient way of running QGIS tasks and
allows you to control QGIS with reduced usage of buttons and menus.
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Figure 18.32: La riga di comando

Moreover, the Commander is configurable, so you can add your custom commands and have them just a few
keystrokes away, making it a powerful tool to help you become more productive in your daily work with QGIS.

18.15.1 Comandi disponibili

I comandi disponibili nella Linea di comando ricadono nelle seguenti categorie:

• Algoritmi di Processing. Questi sono mostrati come: Processing algorithm: <name of the
algorithm>.

• Menu items. These are shown as Menu item: <menu entry text>. All menus items available
from the QGIS interface are available, even if they are included in a submenu.

• Funzioni python. Puoi creare brevi funzioni python che verranno incluse nella lista dei comandi disponibili.
Verranno mostrare come Function: <function name>.

Per eseguire un comando qualsiasi elencato sopra, inizia inserendo il nome del comando e poi seleziona l’elemento
corrispondente dalla lista che mostrerà automaticamente i comandi filtrati con quello che hai inserito.

In the case of calling a Python function, you can select the entry in the list, which is prefixed by Function:
(for instance, Function: removeall), or just directly type the function name (removeall in the previous
example). There is no need to add brackets after the function name.

18.15.2 Creare funzioni personalizzate

Custom functions are added by entering the corresponding Python code in the commands.py file that is found
in the .qgis2/processing/commander directory in your user folder. It is just a simple Python file where
you can add the functions that you need.

The file is created with a few example functions the first time you open the Commander. If you haven’t launched
the Commander yet, you can create the file yourself. To edit the commands file, use your favourite text editor. You
can also use a built-in editor by calling the edit command from the Commander. It will open the editor with the
commands file, and you can edit it directly and then save your changes.

Per esempio, puoi aggiungere la funzione seguente che rimuove tutti i layer:

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Una volta che hai aggiunto la funzione, questa sarà disponibile nella linea di comando e la potrai richiamare con
il comando removeall. Non devi fare altro che scrivere la funzione.
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Le funzioni possono avere parametri aggiuntivi. Aggiungi *args alla definizione della funzione in modo da
aggiungere parametri. Richiamando la funzione dalla linea di comando, i parametri devono essere separati da
spazi.

Qui un esempio di funzione che carica un layer e prende un parametro con il nome del file del layer da caricare.

import processing

def load(*args):
processing.load(args[0])

If you want to load the layer in /home/myuser/points.shp, type in the Commander text box:

‘‘load /home/myuser/points.shp‘‘
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CHAPTER 19

Print Composer

With the Print Composer you can create nice maps and atlasses that can be printed or saved as PDF-file, an image
or an SVG-file. This is a powerful way to share geographical information produced with QGIS that can be included
in reports or published.

19.1 Overview of the Print Composer

The Print Composer provides growing layout and printing capabilities. It allows you to add elements such as
the QGIS map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML
frames. You can size, group, align, position and rotate each element and adjust their properties to create your
layout. The layout can be printed or exported to image formats, PostScript, PDF or to SVG (export to SVG is
not working properly with some recent Qt4 versions; you should try and check individually on your system). You
can save the layout as a template and load it again in another session. Finally, generating several maps based on a
template can be done through the atlas generator.

19.1.1 Sample Session

Before you start to work with the Print Composer, you need to load some raster or vector layers in the QGIS map
canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized to

your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will be
prompted to choose a title for the new Composer.

To demonstrate how to create a map please follow the next instructions.

1. On the left side, select the Add new map toolbar button and draw a rectangle on the canvas holding down
the left mouse button. Inside the drawn rectangle the QGIS map view to the canvas.

2. Select the Add new scalebar toolbar button and click with the left mouse button on the Print Composer
canvas. A scalebar will be added to the canvas.

3. Select the Add new legend toolbar button and draw a rectangle on the canvas holding down the left mouse
button. Inside the drawn rectangle the legend will be drawn.

4. Select the Select/Move item icon to select the map on the canvas and move it a bit.

5. While the map item is still selected you can also change the size of the map item. Click while holding down
the left mouse button, in a white little rectangle in one of the corners of the map item and drag it to a new
location to change it’s size.

6. Click the Item Properties tab on the left lower panel and find the setting for the orientation. Change the
value of the setting Map orientation to ‘15.00° ‘. You should see the orientation of the map item change.

7. Now, you can print or export your print composition to image formats, PDF or to SVG with the export tools
in Composer menu.
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8. Finally, you can save your print composition within the project file with the Save Project button.

You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

19.1.2 The Composer Manager

The Composer Manager is the main window to manage print composers in the project. It helps you add new print

composer, duplicate an existing one, rename or delete it. To open the composer manager dialog, click on the
Composer Manager button in the toolbar or choose Composer → Composer Manager. It can also be reached from the
main window of QGIS with Project → Composer Manager.

Figure 19.1: The Print Composer Manager

The composer manager lists in its upper part all the available print composers in the project. The bottom part
shows tools that help to:

• show the selected composer(s): you can open multiple print composers in one-click

• duplicate the selected composer (available only if one print composer is selected): it creates a new composer
using the selected composer as template. You’ll be prompted to choose a new title for the new composer

• rename the composer (also available only if one print composer is selected): You’ll be prompted to choose
a new title for the composer. Note that you can also rename the composer by double-clicking on its title in
the upper part

• remove the composer: the selected print composer(s) will be deleted from the project.

With the Composer Manager, it’s also possible to create new print composers as an
empty composer or from a saved template. By default, QGIS will look for tem-
plates in user directory (~/.qgis2/composer_templates) or application’s one
(ApplicationFolder/composer_templates). QGIS will retrieve all the available templates and
propose them in the combobox. The selected template will be used to create a new composer when clicking Add
button. You can also save composer templates in another folder. Choosing specific in the template list offers the
ability to select such template and use it to create a new print composer.

19.1.3 Menus, tools and panels of the print composer

Opening the Print Composer provides you with a blank canvas that represents the paper surface when using the
print option. Initially you find buttons on the left beside the canvas to add map composer items: the current QGIS

304 Chapter 19. Print Composer



QGIS User Guide, Release 2.14

map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In
this toolbar you also find toolbar buttons to navigate, zoom in on an area and pan the view on the composer and
toolbar buttons to select a map composer item and to move the contents of the map item.

Figure_composer_overview shows the initial view of the Print Composer before any elements are added.

Figure 19.2: Print Composer

On the right beside the canvas you find two panels. The upper panel holds the tabs Items and Command History
and the lower panel holds the tabs Composition, Item properties and Atlas generation.

• The Items tab provides a list of all map composer items added to the canvas.

• The Command history tab displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition tab allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all items will be converted to raster before printing or saving as PostScript or PDF. In this tab,
you can also customize settings for grid and smart guides.

• The Item Properties tab displays the properties for the selected item. Click the Select/Move item icon to
select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties tab and
customize the settings for the selected item.

• The Atlas generation tab allows you to enable the generation of an atlas for the current Composer and gives
access to its parameters.
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In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number, a combo box to set the zoom level, the number of selected items if applicable and, in the case of atlas
generation, the number of features.

In the upper part of the Print composer window, you can find menus and other toolbars. All Print Composer tools
are available in menus and as icons in a toolbar. See a list of tools in table_composer_1.

The toolbars and the tabs can be switched off and on using the right mouse button over any toolbar or through
View → Toolbars or View → Panels.

Tools

Icon Purpose Icon Purpose

Save Project New Composer

Duplicate Composer Composer Manager

Load from template Save as template

Print or export as PostScript Export to an image format

Export print composition to SVG Export as PDF

Revert last change Restore last change

Zoom to full extent Zoom to 100%

Zoom in Zoom out

Refresh View

Pan Zoom to specific region

Select/Move item in print composition Move content within an item

Add new map from QGIS map canvas Add image to print composition

Add label to print composition Add new legend to print composition

Add scale bar to print composition Add basic shape to print composition

Add arrow to print composition Add attribute table to print composition

Add an HTML frame

Group items of print composition Ungroup items of print composition

Lock Selected Items Unlock All items

Raise selected items Lower selected items

Move selected items to top Move selected items to bottom

Align selected items left Align selected items right

Align selected items center Align selected items center vertical

Align selected items top Align selected items bottom

Preview Atlas First Feature

Previous Feature Next Feature

Last feature Print Atlas

Export Atlas as Image Atlas Settings

Table Composer 1: Print Composer Tools
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Composer Menu

With the Composer → Save Project action, you can save the project file directly from the print composer window.
The Composer menu also provides actions to:

• Create a new and blank print composer with New Composer...

• Duplicate Composer... : Create a new print composer by duplicating the current one

• Open the Composer Manager...

• Print Composers... : Open an existing print composer

Once the layout is designed, with Save as template and Add items from template icons, you can save the current state
of a Print Composer session as a .qpt template and load its item again in another session.

In the Composer menu, there are also powerful ways to share geographical information produced with QGIS that

can be included in reports or published. These tools are Export as Image..., Export as PDF..., Export as SVG... and
Print....

Settings Menu

From Settings → Composer Options you can set some options that will be used as default on any composer during
your work.

• Compositions defaults let you specify the default font to use.

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses.

• Grid and guide defaults defines spacing, offset and tolerance of the grid.

Edit Menu

Copy/Cut and Paste Items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position. Using the Edit → Paste in Place action or pressing Ctrl+Shift+V will paste the items into the current
page, at the same position they were in their initial page. It ensures to copy/paste items at the same place, from
page to page.

Nota: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the Item
Properties tab.

View Menu

Navigation Tools

To navigate in the canvas layout, the Print Composer provides some general tools:

• Zoom In

• Zoom Out
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• Zoom Full

• Zoom to 100%

• Refresh view (if you find the view in an inconsistent state)

• Show Grid behind items.

• Snap Grid to snap items on the grid.

• Show Guides to help user to align items. These are red line that you can click in the rule (above or at the
left side of the layout) and drag and drop to the desired location.

• Snap Guides: allows user to snap items to the guides,

• Smart Guides: uses other composer items as guides to dynamically snap to as user moves or reshapes an
item.

• Clear Guides to remove all current guides.

• Show Bounding box around the items.

• Show Rules around the layout.

• Show Pages or set up pages to transparent. Often composer is used to create non-print layouts, e.g. for
inclusion in presentations or other documents, and it’s desirable to export the composition using a totally
transparent background. It’s sometimes referred to as “infinite canvas” in other editing packages.

• Toggle Full Screen makes the composer window to full screen.

• Hide Panels hides/shows the right panel

• Panels lists all panels available to hide/show them.

• Toolbars same as above for toolbars.

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need
to switch to pan mode while working in the Composer area, you can hold the Spacebar or the mouse wheel.
With Ctrl+Spacebar, you can temporarily switch to Zoom In mode, and with Ctrl+Shift+Spacebar, to
Zoom Out mode.

Hide and Show Panels

To maximise the space available to interact with a composition you can use View → Hide panels or press F10.

Nota: It’s also possible to switch to a full screen mode to have more space to interact by pressing F11 or using
View → Toggle full screen.

Composition Tab

Page size and settings

In the Composition tab, you can define the global settings of the current composition.

You can choose one of the Presets formats for your paper sheet, or enter your custom width, height and units. You
can also choose the page Orientation to use.

Composition can be divided into several pages. For instance, a first page can show a map canvas, and a second
page can show the attribute table associated with a layer, while a third one shows an HTML frame linking to your
organization website. Set the Number of pages to the desired value. you can also custom the Page Background
with the color or the symbol you want.
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Figure 19.3: Composition settings in the Print Composer

The Page size options apply to all the pages in the composition. However, you can modify the values using the
data defined override options (see Data Defined Override Buttons).

A custom page size can also be set, using the Resize page tool. This creates an unique page composition, resizes
the page to fit the current contents of the composition (with optional margins).

Export settings

You can define a resolution to use for all exported maps in Export resolution. This setting can however be overrid-

den each time you are exporting a map. When checked, print as raster means all elements will be rasterized
before printing or saving as PostScript or PDF.

While exporting to an image file format, you can choose to generate a world file by checking World file on and
select a map item. The world file is created beside the exported map, has same name and contains information to
easily georeference it.

Figure 19.4: Export Settings in the Print Composer
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Grid and guides

You can put some reference marks on your composition paper sheet to help you place some items. These marks
can be:

• simple lines (called Guides) put at the position you want. To do that, ensure that Show Rulers and Show
Guides in View menu are checked. Then, click and drag from within the ruler to the paper sheet. A vertical
or horizontal line is added to the paper and you can set its position following the coordinates displayed at
the left bottom of the composer dialog.

• or regular Grid.

Whether grids or guides should be shown is set in View menu. There, you can also decide if they might be used to
snap composer items. The Grid and guides section lets you customize grid settings like Grid spacing, Grid offset
and Snap tolerance to your need. The tolerance is the maximum distance below which an item is snapped to a
grid or a guide.

Figure 19.5: Snapping to grids in the Print Composer

In the Options → Composer menu in QGIS main canvas, you can also set the spacing, offset and snap tolerance
of the grid as much as its style and color. These options are applied by default to any new print composer.

Command History Tab: Revert and Restore actions

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Revert last change

• Restore last change

This can also be done by mouse click within the Command history tab (see figure_composer_1). The History tab
lists the last actions done within the composer. Just select the point you want to revert to and once you do new
action all the actions done after the selected one will be removed.

Figure 19.6: Command history in the Print Composer

Items Tab

The Items tab offers some options to manage selection and visibility of items. All the items added to the print
composer canvas are shown in a list and selecting an item makes the corresponding row selected in the list as well
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as selecting a row does select the corresponding item in the print composer canvas. This is thus a handy way to
select an item placed behind another one. Note that a selected row is shown as bold.

For any selected item, you can :

• set it visible or not,

• lock or unlock its position,

• order its Z position. You can move up and down each item in the list with a click and drag. The upper item
in the list will be brought to the foreground in the print composer canvas. By default, a newly created item
is placed in the foreground.

• change the name by double-clicking the text.

Once you have found the correct position for an item, you can lock it by ticking the box in column. Locked
items are not selectable on the canvas. Locked items can be unlocked by selecting the item in the Items tab and
unchecking the tickbox or you can use the icons on the toolbar.

19.2 Composer Items

19.2.1 Composer Items Common Options

Composer items have a set of common properties you will find on the bottom of the Item Properties tab: Position
and size, Rotation, Frame, Background, Item ID and Rendering (See figure_composer_common_1).

• The Position and size dialog lets you define the size and position of the frame which contains the item. You
can also choose which Reference point will be set at the X and Y coordinates previously defined.

• The Rotation sets the rotation of the element (in degrees).

• The Frame shows or hides the frame around the item. Click on the [Color] and [Thickness] buttons to
adjust those properties.

• Use the Background color menu for setting a background color. Click on the [Color...] button to display a
dialog where you can pick a color or choose from a custom setting. Transparency can be adjusted through
atlering the alpha field settings.

• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
other potential web clients. You can set an ID on an item (for example, a map or a label), and then the
web client can send data to set a property (e.g., label text) for that specific item. The GetProjectSettings
command will list the items and IDs which are available in a layout.

• Rendering mode helps you set whether and how the item can be displayed.

Nota:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map
item or use expressions. These are particularly helpful with atlas generation (See Data Defined Override
Buttons).

Rendering mode

QGIS now allows advanced rendering for Composer items just like vector and raster layers.
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Figure 19.7: Common Item properties Dialogs

Figure 19.8: Rendering mode
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• Blending mode: With this tool you can achieve effects which would otherwise only be achieved using
graphic rendering software. The pixels of your overlaying and underlaying items can be mixed according
to the mode set (see Blending Modes for description of each effect).

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the menu beside the slider.

• Exclude item from exports: You can decide to make an item invisible in all exports. After activating this
checkbox, the item will not be included in export to PDF, print etc..

Size and position

Each item inside the Composer can be moved and resized to create a perfect layout. For both operations the

first step is to activate the Select/Move item tool and to click on the item; you can then move it using the mouse
while holding the left button. If you need to constrain the movements to the horizontal or the vertical axis, just
hold the Shift button on the keyboard while moving the mouse. If you need better precision, you can move
a selected item using the Arrow keys on the keyboard; if the movement is too slow, you can speed up it by
holding Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using the grid snapping or smart guides. Guides are set by clicking
and dragging within the ruler area. To move a guide, click on the ruler, level with the guide and drag it to a new
position. To delete a guide move it off the canvas. If you need to disable the snap on the fly, hold Ctrl while
moving the mouse.

You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items tab. Locked items are not selectable on the canvas.

Locked items can be unlocked by selecting the item in the Items tab and unchecking the tickbox or you can use
the icons on the toolbar.

To unselect an item, just click on it holding the Shift button.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.

Alignment

Raising or lowering the visual hierarchy for elements are inside the Raise selected items pull-down menu. Choose
an element on the Print Composer canvas and select the matching functionality to raise or lower the selected
element compared to the other elements. This order is shown in the Items tab. You can also raise or lower objects
in the Items tab by clicking and dragging an object’s label in this list.

There are several alignment options available within the Align selected items pull-down menu (see fig-
ure_composer_common_3). To use an alignment function, you first select the elements then click on the matching
alignment icon. All selected elements will then be aligned to their common bounding box. When moving items
on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.
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Figure 19.9: Alignment helper lines in the Print Composer
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19.2.2 L’Oggetto Mappa

Clicca sul pulsante Aggiungi mappa presente nella barra degli strumenti del compositore di stampe per aggiun-
gere una mappa. Ora tieni premuto il pulsante del mouse e trascina il rettangolo corrispondente per aggiungere
la mappa. Per visualizzare la mappa attuale puoi scegliere fra tre differenti modalità accessibili dalla scheda
Proprietà oggetto:

• Rettangolo è l’impostazione predefinita. Visualizza un rettangolo vuoto con la scritta ‘La mappa verrà
stampata qui’.

• Cache disegna la mappa alla risoluzione corrente dello schermo. Se ingrandisci/rimpiccolisci la finestra del
compositore di stampe, la mappa non viene ridisegnata, ma l’immagine viene scalata.

• Render means that if you zoom the Composer window in or out, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache è la modalità predefinita per ogni nuova composizione di stampa.

You can resize the map item by clicking on the Select/Move item button, selecting the element, and dragging one
of the blue handles in the corner of the map. This button also helps to move the map to another place. Select the
item and while holding the left mouse button, move to the new place and release the mouse button. After you have
found the right place for an item, you can lock the item position within the Print Composer canvas. Select the map

item and use the toolbar Lock Selected Items or the Items tab to Lock the item. A locked item can only be selected

using the Items tab. Once selected you can use the Items tab to unlock individual items. The Unlock All Items icon
will unlock all locked composer items. With the map selected, you can now adapt more properties in the map Item
Properties tab.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map item frame with the left mouse button.

Proprietà principali

La voce Proprietà principali presente nella scheda Proprietà oggetto fornisce le seguenti funzionalità (vedi fig-
ure_composer_map_1):

• L’area Anteprima ti permette di scegliere fra le modalità ‘Rettangolo’, ‘Cache’ e ‘Visualizza’ descritte so-
pra. Se cambi la vista della mappa in QGIS cambiando le proprietà dei vettori e dei raster, puoi aggiornare
la vista del compositore selezionando l’elemento corrispondente e premendo il pulsante [Aggiorna an-
teprima].

• Il campo Scale ti permette di inserire una scala manuale.

• The field Map rotation allows you to rotate the map element content clockwise in degrees. The
rotation of the map view can be imitated here. Note that a correct coordinate frame can only be added with
the default value 0 and that once you defined a Map rotation it currently cannot be changed.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.

• You can choose to lock the layers shown on a map item. Check Lock layers for map item. After this
is checked, any layer that would be displayed or hidden in the main QGIS window will not appear or be
hidden in the map item of the Composer. But style and labels of a locked layer are still refreshed according
to the main QGIS interface. You can prevent this by using Lock layer styles for map item.

• The button allows you to add quickly all the presets views you have prepared in QGIS. Clicking on the
button you will see the list of all the preset views: just select the preset you want to display. The map

canvas will automatically lock the preset layers by enabling the Lock layers for map item: if you want

to unselect the preset, just uncheck the and press the button. See Layers Panel to find out how to
create presets views.
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Figure 19.10: Scheda proprietà oggetti

Locked layers in the map can also be data-defined, using the icon beside the option. When used, this
overrides the selection set in the drop-down list. You need to pass a list of layers separated by | character.
The following example locks the map item to use only layers layer 1 and layer 2:

concat (’layer 1’, ’|’, ’layer 2’)

Extents

The Extents dialog of the map item tab provides the following functionalities (see figure_composer_map_2):

Figure 19.11: Map Extents Dialog

• The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking
the [Set to map canvas extent] button. This button sets the map extent of the composer map item to the
extent of the current map view in the main QGIS application. The button [View extent in map canvas]
does exactly the opposite, it updates the extent of the map view in the QGIS application to the extent of the
composer map item.
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If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_map_1).

Grids

The Grids dialog of the map Item Properties tab provides the possibility to add several grids to a map item.

• With the plus and minus button you can add or remove a selected grid.

• With the up and down button you can move a grid in the list and set the drawing priority.

When you double click on the added grid you can give it another name.

Figure 19.12: Map Grids Dialog

After you have added a grid, you can activate the checkbox Draw grid to overlay a grid onto the map element.
Expand this option to provide a lot of configuration options, see Figure_composer_map_4.

Figure 19.13: Draw Grid Dialog

As grid type, you can specify to use a ‘Solid’, ‘Cross’, ‘Markers’ or ‘Frame and annotations only’. ‘Frame and
annotations only’ is especially useful when working with rotated maps or reprojected grids. In the divisions section
of the Grid Frame Dialog mentioned below you then have a corresponding setting. Symbology of the grid and
its rendering mode can be chosen. See Rendering mode. Furthermore, you can define an interval in the X and Y
directions, an X and Y offset, and the width used for the cross or line grid type.

• There are different options to style the frame that holds the map. Following options are available: No Frame,
Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Lineborder.
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Figure 19.14: Grid Frame Dialog

• With ‘Latitude/Y only’ and ‘Longitude/X only’ setting in the divisions section you have the possibility to
prevent a mix of latitude/y and longitude/x coordinates showing on a side when working with rotated maps
or reprojected grids.

• Advanced rendering mode is also available for grids.

• The Draw coordinates checkbox allows you to add coordinates to the map frame. You can choose the
annotation numeric format, the options range from decimal to degrees, minute and seconds, with or without
suffix, aligned or not and a custom format using the expression dialog. You can choose which annotation
to show. The options are: show all, latitude only, longitude only, or disable(none). This is useful when the
map is rotated. The annotation can be drawn inside or outside the map frame. The annotation direction can
be defined as horizontal, vertical ascending or vertical descending. Finally, you can define the annotation
font, the annotation font color, the annotation distance from the map frame and the precision of the drawn
coordinates.

Overviews

The Overviews dialog of the map Item Properties tab provides the following functionalities:

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map and the map you want to
use as the overview map, just like a normal map.

Then expand Overviews option and press the green plus icon-button to add an overview. Initially this overview
is named ‘Overview 1’ (see Figure_composer_map_7). You can change the name when you double-click on the
overview item in the list named ‘Overview 1’ and change it to another name.

• With the plus and minus button you can add or remove an overview.

• With the up and down button you can move an overview in the list and set the drawing priority.

When you select the overview item in the list you can customize it.

• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• The Map frame combo list can be used to select the map item whose extents will be drawn on the present
map item.

• The Frame Style allows you to change the style of the overview frame.

• The Blending mode allows you to set different transparency blend modes.
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Figure 19.15: Grid Draw Coordinates dialog

Figure 19.16: Map Overviews Dialog
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• The Invert overview creates a mask around the extents when activated: the referenced map extents are
shown clearly, whereas everything else is blended with the frame color.

• The Center on overview puts the extent of the overview frame in the center of the overview map. You
can only activate one overview item to center, when you have added several overviews.

19.2.3 The Label Item

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties tab.

The Item Properties tab of a label item provides the following functionality for the label item (see Fig-
ure_composer_label):

Figure 19.17: Label Item properties Tab

Main properties

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Labels can be interpreted as HTML code: check Render as HTML. You can now insert a URL, a
clickable image that links to a web page or something more complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be
useful, particularly associated with the atlas functionality: geometry functions and records functions. At the
bottom, a preview of the expression is shown.

Appearance

• Define Font by clicking on the [Font...] button or a Font color selecting a color using the color selection
tool.
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• You can specify different horizontal and vertical margins in mm. This is the margin from the edge of the
composer item. The label can be positioned outside the bounds of the label e.g. to align label items with
other items. In this case you have to use negative values for the margin.

• Using the Alignment is another way to position your label. Note that when e.g. using the Horizontal
alignment in Center Position the Horizontal margin feature is disabled.

19.2.4 The Legend Item

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties tab.

The Item properties of a legend item tab provides the following functionalities (see figure_composer_legend_1):

Figure 19.18: Legend Item properties Tab

Main properties

The Main properties dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_2):

Figure 19.19: Legend Main properties Dialog

In Main properties you can:

• Change the title of the legend.
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• Set the title alignment to Left, Center or Right.

• You can choose which Map item the current legend will refer to in the select list.

• You can wrap the text of the legend title on a given character.

Legend items

The Legend items dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_3):

Figure 19.20: Legend Legend Items Dialog

• The legend will be updated automatically if Auto-update is checked. When Auto-update is unchecked
this will give you more control over the legend items. The icons below the legend items list will be activated.

• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, edit layer names and add a filter.

– The item order can be changed using the [Up] and [Down] buttons or with ‘drag-and-drop’ function-
ality. The order can not be changed for WMS legend graphics.

– Use the [Add group] button to add a legend group.

– Use the [plus] and [minus] button to add or remove layers.

– The [Edit] button is used to edit the layer, groupname or title. First you need to select the legend item.

– The [Sigma] button adds a feature count for each vector layer.

– Use the [filter] button to filter the legend by map content, only the legend items visible in the map will
be listed in the legend.

After changing the symbology in the QGIS main window, you can click on [Update All] to adapt the
changes in the legend element of the Print Composer.

Fonts, Columns, Symbol

The Fonts, Columns and Symbol dialogs of the legend Item Properties tab provide the following functionalities
(see figure_composer_legend_4):

• You can change the font of the legend title, group, subgroup and item (layer) in the legend item. Click on a
category button to open a Select font dialog.

• You provide the labels with a Color using the advanced color picker, however the selected color will be
given to all font items in the legend..

• Legend items can be arranged over several columns. Set the number of columns in the Count field.

– Equal column widths sets how legend columns should be adjusted.

– The Split layers option allows a categorized or a graduated layer legend to be divided between
columns.
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Figure 19.21: Legend Fonts, Columns and Symbol Dialogs

• You can also change the width and height of the legend symbol,set a color and a thickness in case of raster
layer symbol.

WMS LegendGraphic and Spacing

The WMS LegendGraphic and Spacing dialogs of the legend Item Properties tab provide the following function-
alities (see figure_composer_legend_5):

When you have added a WMS layer and you insert a legend composer item, a request will be sent to the WMS
server to provide a WMS legend. This Legend will only be shown if the WMS server provides the GetLegend-
Graphic capability. The WMS legend content will be provided as a raster image.

WMS LegendGraphic is used to be able to adjust the Legend width and the Legend height of the WMS legend
raster image.

Spacing around title, group, subgroup, symbol, icon label, box space or column space can be customized through
this dialog.

19.2.5 The Scale Bar Item

To add a scale bar, click the Add new scalebar icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the scale bar Item Properties tab.

The Item properties of a scale bar item tab provides the following functionalities (see fig-
ure_composer_scalebar_1):

Main properties

The Main properties dialog of the scale bar Item Properties tab provides the following functionalities (see fig-
ure_composer_scalebar_2):
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Figure 19.22: WMS LegendGraphic and Spacing Dialogs

Figure 19.23: Scale Bar Item properties Tab

Figure 19.24: Scale Bar Main properties Dialog
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• First, choose the map the scale bar will be attached to.

• Then, choose the style of the scale bar. Six styles are available:

– Single box and Double box styles, which contain one or two lines of boxes alternating colors.

– Middle, Up or Down line ticks.

– Numeric, where the scale ratio is printed (i.e., 1:50000).

Units and Segments

The Units and Segments dialogs of the scale bar Item Properties tab provide the following functionalities (see
figure_composer_scalebar_3):

Figure 19.25: Scale Bar Units and Segments Dialogs

In these two dialogs, you can set how the scale bar will be represented.

• Select the units you want to use with Scalebar units. There are four possible choices: Map Units, the
default one and Meters, Feet or Nautical Miles which may force unit conversions.

• The Label unit multiplier specifies how many scalebar units per labeled unit. Eg, if your scalebar units are
set to “meters”, a multiplier of 1000 will result in the scale bar labels in “kilometers”.

• The Label for units field defines the text used to describe the units of the scale bar, eg “m” or “km”. This
should be matched to reflect the multiplier above.

• You can define how many Segments will be drawn on the left and on the right side of the scale bar.

• You can set how long each segment will be (fixed width), or limit the scale bar size in mm with Fit segment
width option. In the latter case, each time the map scale changes, the scale bar is resized (and its label
updated) to fit the range set.

• Height is used to define the height of the bar.

Display

The Display dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_4):

You can define how the scale bar will be displayed in its frame.

• Box margin : space between text and frame borders

• Labels margin : space between text and scale bar drawing
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Figure 19.26: Scale Bar Display

• Line width : line width of the scale bar drawing

• Join style : Corners at the end of scalebar in style Bevel, Rounded or Square (only available for Scale bar
style Single Box & Double Box)

• Cap style : End of all lines in style Square, Round or Flat (only available for Scale bar style Line Ticks Up,
Down and Middle)

• Alignment : Puts text on the left, middle or right side of the frame (works only for Scale bar style Numeric)

Fonts and colors

The Fonts and colors dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_5):

Figure 19.27: Scale Bar Fonts and colors Dialogs

You can define the fonts and colors used for the scale bar.

• Use the [Font] button to set the font of scale bar label

• Font color: set the font color

• Fill color: set the first fill color

• Secondary fill color: set the second fill color

• Stroke color: set the color of the lines of the Scale Bar

Fill colors are only used for scale box styles Single Box and Double Box. To select a color you can use the list
option using the dropdown arrow to open a simple color selection option or the more advanced color selection
option, that is started when you click in the colored box in the dialog.
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19.2.6 The Attribute Table Item

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, click and drag with the left mouse button on the Print Composer canvas to place and size the item. You can
better position and customize its appearance in the Item Properties tab.

The Item properties tab of an attribute table provides the following functionalities (see figure_composer_table_1):

Figure 19.28: Attribute table Item properties Tab

Main properties

The Main properties dialog of the attribute table‘ provides the following functionalities (see fig-
ure_composer_table_2):

Figure 19.29: Attribute table Main properties Dialog

• For Source you can normally select only ‘Layer features’.

• With Layer you can choose from the vector layers loaded in the project.

• In case you activated the Generate an atlas option in the Atlas generation tab, there are two additional
Source possible: ‘Current atlas feature’ (see figure_composer_table_2b) and ‘Relation children’ (see fig-
ure_composer_table_2c). Choosing the ‘Current atlas feature’ you won’t see any option to choose the layer,
and the table item will only show a row with the attributes from the current feature of the atlas coverage
layer. Choosing ‘Relation children’, an option with the relation names will show up. The ‘Relation children’
option can only be used if you have defined a relation using your atlas coverage layer as parent, and the table
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will show the children rows of the atlas coverage layer’s current feature (for further information about the
atlas generation, see Generate an Atlas).

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.

Figure 19.30: Attribute table Main properties for ‘Current atlas feature’

Figure 19.31: Attribute table Main properties for ‘Relation children’

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_3, that can be used
to change the visible contents of the table. After making changes use the [OK] button to apply changes to
the table. The upper part of the window shows the list of the attributes to display and the lower part helps to
set the way the data is sorted.

Figure 19.32: Attribute table Select attributes Dialog

In the Columns section you can:

– Remove an attribute, just select an attribute row by clicking anywhere in the row and press the minus
button to remove the selected attribute.
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– Add a new attribute use the plus button. At the end a new empty row appears and you can select empty
cell of the column Attribute. You can select a field attribute from the list or you can select to build a

new attribute using a regular expression ( button). Of course you can modify every already existing
attribute by means of a regular expression.

– Use the up and down arrows to change the order of the attributes in the table.

– Select a cell in the Headings column and, to change the heading, just type in a new name.

– set a precise Alignment (mixing vertical and horizontal alignment options) for each column.

– Select a cell in the Width column and change it from Automatic to a width in mm, just type a number.
When you want to change it back to Automatic, use the cross.

– The [Reset] button can always be used to restore it to the original attribute settings.

In the Sorting section you can:

– Add an attribute to sort the table with. Select an attribute and set the sorting order to ‘Ascending’ or
‘Descending’ and press the plus button. A new line is added to the sort order list.

– select a row in the list and use the up and down button to change the sort priority on attribute level.
Selecting a cell in the Sort Order column helps you change the sorting order of the attribute field.

– use the minus button to remove an attribute from the sort order list.

Feature filtering

The Feature filtering dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_4):

Figure 19.33: Attribute table Feature filtering Dialog

You can:

• Define the Maximum rows to be displayed.

• Activate Remove duplicate rows from table to show unique records only.

• Activate Show only visible features within a map and select the corresponding Composer map to display
the attributes of features only visible on selected map.

• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features shown on the map of that particular
page of the atlas.

• Activate Filter with and provide a filter by typing in the input line or insert a regular expression using

the given expression button. A few examples of filtering statements you can use when you have loaded
the airports layer from the Sample dataset:

– ELEV > 500
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– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%’

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

The last regular expression will include only the airports that have a letter ‘i’ in the attribute field ‘USE’.

Appearance

The Appearance dialog of the attribute table provides the following functionalities (see figure_composer_table_5):

Figure 19.34: Attribute table appearance Dialog

• Click Show empty rows to fill the attribute table with empty cells. This option can also be used to provide
additional empty cells when you have a result to show!

• With Cell margins you can define the margin around text in each cell of the table.

• With Display header you can select from a list one of ‘On first frame’, ‘On all frames’ default option, or
‘No header’.

• The option Empty table controls what will be displayed when the result selection is empty.

– Draw headers only, will only draw the header except if you have chosen ‘No header’ for Display
header.

– Hide entire table, will only draw the background of the table. You can activate Don’t draw
background if frame is empty in Frames to completely hide the table.

– Show set message, will draw the header and adds a cell spanning all columns and display a message
like ‘No result’ that can be provided in the option Message to display

• The option Message to display is only activated when you have selected Show set message for Empty table.
The message provided will be shown in the table in the first row, when the result is an empty table.

• With Background color you can set the background color of the table. The Advanced customization option
helps you define different background colors for each cell (see figure_composer_table_6)

• With the Wrap text on option, you can define a character on which the cell content will be wraped each time
it is met

• With Oversized text you define the behaviour when the width set for a column is smaller than its content’s
length. It can be Wrap text or Truncate text.
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Figure 19.35: Attribute table Advanced Background Dialog

Show grid

The Show grid dialog of the attribute table provides the following functionalities (see figure_composer_table_7):

Figure 19.36: Attribute table Show grid Dialog

• Activate Show grid when you want to display the grid, the outlines of the table cells.

• With Line width you can set the thickness of the lines used in the grid.

• The Color of the grid can be set using the color selection dialog.

Fonts and text styling

The Fonts and text styling dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_8):

• You can define Font and Color for Table heading and Table contents.

• For Table heading you can additionally set the Alignment to Follow column alignment or override this
setting by choosing Left, Center or Right. The column alignment is set using the Select Attributes dialog
(see Figure_composer_table_3 ).
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Figure 19.37: Attribute table Fonts and text styling Dialog

Frames

The Frames dialog of the attribute table provides the following functionalities (see figure_composer_table_9):

Figure 19.38: Attribute table Frames Dialog

• With Resize mode you can select how to render the attribute table contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other composer items, maps, scalebars, legends etc. will not be visible in the
result.

• Activate Don’t draw background if frame is empty prevents the background to be drawn when the table
frame has no contents.

19.2.7 The Image Item

To add an image, click the Add image icon and drag a rectangle onto the Composer canvas with the left mouse
button. You can then position and customize its appearance in the image Item Properties tab.

The image Item Properties tab provides the following functionalities (see figure_composer_image_1):
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Figure 19.39: Image Item properties Tab

You first have to select the image you want to display. There are several ways to set the image source in the Main
properties area.

1. Use the browse button of image source to select a file on your computer using the browse dialog. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.

2. You can enter the source directly in the image source text field. You can even provide a remote URL-address
to an image.

3. From the Search directories area you can also select an image from loading previews ... to set the image
source.

4. Use the data defined button to set the image source from a record or using a regular expression.

With the Resize mode option, you can set how the image is displayed when the frame is changed, or choose to
resize the frame of the image item so it matches the original size of the image.

You can select one of the following modes:

• Zoom: Enlarges the image to the frame while maintaining aspect ratio of picture.

• Stretch: Stretches image to fit inside the frame, ignores aspect ratio.

• Clip: Use this mode for raster images only, it sets the size of the image to original image size without scaling
and the frame is used to clip the image, so only the part of the image inside the frame is visible.

• Zoom and resize frame: Enlarges image to fit frame, then resizes frame to fit resultant image.

• Resize frame to image size: Sets size of frame to match original size of image without scaling.

Selected resize mode can disable the item options ‘Placement’ and ‘Image rotation’. The Image rotation is active
for the resize mode ‘Zoom’ and ‘Clip’.

With Placement you can select the position of the image inside it’s frame. The Search directories area allows
you to add and remove directories with images in SVG format to the picture database. A preview of the pictures
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found in the selected directories is shown in a pane and can be used to select and set the image source.

It is possible to change SVG fill/outline color and outline width when using parameterized SVG files such as
those included with QGIS. If you add a SVG file you should add the following tags in order to add support for
transparency:

• fill-opacity=”param(fill-opacity)”

• stroke-opacity=”param(outline-opacity)”

You can read this blog post to see an example.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes the
rotation of the image (i.e., a rotated north arrow) with the rotation applied to the selected map item.

It is also possible to select a north arrow directly. If you first select a north arrow image from Search directories

and then use the browse button of the field Image source, you can now select one of the north arrow from
the list as displayed in figure_composer_image_2.

Nota: Many of the north arrows do not have an ‘N’ added in the north arrow, this is done on purpose for languages
that do not use an ‘N’ for North, so they can use another letter.

Figure 19.40: North arrows available for selection in provided SVG library

19.2.8 La cornice HTML

Puoi aggiungere una cornice che consente di visualizzare i contenuti di un sito web o anche creare una pagina
HTML e visualizzarla!

Clicca sull’icona Aggiungi cornice HTML, posiziona l’elemento trascinando un rettangolo tenendo premuto
il tasto sinistro del mouse sulla tavola di stampa e personalizzala nella scheda Item Properties (see fig-
ure_composer_html_1).
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Figure 19.41: Corinice HTML, la scheda delle proprietà

Sorgente HTML

Come sorgente di HTML, è possibile impostare un URL e attivare il pulsante radio URL o inserire il codice HTML
direttamente nella casella di testo e attivare il pulsante radio Sorgente.

Il punto Sorgente HTML della cornice HTML della scheda Proprietà oggetto fornisce le seguenti funzionalità
(vedi figure_composer_html_2):

Figure 19.42: Corinice HTML, le proprietà di Sorgente HTML

• In URL puoi inserire l’URL di una pagina web copiata dal browser oppure selezionare un file HTML utiliz-

zando il pulsante Sfoglia . C’è anche la possibilità di utilizzare il pulsante Descrizione definita dei dati
per fornire un URL dai contenuti di un campo attributo di una tabella o utilizzando un’espressione regolare.

• In Sorgente puoi inserire il testo nella casella con tag HTML o fornire una pagina HTML completa.

• Puoi usare il pulsante **[Inserisci un’espressione] ** per inserire un’espressione come
‘‘[%Year($now)%]‘nella casella Sorgente per visualizzare l’anno in corso. Questo pulsante viene at-
tivato solo quando il bottone radio Sorgente è selezionato. Dopo aver inserito l’espressione clicca da
qualche parte nella casella di testo prima di aggiornare il frame HTML, altrimenti si perde l’espressione.

• Attiva Valuta le espressioni QGIS in HTML per vedere il risultato dell’espressione che hai incluso.

• Utilizza il pulsante [Aggiorna HTML] per aggiornare la cornice HTML e vedere il risultato di cambiamenti.
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Cornici

Il punto Cornici della cornice HTML della scheda Proprietà oggetto fornisce le seguenti funzionalità (vedi fig-
ure_composer_html_3):

Figure 19.43: HTML frame, the Frames properties

• With Resize mode you can select how to render the HTML contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to render the
height of the web page. Each frame can be moved around on the layout. If you resize a frame, the
webpage will be divided up between the other frames. The last frame will be trimmed to fit the web
page.

– Repeat on every page will repeat the upper left of the web page on every page in frames of the same
size.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. If the HTML page
that will not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the map layout from being exported when the
frame has no HTML contents. This means all other composer items, maps, scalebars, legends etc. will not
be visible in the result.

• Activate Don’t draw background if frame is empty prevents the HTML frame being drawn if the frame
is empty.

Use smart page breaks and User style sheet

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties tab provides the
following functionalities (see figure_composer_html_4):

Figure 19.44: HTML frame, Use smart page breaks and User stylesheet properties
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• Activate Use smart page breaks to prevent the html frame contents from breaking mid-way a line of text
so it continues nice and smooth in the next frame.

• Set the Maximum distance allowed when calculating where to place page breaks in the html. This distance
is the maximum amount of empty space allowed at the bottom of a frame after calculating the optimum
break location. Setting a larger value will result in better choice of page break location, but more wasted
space at the bottom of frames. This is only used when Use smart page breaks is activated.

• Activate User stylesheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provide below to set the color of <h1> header tag to green and set the font and
fontsize of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Use the [Update HTML] button to see the result of the stylesheet settings.

19.2.9 The Basic Shape Items

To add a basic shape (ellipse, rectangle, triangle), click the Add basic shape icon, place the element holding down
the left mouse. Customize the appearance in the Item Properties tab.

When you also hold down the Shift key while placing the basic shape you can create a perfect square, circle or
triangle.

Figure 19.45: Shape Item properties Tab

The Shape item properties tab allows you to select if you want to draw an ellipse, rectangle or triangle inside the
given frame.

You can set the style of the shape using the advanced symbol style dialog with which you can define its outline
and fill color, fill pattern, use markers etcetera.

For the rectangle shape, you can set the value of the corner radius to round of the corners.

Nota: Unlike other items, you can not style the frame or the background color of the frame.

19.2. Composer Items 337



QGIS User Guide, Release 2.14

19.2.10 The Arrow Item

To add an arrow, click the Add Arrow icon, place the element holding down the left mouse button and drag a line
to draw the arrow on the Print Composer canvas and position and customize the appearance in the scale bar Item
Properties tab.

When you also hold down the Shift key while placing the arrow, it is placed in an angle of exactly 45° .

The arrow item can be used to add a line or a simple arrow that can be used, for example, to show the relation
between other print composer items. To create a north arrow, the image item should be considered first. QGIS
has a set of North arrows in SVG format. Furthermore you can connect an image item with a map so it can rotate
automatically with the map (see The Image Item).

Figure 19.46: Arrow Item properties Tab

Item Properties

The Arrow item properties tab allows you to configure an arrow item.

The [Line style ...] button can be used to set the line style using the line style symbol editor.

In Arrows markers you can select one of three radio buttons.

• Default: To draw a regular arrow, gives you options to style the arrow head

• None: To draw a line without arrow head

• SVG Marker: To draw a line with an SVG Start marker and/or End marker

For Default Arrow marker you can use following options to style the arrow head.

• Arrow outline color: Set the outline color of the arrow head

• Arrow fill color: Set the fill color of the arrow head
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• Arrow outline width: Set the outline width of the arrow head

• Arrow head width: Set the size of the arrow head

For SVG Marker you can use following options.

• Start marker: Choose an SVG image to draw at the beginning of the line

• End marker: Choose an SVG image to draw at the end of the line

• Arrow head width: Set the size of Start and/or End marker

SVG images are automatically rotated with the line. The color of the SVG image can not be changed.

19.3 Creating an Output

Figure_composer_output_1 shows the Print Composer with an example print layout, including each type of map
item described in the previous section.

Figure 19.47: Print Composer with map view, legend, image, scale bar, coordinates, text and HTML frame added

Before printing a layout you have the possibility to view your composition without bounding boxes. This can be

enabled by deactivating View –> Show bounding boxes or pressing the shortcut Ctrl+Shift+B.

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...
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• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

• The Export as PDF icon saves the defined Print Composer canvas directly as a PDF.

19.3.1 Export as Image

Clicking the Export as image icon will ask you to enter the filename to use to export composition: in case of
multi-page composition, each page will be exported to a file with the given name appended with the page number.

You can then override the print resolution (set in Composition tab) and resize exported image dimensions. By

checking Crop to content option, the images output by composer will include only the area of the composition
with content. There’s also an option for margins to add around the item bounds if required.

If the composition includes a single page, then the output will be sized to include EVERYTHING on the compo-
sition. If it’s a multi-page composition, then each page will be cropped to only include the area of that page with
items.

Figure 19.48: Image Export Options

If you need to export your layout as a georeferenced image (e.g., to share with other projects), you need to enable

this feature under the Composition tab. Check World file on and choose the map item to use. With this option,
the ‘Export as image’ action will create a world file along the exported image.

Nota: Exporting big rasters can sometimes fail, even if there seems to be enough memory. This is a problem with
the underlying Qt management of rasters.

19.3.2 Export as SVG

With Export as SVG, you also need to fill the filename (used as a basename for all files in case of multi_page

composition) and then can apply Crop to content option.

The SVG export options dialog allows also to :

• export map layers as svg groups:

• render map labels as outlines

Nota: Currently, the SVG output is very basic. This is not a QGIS problem, but a problem with the underlying
Qt library. This will hopefully be sorted out in future versions.
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Figure 19.49: SVG Export Options

19.3.3 Export as PDF

The Export as PDF exports all the composition into a single PDF file.

If you applied to your composition or any shown layer an advanced effect such as blend modes, transparency
or symbol effects, these cannot be printed as vectors and your effects may be lost. Checking Print as a raster
in Composition tab helps to keep the effects but rasterize the composition. Note that the Force layer to render
as raster in the Rendering tab of Layer Properties is a layer-level alternative that avoids global composition
rasterization.

19.3.4 Generate an Atlas

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation param-
eters, refer to the Atlas generation tab. This tab contains the following widgets (see figure_composer_atlas_1):

Figure 19.50: Atlas generation tab
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• Generate an atlas, which enables or disables the atlas generation.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the features on
which to iterate over.

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Page name combo box to give a more explicit name to each feature page(s) when previewing
atlas. You can select an attribute of the coverage layer or set an expression. If this option is empty, QGIS
will use an internal ID, according to the filter and/or the sort order applied to the layer.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.

You also have options to set the output of the atlas:

• An Output filename expression textbox that is used to generate a filename for each geometry if needed. It is
based on expressions. This field is meaningful only for rendering to multiple files.

• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• A Margin around feature that allows you to select the amount of space added around each geometry
within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• A Predefined scale (best fit). It will use the best fitting option from the list of predefined scales in your
project properties settings (see Project –> Project Properties –> General –> Project Scales to configure
these predefined scales).

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.

Labels

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. What you should
take care of is to place expression part (including functions, fields or variables) between [% and %]. For example,
for a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] km2

or, another combination:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] is an expression used inside the label. both expressions
would result in the generated atlas as:
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The area of PARIS,75001 is 1.94 km2

Data Defined Override Buttons

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly useful with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composition tab for field Presets.

With a Data Defined Override button you can dynamically set the paper orientation. When the height (north-
south) of the extents of a region is greater than its width (east-west), you rather want to use portrait instead of
landscape orientation to optimize the use of paper.

In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. Press the button of field Orientation,
select Edit... so the Expression string builder dialog opens. Enter the following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN ’Landscape’ ELSE ’Portrait’ END

Now the paper orients itself automatically. For each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) - 20

Use the button of field Height to provide following expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 210 ELSE 297 END) - 20

When you want to give a title above the map in the center of the page, insert a label item above the map. First use
the item properties of the label item to set the horizontal alignment to Center. Next activate from Reference
point the upper middle checkbox. You can provide the following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when the
page is automatically rotated in portrait or landscape.

Information provided is derived from the excellent blog (in English and Portuguese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use the Data Defined Override option.

Preview and generate

Figure 19.51: Atlas Preview toolbar

Once the atlas settings have been configured and composer items (map, table, image...) linked to it, you can create

a preview of all the pages by clicking Atlas → Preview Atlas or Preview Atlas icon. You can then use the arrows
in the same toolbar to navigate through all the features:
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• First feature

• Previous feature

• Next feature

• Last feature

You can also use the combo box to directly select and preview a specific feature. The combo box shows atlas
features name according to the expression set in the atlas Page name option.

As for simple compositions, an atlas can be generated in different ways (see Creating an Output for more infor-
mation). Instead of Composer menu, rather use tools from Atlas menu or Atlas toolbar.

This means that you can directly print your compositions with Atlas → Print Atlas. You can also create a PDF
using Atlas → Export Atlas as PDF...: The user will be asked for a directory to save all the generated PDF files,

except if the Single file export when possible has been selected. In that case, you’ll be prompted to give a
filename.

With Atlas → Export Atlas as Images... or Atlas → Export Atlas as SVG... tool, you’re also prompted to select a
folder. Each page of each atlas feature composition is exported to an image or SVG file.

Suggerimento: Print a specific atlas feature
If you want to print or export the composition of only one feature of the atlas, simply start the preview, select the
desired feature in the drop-down list and click on Composer → Print (or export... to any supported file format).
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CHAPTER 20

Plugin di QGIS

20.1 QGIS Plugins

QGIS has been designed with a plugin architecture. This allows many new features and functions to be easily
added to the application. Many of the features in QGIS are actually implemented as plugins.

20.1.1 Core and External plugins

QGIS plugins are implemented either as Core Plugins or External Plugins.

Core Plugins are maintained by the QGIS Development Team and are automatically part of every QGIS distribu-
tion. They are written in one of two languages: C++ or Python.

Most of External Plugins are currently written in Python. They are stored either in the ‘Official’ QGIS Repository
at http://plugins.qgis.org/plugins/ or in external repositories and are maintained by the individual authors. Detailed
documentation about the usage, minimum QGIS version, home page, authors, and other important information
are provided for the plugins in the Official repository. For other external repositories, documentation might be
available with the external plugins themselves. In general, external plugins documentation is not included in this
manual.

Installed external python plugins are placed under ~/.qgis2/python/plugins folder. Home directory (de-
noted by above ~) on Windows is usually something like C:\Documents and Settings\(user) (on
Windows XP or earlier) or C:\Users\(user).

Paths to Custom C++ plugins libraries can also be added under Settings → Options → System.

You can manage your plugins in the plugin dialog which can be opened with Plugins > Manage and install plugins
....

When a plugin needs to be updated, and if plugins settings have been set up accordingly, QGIS main interface will
display a blue link in the status bar to inform you that there are updates for your plugins waiting to be applied.

20.1.2 La finestra di dialogo Plugins

The menus in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways. Each
plugin has some metadata displayed in the right panel:

• information on whether the plugin is experimental

• descrizione

• rating vote(s) (you can vote for your preferred plugin!)

• etichette

• some useful links to the home page, tracker and code repository

• author(s)
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• version available

You can use the filter to find a specific plugin.

All

Here, all the available plugins are listed, including both core and external plugins. Use [Upgrade all] to look
for new versions of the plugins. Furthermore, you can use [Install plugin] if a plugin is listed but not installed,
[Uninstall plugin] as well as [Reinstall plugin] if a plugin is installed. An installed plugin can be temporarily
de/activated using the checkbox.

Figure 20.1: The All menu

Installed

In this menu, you can find only the installed plugins. The external plugins can be uninstalled and reinstalled using
the [Uninstall plugin] and [Reinstall plugin] buttons. You can [Upgrade all] here as well.

Not installed

This menu lists all plugins available that are not installed. You can use the [Install plugin] button to implement a
plugin into QGIS.

Upgradeable

If you activated Show also experimental plugins in the Settings menu, you can use this menu to look for

more recent plugin versions. This can be done with the [Upgrade plugin] or [Upgrade all] buttons. Settings

In this menu, you can use the following options:

• Check for updates on startup. Whenever a new plugin or a plugin update is available, QGIS will inform
you ‘every time QGIS starts’, ‘once a day’, ‘every 3 days’, ‘every week’, ‘every 2 weeks’ or ‘every month’.

• Show also experimental plugins. QGIS will show you plugins in early stages of development, which are
generally unsuitable for production use.

• Show also deprecated plugins. These plugins are deprecated and generally unsuitable for production
use.
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Figure 20.2: The Installed menu

Figure 20.3: The Not installed menu
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Figure 20.4: The Upgradeable menu

To add external author repositories, click [Add...] in the Plugin repositories section. If you do not want one or
more of the added repositories, they can be disabled via the [Edit...] button, or completely removed with the
[Delete] button.

Note that you can use an authentication (basic authentication, PKI) to access to a plugin repository. The default
QGIS repository is an open repository and you don’t need any authentication. You should deploy your own plugin
repository. You can get more information on QGIS authentication support in Authentication chapter.

The Search function is available in nearly every menu (except Settings). Here, you can look for specific
plugins.

348 Chapter 20. Plugin di QGIS



QGIS User Guide, Release 2.14

Figure 20.5: The Settings menu
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20.2 Using QGIS Core Plugins

Icona Plugin Descrizione Riferimento
guida

Cattura Coordinate Cattura le coordinate del mouse usando un SR diverso Plugin Cattura
coordinate

DB Manager Manage your databases within QGIS Plugin DB
Manager

Convertitore
DXF2Shape

Converte da dxf a shp Plugin
Convertitore
DXF2Shape

eVis Uno strumento di visualizzazione di eventi. Visualizza
immagini associate agli elementi di un vettore

Plugin eVis

fTools Strumenti per l’analisi e la gestione di dati vettoriali Plugin fTools

Strumenti GDAL Strumenti raster: interfaccia grafica semplificata per
l’utilizzo dei programmi GDAL più comuni

Plugin
GDALTools

Geometry Checker Check and repair errors in vector geometries Geometry Checker
Plugin

Geometry Snapper Snap geometries to a reference layer Geometry Snapper
Plugin

Georeferenziatore
raster (GDAL)

Georeferenziare i raster con GDAL Plugin
Georeferenziatore

Strumenti GPS Strumenti per caricare e importare dati GPS Plugin GPS

GRASS Attiva i potenti strumenti di GRASS Integrazione con
GRASS GIS

Mappa di
concentrazione

Crea una mappa raster di concentrazione a partire da un
vettore di punti

Plugin Mappa di
concentrazione

Plugin di
interpolazione

Un plugin per l’interpolazione basata sui vertici di un
vettore

Plugin
Interpolazione

Metasearch
Catalogue Client

Interagisce con Catalog Service for the Web (CSW) Client Catalogo
MetaSearch

Offline Editing Consente l’editing offline e la sincronizzazione con il
database

Plugin Offline
Editing

Oracle Spatial
Georaster

Accede a Oracle Spatial GeoRasters Oracle Spatial
GeoRaster Plugin

Gestore plugin Gestisci i plugin di base e quelli esterni La finestra di
dialogo Plugins

Processing Spatial data processing framework ambiente
Processing di
QGIS

Plugin per l’analisi
geomorfologica

Un plugin per l’analisi geomorfologica basata su raster Plugin Analisi
geomorfologica

Plugin grafo
stradale

Trova il percorso più breve Plugin grafo
strade

Plugin di
interrogazione
spaziale

Un plugin per effettuare interrogazioni spaziali su dati
vettoriali

Plugin Spatial
Query

Topology Checker Find topological errors in vector layers Validatore
topologico

Statistiche zonali Calcola statistiche raster per ogni poligono di un vettore Plugin Statistica
zonale
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20.3 Plugin Cattura coordinate

Il plugin Cattura Coordinate è facile da usare e ti permette di mostrare sulla mappa coordinate in due sistemi di
riferimento distinti.

Figure 20.6: Plugin Cattura coordinate

1. Avviare QGIS, selezionare Project Properties dal menu Settings (KDE, Windows) oppure File (Gnome,

OSX) e cliccare sull’icona Projection. n alternativa, cliccare sull’icona CRS status in basso a destra della
barra di stato.

2. Attivare Abilita la riproiezione al volo e selezionare un sistema di coordinate proiettate a scelta (sezione
Lavorare con le proiezioni).

3. Attiva il plugin cattura coordinate nel Gestore Plugin (vedi :ref: finestra di dialogo plugins) e assicu-
rarti che la finestra è visibile all’indirizzo :MenuSelection:‘ Vista -> Panels‘ e verifica che |casella|cattura
coordinate sia abilitata. La finestra di cattura di coordinate appare come mostrato in Figura fig-
ure_coordinate_capture_1. In alternativa, si può anche andare a Vettore-> Cattura coordinate verificando
che la |casella|: guilabel:‘ Cattura coordinate‘ sia abilitata.

4. Cliccare su Clicca per selezionare il SR da usare durante la visualizzazione delle coordinate e selezionare un SR diverso da
quello selezionato precedentemente.

5. Cliccare su [Start capture] per iniziare la cattura delle coordinate. Cliccare un punto nella mappa e il plugin
mostrerà le coordinate espresse nei due SR selezionati.

6. Per abilitare la tracciatura via mouse delle coordinate seleziona l’icona Clicca per abilitare la tracciatura mouse....

7. Le coordinate selezionate possono essere copiate negli appunti.

20.4 Plugin DB Manager

The DB Manager Plugin is officially part of the QGIS core and is intended to be the main tool to integrate and
manage spatial database formats supported by QGIS (PostGIS, SpatiaLite, Geopackage, Oracle Spatial, Virtual

layers) in one user interface. The DB Manager Plugin provides several features. You can drag layers from the
QGIS Browser into the DB Manager, and it will import your layer into your spatial database. You can drag and
drop tables between spatial databases and they will get imported.

The Database menu allows you to connect to an existing database, to start the SQL window and to exit the DB
Manager Plugin. Once you are connected to an existing database, the menus Schema and Table additionally
appear.

The Schema menu includes tools to create and delete (empty) schemas and, if topology is available (e.g., PostGIS
2), to start a TopoViewer.

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
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Figure 20.7: DB Manager dialog

import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

If connected to a database, the main window of the DB Manager offers three tabs. The Info tab provides informa-
tion about the table and its geometry, as well as about existing fields, constraints and indexes. It also allows you
to run Vacuum Analyze and to create a spatial index on a selected table, if not already done. The Table tab shows
all attributes, and the Preview tab renders the geometries as preview.

20.4.1 Working with the SQL Window

You can also use the DB Manager to execute SQL queries against your spatial database and then view the spatial
output for queries by adding the results to QGIS as a query layer. It is possible to highlight a portion of the SQL
and only that portion will be executed when you press F5 or click the Execute (F5) button.

20.5 Plugin Convertitore DXF2Shape

The dxf2shape converter plugin can be used to convert vector data from DXF to shapefile format. It requires the
following parameters to be specified before running:

• Input DXF file: Enter the path to the DXF file to be converted.

• Output Shp file: Enter desired name of the shapefile to be created.

• Output file type: Specify the geometry type of the output shapefile. Currently supported types are polyline,
polygon, and point.
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Figure 20.8: Executing SQL queries in the DB Manager SQL window

Figure 20.9: Plugin Convertitore DXF2Shape
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• Export text labels: When this checkbox is enabled, an additional shapefile point layer will be created, and
the associated DBF table will contain information about the “TEXT” fields found in the DXF file, and the
text strings themselves.

20.5.1 Utilizzo del plugin

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see La finestra di dialogo Plugins) and click

on the Dxf2Shape Converter icon, which appears in the QGIS toolbar menu. The Dxf2Shape plugin dialog
appears, as shown in Figure_dxf2shape_1.

2. Enter the input DXF file, a name for the output shapefile and the shapefile type.

3. Abilitare la casella di controllo Esporta le etichetto di testo , se si vuole creare un layer addizionale di
punti con le etichette.

4. Cliccare su [OK].

20.6 Plugin eVis

(This section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide.
American Museum of Natural History, Center for Biodiversity and Conservation. Available from
http://biodiversityinformatics.amnh.org/, and released under the GNU FDL.)

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (see La finestra di dialogo Plugins).

Il plugin consta di tre moduli, Connessione Database, ID evento, Browser evento che permettono di collegare a
vettori in QGIS foto ed altri documenti geocodificati (es. con coordinate X,Y o lat/long).

20.6.1 Browser evento

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Aprire il modulo Browser evento

To launch the Event Browser module, click on Database → eVis → eVis Event Browser. This will open the
Generic Event Browser window.

The Event Browser window has three tabs displayed at the top of the window. The Display tab is used to view the
photograph and its associated attribute data. The Options tab provides a number of settings that can be adjusted to
control the behavior of the eVis plugin. Lastly, the Configure External Applications tab is used to maintain a table
of file extensions and their associated application to allow eVis to display documents other than images.
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Scheda Visualizza

To see the Display window, click on the Display tab in the Event Browser window. The Display window is used
to view geocoded photographs and their associated attribute data.

Figure 20.10: The eVis display window

1. Area di visualizzazione dell’immagine: è il riquadro inferiore della scheda.

2. Ingrandisci: ingrandisce l’immagine per avere più dettagli. Se l’immagine è troppo grande per l’area di
visualizzazione, compaiono delle barre di scorrimento.

3. Rimpicciolisci: rimpicciolisce l’immagine.

4. Zoom completo: visualizza tutta l’immagine.

5. Attribute information window: All of the attribute information for the point associated with the photo-
graph being viewed is displayed here. If the file type being referenced in the displayed record is not an
image but is of a file type defined in the Configure External Applications tab, then when you double-click
on the value of the field containing the path to the file, the application to open the file will be launched to
view or hear the contents of the file. If the file extension is recognized, the attribute data will be displayed
in green.

6. Pulsanti per la navigazione: usare i pulsanti Precedente all’altro.

Scheda Opzioni

1. File path: A drop-down list to specify the attribute field that contains the directory path or URL for the
photographs or other documents being displayed. If the location is a relative path, then the checkbox must be
clicked. The base path for a relative path can be entered in the Base Path text box below. Information about
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Figure 20.11: The eVis Options window

356 Chapter 20. Plugin di QGIS



QGIS User Guide, Release 2.14

the different options for specifying the file location are noted in the section Specificare la localizzazione ed
il nome di una foto below.

2. Compass bearing: A drop-down list to specify the attribute field that contains the compass bearing asso-
ciated with the photograph being displayed. If compass bearing information is available, it is necessary to
click the checkbox below the drop-down menu title.

3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected
using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in
the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Percorso base: il percorso di base utilizzato dal percorso relativo definito in Figura Figure_eVis_2 (A).

5. Replace path: If this checkbox is checked, only the file name from A will be appended to the base path.

6. Apply rule to all documents: If checked, the same path rules that are defined for photographs will be used
for non-image documents such as movies, text documents, and sound files. If not checked, the path rules
will only apply to photographs, and other documents will ignore the base path parameter.

7. Remember settings: If the checkbox is checked, the values for the associated parameters will be saved for
the next session when the window is closed or when the [Save] button below is pressed.

8. Ripristina: reimposta il campo al valore predefinito.

9. Restore defaults: This will reset all of the fields to their default settings. It has the same effect as clicking
all of the [Reset] buttons.

10. Salva: salva le impostazioni senza chiudere la scheda Opzioni.

Configura applicazioni esterne

Figure 20.12: The eVis External Applications window

1. Tabella riferimento file: una tabella contenente i vari tipi di file utilizzati da eVis. Ogni tipo file necessita
di un’estensione e di un percorso all’applicazione in grado di gestirlo. Ciò permette di aprire diversi tipi di
file come filmati, suoni e documenti testuali, oltre che solo immagini.

2. Aggiungi nuovo tipo file: aggiunge un nuovo tipo di file (estensione ed applicazione).

3. Elimina riga corrente: elimina il tipo di file selezionato in tabella.

20.6.2 Specificare la localizzazione ed il nome di una foto

The location and name of the photograph can be stored using an absolute or relative path, or a URL if the pho-
tograph is available on a web server. Examples of the different approaches are listed in Table evis_examples.
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X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

20.6.3 Specificare la localizzazione ed il nome di altri documenti

Supporting documents such as text documents, videos, and sound clips can also be displayed or played by eVis. To
do this, it is necessary to add an entry in the file reference table that can be accessed from the Configure External
Applications window in the Generic Event Browser that matches the file extension to an application that can be
used to open the file. It is also necessary to have the path or URL to the file in the attribute table for the vector
layer. One additional rule that can be used for URLs that don’t contain a file extension for the document you want
to open is to specify the file extension before the URL. The format is — file extension:URL. The URL
is preceded by the file extension and a colon; this is particularly useful for accessing documents from wikis and
other web sites that use a database to manage the web pages (see Table evis_examples).

20.6.4 Using the Event Browser

When the Event Browser window opens, a photograph will appear in the display window if the document refer-
enced in the vector file attribute table is an image and if the file location information in the Options window is
properly set. If a photograph is expected and it does not appear, it will be necessary to adjust the parameters in the
Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is referenced in the
attribute table, the field containing the file path will be highlighted in green in the attribute information window if
that file extension is defined in the file reference table located in the Configure External Applications window. To
open the document, double-click on the green-highlighted line in the attribute information window. If a supporting
document is referenced in the attribute information window and the file path is not highlighted in green, then it
will be necessary to add an entry for the file’s filename extension in the Configure External Applications window.
If the file path is highlighted in green but does not open when double-clicked, it will be necessary to adjust the
parameters in the Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window, a red asterisk will be displayed on top of the vector
feature that is associated with the photograph being displayed. If a compass bearing is provided, then an arrow will
appear pointing in the direction indicated by the value in the compass bearing display field in the Event Browser
window. The arrow will be centered over the point that is associated with the photograph or other document.

To close the Event Browser window, click on the [Close] button from the Display window.

20.6.5 Strumento ID evento

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Aprire ID Evento

To launch the ‘Event ID’ module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
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Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the Browser evento section of this guide.

20.6.6 Connessione database eVis

Il modulo Connessione Database permette di connettersi ed interrogare un database o altre risorse ODBC, es. un
foglio di calcolo.

eVis can directly connect to the following types of databases: PostgreSQL, MySQL, and SQLite; it can also
read from ODBC connections (e.g., MS Access). When reading from an ODBC database (such as an Excel
spreadsheet), it is necessary to configure your ODBC driver for the operating system you are using.

Aprire Connessione Database

To launch the ‘Database Connection’ module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Connessione Database

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Enter the database host in the Database Host textbox. This option is not available if you selected ‘MS Access’ as
the database type. If the database resides on your desktop, you should enter “localhost”.

Enter the name of the database in the Database Name textbox. If you selected ‘ODBC’ as the database type, you
need to enter the data source name.

When all of the parameters are filled in, click on the [Connect] button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established, you will need to check that the correct parameters were entered above.

1. Database Type: A drop-down list to specify the type of database that will be used.

2. Host Database: nome host del database.

3. Port: The port number if a MySQL or PostgreSQL database type is selected.

4. Database Name: The name of the database.

5. Connect: A button to connect to the database using the parameters defined above.

6. Output Console: The console window where messages related to processing are displayed.

7. Nome utente: nome utente in caso di database protetto.

8. Password: password in caso di database protetto.

9. Query Predefinite: scheda “Query Predefinite”.

10. Connessione Database: scheda “Connessione Database”.

11. Query SQL: scheda “Query SQL”.

12. Help: Displays the online help.

13. OK: chiude Connessione Database .
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Figure 20.13: The eVis Database connection window

Eseguire query SQL

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Click on the [Run Query] button to execute the command. If the query is successful, a Database File Selection
window will be displayed. If the query is not successful, an error message will appear in the Output Console
window.

Nella finestra Scegli file Database assegnare un nome al nuovo layer che sarà creato dai risultati della query.

1. Query SQL: è il riquadro per inserire le query SQL.

2. Esegui Query: pulsante per mandare in esecuzione una query.

3. Console di Output: mostra i messaggi relativi all’esecuzione delle query.

4. Help: Displays the online help.

5. OK: chiude Connessione Database.

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right-clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Suggerimento: Creare un layer vettoriale da un foglio di lavoro Microsoft Excel
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Figure 20.14: The eVis SQL query tab

When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.

Eseguire query predefinite

With predefined queries, you can select previously written queries stored in XML format in a file. This is par-
ticularly helpful if you are not familiar with SQL commands. Click on the Predefined Queries tab to display the
predefined query interface.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.

Select the query you want to run from the drop-down menu and then click on the SQL Query tab to see that the
query has been loaded into the query window. If it is the first time you are running a predefined query or are
switching databases, you need to be sure to connect to the database.

Click on the [Run Query] button in the SQL Query tab to execute the command. If the query is successful, a
Database File Selection window will be displayed. If the query is not successful, an error message will appear in
the Output Console window.

1. Open File: Launches the “Open File” file browser to search for the XML file holding the predefined queries.

2. Predefined Queries: A drop-down list with all of the queries defined by the predefined queries XML file.
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Figure 20.15: The eVis Predefined Queries tab

3. Descrizione query: breve descrizione della query derivata dal file XML.

4. Console di Output: mostra i messaggi relativi all’esecuzione delle query.

5. Help: Displays the online help.

6. OK: chiude Connessione Database .

Formato XML per le query predefinite di eVis

Tag XML letti da eVis
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Tag Descrizione
query Definisce l’inizio e la fine di una istruzione di query.
shortde-
scription

A short description of the query that appears in the eVis drop-down menu.

descrip-
tion

Descrizione più dettagliata che viene mostrata nella casella ’Descrizione query’ di eVis.

database-
type

The database type, defined in the Database Type drop-down menu in the Database Connection
tab.

database-
port

The port as defined in the Port text box in the Database Connection tab.

database-
name

The database name as defined in the Database Name text box in the Database Connection tab.

databaseuser-
name

The database username as defined in the Username text box in the Database Connection tab.

databasep-
assword

The database password as defined in the Password text box in the Database Connection tab.

sqlstate-
ment

Il comando SQL.

autocon-
nect

A flag (“true”” or “false”) to specify if the above tags should be used to automatically connect to
the database without running the database connection routine in the Database Connection tab.

Segue un esempio completo di file XML contenente tre query:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
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<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

20.7 Plugin fTools

Il plugin fTools fornisce una risorsa comprensiva delle più comuni operazioni GIS basate su vettori, senza la ne-
cessità di software addizionale, librerie e soluzioni complesse: il plugin mette a disposizione una suite di funzioni
di analisi veloci e funzionali.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be
disabled and enabled using the Plugin Manager (see La finestra di dialogo Plugins). When enabled, the fTools
plugin adds a Vector menu to QGIS, providing functions ranging from Analysis and Research Tools to Geometry
and Geoprocessing Tools, as well as several useful Data Management Tools.

20.7.1 Strumenti di Analisi

IconaStrumento Azione

Matrice di
distanza

Misura le distanze tra due layer di punti e fornisce il risultato come a) Matrice di
distanza lineare, b) Matrice di distanza standard, c) Sintesi matrice di distanza. Può
limitare i calcoli ai ’k’ punti più vicini.

Somma
lunghezze linee

Calcola la somma della lunghezza di tutte le linee per ogni poligono di un layer di
poligoni.

Punti nel
poligono

Calcola il numero di punti che ricadono all’interno di ogni poligono di un layer di
poligoni.

Lista valori
unici

Elenca i valori unici di un campo di un layer vettoriale.

Statistiche di
base

Calcola statistiche di base, es. media, deviazione standard, somma, di un campo di
un layer vettoriale.

Analisi del
vicino più
prossimo

Calcola le statistiche per valutare il livello di clustering in un layer vettoriale di
punti.

Media
coordinata(e)

Calcola il centro medio (media normale o pesata) di un layer vettoriale o di
un’insieme di elementi ed in funzione di un campo con ID unico.

Intersezioni
linee

Calcola l’intersezione tra linee e restituisce il risultato in uno shapefile di punti.
Utile per localizzare intersezioni fra strade e ponti; ignora le intersezioni con una
lunghezza > 0.

fTools - Strumenti di Analisi
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20.7.2 Strumenti di Ricerca

Icona Strumento Azione

Selezione casuale Seleziona in maniera casuale un numero intero “n” o percentuale “n%” di
elementi.

Selezione casuale
con un sottoinsieme

Selezione casuale in un sottoinseme tramite campo ID unico.

Punti casuali Genera punti pseudo-random.

Punti regolari Genera una griglia regolare di punti su un’area specifica e la esporta come
shapefile di punti.

Reticolo vettoriale Genera una griglia di linee o di poligoni con spaziatura definita dall’utente.

Seleziona per
posizione

Seleziona elementi in base alla loro posizione relativa ad un altro layer: crea
una nuova selezione oppure aggiunge/sottrae alla selezione corrente.

Poligono
dall’estensione del
layer

Crea un poligono rettangolare dall’estensione di un layer raster o vettoriale.

fTools - Strumenti di Ricerca

20.7.3 Strumenti di Geoprocessing

Icona Strumento Azione

Poligono/i
convesso/i

Crea il poligono minimo convesso di un layer vettoriale o poligoni minimi
convessi sulla base di un campo in input.

Buffer Crea buffer intorno ad un elemento in funzione di una distanza impostata o di
un campo in input.

Intersezione Sovrappone due layer e ne restituisce uno nuovo contenente la superficie di
intersezione dei layer di input.

Unione Sovrappone due layer e ne restituisce uno nuovo contenente la superficie totale
dei layer di input.

Differenza
simmetrica

Sovrappone due layer e ne restituisce uno nuovo contenente la superficie dei
layer di input tranne la loro intersezione.

Clip Sovrappone due layer e ne restituisce uno nuovo contenente la superficie che
interseca il clip layer.

Differenza Sovrappone due layer e ne restituisce uno nuovo contenente la superficie che
non interseca il clip layer.

Dissolvenza Unisce elementi sulla base di un campo in input: gli elementi con lo stesso
valore sono combinati in un elemento unico.

Elimina poligoni
frammentati

Merges selected features with the neighboring polygon with the largest area or
largest common boundary.

fTools - Strumenti di Geoprocessing
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20.7.4 Strumenti di Geometria

IconaStrumento Azione

Verifica la validità
della geometria

Check polygons for intersections, closed holes, and fix node ordering. You can
choose the engine used by the in the options dialog, digitizing tab Change the
Validate geometries value. There is two engines: QGIS and GEOS which have
pretty different behavior. Another tools exists which shows different result as
well: Topology Checker plugin and ‘must not have invalid geometries’ rule.

Estrai/Aggiungi
colonne
geometriche

Aggiunge informazioni sulla geometria a layer di punti (XCOORD, YCOORD),
di linee (LENGTH), di poligoni (AREA, PERIMETER).

Centroidi di
poligoni

Calcola i centroidi per ogni poligono di un layer di input.

Triangolazione di
Delaunay

Calcola la triangolazione di Delaunay su un layer di punti in input.

Poligoni di
Voronoi

Calcola i poligoni di Voronoi su un layer di punti in ingresso.

Semplifica
geometrie

Generalizza linee e/o poligoni con un algoritmo modificato di Douglas-Peucker.

Infittisci
geometrie

Infittisce linee o poligoni aggiungendo dei vertici

Da parti multiple
a parti singole

Converte elementi multi-parte in più elementi semplici. Crea linee e poligoni
semplici.

Da parti singole a
parti multiple

Unisce più elementi in un elemento multi-parte sulla base di un campo in input.

Da poligoni a
linee

Converte poligoni in linee, poligoni multi-parte in linee semplici.

Da linee a
poligoni

Converte linee in poligoni, linee multi-parte in poligoni semplici.

Estrai vertici Estrae vertici da layer di linee e poligoni e restituisce un nuovo layer di punti.

fTools - Strumenti di Geometria

Nota: Lo strumento Semplifica geometrie può essere usato per rimuovere vertici doppi in layer di linee o di
poligoni. Il trucco è impostare il valore 0 per il parametro Tolleranza di semplificazione.

20.7.5 Strumenti di Gestione Dati

IconaStrumento Azione

Definisce la
proiezione
cartografica corrente

Specifica il SR per gli shapefile senza SR associato.

Unisci attributi per
posizione

Aggiunge attributi ad un layer vettoriale sulla base di relazioni spaziali.
Attributi di un layer vengono aggiunti alla tabella attributi di un altro layer: il
risultato è salvato come nuovo shapefile.

Dividi vettore Divide il layer di input in più layer separati sulla base di un campo in input.

Unisci shapefile Unisce più shapefile in un unico shapefile sulla base del tipo di layer (punti,
linee, poligoni).

Crea indice spaziale Crea un indice spaziale per i formati supportati da OGR.
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fTools - Strumenti di Gestione Dati

20.8 Plugin GDALTools

20.8.1 Cosa sono gli strumenti GDAL?

Il plugin GDALTools fa da interfaccia grafica ad una collezione di strumenti GDAL (Geospatial Data Abstraction
Library), http://gdal.osgeo.org: es. strumenti per interrogare, riproiettare, unire raster in vari formati. Sono inclusi
strumenti per derivare da un DEM dati tipo curve di livello, pendenze, ombreggiature o anche per collegare in un
raster virtuale diversi file raster (Virtual Raster Tile in XML). Tutti questi strumenti sono disponibili quando il
plugin è installato e attivato.

La libreria GDAL

The GDAL library consists of a set of command line programs, each with a large list of options. Users comfortable
with running commands from a terminal may prefer the command line, with access to the full set of options. The
GDAL Tools plugin offers an easy interface to the tools, exposing only the most popular options.

20.8.2 Lista degli strumenti GDAL

Figure 20.16: La lista degli Strumenti GDAL

Proiezioni

Warp
(Reproject)

This utility is an image mosaicing, reprojection and warping utility. The program can
reproject to any supported projection, and can also apply GCPs stored with the image if the
image is “raw” with control information. For more information, you can read on the GDAL
website http://www.gdal.org/gdalwarp.html.

Assign
projection

This tool allows you to assign projection to rasters that are already georeferenced but miss
projection information. Also with its help, it is possible to alter existing projection definitions.
Both single file and batch mode are supported. For more information, please visit the utility
page at the GDAL site, http://www.gdal.org/gdalwarp.html.

Extract
projection

This utility helps you to extract projection information from an input file. If you want to
extract projection information from a whole directory, you can use the batch mode. It creates
both .prj and .wld files.
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Conversione

Rasterize
This program burns vector geometries (points, lines and polygons) into the raster band(s) of a
raster image. Vectors are read from OGR-supported vector formats. Note that the vector data
must in the same coordinate system as the raster data; on the fly reprojection is not provided. For
more information see http://www.gdal.org/gdal_rasterize.html.

Poly-
gonize

This utility creates vector polygons for all connected regions of pixels in the raster sharing a
common pixel value. Each polygon is created with an attribute indicating the pixel value of that
polygon. The utility will create the output vector datasource if it does not already exist,
defaulting to ESRI shapefile format. See also http://www.gdal.org/gdal_polygonize.html.

Translate
This utility can be used to convert raster data between different formats, potentially performing
some operations like subsetting, resampling, and rescaling pixels in the process. For more
information you can read on http://www.gdal.org/gdal_translate.html.

RGB
to PCT

This utility will compute an optimal pseudocolor table for a given RGB image using a median
cut algorithm on a downsampled RGB histogram. Then it converts the image into a
pseudocolored image using the color table. This conversion utilizes Floyd-Steinberg dithering
(error diffusion) to maximize output image visual quality. The utility is also described at
http://www.gdal.org/rgb2pct.html.

PCT
to RGB

This utility will convert a pseudocolor band on the input file into an output RGB file of the
desired format. For more information, see http://www.gdal.org/pct2rgb.html.

Estrazione

Con-
tour

This program generates a vector contour file from the input raster elevation model (DEM). On
http://www.gdal.org/gdal_contour.html, you can find more information.

Clip-
per

This utility allows you to clip (extract subset) rasters using selected extent or based on mask layer
bounds. More information can be found at http://www.gdal.org/gdal_translate.html.
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Analisi

Sieve This utility removes raster polygons smaller than a provided threshold size (in pixels) and
replaces them with the pixel value of the largest neighbor polygon. The result can be written
back to the existing raster band, or copied into a new file. For more information, see
http://www.gdal.org/gdal_sieve.html.

Near
Black

This utility will scan an image and try to set all pixels that are nearly black (or nearly white)
around the edge to exactly black (or white). This is often used to “fix up” lossy compressed
aerial photos so that color pixels can be treated as transparent when mosaicing. See also
http://www.gdal.org/nearblack.html.

Fill
nodata

This utility fills selected raster regions (usually nodata areas) by interpolation from valid
pixels around the edges of the areas. On http://www.gdal.org/gdal_fillnodata.html, you can
find more information.

Proximity This utility generates a raster proximity map indicating the distance from the center of each
pixel to the center of the nearest pixel identified as a target pixel. Target pixels are those in
the source raster for which the raster pixel value is in the set of target pixel values. For more
information see http://www.gdal.org/gdal_proximity.html.

Grid (In-
terpolation)

This utility creates a regular grid (raster) from the scattered data read from the OGR
datasource. Input data will be interpolated to fill grid nodes with values, and you can choose
from various interpolation methods. The utility is also described on the GDAL website,
http://www.gdal.org/gdal_grid.html.

DEM
(Terrain
models)

Tools to analyze and visualize DEMs. It can create a shaded relief, a slope, an aspect, a
color relief, a Terrain Ruggedness Index, a Topographic Position Index and a roughness
map from any GDAL-supported elevation raster. For more information, see
http://www.gdal.org/gdaldem.html.

Miscellanea

Build Virtual
Raster (Catalog)

This program builds a VRT (Virtual Dataset) that is a mosaic of the list of input GDAL
datasets. See also http://www.gdal.org/gdalbuildvrt.html.

Merge This utility will automatically mosaic a set of images. All the images must be in the
same coordinate system and have a matching number of bands, but they may be
overlapping, and at different resolutions. In areas of overlap, the last image will be
copied over earlier ones. The utility is also described at
http://www.gdal.org/gdal_merge.html.

Information This utility lists various information about a GDAL-supported raster dataset. On
http://www.gdal.org/gdalinfo.html, you can find more information.

Build
Overviews

The gdaladdo utility can be used to build or rebuild overview images for most supported
file formats with one of several downsampling algorithms. For more information, see
http://www.gdal.org/gdaladdo.html.

Tile Index This utility builds a shapefile with a record for each input raster file, an attribute
containing the filename, and a polygon geometry outlining the raster. See also
http://www.gdal.org/gdaltindex.html.

GDAL Tools Settings

Use this dialog to embed your GDAL variables.
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20.9 Geometry Checker Plugin

Geometry Checker is a powerful core plugin to check and fix the geometry validity of a layer. The Geometry
Checker dialog show differents grouped settings in the first tab (Settings):

• Input vector layer: to select the layer to check. A Only selected features checkbox can filter the geometry
to the one selected.

• Geometry validity: give to the user the choice between Self intersections, Duplicate nodes, Polygon with
less than 3 nodes.

• Allowed geometry types: to allow only some geometry types like point, multipoint, line, multiline, polygon
and multipolygon.

• Geometry properties displays Polygons and multipolygons may not contain any holes and Multipart
objects must consist of more than one part.

• Geometry conditions: user can add some condition to validate the geometries with a minimal segment
length, a minimum angle between segment, a minimal polygon area and sliver polygons detection.

• Topology checks: checks for duplicates, for features within other features, overlaps smaller than a number,
for gaps smaller than a number.

• Tolerance: you can define here the tolerance for the check.

• Output vector layer gives the choice to the user how get the result between modifiy the current layer and
create a new layer.

After you are happy with the configuration, you can click on the [Run] button.

The results appear in the second tab and as an overview layer of the errors in the canvas (its name is checker). A
table list the geometry check result with one error by row: the first row is an ID, the second the reason of the error,
then the coordinates of the error, a value (depending on the type of the error) and finally the resolution column
which indicates the resolution of the error. At the bottom of this table, you can export the error into a shapefile.
At the left, you have the number of the errors and the fixed errors.

The Geometry Checker Plugin can find the following errors:

• Self intersections: a polygon with a self intersection,

• Duplicate nodes: two duplicates nodes in a segment

• Holes: hole in a polygon,

• Segment length: a segment length lower than a threshold,

• Minimum angle: two segments with an angle lower than a threshold,

• Minimum area: polygon area lower than a treshold,

• Silver polygon: this error come from very small polygon (with small area) with a large perimeter,

• Duplicates features,

• Feature within feature,

• Overlaps: polygon overlapping,

• Gaps: gaps between polygons

The following figure shows the different checks made by the plugin.

You can select a row to see the localisation of the error. You can change this behaviour by selecting another action

between error (default), Feature, Don’t move, and Highlight contour of selected features.

Below the zoom action when clicking on the table row, you can Show the selected features in attribute table, Fix
selected errors using default resolution and Fix selected errors, prompt for resolution method. In the latter, you
will see a window to choose the resolution’s method among which:
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Figure 20.17: The Geometry Checker Plugin
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Figure 20.18: The Differents checks supported by the plugin
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• Merge with neighboring polygon with longest shared edge,

• Merge with neighboring polygon with largest area,

• Merge with neighboring polygon identical attribute value,if any, or leave as it

• Delete feature

• No action

Suggerimento: Fix multiple errors
You can fix multiple errors by selecting more than one row in the table with the CTRL + click action.

The default action could be changed with the last icon Error resolution settings. For some type of errors, you can
change the default action between some specific action or No action.

Finally, you can choose which attribute to use when merging features by attribute value.

20.10 Geometry Snapper Plugin

The Geometry Snapper tool allows to align automatically the edges and vertices of one vector layer to the edges
and vertices of a second layer using a user defined tolerance.

The below interface shows the settings of this plugin. User needs to choose the layer to change (see input vector
layer) and the reference layers to snap to. A Maximum snapping distance (map units) allows to change the
snapping tolerance.

You can snap only selected feature(s) checking the Only selected features.

Output vector layer allows you to choose between Modifying input layer or Create a new layer.

Figure 20.19: The Geometry Snapper Plugin

20.11 Plugin Georeferenziatore

Il Plugin Georeferenziatore è uno strumento per generare file di georeferenziazione (world file) per i raster. Per-
mette di georeferenziare raster in sistemi di coordinate geografiche o proiettate, creando un nuovo GeoTiff oppure
associandogli un world file. L’approccio di base del plugin è quello di individuare punti del raster per i quali puoi
determinare accuratamente le coordinate.

Features
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Icona Azione Icona Azione

Carica un raster Avvia la georeferenziazione

Genera uno script GDAL Carica punti GCP (Ground Control Point)

Salva punti GCP Imposta la trasformazione

Aggiunge un nuovo punto Elimina un punto

Sposta un punto GCP Sposta la vista

Ingrandisce la vista Rimpicciolisce la vista

Zoom sul layer Zoom precedente

Zoom successivo Link Georeferencer to QGIS

Link QGIS to Georeferencer Stiramento completo dell’istogramma

Stiramento locale dell’istogramma

Strumenti del georeferenziatore

20.11.1 Utilizzo del plugin

Per le coordinate X e Y (espresse in gradi, primi e secondi DMS (dd mm ss.ss), in gradi decimali (DD (dd.dd) o le
coordinate proiettate (mmmm.mm) espresse in metri), che corrispondono ai punti selezionati sull’immagine, puoi
usare due procedure alternative:

• Alcune volte nei raster sono presenti punti con le coordinate scritte sull’immagine. In questo caso puoi
inserire manualmente le coordinate.

• Using already georeferenced layers. This can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and with the projection that you
want for your image. In this case, you can enter the coordinates by clicking on the reference dataset loaded
in the QGIS map canvas.

Una procedura meno usuale consiste nel selezionare più punti del raster, specificarne le coordinate e scegliere
un metodo di trasformazione. Sulla base dei parametri inseriti, il plugin calcola i parametri del world file. Più
coordinate vengono fornite, migliore sarà il risultato.

The first step is to start QGIS, load the Georeferencer Plugin (see La finestra di dialogo Plugins) and click on
Raster → Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as
shown in figure_georeferencer_1.

Come esempio si può provare a georiferire la carta topografica del South Dakota scaricabile da:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz. Sarà possibile visualizzare la carta anche con i dati
di GRASS della location spearfish60.

Aggiungere punti GCP

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_2). For this procedure you have three options:

• Cliccare su un punto del raster ed inserire le coordinate X/Y manualmente.

• Click on a point in the raster image and choose the From map canvas button to add the X and Y
coordinates with the help of a georeferenced map already loaded in the QGIS map canvas.

• With the button, you can move the GCPs in both windows, if they are at the wrong place.
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Figure 20.20: Finestra di dialogo del plugin Georeferenziatore

3. Continua a inserire punti. Dovresti inserire almeno 4 GCP: più punti vengono inseriti, migliore sarà il
risultato. Ci sono strumenti del plugin per spostarsi nell’area di lavoro.

Figure 20.21: Aggiungi punti all’immagine raster

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP points and Save GCP points as buttons to manage the files.

Impostare una trasformazione

Una volta aggiunti i GCP, è necessario definire le impostazioni di trasformazione del processo di georeferenzi-
azione.
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Figure 20.22: Impostare i parametri della georeferenziazione

Algoritmi di trasformazione disponibili

Sono disponibili diversi algoritmi di trasformazione: la scelta dipende dal numero di GCP a disposizione, dal tipo
e dalla qualità dei dati di input e dall’entità di distorsione geometrica accettabile nel risultato finale.

Sono disponibili le seguenti tipologie di trasformazione:

• L’algoritmo di trasformazione lineare è utilizzato per generare un file di georeferenziazione o world file, ed
è differente rispetto agli altri algoritmi, in quanto attualmente non adatta deformandolo il raster originale.
Questo algoritmo in genere non è adatto nel caso in cui si lavori con immagini scannerizzate.

• La trasformazione di Helmert esegue una rototraslazione del raster con variazione di scala.

• The Polynomial algorithms 1-3 are among the most widely used algorithms introduced to match source
and destination ground control points. The most widely used polynomial algorithm is the second-order
polynomial transformation, which allows some curvature. First-order polynomial transformation (affine)
preserves collinearity and allows scaling, translation and rotation only.

• L’algoritmo di traformazione Thin Plate Spline (TPS) è un metodo di georeferenziazione recente, che
permette di introdurre delle deformazioni localizzate all’interno dei dati. Questo algoritmo risulta partico-
larmente efficace quando si vogliono georeferenziare immagini di scarsa qualità.

• La traformazione Proiettiva consiste in una rotazione ed in una traslazione delle coordinate.

Metodo di ricampionamento

La scelta del metodo di ricampionamento dipende dai dati in input e da alcuni requisiti utente. Se, ad esempio,
non si accettano modifiche alle statistiche dell’immagine, allora il metodo del vicino più prossimo sarà più adatto.
Se, invece, si richiede un risultato più ‘liscio’ (smoothed) si utilizzerà il metodo cubico.

Puoi scegliere tra cinque diversi metodi di ricampionamento:

1. Vicino più prossimo

2. Lineare

376 Chapter 20. Plugin di QGIS



QGIS User Guide, Release 2.14

3. Cubico

4. Spline cubica

5. Lanczos

Altre impostazioni di trasformazione

Bisogna definire varie altre opzioni per l’output.

• La casella di controllo Crea il file di georeferenziazione è attiva solo se scegli la trasformazione lineare,
quando il raster non viene fisicamente deformato. in tal caso, quindi, la casella Raster in output non è attiva
perché viene creato solo un nuovo file world.

• Per tutti gli altri tipi di trasformazione devi defnire un Raster in output.Come modalità predefinita, viene
creato un nuovo file ([nomefile]_modificato) nella stessa cartella del raster di partenza.

• Devi poi scegliere il SR (Sistema di riferimento) (sezione Lavorare con le proiezioni) per il Raster georiferito
(vedi Lavorare con le proiezioni).

• Puoi creare delle mappe pdf e anche dei report pdf. Il report fornisce informazioni sui parametri di
informazione utilizzati, un immagine dei residui e una lista con tutti i punti GCP con i loro errori standard.

• Puoi attivare la casella di controllo imposta risoluzione finale che permette di definire la risoluzione del
raster di output. il valore predefinito è 1.

• Puoi attivare la casella di controllo Utilizzare 0 per la trasparenza dove necessario, i pixel con valore 0
saranno trasparenti.

• Finally, Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Proprietà del raster

Cliccando su Proprietà raster nel menu Preferenze, si apre la finestra di dialogo Proprietà del layer - Raster.

Configurare il georeferenziatore

• You can define whether you want to show GCP coordinates and/or IDs.

• Imposta le unità dei residui, pixel e unità di mappa.

• Per i report PDF puoi definire margini e pdimensione pagina

• Puoi attivare la casella di controllo Mostra la finestra del georeferenziatore agganciata.

Eseguire la trasformazione

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.

20.12 Plugin Mappa di concentrazione

The Heatmap plugin uses Kernel Density Estimation to create a density (heatmap) raster of an input point vector
layer. The density is calculated based on the number of points in a location, with larger numbers of clustered
points resulting in larger values. Heatmaps allow easy identification of “hotspots” and clustering of points.
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20.12.1 Attivare il plugin Mappa di concentrazione

First this core plugin needs to be activated using the Plugin Manager (see La finestra di dialogo Plugins). After

activation, the heatmap icon can be found in the Raster Toolbar, and under the Raster → Heatmap menu.

Select the menu View → Toolbars → Raster to show the Raster Toolbar if it is not visible.

20.12.2 Utilizzo del plugin

Clicking the Heatmap tool button opens the Heatmap plugin dialog (see figure_heatmap_2).

La finestra di dialogo ha le seguenti opzioni:

• Input point layer: Lists all the vector point layers in the current project and is used to select the layer to be
analysed.

• Output raster: Allows you to use the button to select the folder and filename for the output raster
the Heatmap plugin generates. A file extension is not required.

• Output format: Selects the output format. Although all formats supported by GDAL can be chosen, in
most cases GeoTIFF is the best format to choose.

• Radius: Is used to specify the heatmap search radius (or kernel bandwidth) in meters or map units. The
radius specifies the distance around a point at which the influence of the point will be felt. Larger values
result in greater smoothing, but smaller values may show finer details and variation in point density.

When the Advanced checkbox is checked, additional options will be available:

• Rows and Columns: Used to change the dimensions of the output raster. These values are also linked to
the Cell size X and Cell size Y values. Increasing the number of rows or columns will decrease the cell size
and increase the file size of the output file. The values in Rows and Columns are also linked, so doubling
the number of rows will automatically double the number of columns and the cell sizes will also be halved.
The geographical area of the output raster will remain the same!

• Cell size X and Cell size Y: Control the geographic size of each pixel in the output raster. Changing these
values will also change the number of Rows and Columns in the output raster.

• Kernel shape: The kernel shape controls the rate at which the influence of a point decreases as the distance
from the point increases. Different kernels decay at different rates, so a triweight kernel gives features
greater weight for distances closer to the point then the Epanechnikov kernel does. Consequently, triweight
results in “sharper” hotspots, and Epanechnikov results in “smoother” hotspots. A number of standard
kernel functions are available in QGIS, which are described and illustrated on Wikipedia.

• Decay ratio: Can be used with Triangular kernels to further control how heat from a feature decreases with
distance from the feature.

– A value of 0 (=minimum) indicates that the heat will be concentrated in the centre of the given radius
and completely extinguished at the edge.

– A value of 0.5 indicates that pixels at the edge of the radius will be given half the heat as pixels at the
centre of the search radius.

– A value of 1 means the heat is spread evenly over the whole search radius circle. (This is equivalent
to the ‘Uniform’ kernel.)

– A value greater than 1 indicates that the heat is higher towards the edge of the search radius than at the
centre.

The input point layer may also have attribute fields which can affect how they influence the heatmap:

• Use radius from field: Sets the search radius for each feature from an attribute field in the input layer.

• Use weight from field: Allows input features to be weighted by an attribute field. This can be used to
increase the influence certain features have on the resultant heatmap.
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When an output raster file name is specified, the [OK] button can be used to create the heatmap.

20.12.3 Tutorial: Creating a Heatmap

For the following example, we will use the airports vector point layer from the QGIS sample dataset (see Dati
campione). Another excellent QGIS tutorial on making heatmaps can be found at http://www.qgistutorials.com.

In Figure_Heatmap_1, the airports of Alaska are shown.

Figure 20.23: Airports of Alaska

1. Select the Heatmap tool button to open the Heatmap dialog (see Figure_Heatmap_2).

2. In the Input point layer field, select airports from the list of point layers loaded in the current
project.

3. Specify an output filename by clicking the button next to the Output raster field. Enter the filename
heatmap_airports (no file extension is necessary).

4. Leave the Output format as the default format, GeoTIFF.

5. Change the Radius to 1000000 meters.

6. Click on [OK] to create and load the airports heatmap (see Figure_Heatmap_3).

QGIS will generate the heatmap and add the results to your map window. By default, the heatmap is shaded in
greyscale, with lighter areas showing higher concentrations of airports. The heatmap can now be styled in QGIS
to improve its appearance.

1. Open the properties dialog of the heatmap_airports layer (select the layer heatmap_airports,
open the context menu with the right mouse button and select Properties).

2. Select the Style tab.

3. Change the Render type to ‘Singleband pseudocolor’.

4. Select a suitable Color map , for instance YlOrRed.
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Figure 20.24: The Heatmap Dialog

Figure 20.25: The heatmap after loading looks like a grey surface
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5. Click the [Load] button to fetch the minimum and maximum values from the raster, then click the [Classify]
button.

6. Press [OK] to update the layer.

Il risultato finale è mostrato nella figura Figure_Heatmap_4.

Figure 20.26: Styled heatmap of airports of Alaska

20.13 Plugin Interpolazione

The Interpolation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (see
Figure_interpolation_1). The plugin requires the following parameters to be specified before running:

• Input Vector layers: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combo box.

• Attributo interpolazione: seleziona il campo attributo da utilizzare per l’interpolazione e abilita la casella

di controllo Usa la coordinata Z per l’interpolazione per utilizzare i valori Z del livello.

• Interpolation Method: Select the interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’. With the TIN method you can create a surface formed by
triangles of nearest neighbor points. To do this, circumcircles around selected sample points are created
and their intersections are connected to a network of non overlapping and as compact as possible triangles.
The resulting surfaces are not smooth. When using the IDW method the sample points are weighted during
interpolation such that the influence of one point relative to another declines with distance from the unknown
point you want to create. The IDW interpolation method also has some disadvantages: the quality of the
interpolation result can decrease, if the distribution of sample data points is uneven. Furthermore, maximum
and minimum values in the interpolated surface can only occur at sample data points. This often results in
small peaks and pits around the sample data points.
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• Configure Interpolation Method: Configure the interpolation method you have chosen. For the TIN
method you can choose between Linear and Clough Toucher (cubic) interpolation methods. You can also
save the triangulation in shapefile format. For IDW interpolation you can set the distance coefficient.

• Numero di colonne/righe: Specifica il numero di righe e colonne per il file di output raster.

• File di output: nome del raster di output.

• Aggiungi il risultato al progetto per caricare il risultato sulla mappa.

Note that using lines as constraints for the interpolation the triangulation (TIN method) you can either use ‘struc-
ture lines’ or ‘break lines’. When using ‘break lines’ you produce sharp breaks in the surface while using ‘structure
lines’ you produce continuous breaks. The triangulation is modified by both methods such that no edge crosses a
breakline or structure line.

Figure 20.27: Plugin Interpolazione

20.13.1 Utilizzo del plugin

1. Start QGIS and load a point vector layer (e.g., elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see La finestra di dialogo Plugins) and click on the

Raster → Interpolation → Interpolation menu, which appears in the QGIS menu bar. The Interpolation
plugin dialog appears as shown in Figure_interpolation_1.

3. Select an input layer (e.g., elevp ) and column (e.g., ELEV) for interpolation.

4. Seleziona un metodo di interpolazione (per esempio ‘Rete Irregolare Triangolata (TIN)’), e specifica la
dimensione delle celle a 5000 come il nome del raster output(per esempio elevation_tin).

5. Cliccare su [OK].

20.14 Client Catalogo MetaSearch

20.14.1 Introduzione

MetaSearch è un plugin di QGIS per interfacciarsi con i servizi di catalogazione metadati, con il supporto dello
standard Catalogue Service for the Web (CSW) dell’OGC.

MetaSearch offre un approccio semplice ed intuitivo con un’interfaccia user-friendly per effettuare ricerche in
cataloghi di metadati all’interno di QGIS.
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20.14.2 Installazione

MetaSearch is included by default with QGIS 2.0 and higher. All dependencies are included within MetaSearch.

Installa MetaSearch dal gestore di plugin di QGIS o manualmente da http://plugins.qgis.org/plugins/MetaSearch.

20.14.3 Lavorare con i cataloghi di metadati in QGIS

CSW (Catalogue Service for the Web)

CSW (Catalogue Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines com-
mon interfaces to discover, browse and query metadata about data, services, and other potential resources.

Avvio

To start MetaSearch, click icon or select Web → MetaSearch → MetaSearch via the QGIS main menu. The
MetaSearch dialog will appear. The main GUI consists of three tabs: Services, Search and Settings.

Gestione servizi catalogazione

The Services tab allows the user to manage all available catalogue services. MetaSearch provides a default list of
Catalogue Services, which can be added by pressing [Add default services] button.

Per l’elenco di tutti i servizi di catalogazione, fare click sul menu a scomparsa.

20.14. Client Catalogo MetaSearch 383

http://plugins.qgis.org/plugins/MetaSearch
http://www.opengeospatial.org/standards/cat
http://www.opengeospatial.org


QGIS User Guide, Release 2.14

Figure 20.28: Gestione servizi catalogazione

To add a Catalogue Service entry, click the [New] button, and enter a Name for the service, as well as the URL
(endpoint). Note that only the base URL is required (not a full GetCapabilities URL). Clicking [OK] will add the
service to the list of entries.

To edit an existing Catalogue Service entry, select the entry you would like to edit and click the [Edit] button, and
modify the Name or URL values, then click [OK].

To delete a Catalogue Service entry, select the entry you would like to delete and click the [Delete] button. You
will be asked to confirm deleting the entry.

MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="http://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>

To load a list of entries, click the [Load] button. A new window will appear; click the [Browse] button and
navigate to the XML file of entries you wish to load and click [Open]. The list of entries will be displayed. Select
the entries you wish to add from the list and click [Load].

Click the [Service info] button to displays information about the selected Catalogue Service such as service
identification, service provider and contact information. If you would like to view the raw XML response, click
the [GetCapabilities response] button. A separate window will open displaying Capabilities XML.
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Ricerca servizi di catalogazione

Figure 20.29: Searching catalogue services

The Search tab allows the user to query Catalogue Services for data and services, set various search parameters
and view results.

Sono disponibili i seguenti parametri di ricerca:

• Keywords: free text search keywords

• From: the Catalogue Service to perform the query against

• Bounding box: the spatial area of interest to filter on defined by Xmax, Xmin, guilabel:Ymax, and guil-
abel:Ymin. Click [Set global] to do a global search, click [Map extent] to do a search on the visible area
only or manually enter custom values as desired

Clicking the [Search] button will search the selected Metadata Catalogue. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the [View search results as XML] button opens a window with the service
response in raw XML format.

Clicking a result will provides the following options:

• se il metadato ha un’estensione geografica associata, ne verranno mostrati i limiti nella mappa

• doppio click su un record ne mostra i metadati con qualsiasi collegamento di accesso associato. Cliccando
su un link questo verrà aperto all’interno del browser

• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate [Add to
WMS/WMTS|WFS|WCS] buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialogue will then appear
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Figure 20.30: Metadata record display

Impostazioni

You can fine tune MetaSearch with the following settings:

• Connection naming: when adding an OWS connection (WMS/WMTS|WFS|WCS), the connection is stored
with the various QGIS layer provider. Use this setting to set whether to use the name provided from
MetaSearch, whether to overwrite or to use a temporary name

• Results paging: when searching metadata catalogues, the number of results to show per page. Default value
is 10

• Timeout: when searching metadata catalogues, the number of seconds for blocking connection attempt.
Default value is 10

20.15 Plugin Offline Editing

For data collection, it is a common situation to work with a laptop or a cell phone offline in the field. Upon return-
ing to the network, the changes need to be synchronized with the master datasource (e.g., a PostGIS database). If
several persons are working simultaneously on the same datasets, it is difficult to merge the edits by hand, even if
people don’t change the same features.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.
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Figure 20.31: Metasearch setting

20.15.1 Utilizzo del plugin

• Open some vector layers (e.g., from a PostGIS or WFS-T datasource).

• Save it as a project.

• Go to Database → Offline Editing → Convert to offline project and select the layers to save. The content
of the layers is saved to SpatiaLite tables.

• Modificare il layer in modalità non in linea.

• After being connected again, upload the changes using Database → Offline Editing → Synchronize.

20.16 Oracle Spatial GeoRaster Plugin

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

carica un raster nella tabella predefinita GDAL_IMPORT in una colonna con nome RASTER.

20.16.1 Gestire le connessioni

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see La finestra di dialogo Plu-
gins). The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database that

contains the data. To do this, begin by clicking on the Add Oracle GeoRaster Layer toolbar button – this will open
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Figure 20.32: Crea un progetto offline da PostGis o layer WFS

the Select Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the
connection parameters (See Figure_oracle_raster_1):

• Name: Enter a name for the database connection.

• Database instance: Enter the name of the database that you will connect to.

• Username: Specify your own username that you will use to access the database.

• Password: Provide the password associated with your username that is required to access the database.

Figure 20.33: Finestra di dialogo di creazione connessione Oracle

Cliccando su [OK] parametri della connessione vengono salvati e si ritorna nella finestra di dialogo per la scelta del
georaster (figura Figure_oracle_raster_2), Selezionare la connessione appena impostata e cliccare su [Connetti]
per modificare la connessione cliccare su [Modifica], per rimuoverla cliccare su [Elimina].
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20.16.2 Selezionare un GeoRaster

Once a connection has been established, the subdatasets window will show the names of all the tables that contain
GeoRaster columns in that database in the format of a GDAL subdataset name.

Selezionare una tabella con il mouse e cliccare su [Seleziona]: apparirà un nuovo elenco con i nomi delle colonne
GeoRaster della tabella selezionata.

Click on one of the listed subdatasets and then click on [Select] to choose one of the table/column combinations.
The dialog will now show all the rows that contain GeoRaster objects. Note that the subdataset list will now show
the Raster Data Table and Raster Id pairs.

At any time, the selection entry can be edited in order to go directly to a known GeoRaster or to go back to the
beginning and select another table name.

Figure 20.34: Finestra di dialogo di selezione GeoRaster Oracle

The selection data entry can also be used to enter a WHERE clause at the end of the iden-
tification string (e.g., geor:scott/tiger@orcl,gdal_import,raster,geoid=). See
http://www.gdal.org/frmt_georaster.html for more information.

20.16.3 Visualizzare un GeoRaster

Finally, by selecting a GeoRaster from the list of Raster Data Tables and Raster Ids, the raster image will be loaded
into QGIS.

The Select Oracle Spatial GeoRaster dialog can be closed now and the next time it opens, it will keep the same
connection and will show the same previous list of subdatasets, making it very easy to open up another image
from the same context.

Nota: GeoRasters that contain pyramids will display much faster, but the pyramids need to be generated outside
of QGIS using Oracle PL/SQL or gdaladdo.

The following is an example using gdaladdo:
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gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Questo è, invece, un esempio con PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

20.17 Plugin Analisi geomorfologica

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (see Figure_raster_terrain_1).

Descrizione delle analisi:

• Slope: Calculates the slope angle for each cell in degrees (based on first- order derivative estimation).

• Esposizione: 0 gradi per nord e continuando in senso orario.

• Hillshade: Creates a shaded map using light and shadow to provide a more three-dimensional appearance
for a shaded relief map. The output map is a Single band gray reflecting the gray value of the pixels.

• Ruggedness Index: A quantitative measurement of terrain heterogeneity as described by Riley et al. (1999).
It is calculated for every location by summarizing the change in elevation within the 3x3 pixel grid.

• Relief: Creates a shaded relief map from digital elevation data. Implemented is a method to choose the
elevation colors by analysing the frequency distribution. The output map is a multiband color with three
bands reflecting the RGB values of the shaded relief.

Figure 20.35: Plugin Analisi geomorfologica (calcolo pendenza)

20.17.1 Usare il plugin

1. Start QGIS and load the gtopo30 raster layer from the GRASS sample location.

2. Load the Raster Terrain Analysis plugin in the Plugin Manager (see La finestra di dialogo Plugins).

3. Select an analysis method from the menu (e.g., Raster → Terrain Analysis → Slope). The Slope dialog
appears as shown in Figure_raster_terrain_1.
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4. Specificare nome, percorso e formato del file di output.

5. Cliccare su [OK].

20.18 Plugin grafo strade

The Road Graph Plugin is a C++ plugin for QGIS that calculates the shortest path between two points on any
polyline layer and plots this path over the road network.

Figure 20.36: Plugin grafo strade

Caratteristiche principali:

• Calculates path, as well as length and travel time.

• Optimizes by length or by travel time.

• Exports path to a vector layer.

• Highlights roads directions (this is slow and used mainly for debug purposes and for the settings testing).

As a roads layer, you can use any polyline vector layer in any QGIS-supported format. Two lines with a common
point are considered connected. Please note, it is required to use layer CRS as project CRS while editing a roads
layer. This is due to the fact that recalculation of the coordinates between different CRSs introduces some errors
that can result in discontinuities, even when ‘snapping’ is used.

In the layer attribute table, the following fields can be used:

• Speed on road section (numeric field).

• Direction (any type that can be cast to string). Forward and reverse directions correspond to a one-way road,
both directions indicate a two-way road.

If some fields don’t have any value or do not exist, default values are used. You can change defaults and some
plugin settings in the plugin settings dialog.
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20.18.1 Utilizzo del plugin

After plugin activation, you will see an additional panel on the left side of the main QGIS window. Now, en-
ter some parameters into the Road graph plugin settings dialog in the Vector → Road Graph menu (see fig-
ure_road_graph_2).

Figure 20.37: Road graph plugin settings

After setting the Time unit, Distance unit and Topology tolerance, you can choose the vector layer in the Trans-
portation layer tab. Here you can also choose the Direction field and Speed field. In the Default settings tab, you
can set the Direction for the calculation.

Finally, in the Shortest Path panel, select a Start and a Stop point in the road network layer and click on [Calcu-
late].

20.19 Plugin Spatial Query

The Spatial Query Plugin allows you to make a spatial query (i.e., select features) in a target layer with reference to
another layer. The functionality is based on the GEOS library and depends on the selected source feature layer.

Gli operatori spaziali sono:

• Contiene

• E’ uguale a

• Sovrappone

• Attraversa

• Interseca

• E’ disgiunto

• Tocca

• E’ contenuto
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20.19.1 Come usare il plugin

Come esempio: trova le regioni dell’Alaska che contengono areoporti. Sono necessari i seguenti passaggi:

1. Start QGIS and load the vector layers regions.shp and airports.shp.

2. Load the Spatial Query plugin in the Plugin Manager (see La finestra di dialogo Plugins) and click on the
Spatial Query icon, which appears in the QGIS toolbar menu. The plugin dialog appears.

3. Seleziona il layer regions come layer principale airports come layer di riferimento.

4. Seleziona l’operatore ‘Contains’e clicca [Apply].

Ora avrai una lista di risultatu IDs dall’interrogazione, come mostra la figure_spatial_query_1

• Click on Create layer with list of items.

• Select an ID from the list and click on Create layer with selected.

• Select ‘Remove from current selection’ in the field And use the result to .

• You can Zoom to item or display Log messages.

• Additionally in Result Feature ID’s with the options ‘Invalid source’ and ‘Invalid reference’ you can have a
look at features with geometry errors. These features aren’t used for the query.

Figure 20.38: Spatial Query analysis - regions contain airports

20.20 Validatore topologico

La topologia tratta le relazioni spaziali tra punti, linee e poligoni, che rappresentano le geometrie di una re-
gione geografica. Con il validatore topologico puoi verificare se i tuoi vettori rispettano le regole topologiche.
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Figure 20.39: Il validatore topologico

Queste regole verificano se le relazioni spaziale delle geometrie di un vettore sono ‘Uguali’, ‘Contiene’, ‘Sovrap-
pone’, ‘Sovraposta’, ‘Incrocia’, o se i vettori sono ‘Disgiunti’, ‘Intersecano’, Sovrastano’ o ‘Toccano’ altri vettori.
Dipende dalle tue richieste su quali regole di topologia applicherai per i vettori (ad esempio, normalmente non
accetterai superamento in vettori di linee se non nel caso di raffigurazione di strade senza uscita).

QGIS ha integrata una funzione di editing topologico molto utile per la creazione di nuove geometrie senza errori.
Ma gli errori di dati esistenti e gli errori degli utenti sono difficili da trovare. Questo plugin ti aiuta a trovare tali
errori attraverso un elenco di regole topologiche.

E’ molto semplice creare condizioni topologiche con il validatore topologico

Sui vettori di punti puoi utilizzare le seguenti condizioni:

• deve essere coperto da: puoi scegliere un vettore dal progetto. I punti che non sono coperti da un dato
vettore vengono messi nel campo ‘errore’.

• deve essere coperto dai punti terminali: puoi scegliere vettore di linee dal progetto.

• deve essere dentro: puoi scegliere un vettore poligono dal progetto. I punti devono essere all’interno di un
poligono. In caso contrario, segnala ‘Errore’ per il punto.

• non deve avere duplicati: ogni volta che un punto è rappresentato due o più volte, apparirà nel campo
‘Errore’.

• non deve avere geometrie non valide: verifica se le geometrie sono validi.

• non deve avere geometrie multi-part: tutti i punti multipli sono segnalati come ‘Errore’.

Sui vettori di linee hai a disposizione le seguenti regole topologiche:

• End points must be covered by: Here you can select a point layer from your project.

• non deve avere nodi sospesi: individuerà le eccedenze nel vettore di linee.

• non deve avere duplicati: ogni volta che una linea è rappresentata due o più volte, apparirà nel campo
‘Errore’.
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• non deve avere geometrie non valide: verifica se le geometrie sono validi.

• non deve avere geometrie multi-part: alcune volte, una geometria è in realtà un insieme di geometrie sem-
plici (single-parte). Tale geometria è chiamato geometria multi-part. Se contiene anche un solo elemento
di geometria multi-part, noi lo chiamiamo punti multipli, linee-multiple o poligoni multipli. Tutte le linee
multiple sono segnalate come ‘Errore’.

• non deve avere pseudo: il punto terminale di una linea dovrebbe essere collegato ai punti finali di altre
due geometrie. Se il punto terminale è collegato al punto terminale di una sola altra geometria, il punto
terminale è chiamato un nodo pseudo.

Per i vettori poligono hai a disposizione le seguenti regole:

• deve contenere: il vettore poligono deve contenere almeno un punto della geometria dal secondo vettore.

• non deve avere duplicati: i poligoni dello stesso vettore non devono avere geometrie identiche. Ogni volta
che un poligono è rappresentato due o più volte aparirà nel campo ‘Errore’.

• non deve avere vuoti: poligoni adiacenti non devono formare spazi vuoti tra di loro. I confini amministrativi
potrebbero essere citati come esempio (poligoni stato degli Stati Uniti non hanno spazi vuoti tra di loro ...).

• non deve avere geometrie non valide: verifica se le geometrie sono validi. Alcune delle regole che definis-
cono una geometria validi sono:

– I poligoni anello devono essere chiusi.

– Anelli che definiscono i buchi devono essere all’interno anelli che definiscono i confini esterni.

– Gli anelli non possono auto-intersecarsi (non si possono né toccare né incrociare l’un l’altro).

– Gli anelli non tocchino altri anelli, tranne che in un punto.

• non deve avere geometrie multi-part: alcune volte, una geometria è in realtà un insieme di geometrie sem-
plici (single-parte). Tale geometria è chiamato geometria multi-part. Se contiene anche un solo elemento di
geometria multi-part, noi lo chiamiamo punti multipli, linee-multiple o poligoni multipli. Ad esempio, un
paese composto di una o più isole può essere rappresentato come un multi-poligono.

• non deve sovrapporsi: poligoni adiacenti non devono condividere un’area comune.

• non deve sovrapporsi con: poligoni adiacenti da un vettore non devono condividere un’area comune con
poligoni di un altro vettore.

20.21 Plugin Statistica zonale

With the Zonal statistics plugin, you can analyze the results of a thematic classification. It allows you
to calculate several values of the pixels of a raster layer with the help of a polygonal vector layer (see fig-
ure_zonal_statistics). Choosing a color band, the plugin generates output columns in the vector layer with an
user-defined prefix and calculates for each polygon, statistics on pixels that are within. The available statistics are
:

• Count: to count the number of pixels

• Sum: to sum the pixel values

• Mean: to get the mean of pixel values

• Median: to get the median of pixel values

• StDev: to get the standard deviation of pixel values

• Min: to get the minimum of pixel values

• Max: to get the maximum of pixel values

• Range: to get the range (max - min) of pixel values

• Minority: to get the less represented pixel value
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• Majority: to get the most represented pixel value

• Variety: to count the number of distinct pixel values

Figure 20.40: Zonal statistics dialog
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CHAPTER 21

Aiuto e supporto

21.1 Le Mailing list

QGIS è in continuo sviluppo e, come tale, non funzionerà sempre come ci si aspetta. Il miglior modo di ottenere
aiuto è unirsi a una mailing list di qgis. Le vostre domande raggiungeranno una audience più ampia e le risposte
ottenute saranno anche a beneficio di altri.

21.1.1 qgis-users

Questa mailing list è usata per discussioni su QGIS in generale, così come per domande speci-
fiche sulla sua installazione ed uso. Potete sottoscrivere la maling list qgis-users al seguente URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

21.1.2 fossgis-talk-liste

Per l’utenza di lingua tedesca, FOSSGIS e.V. mette a disposizione la mailing list fossgis-talk-liste. Questa mailing
list è usata per discussioni sul GIS open source in generale, incluso QGIS. Potete sottoscrivere la mailing list
fossgis-talk-liste al seguente URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

21.1.3 qgis-developer

Gli sviluppatori con problemi di natura più tecnica possono unirsi alla mailing list qgis-developer andando qui:
http://lists.osgeo.org/mailman/listinfo/qgis-developer

21.1.4 qgis-ux

Una lista dedicata dove le persone possono leggere e discutere riguardo all’esperienza d’uso (User Experience) di
QGIS o ai suoi problemi di usabilità.

http://lists.osgeo.org/mailman/listinfo/qgis-ux

21.1.5 qgis-commit

Ogni volta che viene inserito un ‘commit’ repository del codice di QGIS, viene inviata una email a questa mailing
list. Se desiderate essere aggiornati su ogni cambiamento all’attuale codice, potete sottoscrivere questa mailing
list all’URL: http://lists.osgeo.org/mailman/listinfo/qgis-commit
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21.1.6 qgis-trac

Questa mailing list notifica email collegate alla gestione del progetto, inlcusi i bug report, i compiti assegnati e le
richieste di nuove caratteristiche. Potete sottoscriverla all’URL: http://lists.osgeo.org/mailman/listinfo/qgis-trac

21.1.7 qgis-community-team

Questa mailing list si occupa di argomenti come la documentazione, l’aiuto contestuale, la guida utente, i siti web
e i lavori di traduzione. Se volete lavorare anche sulla guida utente, questa mailing list è un buon punto di partenza
per fare le vostre domande. Potete sottoscriverla all’URL: http://lists.osgeo.org/mailman/listinfo/qgis-community-
team

21.1.8 qgis-release-team

Questa mailing list si occupa di argomenti quali il processo di rilascio, i pacchetti binari per i
vari sistemi operativi e l’annuncio delle nuove release in generale. Potete sottoscriverla all’URL:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

21.1.9 qgis-tr

Questa lista si occupa delle traduzioni. Chi desidera lavorare alla traduzione del sito web, dei manuali o
dell’intefaccia grafica (GUI) trova in questa lista un buon punto di partenza per le proprie domande. La lista
può essere sottoscritta all’URL http://lists.osgeo.org/mailman/listinfo/qgis-tr

21.1.10 qgis-edu

Questa lista si occupa degli aspetti educativi di QGIS. Chi desidera lavorare su materiali educativi trova
in questa lista un buon punto di partenza per le proprie domande. Può essere sottoscritta all’URL
http://lists.osgeo.org/mailman/listinfo/qgis-edu

21.1.11 qgis-psc

This list is used to discuss Steering Committee issues related to overall management and direction of QGIS. You
can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-psc

Siete invitati a sottoscrivere qualunque mailing list desideriate fra queste. Ricordate che potete contribuire rispon-
dendo alle domande e condividendo le vostre esperienze. Notate che le mailing list qgis-commit e qgis-trac sono
riservate alle sole notifiche e non sono dedicate allo scambio di comunicazioni fra gli utenti.

21.2 IRC

Siamo anche presenti su IRC - ci si può registrare al canale #qgis su irc.freenode.net. Per favore, aspettate pazien-
temente le risposte alle vostre domande, dato che molte persone sul canale IRC sono al lavoro su altre cose, e
potrebbero impiegare un po’ di tempo prima di notare la vostra richiesta. Se avete perso una discussione su IRC,
non c’è problema! Noi registriamo tutte le discussioni, cosicchè possiate mettervi in pari semplicemente leggendo
i log salvati su http://qgis.org/irclogs.

E’ inoltre disponibile un supporto commerciale per QGIS. Per maggiori informazioni, visitate il sito web
http://qgis.org/en/commercial-support.html.
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21.3 BugTracker

Sebbene la mailing list qgis-users sia utile per domande del tipo ‘come si fa XYZ su QGIS?’, potreste vol-
erci comunicare qualche bug. Potete inviare le vostre segnalazioni utilizzando il bug tracker di QGIS, all’URL
http://hub.qgis.org/projects/quantum-gis/issues. Nel creare un nuovo ticket, per favore fornite anche un indirizzo
email al quale potervi contattare per ulteriori informazioni.

Ricordate che un bug da voi segnalato potrebbe ricevere una priorità diversa da quella che vi aspettereste (a seconda
della serietà del problema). Alcuni errori richiedono un significativo sforzo allo sviluppatore e non sempre ci sono
abbastanza risorse umane disponibili.

Le richieste per nuove caratteristiche possono essere sottoposte tramite lo stesso sistema di segnalazioni usato per
i bug. Assicuratevi di aver prima selezionato il tipo Feature.

If you have found a bug and fixed it yourself, you can submit either a Pull Request on the Github QGIS Project
(prefered) or a patch also. The lovely redmine ticketsystem at http://hub.qgis.org/projects/quantum-gis/issues has
this type as well. Check the Patch supplied checkbox and attach your patch before submitting your bug.
One of the developers will review it and apply it to QGIS. Please don’t be alarmed if your patch is not applied
straight away – developers may be tied up with other commitments.

Note that if you supply a Pull Request, your change would be more likely be merged into the source code!

21.4 Blog

The QGIS community also runs a weblog at http://planet.qgis.org/planet/, which has some interesting articles for
users and developers as well provided by other blogs in the community. You are invited to contribute your own
QGIS blog!

21.5 Plugins

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here, you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.

21.6 Wiki

Lastly, we maintain a WIKI web site at http://hub.qgis.org/projects/quantum-gis/wiki where you can find a variety
of useful information relating to QGIS development, release plans, links to download sites, message-translation
hints and more. Check it out, there are some goodies inside!
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CHAPTER 22

Appendice

22.1 GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
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any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or exe-
cutable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,
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(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and “any later version”, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTH-
ERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGES.

QGIS Qt exception for GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code of this program
with the Qt library, including but not limited to the following versions (both free and commercial): Qt/Non-
commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded (or with modified versions of Qt that use
the same license as Qt), and distribute linked combinations including the two. You must obey the GNU General
Public License in all respects for all of the code used other than Qt. If you modify this file, you may extend this
exception to your version of the file, but you are not obligated to do so. If you do not wish to do so, delete this
exception statement from your version.

22.2 GNU General Public License

Version 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

http://fsf.org/

Ognuno ha la possibilità di copiare e distribuire copie letterali di questo documento di licenza, i cambi non sono
permessi.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying
it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.
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This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers
to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related
matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be
a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical,
ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is
called Opaque.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format,
LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML,
PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF
and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word pro-
cessors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-
generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.)
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To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many
as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICHE

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses
a copy of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.

3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.
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7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the “History” section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and pre-
serve in the section all the substance and tone of each of the contributor acknowledgements and/or dedica-
tions given therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

13. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

14. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant
Section.

15. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections
as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from
the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections
of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents,
make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author
or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in
the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming
one section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections
Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other respects
regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in
or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the
compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket
the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the
terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright
holders, but you may include translations of some or all Invariant Sections in addition to the original versions of
these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation and the
original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (sec-
tion 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt
of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a
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proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained
in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with ... Texts.” line with
this:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.
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